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Dear Reader,

Thank you for choosing Introducing Revit Architecture 2010: BIM for Beginners. This 

book is part of a family of premium-quality Sybex books, all of which are written by out-

standing authors who combine practical experience with a gift for teaching.

Sybex was founded in 1976. More than 30 years later, we’re still committed to produc-

ing consistently exceptional books. With each of our titles, we’re working hard to set a new 

standard for the industry. From the paper we print on, to the authors we work with, our 

goal is to bring you the best books available.

I hope you see all that reflected in these pages. I’d be very interested to hear your com-

ments and get your feedback on how we’re doing. Feel free to let me know what you think 

about this or any other Sybex book by sending me an email at nedde@wiley.com. If you think 

you’ve found a technical error in this book, please visit http://sybex.custhelp.com. 

Customer feedback is critical to our efforts at Sybex. 

	 Best regards,

	  

	 Neil Edde

	 Vice President and Publisher

	 Sybex, an Imprint of Wiley
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Introduction
Welcome to the third  edition of Introducing Revit Architecture, which 

was written based on the 2010 release of the software.

It was great fun revisiting our first book — we worked hard to polish it up and cap-

ture the new features in the 2010 release of Revit Architecture. We enjoyed the synergy 

of three friends, three architects, three authors collaborating to bring this project into 

reality. But mostly, we were all driven by the feeling that we’re doing something great: 

introducing Revit to those who have not been acquainted with its incredible power and 

its ability to put some fun back into using software and designing architecture.

This book is written for beginners who have never seen (or may have only heard about) 

Revit. It’s for architects of any generation — you don’t need to be a high-tech wizard to get 

into Revit. Toward that end, we wanted to make a book that is as much about architecture 

as it is about software. We’ve added many time-saving and inspiring concepts to the book 

to get you motivated and to help you on your journey into the new era of building infor-

mation modeling (BIM). We think we’ve succeeded, because the book is full of real-world 

examples that show how to use Revit practically and creatively based on all of our experi-

ences out there in professional practice.

This book will help you learn Revit and BIM basics easily and efficiently via straight-

forward explanations, real-world examples, and practical tutorials that focus squarely on 

accomplishing vital Revit tasks.

Our book begins with an overview of BIM concepts before introducing the Revit inter-

face. You’ll start working with basic modeling features, learning how to create walls, floors, 

roofs, and stairs. The book then explains how to use components and provides descriptions 

and examples of Revit’s suite of editing tools.

The book continues by looking deeper into the capabilities of core modeling elements. 

We explain how Revit works with other applications, show you how to document the 

model for construction, and explore how you can integrate annotations into the model.

After we discuss printing to paper and files, we explore worksets and team collabora-

tion, followed by a look at some of Revit’s more advanced options. The book concludes 

with a chapter on troubleshooting and best practices; that’s where we try to share our 

practical experience with you so you can avoid some of the common beginner pitfalls 
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xvi  ■   Introduction

(and enjoy beginner’s luck). Also featured is a full-color gallery containing inspirational 

Revit projects from around the globe.

The book’s companion web page, at www.wiley.com/go/introducingrevit2010, features all 

the tutorial files necessary to complete the book’s exercises, plus sample families and a trial 

version of the Revit software. 

Enjoy! Revit has changed our lives. Maybe it will change yours as well.

We welcome your feedback! Please feel free to e‑mail us at GoRevit@gmail.com.

Tatjana Dzambazova

Eddy Krygiel

Greg Demchak
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Understanding BIM

C hap te r 1

A great building must begin with the unmeasurable, must go through measurable 

means when it is being designed and in the end must be unmeasurable.

Louis Kahn——

Building information modeling  (BIM) is an emerging 

approach to the design, analysis, and documentation of buildings. At its core, BIM is about 

the management of information throughout the entire life cycle of a design process, from 

early conceptual design through construction administration, and even into facilities 

management. By information we mean all the inputs that go into a building design: the 

number of windows, the cost of materials, the size of heating and cooling equipment, 

the total energy footprint of the building, and so on. This information is captured in a 

digital model that can then be presented as coordinated documents, be shared across 

disciplines, and serve as a centralized design management tool. With a tool like Revit, 

you will reap the benefits of fully coordinated documents, but this represents just the tip 

of the BIM iceberg.

In this chapter, we’ll present the BIM basics and summarize how BIM differs from 

traditional 2D drafting-based methodologies. We will explain the key characteristics of 

Revit and how Revit is elegantly designed to deliver the benefits of building information 

modeling. Topics we’ll cover include:

A brief history of architectural documentation■■

Advantages of a BIM approach■■

How BIM is different from CAD■■

Why Revit?■■

Revit concepts■■

Types of elements in Revit■■

Tips for getting started in Revit■■

73559c01.indd   1 6/2/09   1:49:09 PM



2  ■   Chapter 1 : Understanding BIM

A Brief History of 
Architectural Documentation
The production of design documents has traditionally been an 

exercise in making drawings to represent a building. These 

drawings become instruction document sets: an annotated 

booklet that describes how the building is to be built. The plan, 

section, and elevation are all skillfully drafted, line by line, draw-

ing by drawing. Whether physical or digital, these traditional 

drawing sets are composed of graphics where each line is part of a 

larger abstraction meant to convey design intent so that a build-

ing can eventually be constructed. When Filippo Brunelleschi 

drew the plans for Santa Maria del Fiore (Figure 1.1) in 

Renaissance Italy, the drawings represented ideas of what the 

building would look like. They were simplified representations of 

a completed project, used to convey ideas to the patron. In those 

days, the architect also played the role of builder, so there was no 

risk of losing information between the documentation of the 

building and the actual building of it. This was the age of the 

master builder, when architect and builder shared the same 

responsibility and roles. Even so, Brunelleschi still needed to 

communicate his vision to his patrons and his workers, and he 

not only produced beautiful drawings, but also built elaborate 

scale models so that others could easily visualize the project.

As buildings became increasingly complex, specialization in 

the design and construction process emerged. In turn, this led to 

the need for more elaborate forms of information exchange. One 

person was no longer responsible for both the design and con-

struction phases, so it became necessary for designers to convey 

design intent with richer amounts of information and 

instructions.

Jump ahead in time to the twentieth century. The use of steel 

had been fully embraced, thus allowing buildings to reach higher 

than ever before; the age of the skyscraper and modern construc-

tion was in full force. The Power and Light Building (Figure 1.2) 

was erected in Kansas City, Missouri, in only 19 months. An Art 

Deco testament to the boldness of the times, the building was 

Figure 1.1

Santa Maria 
del Fiore

Ima


g
e

 co


u
rtes




y
 of

 
L

a
u

ra


 L
es

n
iewski






Figure 1.2

Power and  
Light Building, 

Kansas City, MO
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A Brief History of Architectural Documentation  ■   3

built without the use of modern earthmoving machinery or other heavy equipment. The 

drawing set for a building of this size in the 1930s would have been about 35 pages long. 

The Power and Light Building was more complex than its predecessors but far simpler 

than today’s large commercial projects. There were no data or telecom systems, no air 

conditioning other than operable windows, and no security systems other than locks on 

the doors.

Fast-forward to late twentieth-century buildings. Buildings are now more complex 

than ever before. Documentation sets span all disciplines and are hundreds of pages long. 

The number of people who will touch a set of drawings — to produce them, evaluate them, 

or use them to build the building — has become huge. Integrated building systems con-

tinue to expand with the growth of technology. Today, we have more security, electrical, 

data, telecom, HVAC, and energy requirements than ever before (see Figure 1.3). The 

quality and quantity of information that goes into a documentation set can no longer be 

thought of as abstract approximations — the cost of error is far too high, and fully coor-

dinated drawings are expected. The use of computer-based technology has replaced pen 

and paper, yet documents are still largely generated in 2D. Drawing and editing lines 

has become faster and more efficient, but in the end, they are still collections of manu-

ally created, non-intelligent lines and text.

Engaging our hyperdrive, let’s jump to 1998 — the dawn of the Internet boom. 

Technology companies are flourishing, and start-ups are a dime a dozen. In the suburbs 

of Boston, a new approach to architectural documentation is about to be launched. The 

premise is simple: model the building once, and let architects view, edit, and annotate the 

Figure 1.3

Layers of design
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4  ■   Chapter 1 : Understanding BIM

model from any point of view, at any time. A change to the model from any view simulta-

neously updates all other views. Drawings cease to be separate, uncoordinated collections 

of lines and become by-products of a model-based design approach. Revit — which 

comes from ″Revise Instantly″ — is born, and with it the foundation for a new approach 

to how buildings are designed, evaluated, represented, and documented (see Figure 1.4). 

In 2002, Autodesk acquires Revit Technology and continues to develop it. Welcome to the 

world of building information modeling.

Advantages of a BIM Approach
The ultimate benefits of BIM are still emerging in the market and will radically change 

the way buildings are designed and built. A shift in process and expectation is happening 

in the construction market, and architects are stepping up to the challenge. The focus is 

shifting from traditional 2D abstractions to on-demand simulations of building perfor-

mance, usage, and cost. This is no longer a futuristic fantasy but a practical reality. In the 

age of information-rich digital models, we can now have all disciplines involved with a 

project sharing a single database. Architecture, structure, mechanical, infrastructure, and 

construction are tied together and able to coordinate in ways never before possible. Models 

can now be sent directly to fabrication machines, bypassing the need for traditional shop 

drawings. Energy analysis can be done at the outset of design, and construction costs are 

becoming more and more predictable. These are just a few of the exciting opportunities 

that a BIM approach offers.

BIM has shifted how designers and contractors look at the entire building process, from 

preliminary design through construction documentation, into actual construction, and 

even into postconstruction building management. With BIM, a parametric 3D model is 

used to generate traditional building abstractions such as plans, sections, elevations, details, 

Figure 1.4

The founders 
and some original 
members of Revit 

Technology, having 
a tug-of-war at a 

release party, 
circa 2000
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How BIM Is Different from CAD  ■   5

and schedules. Drawings produced using BIM are not just discrete collections of manu-

ally coordinated lines but interactive representations of a model.

Working in a model-based framework guarantees that a change in one view will prop-

agate to all other views of the model. As you shift elements in plan, they change in elevation 

and section. If you remove a door from your model, it simultaneously is removed from all 

views, and your door schedule is updated. This enhanced document delivery system allows 

unprecedented control over the quality and coordination of the document set.

With the advent of BIM, designers and builders have a better way to create, control, 

and display information. Some of the advantages that first-time users can expect to real-

ize are as follows:

Three-dimensional design visualization improves understanding of the building and •	

its spaces and gives you the ability to show a variety of design options to both the 

team and the client.

Integrated design documents minimize errors in documentation cross-referencing •	

and keynoting, allowing clearer, more precise documents.

Interference checking permits you to see conflicts immediately among architectural, •	

structural, and mechanical elements in 3D and to avoid costly errors on site.

Automated, always up-to-date schedules of building components (like door and •	

room-area schedules) are data-driven, and can drive data and improve the visibility 

of costs and quantities.

Material quantity take-offs allow better predictability and planning.•	

Sustainable strategies are easier to explore, enabling you to design better buildings •	

and make a better world.

How BIM Is Different from CAD
The key difference between BIM and computer-aided design (CAD) is that a traditional 

CAD system uses many separate (usually 2D) documents to explain a building. Because 

these documents are created separately, there is little to no correlation or intelligent con-

nection among them. A wall in a plan view is represented with two parallel lines, with no 

understanding that those lines represent the same wall in a section. The possibility of 

uncoordinated data is very high. BIM takes the opposite approach: it assembles all infor-

mation into one location and cross-links that data among associated objects. The BIM 

model, by contrast, is a centralized database model. All documents within the BIM model 

are interdependent and share intelligence. (See Figures 1.5 and 1.6.)

By and large, CAD is a 2D technology that outputs a collection of lines and text on a 

page. These lines have no inherent meaning, whether inside the computer or on the printed 

sheet. CAD drafting has its efficiencies and advantages over pen and paper, but it is really 
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6  ■   Chapter 1 : Understanding BIM

just a digital simulation of the act of drafting. This form of drawing is how architects and 

other designers have worked for the last couple of hundred years. Historically, the designer 

drew a set of plans and then used those plans to manually derive sections, elevations, and 

details. During the development of a project, if any of those items changed, the designer had 

to modify each of the other drawings that were affected to take the change into account. 

For a long time, this meant getting out an eraser and an eraser shield and spending days 

picking up changes. Today, you can use the Delete key, but the goal is fundamentally the 

same. This is where BIM makes a significant departure from CAD platforms.

Figure 1.5

A CAD project 
consists of many 

uncorrelated, 
independently 

created files.
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Figure 1.6

The BIM model is a 
centralized data-
base in which all 
documents are 
interdependent.

The beauty of BIM is that it manages change for you. Unlike CAD, the intent of BIM 

is to let the computer take responsibility for interactions and calculations (something 

computers are good at), providing you — the designer — with more time to design and 

evaluate your decisions. A core feature of BIM is that it allows you to create and modify 

everything in one design context. When a change to a project is done by the user in one 

place, the system will propagate that change to all relevant views and documents of the 

project. As you model in plan, the elevations, sections, and details are also being gener-

ated. Where you make the change is up to you to decide; make the change once, and the 
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system will take care of the rest. With a BIM tool such as Revit, if you change the size of a 

window opening in elevation, this change is made throughout the entire model: sections, 

floor plans, schedule tables, and quantity take-offs.

Here are a few other big differences between BIM and CAD:

BIM adopts a task-oriented rather than an object-oriented methodology.  In 2D CAD draft-

ing you draw two lines to represent a wall. In BIM, the task of creating a wall is presented 

in the form of an interactive tool named Wall. This wall has properties like width, height, 

bearing or nonbearing, demolished or new, interior or exterior, fire rating, and materials 

(such as boards or brick). The wall interacts with other walls to automatically join geom-

etries and clean up connections, showing how the walls will be built. Similarly, if you add 

a door, it’s more than four lines and an arc; it’s a door in plan and elevation. Adding it to 

the wall automatically creates an opening in the wall in all views where the door is visible. 

As we will discover, the tools available for walls are specific to walls, allowing you to attach 

walls to roofs and floors, punch openings, and change the layered construction of the wall. 

Again, all of these interactions are not just properties; they are focused on specific tasks 

associated with architectural walls.

BIM keeps you honest.  An additional advantage of a BIM methodology is that you can’t 

cheat your design. Because the elements have properties based on real-life properties, you’ll 

find it difficult to fake elements within the design. If you have a door in plan, it automati-

cally appears in the other associated views, such as elevation or section. In a CAD-based 

system this can be easy to overlook because the door has to be manually transcribed from 

plan to section and elevation and is easily forgotten or drawn at a wrong location. Because 

BIM is based on actual assemblies, it’s difficult to misrepresent dimensions or objects 

within the model.

BIM is more than a 3D modeler.  Other software packages, like SketchUp, Rhinoceros, 

Autodesk® Alias Studio™, Autodesk® Maya® and Autodesk® 3ds Max®, are excellent model-

ing applications. However, these modeling applications don’t have the ability to document 

your design for construction or to be leveraged downstream. This is not to say these tools 

don’t play a part in a BIM workflow. Many architects use these tools to generate concept 

models, which can then be brought into a BIM application and progressed through 

design, analysis, and documentation.

BIM is a data-driven design tool.  BIM lets you create custom content and libraries through-

out the course of your project. This content contains a rich amount of data that will 

inform schedules, quantity take-offs, and analysis. Again, it’s not just 3D — it’s 3D with 

intelligent information (metadata).

BIM is based on an architectural classification system, not ″layers.″  Because a building 

model is an assembly of meaningful, to-be-built objects, you control visibility and graphics 
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of objects using a rational list of well-understood categories. This is different from CAD, 

where every line belongs to a layer, and it is up the user to manage all these layers. For 

example, in Revit, there is no way to accidentally place a window into the ″wall″ layer. In 

a BIM world, layers become obsolete; after all, in the real world buildings are not made of 

abstract, color-coded layers.

Potential Hazards
One of the powers of Revit is the ability to work in a single-file environment where the 

design and documentation of the building happens on a holistic logical model. This can 

also be a disadvantage if you do not take it seriously and give it full consideration. Users 

who may be quick to make changes, without thinking how such a change will ripple 

through the model, can cause unintended problems if they’re not careful. To put it another 

way, BIM (like any database environment) requires a great degree of accountability.

Revit is a parametric modeler: it creates relationships between building elements in 

order to streamline the design process. For example, if you delete a level from your model, 

then all the walls, doors, and furniture on that level will also be deleted. Likewise, if you 

delete a wall, all the doors and windows in that wall will be deleted. If you underlay the 

roof in your second floor so that you can see the extents of the roof overhang, deleting the 

lines that represent the roof overhang actually means deleting the roof! These are basic 

mistakes that new users might encounter as they readjust their mental model and come 

to see the model as not just lines but actual building elements. A nice consequence of this 

is that Revit will not let you leave elements floating around in an abstract, 3D vacuum. 

You will not have views cluttered with fragmented geometry from some other file, exploded 

blocks, or mysterious lines. At the same time, you must take care when making large-scale 

changes to a model, especially the further along in the design process you go.

Anticipate that tasks in Revit will take different amounts of time when compared to a 

CAD production environment. It isn’t an apples-to-apples equation. You’ll perform tasks 

in Revit that you never had in CAD; conversely, some of the CAD tasks that took weeks 

(chamfering and trimming thousands of lines to draw walls properly or making a door 

schedule) take almost no time using Revit.

If you’ve never worked in a 3D model-based environment, it can be frustrating at first 

to move from a strictly 2D world into the 3D BIM. At the same time, it’s really quite nice 

to have immediate access to perspective views at any time! The Revit world is one with a 

white screen, no layers, and no cross-references. This often leads to generic comparisons 

and some growing pains — but just stick with it, be patient, and you’ll be hooked in no 

time at all. With any transition there is a learning curve; as you begin to use Revit, you’ll 

quickly see the benefits.
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Why Revit?
Revit is the most technologically advanced BIM application. Currently, a number of BIM 

applications are on the market, provided by a host of different software vendors. While 

most other BIM applications in today’s market are based on technology that is 20-plus 

years old, Revit was designed from the ground up as a BIM platform to specifically address 

problem areas of the architecture, engineering, and construction (AEC) industry: com-

munication, coordination, and change management. As you complete more projects with 

Revit, you’ll begin to understand some of its advanced functionality. Being able to go direct 

to fabrication with your designs, provide digital shop drawing submittals, and execute 4D 

construction planning are just a few of the possibilities. In CAD, users have to do a lot of 

manual updating (and remember to do it). By contrast, Revit understands when a change 

happens and does the entire sequence of changes (updates) automatically without any 

additional effort on the user’s part. To put it more pretentiously, Revit offers the compel-

ling advantage of concurrent information. 

Revit is a technological platform that currently supports architectural, structural, 

and mechanical disciplines, but the possibilities for extending them are immense. It’s 

supported by a patented parametric change engine that is unmatched in sophistication 

within the AEC world of applications. It’s also the leading software package in the inter-

national market.

Revit Concepts
As we mentioned before, the name Revit comes from ″Revise Instantly.″ Revit is built for 

managing change, something that we architects have to do in our practice all the time.

Parametric Objects and Parametric Relationships
Most of us have heard the phrase parametric objects, but what makes an object paramet-

ric? A parametric object is a smart object that can change its size, materials, and graphic 

look but is consistently the same object. For example, think of a door. A single flush door 

can be 32″, 34″, or 36″ (70, 75, 80, 85, or 90 cm). It can also be painted or solid wood. All 

of these sizes and colors can be part of the same door family, with different parametric 

values applied.

Or consider a table: it can be the same shape but made out of wood or metal, with a 

glass or wood top, and with the top extending over the legs or flush with them. Again, 

they’re all in the same table family; only the parametric values are different. The param-

eters are meaningful ways to create variations of an element. And most importantly, this 

information is always accessible, reversible, editable, and schedulable.

In most CAD systems, to accommodate all the types of doors mentioned previously, 

you need to make not only a separate block for each representation (thus plan, elevation, 

and section typically comprise seven or eight blocks) but also as many blocks as there are 
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size combinations or variations. If you then wish to make a table that is 4′–0″ square 
(50/50) to 5′–0″ square (70/70), you use the Scale command, which unfortunately makes 
the table legs bigger than needed because they resize along with the table top! A paramet-
ric object allows you to effect a change on each parameter without affecting the others 
unless desired. So, you can change the size of the table legs independent from the table 
top, and so on.

Bidirectional Associativity
Objects with parameters that can be edited are nothing new in the world of software. But 

what makes Revit unique is its ability to create relationships within objects and between 

objects. This ability has been referred to as the parametric change engine, and is a core 

technological advantage built into Revit. Walls, for example, can be attached to roofs, so 

when the roof changes to a new shape or size, all walls attached to the roof automatically 

adapt to the new roof shape. Walls, floors, roofs, and components all have explicit rela-

tionships to levels. If a level changes height, all elements associated with that level will 

update automatically: the walls below the level will extend to the new height of the level 

above, and so forth. When you change the size of a room by moving a wall, you are chang-

ing not only the wall but everything that wall affects in the model as well: the size of the 

room, color-fill diagrams, ceilings, floors, the doors and windows in the wall, and any 

dimensions to that wall, such as area and volume.

The parametric relationships are extended to annotations and sheet management as 

well. Tags are not simple graphics with a text notation; they are interactive graphical 

parameters that read the information directly from the characteristics and parameters of 

the element being tagged. To edit a tag is to edit the element, and vice versa. When you’re 

laying out sheets and a section view is placed onto a sheet, the section key automatically 

references the sheet number and detail number on the sheet. Change the sheet number, 

and the section tag updates instantly. This is what a real parametric engine is and what 

ensures total coordination of your documentation. This parametric engine guarantees 

that a ″change anywhere is a change everywhere.″

Embedded Relationships
Revit has embedded logical relationships among elements, so that when one is modified, 

all related objects follow the change. To illustrate this, let’s try a ″smart″ move. Look at 

Figures 1.7 and 1.8. To make one of the rooms smaller and move the south wall 3′–0″ (1 m), 
you select the wall and drag it. The four walls perpendicular to and intersecting this wall 
adapt themselves, and the room area updates automatically. All you do is move the one 
wall. There is no need to create a complex series of selections, no need to use trim and 
extend tools, and no need to recompute room areas. Revit does all of this for you with a 
few mouse clicks.
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If for some reason this automatic behavior is not to your liking — for example, when 

you are dealing with a renovation project and do not want to have existing conditions be 

affected by new construction — this is not a problem. Revit will not force you to do 

something you don’t intend to: it allows you to break the ″smart″ relationships if needed 

by disallowing the joins between the walls. Hover the mouse over the end of a selected 

wall, right-click, and choose Disallow Join from the context menu. Only that one wall 

will be modified, and the others will not be affected.

You can also lock elements in place to prevent unintended consequences. You’ll notice 

locks when aligning elements or selecting dimensions; these locks allow you to create hard 

Figure 1.7

The floor plan 
before the change

Figure 1.8

The same floor plan 
after moving the 

south wall up, 
towards the interior 

of the house
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constraints between elements in the model. For the most part, you’ll find the default 

embedded behaviors make sense, and you’ll not have to lock everything with explicit 

dimensions.

User-Defined Rules
During the design phase, you may want to maintain some dimensional rules and make 

sure these are not violated. Requirements like keeping the structural gridlines fixed (pin), 

or keeping a hallway a fixed width (lock), are some typical examples. You want to lock this 

rule down and keep it persistent as the design evolves. Such design rules are used all the 

time, but not many software applications let you capture this design intent and apply it in 

the model. For instance, you may want your door jamb always positioned 4″ (25 cm) from 

the wall corner, or you may want three windows in a room to be always positioned at equal 

distances, and the sill height for your windows to always be 4′–0″ (1.20 m) above the floor. 

You want the rules and relationships to be remembered regardless of how many changes 

occur in the design process. Revit allows you to define and lock these relationships with 

constraints: explicit dimensional rules that keep elements locked to one another.

Types of Elements in Revit
Every parametric object in Revit is considered a family. In this section, we’ll discuss how 

Revit organizes all these families and the data associated with them. Then we’ll explain 

the available types of families, the principles of their behavior, how to create them, and 

where to find them. The categories are divided into two primary buckets: model catego-

ries and annotation categories.

How Revit Organizes Data
Revit organizes all the data in the model using building industry-specific classifications. 

This system of organization manages relationships among classes of elements as well as 

their graphical display. At the top of this organization is a fixed list of categories into which 

all elements ultimately belong and a generic category to which unusual, nonstandard ele-

ments can be assigned. Every element you select in Revit belongs to one of these fixed 

categories.

Model Categories

Model categories include all physical object types typically found in buildings. All 3D 

families will use one of these categories, making them easy to schedule and control 

graphically. Also included are 2D elements that need to be represented in 3D views and 

that are used to add more detail to the model, such as floor patterns, ceiling hatch, and 

construction details. For elements that don’t fit into the Revit categorization system, the 

generic model category can be used. 
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Annotation Categories

Annotation categories are all the annotations, symbols, text, and other 2D data added to 

a view to describe how the building is to be constructed. For example, all wall tags are 

members of the annotation category Wall Tags. Annotation categories also include 2D 

graphics overlaid on the model to convey additional information about the model. These 

annotations are view specific and appear only in the view they were created in. The one 

exception to this rule is entities created in dependent views. Examples include dimen-

sions, tags, callouts, section marks, and text notes.

To view all the model and annotation categories, select the Manage tab and from the 

Settings panel, select Object Styles. This brings up the Object Styles dialog box, where 

you can set the graphics for all categories and subcategories in the project. The table of 

categories is shown in Figure 1.9.

Subcategories

Below each category can be many subcategories. Within the Door category you’ll see 

subcategories for elevation swing, frame/mullion, glass, opening, panel swing, and other 

user-defined elements. You can add or remove subcategories when creating or editing 

families. The beauty of this system is that you can control the visibility and graphics of 

each subcategory independently. This allows you to use different line weights for different 

subcomponents of families. So, in our door example, you can independently control the 

graphics for the door leaf, frame, mullions, and glass. Figures 1.10 through 1.12 show how 

different subcomponents of a door can be turned on and off in a view.

Annotation categories don’t appear in 3D views.

Figure 1.9

The Object Styles 
dialog box, where 

the graphics for all 
categories and sub-

categories in the 
project are set
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Figure 1.10

A door family at the 
fine level of detail

Figure 1.11

The same door at 
the medium level of 
detail. Note that 
hardware is not 
visible.
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Controlling the Visibility of Elements in Revit

As you learned earlier in this chapter, there are no layers in Revit. You may be asking 

yourself, ″Just a second! How will I live without layers? How will I control the visibility of 

what I want to present in different drawings at different scales?″
Let’s look at the origin of layers. In the pre-digital era (and still, in some offices), 

projects were drawn manually on translucent paper called trace. Multiple layers of that 

trace paper were stacked and shuffled to create different representations of the same 

plan. Furniture was usually drawn on one sheet of trace paper, mechanical systems on 

another, and so forth. In a paper-based workflow, to make a change you erased some-

thing on one sheet and redrew it on another.

CAD applications use layers as a digital version of trace paper to control the visibility 

of elements. These digital layers let you control the visibility of the elements representing 

your designs.

Instead of using layers, Revit uses object categories’ view-specific settings to control 

how a drawing looks. The Visibility/Graphic Overrides dialog box, shown in Figure 1.13, 

lets you control visibility of categories on a view-by-view basis. For example, instead of 

putting door handles on their own layer so they show only in high-scaled detailed views, 

Revit has commands to control the visibility of elements per view. If you don’t want to 

show the fine-grained details of an element, such as door handles and hardware, you can 

change the level of detail for your view, as shown earlier in Figures 1.10 and 1.11.

Figure 1.12

The same door at 
the coarse level of 

detail. The entire 
door is reduced to 

an opening.
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Families in Revit
Independently of whether it’s a model or annotation category, a Revit element (from now 

on, family) can be a system family, a component family, or an in-place family.

System Families

Examples of system families are walls, roofs, floors, ceilings, stairs, railings, ramps, and 

mullions. To create a system family, you must be in the project environment (you will not 

be able to create system families in the Family Editor). To make new, additional types of 

these families, you need to duplicate an existing family of the same type and modify it. 

So, to create a new wall type, for example, you must duplicate an existing wall, change its 

name, and then change the properties of the wall.

This method of duplicating a type to create new types is used frequently in Revit, so 

get used to this concept. While you cannot save a system family to a shared library as a 

standalone component, it is possible to transfer these families between projects. To reuse 

system families from one project to another, select Manage ➔ Transfer Project Standards, 

then choose the category you want to transfer. We’ll go into more detail about creating 

and using system families later in this book.

Component Families

Component families (sometimes called standard families) are created outside of the proj-

ect environment — still in Revit, but in a specific environment called the Family Editor. 

Component families have their own file format extension (.rfa) and can be stored or edited 

as separate files independent of a model, and then loaded at any time into a project.

Figure 1.13

The Visibility/
Graphic Overrides 
dialog box lets you 
control visibility of 
categories on a 
view-by-view basis.
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To see how Revit organizes component families, choose Home ➔ Component ➔ Load 

from Library. You’ll see the folders in which these families are stored.

To create a new component family, you can either duplicate an existing one in Windows 

Explorer and modify it in the Family Editor or create a new one in the Family Editor, using 

the family templates included with each copy of Revit. An important advantage to using 

Revit is that you are not required to know any programming or scripting language to cre-

ate new, smart, parametric families. This is an important advantage of Revit.

To open a template, open the Application Menu (R) ➔ New ➔ Family. Embedded in each 

template are smart behavior characteristics of the family you’re creating. Doors, windows, 

balusters, casework, columns, curtain wall panels, entourage, furniture, massing elements, 

generic objects, and plantings are all examples of Revit component families.

In-Place Families

In-place families are custom objects that are specific to a certain context within the model. 

A complex railing fence on a site is an example of an in-place family. These families use 

the same functionality available in the Family Editor, but are made available in the con-

text of a project file. Avoid making in-place families if you plan to reuse the family, or 

have multiple instances of it in the project.

Tips for Getting Started in Revit
Knowing how and where to begin your journey can be a challenge, and we want to give 

you a few pointers to help you get started. Although this list isn’t complete by any means, 

it should help steer you in the right direction:

Begin with the end in mind.  When you begin any project, planning is always a good way 

to start. You can set yourself up for a successful implementation from the beginning by 

using a bit of forethought about your process, workflow, and desired outcome.

Get your project and office standards in place early.  As design professionals, we have a ten-

dency to develop unique graphic conventions and styles for our documents. This is a spe-

cific area where good planning leads to a good project. If possible, get your standards in 

place before you begin a project. Revit does an excellent job of getting you started with a 

good template of graphic standards to work with. However, if you’re like most architects, 

an application right out of the box is never quite nice enough. Revit provides a good start-

ing point for customization, and with some up-front time, you soon can have your proj-

ect and office standards up and running. Once you nail down your standards, they can 

be easily applied to your project using Transfer Project Standards.

Remember that the first project you do in Revit is a change in methodology.  You’re leverag-

ing technology to help you change the way you approach design and documentation. Don’t 
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expect the process to have the same workflow as it did in a CAD-based system. Try to stay 

flexible in your expectations and schedule and allow yourself time to adapt to the change.

Don’t try to conquer the world on the first project.  There are many advantages to using 

BIM as a design and documentation methodology. As this process becomes more main-

stream within the industry, those benefits will only increase. All of these things and more 

are possible with the use of Revit, but it will take a couple of projects to get there. Tailor 

the use of BIM to the project, and use the features that will maximize the benefits of using 

BIM. Choose your goals realistically, based on the expertise of your project team, and 

plan ahead so those goals can be met successfully. Consider a project that is less complex 

for your initial effort.

Model correctly from the beginning.  We can’t stress this enough. As you refine your 

design, it’s critical to model correctly right from the beginning so you don’t have to fix 

things later. What does this mean? As an example, think of a wall. Does it sit on the floor, 

or does the floor attach to the wall? If you can begin to think about how your project will 

be assembled, it will save you a lot of time at the end. It’s good practice to plan ahead, but 

remember that Revit will allow you to make major changes at any stage in the process 

and still maintain coordination. If you are still in early phase of design and do not know 

the exact wall type, use generic walls to capture your design intent; changing these later 

will be simple.

Get information into the project as soon as it is known.  A key advantage of using Revit is the 

ability to change your project schedule. In a traditional design process, most of the effort 

on a project is realized during the construction-document phase. At that time, a typical 

project has the most staff working on the project, and it can be fairly difficult to implement 

major changes to the project design. This is due to the complexity of the documents by this 

time and the amount of effort needed for the team to redraw all the changed information. 

You’ll find that with Revit, design change is largely managed by the software itself. This 

gives you a great deal of flexibility in both your design and documentation. Take advan-

tage of this shift in the process, and add information to your model early. It can be in the 

form of more detailed content or showing the material construction of your wall system. 

Remember that you can change all this information much more quickly and easily than 

you ever could in CAD, so don’t assume you’re locked into the information you displayed 

early in the design process.

One of the most important rules to follow as you begin your project is to model the building 

as it will be built, but keep in mind that you do not need to model every condition three-

dimensionally. Use Revit to get the essential dimensions and building form coordinated. You 

can then embellish the model with 2D details to convey the fine grain.
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Plan for better communication among team members early in the process.  Communication 

within a team is critical for understanding a project and documenting it successfully. One 

of the downfalls inherent in a CAD-based system is that there is no connection among the 

different files that make up the drawing set. This phenomenon carries through to the 

project team and is a function of project workflow and project management. In CAD, it’s 

possible for team members to work in some degree of isolation. They aren’t forced to imme-

diately reconcile their changes with changes made by their teammates. Revit’s single-model 

environment forces a much higher degree of team communication between, not only the 

architects, but also the structural and mechanical engineers.

Don’t try to model everything.  Most of us have drafted in a 2D environment until now. 

Moving to a 3D world is a significant change. Do you have to model every single screw? 

Every mullion? Every stud? That’s a good question. The simple answer is no, you don’t 

have to, and in fact you should not attempt to do so. Like any BIM system, Revit isn’t 100 

percent 3D information. Typical workstations aren’t capable of handling all the data of a 

building in model form. Additionally, few projects have the time in their schedule to model 

the screws in a sheet of gypsum board or the sealant around all the windows; some of 

that information is best presented in 2D or in the specifications. This still leaves you with 

a wide range of options for modeling. In the beginning, err on the side of simplicity. It’s 

far easier to add complexity to your model later on as you gain experience and confidence 

than it is to troubleshoot over-constrained parameters early in the process. Start with the 

big ideas: walls, openings, roofs, and so forth. Work your way down to a comfortable level 

of detail for both you and your computer.

Organize your team.  A BIM project team includes three basic technical roles. These roles 

are interchangeable, especially on smaller projects with fewer team members. However 

small the team, it’s useful to make sure all these roles are filled:

Building designer  This is the person or team whose primary responsibility is to fig-

ure out what the project will look like and how it will be made. They create walls, 

floors, and roofs, and locate windows, doors, and other building elements.

Content/family creator  The family creator’s primary role is to create the parametric 

content in the Revit model. This is typically someone with 3D experience who also 

has a firm understanding of Revit and Revit families. The families, as you’ll see later, 

have parameters that can control visibility, size, color, proportion, and a number of 

other things.

Documenter  This role supplies the bulk of the documentation. It consists of drafting 

some of the 2D line work over portions of the 3D model to show detail, adding anno-

tations and keynotes, and creating details.

Ask for help.  If you get stuck along the way, don’t assume you’re alone. There are myriad 

resources to help you find a specific solution to your problem. Chances are, someone has 

tried the same thing before. In our digital age, a wealth of information is available online; 
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powerful communities of passionate users are out there willing to help. Another option 

is to hire a consultant to help your teams with their first projects. Autodesk Consulting 

as well as many resellers offer the services of excellent, experienced users. So before you 

spend hours trying to work through a particular problem on your own, try tapping 

some of the existing resources:

Revit Help Menu  Your first stop, if or when you get stuck, should be the Revit Help 

menu. It’s one of the easiest and most robust help menus out there, and it can give 

you a lot of useful information very quickly. It’s also the most accessible help source. 

As with most applications, it’s at the far right of the menu bar.

Subscription Support  If you have bought Revit on subscription, Revit Subscription 

Support offers an exemplary web-based support system. Their responses are speedy, 

and their advice is top-notch. If you need information more quickly, Revit also has 

an online knowledge base of FAQs that is available without a subscription. Both of 

these resources can be accessed at www.autodesk.com/revit.

AUGI  Autodesk User Group International (AUGI) is also an excellent source for tips 

and tricks. It’s an online user community free to participate in, ask questions, get 

answers, and share families and examples. To get the benefit of this fantastic online 

resource, go to www.augi.com and look for Revit Architecture as a product. If you never 

logged in, you will have to register once; from then on it’s easy! 

Revit City  Looking for content and families? Revit City, another free online service, 

has a growing database of free families posted by other users. Its address is  

www.revitcity.com.

Autodesk Discussion Groups  These pages offer insightful discussions and some great 

Q&A threads: http://discussion.autodesk.com/.

AECbytes  This website, put together by Lachmi Khemlani, is dedicated to following 

and reporting on the trends in the AEC industry, with a strong focus on BIM, tech-

nology, and the direction of the industry: www.aecbytes.com. 

Blogs  There are numerous blogs from passionate, experienced Revit aficionados. 

Here are some of them in no particular order:

http://revit4you.blogspot.com/•	  (Philippe Drouant [French])

http://revitoped.blogspot.com/•	  (Steve Stafford)

http://revitnorge.blogspot.com/•	  (Håvard Vasshaug [English and Norwegian])

http://designreform.net/•	  (Dave Fano)

http://www.allthingsbim.blogspot.com/•	  (James Vandezande)

http://architechure.blogspot.com/ •	 (Phil Read)

http://irevit.blogspot.com/•	  (Craig Barbieri)

http://dorevit.blogspot.com•	  (Robert Manna)
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http://do-u-revit.blogspot.com/•	  (David Baldacchino)

http://malleristicrevitation.blogspot.com/•	  (Aaron Maller)

http://www.bimx.blogspot.com•	  (Laura Handler)

http://www.revitbeginners.blogspot.com/•	  (Bradley Hartnagle)

http://revitbeginners.blogspot.com/•	  (David Duarte)

http://www.revitcoaster.blogspot.com•	  (Troy Gates)

http://revitit.blogspot.com/•	  (Daniel Hurtubise)

http://revitrocks.blogspot.com/•	  (Daryl Gregoire)

http://www.revitfamilies.blogspot.com•	  (Shaun Van Rooyen)

http://www.revit-alize.blogspot.com•	  (Bruce Gow)

http://www.revitrants.blogspot.com•	  (Chris Price)

http://blog.reviteer.com/ •	 (Tom Dorner)

http://www.revitlution.blogspot.com•	  (Christopher Zoog)

http://www.revit-up.blogspot.com•	  (The PPI Group’s Revit evangelist)

http://www.greenrevit.blogspot.com/•	  (Beau Turner and Bradley Hartnagle)

http://www.revitup.co.za•	  (Justin Taylor)

http://gmcdowelljr.wordpress.com/•	  (Greg McDowell, Jr.)

http://www.autodesk-revit.blogspot.com/•	  (David Light)

http://www.auservice-bim.blogspot.com•	  (Simone Cappochin [Italian])

http://www.cmotion.net/products/revit-tools.html•	  (Siggi Pfundt and Gotthard 

Lanz [German and Italian])

We apologize to all our friends and colleagues whose blogs we failed to mention. The 

number of Revit aficionados grows every day and so does the number of new blogs. A 

good tip is to always look on the sidebar of any Revit blog: you will find links to many 

others! Go and take part — be a part of a strong and growing community that can help 

and be helped by you!
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Getting Acquainted with the 
Revit Interface and File Types

C hap te r 2

In this chapter  you’ll become acquainted with the graphical user interface 

(GUI) of Revit Architecture. We explain terminology, menu arrangements, tools, views, 

common commands, and the basics to get you up and running. Topics we’ll cover include:

Overview of the Revit user interface■■

Modifying and personalizing the interface■■

Selecting objects and navigating views■■

Using keyboard shortcuts■■

Setting up your project environment■■

Revit file formats■■
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Overview of the Revit User Interface
In this section we look at how Revit appears when you first install it, and familiarize you 

with how the interface is organized. We explore the use of some standard-looking toolbars 

and menus, as well as some features that are unique to Revit. One of the things you’ll 

notice from the beginning is that Revit is tailored for the architectural design community. 

The tools, commands, and objects that you use in Revit are based on tasks and require-

ments taken directly from the practice of architecture.

If you have used Revit in the past, you will notice that the user interface (UI) of Revit 

2010 is dramatically different from that of its previous version. Revit, along with an entire 

family of Autodesk products, has moved to the “ribbon” paradigm, allowing both easier 

use of Revit itself and easier adoption of other relevant Autodesk products that today have 

similar user interfaces. For existing users, we will be calling out the location of certain 

commands that we believe are not obvious in their placement in the new “ribbonized” UI.

Starting Revit
There are several ways to start Revit: by double-clicking the Revit icon that was auto-

matically created on your desktop during installation, by going to C:\Program Files\Revit 

Architecture 2010\Program and double-clicking Revit.exe, or by double-clicking on any 

file with the .rvt extension.

The Basic Screen
When you start Revit, you will see the screen that looks like Figure 2.1. (You might not see 

any project thumbnails as they only show once you start creating Revit projects or families.)

Throughout this book, when we say Revit we’re referring to Revit Architecture. It’s simpler this way!

Figure 2.1

Revit's start page
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The start page, redesigned for Revit 2010, offers the following possibilities:

Project

Open a recent project (select one of the preview thumbnails)•	

Open any existing project (click the Open button)•	

Create a new project (click the New button)•	

Families

Open a recently created or modified family (select Open under Family)•	

Create a new family (click the New button)•	

Create a new Conceptual Mass (click the New Conceptual Mass option, which is new •	

to Revit 2010)

Link to the Revit library on the Web (click the Web Library button) •	

Once you click New Project, a fresh Revit project that looks like Figure 2.2 will open. 

(There may be slight differences depending on which language version of Revit you have 

installed.)

The Revit interface, new to Revit 2010, integrates the ribbon paradigm by grouping 

workflow-based functions and tools in separate ribbons and exposing only task-relevant 

options to the user. This saves workspace and makes the UI less overwhelming. Let’s take 

a look at individual parts of the UI. 

Application Frame Overview

Revit’s application frame has the following main zones:

The Application Menu  ​The big purple R on top left of your screen (Figure 2.3) is what we 

will be referring to as the Application button or Application Menu. Clicking this button 

Figure 2.2

The Revit Interface
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opens the Application Menu, which offers options for creating new 

projects or families; opening existing projects or families; saving; 

exporting the project in various CAD, schedule, and other formats; 

publishing and printing; and viewing licensing information. All of 

this will be extensively covered later in this book. In this chapter we 

will only enter into more detail about those features that will not be 

covered later in the book.

Figure 2.3

The Application 
Menu

Options button  ​At the bottom right when opening the  

Application Menu, you will also find the Options button, which 

hosts options for project settings (Figure 2.4). Located in various 

tabs are different settings that you can change to accommodate 

your decisions about file location selection, rendering path, the 

SteeringWheel and the View Cube, spelling, and macros, as well 

as some general settings such as username, intervals for saving 

reminders, and the application frame display theme.

Figure 2.4

The Options but-
ton is accessible 

from the Applica-
tion Menu.

Title bar  ​The title bar is displayed at the top of the Revit application 

frame, as in other Windows applications. In the title bar (Figure 2.5), 

you see the version of Revit that you’re running (Revit Architecture 

2010) as well as the name of the project that is currently active. If a 

single view is open in the main view window, the name of that view is 

displayed after the filename. However, if more than one view is open 

in the View window, the view name is not shown.

Figure 2.5

The title bar

The title bar in Figure 2.5 indicates that the version is Revit 

Architecture 2010, the name of the open file is Source_House…, and the 

name of the active view is 3D View.

The Quick Access Toolbar  ​The Quick Access Toolbar (Figure 2.6) is 

new to Revit 2010 and is located to the left of the title bar. It enables 

quick access to most used commands such as open, save, undo/redo, 

switch to 3D view, and options for forcing synchronization of local files 

to the central file when in a worksharing environment.

You can add any tool from the Ribbon to the Quick Access Toolbar. 

To do that, right-click over any tool and select the Add to Quick Access 

Toolbar option. To remove the any tool from the Quick Access Toolbar, 

right-click the tool and select Remove from Quick Access Toolbar.
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Info Center  ​This is also new to the Revit 

2010 interface. The Info Center toolbar 

(Figure 2.7) is located in the same zone 

as the title bar, to its far right.

Links to a variety of information 

sources are located in the Info Center 

bar. From left to right, the first thing 

you will see is a search field where you 

can type a term such as the name of a 

function or feature that you are search-

ing for. Subscription Center links to the 

Subscription Center, where various 

benefits and services available to subscription users only are accessible. The 

Communication Center links to product updates and various product announcements. 

The Favorites button will link to topics you identify as your favorites throughout your 

work with Revit. To add topics to your Favorites, click the icon that appears next to the 

link on the Info Center Search results panel, Subscription Center panel, or 

Communication Center panel. The last button is the Help button, which links to the 

Revit Architecture Help directory.

Ribbon  ​The newly introduced Ribbon (Figure 2.8) stores all Revit commands and tools 

necessary to create and edit your project information. The Ribbon displays automatically 

when you open a file or create a new project in Revit.

The Ribbon can be minimized for maximum use of the drawing area and has three 

different display settings accessible from the drop-down arrow at the far right of the tabs 

part of the ribbon:

Full Ribbon (displays the ribbon in all its glory)•	

Panel tiles (semi-minimized state of the Ribbon that only shows the panel and •	

label tabs)

Tabs•	

Figure 2.6

The Quick Access bar

Figure 2.7

The Info Center bar

Figure 2.8

Different display 
settings of the Rib-
bon; from top down: 
full Ribbon, panel 
tiles, tabs
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The Ribbon is organized in tabs that are themselves organized in panels. Each panel 

holds logically connected tools for executing a certain type of activity.

Figure 2.9 shows a tab (the Home tab). It has seven panels containing the creation 

tools for most modeling elements in Revit.

There are eight tabs in Revit: 

Home   ​The Home tab contains all tools necessary to build the 3D elements of a 

building model in Revit.

Create  ​Available only in the Family Editor, the Create tab gives you a set of tools nec-

essary to create a Revit family.

Insert  ​Raster images and CAD files are often inserted in a Revit file for help or sup-

port or to provide additional information for your project. The Insert tab contains 

tools for importing and managing these files.

Annotate  ​To describe or enhance the display of the building model, you often use 2D 

elements. The Annotate tab contains all the tools for adding 2D elements to a project.

Figure 2.9

Organization of the 
Ribbon

Tab

PanelTool
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Modify  ​Once created, all elements need to be changed or edited. The Modify tab 

contains a sub-set of editing tools. Other editing tools will become available to you 

whenever you select an element, at which point a specific contextual tab will appear.

Massing & Site  ​Creating and modifying conceptual mass studies is a way to start a proj-

ect in Revit. You will find all conceptual massing tools under the Massing & Site tab.

Collaborate  ​It is rare that only one person works on a project. Tools that help users 

collaborate on the same project and manage that collaboration are found on the 

Collaborate tab.

View  ​A Revit project is described through many views that are different representa-

tions of the model database. Tools for creating and managing those views are located 

on the View tab.

Manage  ​Design options as well as many project-related settings and options are all 

located on the Manage tab.

Now we have covered almost everything you need to know about the ribbon interface 

of Revit. If you notice additional tabs on your Revit ribbon, you probably have installed 

some additional separately purchased add-ins. 
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To finish up, we just want to turn your attention to some Revit tools that are somewhat 

invisible because they are hidden in expanded panels and dialog launchers. 

Expanded panels   ​These become accessible when you select the drop-down arrow at the 

bottom of a panel. When you expand the panel, additional tools and controls appear. 

To keep a panel expanded, click the push-pin icon in the bottom-left corner of the 

expanded panel.

Dialog launchers  ​These allow you to open a dialog. A dialog-launcher arrow on the bot-

tom of a panel opens a dialog to define settings or complete a task.

Modifying and Personalizing the Interface
Revit 2010 will give you more control over personalizing and modifying the user inter-

face. Let’s take a look at what is possible.

Customizing the Ribbon
The ribbon UI in Revit can be changed and customized per your needs. This feature is 

new in Revit 2010. A full customization of the UI is still not possible; however, you can 

make certain changes to it, such as modifying the panel order or moving a panel off the 

Ribbon to your desktop. Revit 2010 supports working across multiple monitors. Let’s 

examine the changes you can make to the UI. 

You can change the order of the panels within the tabs and also undock them from the 

Ribbon so they float in the workspace and are visible at all times (Figure 2.10). With mul-

tiple monitors, you can move these panels from screen to screen.

To modify the order of the panels in a tab, click over the title of the panel, hold the 

mouse button down, and move to another location. 

You can place an undocked toolbar back in the Ribbon by hovering the mouse over the 

undocked, floating bar and clicking on the arrow at the top right of the dialog that opens. 

Doing so activates the Return Panels to Ribbon command (Figure 2.11).

Revit memorizes and stores all changes you make to the UI so that they are there each 

time you start Revit.

If you have played around with customization of the UI a 

little too much and want to revert to the default state of the 

Ribbon — the one you saw when you installed Revit — you 

Figure 2.10

The Build panel undocked from the Home tab

Figure 2.11

Returning an undocked panel to the Ribbon by selecting Return 
Panels to Ribbon
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can do so by deleting the file in which these changes have been recorded. The name of 

that file is UIState.dat and it is usually located as follows:

Windows XP  ​C:\Documents and Settings\ UserName \Local Settings\Application Data\

Autodesk\Revit\Autodesk Revit Architecture 2010 

Windows Vista  ​C:\Users\UserName\AppData\Local\Autodesk\Revit\Autodesk Revit 

Architecture 2010

Once you delete this file and restart Revit, you will see the standard UI setup.

Project Browser 

As in previous releases of Revit, you can undock the Project Browser and make it float 

over the drawing area, as shown here: 
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Users with double screens can now place the Project Browser in the second screen. 

Revit 2010 will remember all changes made to the interface and will display them in the 

next launch of the application.

Keyboard Shortcuts
Keyboard shortcuts are the fastest way to work with Revit. The shortcuts assigned to 

the existing Revit commands are unfortunately not as obvious in the new UI as they 

were previously. You have to hover over a tool and wait for the tooltip to appear in order 

to see the assigned shortcut, which is described with 

two uppercase letters (Figure 2.12). To change the 

automatically assigned shortcuts, edit the Keyboard​

Shortcuts.txt file located in \Program Files\Autodesk 

Revit Architecture 2010\. This location is unchanged 

from previous releases of Revit.

You will have to restart Revit after changing the keyboard shortcuts in the .txt file. 

Keytips
Revit 2010 introduced a new concept called Keytips. To display the keytips on the Quick 

Access Toolbar or the main toolbars, press the Alt key (Figure 2.13).

If you want to display the keytips for all the tools 

within a tab, after pressing the Alt key, click a letter that 

describes that tab (H for Home for example). This opens 

the Home tab and now the Keytips of all individual tools 

under the Home tab are displayed as well. 

Other Important Tools 
When you use certain tools or select elements in Revit, a contextual ribbon tab displays 

that contains a set of tools relating only to that tool or element. The first panel of those 

tools is the Element tab, in which the Element Properties 

button and the Type Selector (which you access by clicking 

Change Element Type) are located (Figure 2.14).

Element Properties 

The Element Properties button is located at the far left of the Elements tab and  

becomes active when you select an element or tool. Clicking this button opens the 

Instance Properties dialog box (Figure 2.15), where all instance and type param-

eters of selected elements are displayed and can be edited. You can also open this dialog 

box by right-clicking an element and selecting Element Properties from the context menu

Figure 2.12

Keyboard shortcuts 
are visible in the 

tooltip

Figure 2.13

Keytips display 
when you press the 

Alt key

Figure 2.14

The Element Proper-
ties button and the 

Type Selector are 
crucial to the cre-

ation or modifica-
tion of any element
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Figure 2.15

A context menu appears when you right-click 
an element

Type Selector

The Type Selector is located on the Element panel when creating or an element. Its con-

tents change depending on the current function or selected elements. The Type Selector 

(Figure 2.16) is a drop-down list of element types available in the project. For example, 

if you select the Wall tool from the Home tab, the Type Selector that is invoked when 

you click the Change Element Type button shows you a list of all available types of walls 

in your project. If you select a wall from within the project (the drawing area) you are 

working on, the Type Selector displays the type of that wall and allows you to select a 

different wall type from the list. This works with just about any element you can select in 

Revit, and is an extremely powerful way to make easy and fast changes to the model.

Figure 2.16

The Type Selector

Options Bar
The Options bar changes depending on the type of element being created or selected and 

displays context-sensitive options relevant to that tool only. In Figure 2.17, you can see 

several states of the Options bar displayed when different elements or tools are being 

selected.
Figure 2.17

The Options bar for 
dimensions, walls, 
windows and model 
in-place mass
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Status Bar
The status bar is located at the very bottom of the application window, on the far left. 

Here you will see helpful text that describes what you have selected and what you should 

do next when in a command. This information also includes the names of the family and 

type that you have selected or are hovering over. Whenever you aren’t sure what your next 

step should be, look at the status bar. Figure 2.18 is an example of the status bar in action.

Count Selection Tool
The Count Selection tool (Figure 2.19) is located on the far right in the same zone as the 

status bar. The Count Selection tool gives information about the number of Revit ele-

ments currently selected.

Clicking anywhere in the count box invokes 

the Selection Filter dialog box, where you can 

narrow down a selection if needed. You can also 

access the Count Selection tool by clicking the 

Filter button located in the ribbon under the Multi-Select tab. This Filter is activated 

automatically upon selection of multiple different elements (Figure 2.20).

Next to the Count Selection tool, you will find the Press & Drag check box. When 

this option is checked, you can drag an element without having to select it.

Project Browser
The Project Browser is the heart and soul of the Revit user interface (Figure 2.21). Imagine 

for a moment that your Revit project is actually a database. By looking at the database from 

different points of view, you generate floor plans, sections, schedule 

tables — or as they are called in Revit, “views” of the database. So, 

from the Project Browser you can navigate to all your views, create 

new views, access element properties, and place all forms of con-

tent in your project, ranging from linked Revit files to rendered 

images. Let’s take a moment to explore the various parts of the 

Project Browser.

Views

There are many types of views in which building information can 

be represented in Revit. These views are listed and organized in the 

Project Browser using a collapsible tree navigation framework. Types 

of views include plans, ceiling plans, sections, elevations, 3D views, 

animations, schedule tables, legends, and sheets. Once a view has 

been created, it can be duplicated to create a similar view and then 

modified to fit the requirements of various design deliverables. For 

example, you can create a plan view of a first floor of a building 

Figure 2.18

The status bar  
indicates the name 

of the family and 
type selected or 

hovered over

Figure 2.19

Count Selection tool

Figure 2.20

The Filter command 
appears in the rib-

bon when you select 
multiple elements of 
different categories

Figure 2.21

The Project Browser 
displays the context 

menu for a view
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with furniture layout and then duplicate it to make an electric layout plan. Every view 

allows you to control which elements will be visible and how will they will be visible. 

Elements also have additional view-related parameters, such as scale, name, and visibility 

and graphics settings. You can access these properties by right-clicking on the view name 

in the Project Browser (Figure 2.21) and selecting Properties from the context menu.

Families

In the Project Browser, you can also see all the loaded families (library elements) in your 

project. Loaded means that they are a part of the project library, not necessarily that they 

have been used in the project. From here, you can drag and drop those families into the 

drawing area, query their properties, create new types of elements, and even select all 

instances of a given element in the model in order to perform wholesale changes. The 

right-click menu for families in the Project Browser (Figure 2.22) is different from that 

for views. Use the keyboard shortcut VP for quick access to View Properties.

Revit Links

Revit links are other Revit projects that are referenced (linked) into your current project. 

If they are present in a project, they are listed in the Project Browser. From here you can 

reload, unload, open, copy, and visually identify the links in your project (Figure 2.23).

Navigating Through a Project
To open views listed in the Project Browser, double-click the name of the view you wish 

to open. The name of the open and active view is displayed in bold letters in the Project 

Browser. The Project Browser makes navigating through a project easy — all views are at 

your fingertips and organized into familiar categories. We’ll discuss views in more detail 

in Chapter 3.

Organization of the Project Browser

The Project Browser displays views in an organized tree structure that is predefined. The 

default organization shows views grouped by view type (plan views, ceiling plans, sections, 

and so on). Additional predefined organizations are also provided, and you can customize 

these to suit your specific needs. You can also create completely new view organizations in 

Figure 2.22

Context menu for a 
family

Figure 2.23

Links appear in the 
Project Browser

Using the Select All Instances command from the Families context menu in the Project 

Browser is a great way to instantly change all instances of a particular family from one type to 

another. For example, if you have placed a series of 2′ × 2′ (60 cm × 60 cm) windows in your 

project and need to swap them with windows of another size or type, you can click Select All 

Instances and choose a new size from the Type Selector. With that one click, you will change 

all the instances throughout the entire model.
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the Project Browser. When you right-click on the View All node in the Project Browser, the 

Type Properties dialog box appears. Under Type you can see the list of all predefined orga-

nizational types (Figure 2.24). Try them out — switch from one to another to notice the 

different organizations of the project that they offer. To explore how these are set up or to 

make your own Project Browser organization, click the Properties button and check out 

the rules used to structure views.

E x e r c i s e :  O pe n i n g V i e ws

To get a feel for how to use the Project Browser, follow these steps:

	 1.	 Open Botta.rvt from the Chapter 2 folder on the book’s companion web page,  

www.wiley.com/go/introducingrevit2010.

You’ll see a 3D axonometric view of the project you’re viewing, as shown here:

	 2.	 To see the plan views, double-click 0-Ground Floor in the Project Browser. The 0-Ground 

Floor name is now displayed in bold, indicating that it is the active view in the project.

	 3.	 Following the same logic, double-click 1 First Floor and 4 Roof Floor or any of the 3D 

views or elevations. Double-click the Wall Schedule to open a schedule view of all walls 

in the project. Or double-click the Sheet List to view the sheets prepared to be printed 

and sent out to the owner.

In Revit, all the documents you just opened are called views, and they show different repre-

sentations of information from the underlying database of this building. You’ll learn how to 

create and manage different views, and many other things about the Project Browser, in 

Chapter 3, “Views.”

	 4.	 Close the file without saving.
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View Window
The View window, or as users call it, the work space, is the area where the model is gener-

ated graphically. It’s where all the action takes place. The View window can show just one 

view, or it can be tiled in several windows to arrange as many views 

as you need when working on a project (for example, you can split 

the view window into two windows — one showing a plan view and 

another showing a section view). One of the functions unique to 

Revit is that when you work in a window showing multiple views, 

whenever you modify or create an element in one view, all other views 

update concurrently, reflecting the change instantaneously and with-

out any need for a manual refresh.

G e t t i n g Acq uai n t e d w i t h t h e V i e w W i n d ow

In this simple exercise, we are going to open a project file, open some common views, and 

then tile the views. When you select something, note how it gets selected in all views. This is 

a core concept when working in an integrated 3D model.

	 1.	 Open the file Residence_Taurer_1.rvt at the book’s companion web page.

	 2.	 Open the plan view (ground floor), section view, and 3D axonometric view.

	 3.	 Select the View Tab and from the Windows panel, select the Tile Windows button  

(shortcut WT) 9i02.

	 4.	 Select a wall — notice how it turns red (indicating selection) in all open views.

The View window shows three views: plan view (ground floor), section view, and a 3D 

axonometric view. Revit allows you to open and work in as many views as needed for clarity 

of the task. You can also simultaneously view changes taking place as the model is edited.

Figure 2.25 shows three open views that have been cascaded, stacking one view behind 

another. The Cascade Views button  is another way to display multiple views simulta-

neously. You will find the Cascade tool under the Window panel, just above the Windows 

button (shortcut WC).

Figure 2.24

The Type Properties 
dialog box of a View

It’s quite usual to open many views when working. So, how do you return to a single view 

window once you have opened and tiled several? To see just one view again, select the view 

and maximize it the way you would any window, using the control at the top right of the 

View window. Doing this, however, does not close all other views that were open — they 

are still open in the background and affect the performance of Revit. To make sure all open 

views are closed in the background, in the Manage tab from the Window panel select Close 

Hidden.
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Notice that when you are working in multiple views, one of the title bars of the tiled 

views is highlighted while the others appear slightly greyed out. That highlighting 

denotes that this view is the active one. Any activity that you do (such as drawing, modi-

fying, or deleting) takes place in the active view (Figure 2.26). Also, the name of the 

active view is displayed in the Project Browser in bold letters indicating which is the 

active view.

While Revit allows you to open and work in as many views as you wish, you will need to be pru-

dent about how you use this capability; having too many open views can affect Revit’s overall 

performance (speed). The relationship between the number of views you can open and your 

performance will depend on the speed of your computer and the amount of RAM it has.

View Control Bar
A view in Revit can be represented in many different scales, levels of detail, and model 

graphic styles. Shadows can be turned on and off, crop regions can be used to limit what 

portion of the model you wish to be visible, and the view can also hide elements and cat-

egories of elements. The View Control bar (Figure 2.27) contains shortcuts to many of the 

tools you’ll use most often. The following sections look at some of these tools.

Figure 2.25

Cascaded views
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Scale

The first tool indicates the scale in which the drawing will be 

printed. Clicking the Scale tool gives you a standard set of scales 

to choose from. The scale of the view determines how big your 

drawing will be when printed and also creates a visual relation-

ship between annotations and the model. Annotations are always 

shown in paper size, and the model adjusts its graphics according 

to the view scale. Put simply, a plan view at 1/4″ = 1′–0″ (1:50) will 

be twice as large as a plan view at 1/8″= 1′–0″ (1:100) when printed, 

but in each view the text notes will be the same size.

In Revit you can create your own custom scales. Revit will 

allow you to create scales up to 1:1, or 12′ = 1′. To do that, click 

the Scale button (the first one) on the View Control bar. In the 

drop-down menu, select Custom. A new Custom Scale dialog box 

opens (Figure 2.28). You can create your custom scale and assign 

a specific name to it. The name you give to the custom scale 

appears on the View Control bar, view title, or title block. If you 

do not give a specific name to the custom scale you create, then 

the numeric value of the scale is displayed.

Figure 2.26

Tiled windows

Scale

Model 
Graphic 

Style
Crop 

Region

Reveal Hidden 
Elements

Detail 
Level

Advanced 
Model 
Graphics

Hide/Isolate

Figure 2.27

The View Control bar

Figure 2.28

Custom scale 
options
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T h i n Li n e M o d e

By default Revit displays real line weights of the model. Sometimes, though, this can make 

it hard to read the model, especially when working in high scales and zooming close to a 

detail. In such cases, for visual clarity, you can use the Thin Lines mode tool , 

which lets you see all lines drawn a single pixel wide.

Once active, this feature affects all views. As the following graphic demonstrates, when 

selected, Thin Lines mode displays all lines as being a single pixel wide, regardless of view 

scale. When this tool is deselected, the line thickness corresponds to the thickness you have 

assigned to the elements and shows how the drawings will look when printed.

Note that this command affects only how Revit appears in the screen views and not how 

Revit prints. Thin Lines mode is located in the View toolbar because it affects all views, not 

just the active view.

In Revit, some types of graphics are drawn independently of any zoom scale: 

Reference planes•	

Work plane grids•	

Snap lines•	

Alignments•	

Selection bounding box•	

Group boundaries•	

Measure tool lines•	

These lines are drawn with a consistent screen-based line style.

Detail Level

This icon indicates the level of detail assigned to the view. There are three levels of detail 

in Revit, as illustrated in Figure 2.29: Coarse, Medium, and Fine. You can select a level to 

show more or less information and detail in a view.

Figure 2.29

Detail level options in 
the View Control bar
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Depending on the type of drawing and where in the process your project is, you can 

use the detail level options to expose more or less information in your documents. At 

1″=50′ (1:600 scale), for example, you may represent a wall as a solid fill, regardless of the 

number of layers in the wall construction. At 1/4″ =1′–0″ (1:50), you probably want to 

show the different layers of the wall assembly. The same applies to a door or window. A 

door is represented with different levels of abstraction depending on the scale. 

Figure 2.30 illustrates a standard door shown in three levels of detail.

When using a computer-aided design (CAD) system, you use separate blocks for each 

of these symbolic representations. In the case of a door, you would have to create three dif-

ferent symbols that are drawn in different levels of detail. In 2D CAD, you would also need 

separate symbols for the section and elevation of a door. In Revit, the door is modeled 

once and can be designed so that it can show itself in meaningful representations for dif-

ferent scales as well as view types. The trick is that it’s always the same object — it’s just 

showing different levels of information about itself.

Model Graphic Style

You may already be acquainted with this type of graphic display from 

using other design applications. The options shown in Figure 2.31 

allow you to display the model in one of four modes: Wireframe, 

Hidden Line, Shading, and Shading with Edges. These 

are demonstrated in Figure 2.32.

Figure 2.30

Detail level options

Figure 2.31

Model graphic 
style in the View 
Control bar
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Project courtesy of Paul Woddy

Graphic Display Options

Graphic Display Options is a set of view options that let you control shadow and silhou-

ette settings. Here you can fine-tune the sun angle, time of day, intensity, and other vari-

ables. The settings shown in Figure 2.33 let you add graphic 

embellishments, such as brightness of the sun, contrast of 

shadows, and style of silhouette outlines:

Shadows and sun  ​Shadows can be turned on or off using the 

button from the View bar. The location of the sun can be 

Figure 2.32

Model graphic 
styles demonstrated

Wireframe Hidden Line

Shading Shading with Edges

Figure 2.33

Graphic Display 
Options in the View 

Control bar
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relative to your model (summer solstice) or relative to the view (sun from top right, for 

example). Using the Sun Position in the Graphic Display Options dialog box shown in 

Figure 2.34, you can create accurate sun-angle studies by locating the model on the 

earth and dialing in various times and dates. The controls become available from the 

Graphic Display Options dialog box whenever the Cast Shadows option is selected. 

You’ll learn how to create sun studies in Chapter 8, “Preparing Docs for Clients.” Some 

examples of sun studies are shown in Figure 2.35.

Silhouette edges  ​Creating silhouette effects can give a nice artistic touch to your perspec-

tive or axonometric views, as shown in Figure 2.36. Silhouette edges can be applied only 

to the Hidden Line and Shading with Edges graphic styles.

U s e C au t i o n w i t h S h ad ows

When you’re working on bigger projects, shadows can affect performance significantly. Try 

to keep this feature turned off while you work, and activate it only when you need to validate 

your design or print the documents. Alternatively, because shadows are view specific, keep 

the views that use shadows closed while you work.

Figure 2.34

Graphics Display 
Options dialog box

When creating a silhouette edge, you can use any line style as a silhouette edge style — 

those offered by Revit as well as custom-created lines. Should you wish to emphasize some 

corners more than others, you can additionally use the Linework tool and override different 

lines with stronger or weaker line types as a final touch on the final image.
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Images courtesy of BNIM Architects

Crop Region

The Crop Region tool allows you to limit what part of the model is visible. To better 

understand it, imagine that you have a piece of paper in which you have cut a rectangu-

lar hole and you are viewing the model through that hole. A crop region can be applied 

to all interactive views. The boundary of the region can be visible or invisible depend-

ing on how the view was generated. In sections and callout views, a crop region is auto-

matically visible by default. Plan views, on the other hand, do not show their crop 

regions by default. The Crop Region tool is accessible from the View Control bar, as 

shown in Figure 2.37. 

Some examples of crop regions are shown in Figure 2.38.

Figure 2.35

Sun studies

Spring / Fall

Summer

Winter

73559c02.indd   44 6/4/09   8:40:37 PM



Modifying and Personalizing the Interface  ■   45

The Crop View toggle makes the crop region 

active and crops the view. Do Not Crop View keeps 

the crop boundary but it does not crop anything. 

(This is useful for the dependent views, which we 

will discuss later.)

You can toggle the visibility of the crop region (its boundary) using the Show/Don’t Show 

Crop button. You’ll notice a boundary around your model when the region is visible. You can 

change the size of this boundary by selecting it and 

dragging it with the blue arrows. The crop region can 

also be activated through View ➔ Properties and is 

applicable in both 2D and 3D views.

Hide and Isolate

Hiding and isolating elements is a useful way to work 

with a model when it starts to get more complex. 

These tools will help you isolate problems, and get 

clutter out of the way when you’re working.

Temporary hide and isolate  ​The Hide/Isolate tool in 

the View Control bar allows you to temporarily 

change the visibility of elements in a view. Please 

note the meaning of the word temporarily: it 

Figure 2.36

Shadow view with 
silhouette edges

Figure 2.37

Crop Region 
options in the View 
Control bar

Figure 2.38

Crop region 
examples
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indicates that the view is in a temporary state, and this state will not be saved or printed. 

This temporary mode is useful in visually cluttered situations when you want to isolate an 

object in order to work undistracted and freely with it, or when you need to view a portion 

of the model without the presence of certain elements. This feature allows you to change 

the visibility of a view independent of object types.

To hide or isolate an element or an entire category 

of elements, first select the elements and choose 

among the options under the eyeglasses icon . 

Figure 2.39 shows the different options available with 

the Hide/Isolate tool. Keep 

the following in mind:

Isolating an •	

element isolates only the selected element in 

that view.

Hiding an element hides only the selected ele-•	

ment in that view.

Isolate Category isolates the entire category in that view.•	

Hide Category hides the entire category in that view.•	

Once you’ve hidden an element, the eyeglasses icon turns cyan and a cyan border is 

drawn around the view, both indicating that something is temporarily hidden in this 

view. To reset the view to the normal state, select Reset Temporary Hide/Isolate. The tem-

porary hide or isolate state is applied to one view only and is instantly lost when you press 

Esc, change a view, or reopen a project. The state isn’t saved and is not printable.

The Apply Hide/Isolate to View option allows you to convert a temporarily hidden or 

isolated element into a permanently hidden element in the active view that saves and prints.

Permanent hide/isolate  ​The permanent Hide/Isolate tools allows for elements to be hid-

den in a view that can be saved and printed.

There are two ways to permanently hide or isolate elements:

Convert a temporarily hidden or isolated element in a view to a permanent state •	

using the Apply Hide/Isolate button.

Select an element in the drawing area, right-click, select Hide in View from •	

the context menu, and choose Element or Category from the menu (shown in 

Figure 2.40).

Figure 2.39

Hide/Isolate options in the View 
Control bar

Figure 2.40

Hide/Isolate context 
menu options
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Tools for Controlling the Display of Annotations in a Cropped View

Note the difference between the two dialog boxes shown here. The first one is the View Properties dialog box of a 2D 

view; the second is for a 3D view. Some tools are specific to certain type of views. Let’s review them.

An n otat i o n Cr o p

If you need to show only a portion of a floor plan that contains text, dimensions, and keynotes and use the Crop tool, 

it will crop the model elements but not the annotations. The Annotation Crop option makes the crop region aware of 

annotations as well as the model and lets you crop 

them with an additional crop region. 

The Annotation Crop option is turned off by 

default. Select the View Properties button located 

in the Graphics panel of the View tab to enable it. 

This creates a second crop region in the same view. 

Note that the model and annotation crop are sepa-

rately controlled, and you can change their extents 

using the blue arrows when the border of the crop 

is activated. This is shown by the outer dashed box. 

It is important to know that the annotation crop can 

never be smaller than the model crop. The offset 

between the annotation crop and model crop can 

be preset by selecting the crop region and clicking 

the Size button in the Options bar. This opens the 

Crop Region Size dialog box, where you can present 

the offset for the annotation crop.

Extended view properies

Annotation crop visible
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Both the temporary and the permanent Hide and Isolate tools affect the current view only.

Reveal Hidden Elements Mode

When you’re working in a team, some team members may hide certain elements in a view 

and leave them hidden when they leave the view. To make sure you can quickly assess what 

is going on and have an instant view of all the information you should, use the Reveal 

Hidden Elements Mode tool. This tool offers a special way to display the view: after activat-

ing the Reveal mode, the model will be represented as halftone, and hidden elements or 

categories will appear in a bold magenta color that pops out and indicates what has been 

hidden.

In this mode, the temporarily hidden elements and categories (if any) are represented 

with cyan and the permanently hidden elements with magenta, as shown in Figure 2.41. 

To indicate that you’re in a Reveal mode, the drawing window has a magenta line around 

the drawing area. The lightbulb icon is changed as well and appears in a frame, “lit up.”

Figure 2.42 shows a sample plan and 

the same plan with Reveal Hidden 

Elements Mode turned on. Unlike when using temporarily hidden elements, this mode 

allows you to add elements or categories to or remove them from the permanently hidden 

mode. To do this, select any element (regardless of its state), right-click, and select Hide or 

Unhide from the context menu. You can also use the Options bar to unhide elements or 

categories.

Figure 2.41

Reveal Hidden Ele-
ments mode 

options in the View 
Control bar

Figure 2.42

Floor plan

Floor plan with Reveal Hidden Elements Mode turned on
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Co n t r oll i n g t h e E x t e n t o f a 3 D V i e w: S e c t i o n B ox

For 3D views, an additional cropping feature is available that allows you to crop the model with a 3D clipping box. This 

option, named Section Box, cuts through your model like a cake, vertically and horizontally, and is available in both 

axonometric and perspective (camera) views. This tool is effective for creating perspective sections that are highly 

informative, creative, and appealing, that shows what’s going on in your model, or for isolating in 3D a portion of the 

model that you wish to indicate a detail solution for. To enable the Section Box tool, select the Section box option in 

the View Properties dialog box. If you orient the 3D view to another view (when in 3D view, right-click on the View-

Cube, choose Orient to View, select another view), a section box will be turned on and automatically initialized.

Note that the grips that allow changing the extents of the section box are sometimes somewhat awkward to select. 

This often results in beginning users failing to notice that instead of moving the section box extents, they are actually 

moving a real element in the building model that basically changes the entire project. We recommend that beginning 

users be overly cautious and careful when changing the extents of the section box. 

To o lt i ps

When you hover over an element in the view, Revit helps you identify that object with a tooltip. You can read the name 

of the object and the type of family to which it belongs. The same information is also displayed in the status bar.

Consistent with Microsoft conventions, tooltips also appear when 

hovering over any button in the UI, helping new users to identify 

what the button is used for.

A rendered view using the Section Box tool

Tooltip
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Selecting Objects and Navigating Views 
Now that you are familiar with the interface, let’s look at some common tools and how 

you will use them when working with Revit.

Using the Mouse
Although using the mouse cursor may seem like a fairly basic function of any software, 

Revit has some built-in functionality that lets you take full advantage of the graphical 

interface. Revit was built around the use of a Windows mouse like that shown in 

Figure 2.43. Additional options include some keyboard and mouse routines to allow you 

to maximize workflow.

Left Mouse Button

To select an object, use the left mouse button . This button also allows you to spec-

ify a starting point when drawing an element, navigate through the user interface, and 

select different tools.

Right Mouse Button

Right-clicking an object  opens a context menu with  

various additional tools specific to the selected object.

Anywhere in the free space of the View window, right-clicking 

opens a menu specific to the navigation of the particular view 

(Figure 2.44). Note the View Properties option. This is something 

you’ll use regularly, and we’ll go into more detail about its spe-

cific functions later in this chapter.

Zooming, Panning, and Scrolling in a View
The basic navigation functions, Zoom, Pan and Scroll can be 

achieved through the use of combinations of the mouse and key-

board buttons or by using the steering wheels and the navigation 

cube. Here how this is done.

Mouse Scroll Wheel

The scroll wheel can be rolled , held while moving the mouse, or used with modi-

fier keys to alter your view:

Zoom  ​Scrolling the mouse wheel while in a view invokes the Zoom command so you 

can zoom in and out, depending on the scrolling direction. Pressing the wheel while 

holding down the key (Ctrl+mouse wheel) also invokes Zoom but with a slightly 

smaller zoom factor.

Pan  ​Moving the mouse while pressing and holding the mouse wheel invokes the Pan 

command.

Figure 2.44

A context menu with 
view-specific informa-
tion and options
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Spin  ​When in a 3D axonometric view, holding the Shift key with the mouse wheel pressed 

allows you to spin the entire model. When an element is selected, the model spins around 

that element.

These last three functionalities (Zoom, Pan, and Spin) are also available in the 

SteeringWheel and ViewCube tools.

SteeringWheels 

A three-button scroll mouse is recommended for effective use and navigation in Revit, but 

you can achieve all of the needed behaviors with a two-button mouse as well. We will 

explain that and all navigation possibilities in this section.

Whenever you open a 2D view in a project, you will see a floating palette located on 

the far right of the View window.

There are two tools in the floating palette when opening a 2D view: the Full 

Navigation wheel and the Zoom tool. Upon selection of the Full Navigation wheel, the 

SteeringWheel appears on the screen. It follows (travels with) the mouse to provide quick 

access to the navigation tools in the context of the work you do. When placed in 2D view, 

the wheel looks as shown in Figure 2.45 and offers three functionalities:

Zoom  ​The Zoom option in the SteeringWheel has the following behavior:

When used in a 3D context, Zoom dollies the camera in and out.•	

When used in a 2D context, Zoom moves up and down, perpendicular to the view.•	

Pan  ​Panning the view has several meanings. When used in a 3D context, Pan dollies the 

camera left and right. When used in a 2D context, Pan means one of two things:

When you use the 2D SteeringWheel in any 2D view, Pan means •	 scroll.

When you are in a sheet view with an active 2D view, Pan allows you to scroll •	

the sheet view on the sheet.

Rewind

The Rewind History stack is view specific and is persistent for each view throughout the 

session, until the file is closed. It is a 

practical tool that allows you to go 

back to a previous camera state with 

one mouse click. Figure 2.46 shows the 

Rewind tool in process.

Figure 2.45

SteeringWheel tool 
in 2D view allows for 
zoom, pan, and 
rewind

For users accustomed to previous versions of Revit, note that there are hidden tools in the 

context (right-click) menu of the ViewCube.

Figure 2.46

Rewind allows a 
one-click access to 
different previous 
camera states of the 
model
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Here are general guidelines for all SteeringWheels:

Click a region of the SteeringWheel, keep the left button pressed, and move the •	

mouse to navigate in the view.

Click the arrow or right-click the Navigation Wheel to access the context menu.•	

Navigation in 3D views

The SteeringWheel in 3D view looks slightly different, as shown on Figure 2.47. The 

wheel shown on the figure is the Full Navigation wheel. You can choose to have different 

versions of the navigation wheel by expanding the list that appears when you select the 

arrow below the wheel icon on the floating palette. You can set the default appearance of 

the SteeringWheels from the Application Menu by selecting the Options button and the 

SteeringWheels tab.

You will find additional tools in this wheel:

Orbit  ​Replaces the old Spin command.

Look  ​Replaces the old Turn command.

Walk  ​Click and hold the left mouse button on this tool and start moving the mouse in a 

direction you wish to walk through the model. Using Ctrl+> and Ctrl+< lets you increase 

or decrease walk speed in Walk mode.

Center  ​Lets you define a pivot point around which all other movements will be oriented.

Top Down  ​Click and drag this tool; it initiates a slider (Figure 2.48) that, when moved up 

or down, moves the view of the model in those directions.

There are additional settings in the floating palette of the SteeringWheels that let you 

define size or transparency. Expand the palette to view them all (Figure 2.49).

You will notice that the SteeringWheel will also be present in the preview window of 

the Type Properties dialog box of any element in Revit (Figure 2.50).

ViewCube

For even easier navigation in 3D views, there is another new navigation tool in Revit: 

the ViewCube (Figure 2.51).

The ViewCube tool allows for intuitive and easy navigation through 3D views. It 

appears in the top-right corner of all 3D views, both in the Revit project environment 

and in the Family Editor.

Figure 2.47

The Full Navigation 
wheel in 3D views

Figure 2.48

Use the on-screen 
controls to move 

the camera

Before you continue, try this behavior on any of the sample files you’ve used up to now. 

Open a 3D view, and using the mouse and keyboard combinations or the SteeringWheels, 

familiarize yourself with the navigation commands. You’ll use them frequently throughout 

the model and documentation process.

Figure 2.49

Additional settings 
for docking or 
 display of the  

SteeringWheels
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To use the ViewCube, click its icon to orient the view to a direction of your choice. To 

rotate the view, drag the ViewCube in one direction. The right-click menu of the ViewCube 

will let you reset the Home camera, reset the Front direction, lock to the current selection, 

and orient the current view to an existing view or a predefined standard direction. Right-

click the ViewCube and click Properties to set the ViewCube properties. Figure 2.52 shows 

an example of the ViewCube reorienting a 3D view to Top.

Using the ViewCube you can with one click orient any 3D view into a Top view or 

Elevation view, as shown in Figure 2.53. Try this out! You will be surprised at the ease of 

use and the speed with which you can access specific views of your model.

Figure 2.50

SteeringWheel 
tool in the preview 
window

Figure 2.51

ViewCube

Figure 2.52

A 3D view oriented 
to Top using the 
ViewCube
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For previous users of Revit, it is important to mention that the ViewCube now has a 

context menu that contains many functions that were more obviously exposed in older 

versions of Revit UI but are hidden here. Right-click on the ViewCube to find the Orient 

to View or Orient to Direction tool as well as other view-related options.

Selecting Objects
To select an individual element, click on it. To select multiple elements, several options are 

available. The easiest way to select multiple elements is with a selection window. Depending 

on the direction that you drag the mouse, you can select different elements. If you are an 

AutoCAD user, this will be very familiar.

Dragging a selection window from left to right (Figure 2.54) while holding down the 

left mouse button results in the selection of only those elements that are entirely within 

the selection window.

Dragging the selection window from right to left (Figure 2.55) results in the selection 

of elements that intersect or are entirely within the selection window. Note that enabling 

the option Press + Drag at the bottom right of the application window lets you drag an 

element when you hold down the left mouse button while dragging. If you find that you 

accidentally drag an element when creating a window selection, deselect this option to 

avoid dragging elements.

Figure 2.53

The ViewCube in 
perspective view—

dragging the corners 
of the ViewCube, you 

can easily orient the 
view in a direction of 

your choice
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To be more specific about what you want to select, you can select all elements of a par-

ticular type by using the right-click menu when an element is selected. Choose Select All 

Instances from the menu, and all elements in the model of that type will become selected. 

You can then make changes, delete all the elements, or swap the element with a new type.

You can also limit selection to categories by using the Filter tool, located in the Filter 

panel of the Mulit-Select tab. Once you’ve selected multiple elements of different catego-

ries, click the Filter button, which opens a dialog box that shows the selected categories. 

To deselect categories, uncheck them.

Manipulating Objects
Many elements can be edited directly in the view using graphical controls. Let’s take a 

look at these.

Figure 2.54

Left-to-right win-
dow selection on 
the left results in 
the selection shown 
on the image on the 
right side

Elements contained in the 
selection box are highlighted.

Figure 2.55

Right-to-left 
window selection
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Grip Editing

Many elements display blue grips when selected that allow you to modify their size or 

location. Selecting and dragging the grip provides a preview (like the one in Figure 2.56) 

of the final outcome prior to completing the drag operation.

For walls and lines, blue-filled grips are displayed at the ends of selected element in 

plan view, and along the ends, bottoms, and tops of selected walls in elevation and 3D 

views, where they’re labeled as shape handles. You can click and drag these controls to 

resize an element, as shown in Figure 2.57.

The blue grips also have additional functionality. With walls, by right-clicking and 

accessing the context menu, you can control the wall joins (the way the walls connect) 

by using the grips to disallow joins between two walls. By default, the walls join auto-

matically, but this behavior may be undesirable in some conditions (see Figure 2.58).

Figure 2.56

Dragging a grip 
enables a preview of 

the movement’s 
outcome

Figure 2.57

Wall grips and 
shape handles

Figure 2.58

Using grips to edit 
wall joins

The default 
wall condition

The Grip context menu The walls 
unjoined
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When you select a chain of walls or lines (Figure 2.59), drag controls appear at the 

coincident endpoints; you can drag these to change the layout of the chain. Touching 

walls are selected at the same time, and the filled blue grip turns into an empty blue grip 

(see Figure 2.60). 

Move

Each object, when selected, can be moved without invoking the Move command in the 

toolbars. When you move your mouse close to the element, a set of crosshairs appears. By 

clicking and holding the left mouse button, you can dynamically move the element 

selected.

Smart Constraints

Revit has many embedded help tools to make your life easier when creating or editing 

objects. One of these is the dashed blue line shown in Figure 2.61. This line displays each 

time a movement is constrained to a plane, as with walls and lines in plan views.

The line helps you maintain the same plane of the wall when extending it, without the 

necessity of holding down the Shift key or using any other auxiliary tool.

A similar dashed line helps you place a new element, similar to an adjacent one, by 

taking a reference from the nearby element. Figure 2.62 shows how placing new level lines 

in section or elevation references the start or end of an existing level line.

You can right-click the wall end controls and use the context menu to allow or disallow wall 

joins. Once a wall end join is disallowed, an icon shows up when that wall is selected, indicat-

ing that the end is disallowed. Clicking that icon reestablishes the join.

Figure 2.59

Wall grip when 
multiple walls are 
selected

Figure 2.60

Manipulating 
multiple walls using 
the grips

Figure 2.61

Manipulating the 
wall constrained to 
a plane
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When you’re drawing or editing elements, 

Revit lets you orient them with respect to 

other elements without changing coordinate 

systems. This is a neat advantage of Revit.

If you want to draw a wall parallel to 

another that is already drawn, Revit recog-

nizes the angle of that wall and offers it as a 

constraint. This lets you draw the second ele-

ment, keeping it parallel to the first wall dur-

ing its creation (see Figure 2.63).

Using the spacebar also helps you orient elements during creation or while editing 

them. During placement, pressing the spacebar lets you rotate elements at 90-degree 

intervals. However, if you mouse over a nonorthogonal reference (such as the wall in 

Figure 2.64), the spacebar starts rotating the element, adding the angle for reference. For 

example, a bed placed next to a nonorthogonal wall can be quickly oriented to the angle 

of the wall. Just imagine how cool this is after all the trouble you may have had in the 

past defining locations!

Figure 2.62

Referencing similar 
elements

Figure 2.63

A new element is 
constrained when 

created near a simi-
lar one.

Figure 2.64

Use the spacebar to 
rotate elements 

during placement
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Flip Controls

You click a flip control  to change the orientation of an element. Flip controls are shown 

by two opposing blue arrows. For example, when you flip a wall, you reverse the order of 

its component layers. Figure 2.65 demon-

strates how to use a flip control.

Swinging doors have two flip con-

trols: Flip Facing (which controls 

whether the door swings in or out) and 

Flip Hand (which controls whether the 

door swings right or left, as shown in 

Figure 2.66).

The flip control applies not only dur-

ing creation of an element but also when 

an element is edited later. Note that flip controls are displayed only when applicable: they 

don’t appear for items that don’t need to be flipped (a table, for example).

Manipulating Objects Using Dimensions

In Revit, dimensions are much more than static forms of documentation. They can be 

used to interactively adjust the model at any time. Temporary dimensions are displayed 

each time an object is selected, inserted, or edited. Revit allows you to type a value in the 

temporary dimension string that determines the position or size of an object. Permanent 

dimensions work the same way; you can edit the location of elements directly by chang-

ing dimensional values.

A wall 32′ (10m) long displays a 32′ (10 m) temporary dimension. However, if you 

enter a 20′ (6 m) dimension, the wall becomes 20′ (6 m) long (see Figure 2.67).

Figure 2.65

Editing a wall using 
a flip control

The wall in its original position

The selected wall, showing the flip 
controls

The finished wall, modified

Figure 2.66

Door flip controls

Figure 2.67

Modifying a wall 
using temporary 
dimensions
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New Revit users are sometimes confused about which 

elements change or move when you use temporary dimen-

sions. When you use temporary dimensions to change dis-

tances between elements, the selected element moves. If you 

select the wall on the right in Figure 2.68 and type a value in 

the temporary dimension area, the wall at the right moves, 

not the left one.

It works the same way for levels. If you need to modify the 

height between levels, select the level you wish to move, and 

modify the temporary dimension. Regardless of whether 

you’re changing the upper dimension or the lower dimen-

sion, in each case Level 2 is modified, as shown in 

Figure 2.69.

Constraints (locks)

Revit is one of the rare architectural authoring applications 

that allow you to embed your design intent in the form of 

locks and constraints that persist until you consciously 

remove them. Here are a few examples:

You can tell a door to be a certain distance from a wall so it fits a closet and lock •	

that relationship so that when you move the wall or the door, that relationship is 

maintained.

You can space windows equidistant along an exterior wall so that even if you change •	

the length of the façade, the windows keep their positions relative to the wall’s length.

You can keep an exterior wall attached to the roof so that if you change the height of •	

the roof, the walls also move, reflecting that change.

In the example in Figure 2.70, the door is constrained to a 1′–4″ (40 cm) distance 

from the wall to accommodate a cupboard. To constrain a distance, you set it by placing 

a dimension, selecting the dimension, and locking it with the Create or remove a con-

straint toggle. After having locked the door to the wall (Figure 2.71) at a distance of 1′–4″ 

(40 cm), if you move the wall in the drawing, the door will always move with it, retaining 

the locked distance.

Setting Constraints with the Pin

The Pin tool is another way to set a constraint for an element. In this case, the element is 

constrained not with respect to another element in the model but geospatially. You can 

pin your grid system so it doesn’t move from its location or pin elements from an existing 

building so they aren’t mistakenly modified while you’re working on new additions. The 

Pin command appears under the Modify panel of the Modify tab whenever an element is 

selected .

Figure 2.68

It is always the 
selected element 

that moves when you 
manipulate a dis-

tance using the tem-
porary dimension

Figure 2.69

Modifying levels 
using temporary 

dimensions
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Figure 2.70

Temporary 
dimensions at a 
closet door

Figure 2.71

Locking the door 
location
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Pin also appears in element types like the predefined curtain walls shown in Figure 2.72. 

By default, the pins exist here because there are embedded rules in a type-based curtain 

wall that you don’t want to inadvertently change. If, however, you consciously decide to 

change the type or a distance (like the space between the mullions), you can unlock the 

pin at any time by clicking it. This undoes the constraint and allows you to freely change 

the element from now on. Locked and unlocked pins in a curtain wall are shown in 

Figure 2.73.

Figure 2.73

Using the Pin tool

A pinned mullion An unpinned mullion

Figure 2.72

Pins in a curtain wall

Moving with Nearby Elements

Another type of constraint is designed for logical relationships between elements. 

When furnishing a space, you probably want to align the bed or dresser with a wall. If 

you change your design, you want the furni-

ture to follow the wall to the new location. For 

this purpose, Revit has a command called 

Move with Nearby Elements. When you select 

a furniture element, like the bed in Figure 2.74, 

this option appears on the Options bar. It lets 

you check a box to move the associated ele-

ments. By selecting this option, you create an 

invisible relationship between the bed and the 

wall so that each time you move the wall, the 

bed moves with it.

Using Instance Parameters to Change Size

When elements appear with editable drag controls, these are considered instance parameters. 

This means you can modify the geometry on an instance-by-instance basis rather than 

change the definition of a type and have all occurrences of the type in the model update at 

Figure 2.74

Moving an element 
with nearby  

elements
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once. Many elements in Revit are driven by type parameters, but this doesn’t restrict making 

and using content that is more flexible and driven only at the individual instance level.

This type of instance-level behavior may be desirable for windows and doors. Once a 

window or door is placed in a wall, there seems to be no way to change its size aside from 

opening the properties of that object and changing type parameters. When you select a 

window, blue grip controls do not appear as they do when you select walls. You might won-

der: why can I not drag windows and doors to be any width and height I want? Essentially, 

the dimensions of windows and doors are defined as type parameters by default, and Revit 

does not let you manipulate these dimensions on a per-instance basis. This is done inten-

tionally, because you typically want to use a standard range of door sizes and keep this 

information stable and predictable. Nonetheless, it is possible to create windows and doors 

that vary in size and shape on a per-instance basis. Remember that Revit makes some 

assumptions about desired behavior, but in most cases it lets you move beyond the typ-

ical and not be hindered.

Should you want the ability to change the dimensions of windows and doors with direct 

editing (using the blue grips), you must change the parameters for width and height from 

type parameters to instance parameters. This can be done in the Family Editor with a few 

clicks. Note that this method of working takes away the advantage of having all windows 

and doors changed at once via a single parameter change. You also need to be careful not 

to create any odd custom sizes unintentionally. Figure 2.75 shows an example of a window 

as a type and an instance.

Using Keyboard Shortcuts
Revit comes with many predefined keyboard shortcuts that allow you to call certain Revit 

commands quickly. We talked about viewing and changing the automatically assigned 

keyboard shortcuts earlier in this chapter, in the section “Modifying and Personalizing 

the Interface.” There are a few other keyboard shortcuts in Revit that you should know 

because they will help you achieve various goals:

Tab  ​The Tab key is similar to the Cycle command you may know from AutoCAD. It allows 

you to cycle through various elements near the cursor when more than one is present. In 

Revit this can happen frequently, so get used to using this key. The Tab key is useful when 

you’re dimensioning because it allows you to cycle through various references of the ele-

ments dimensioned (dimension to wall center instead of wall face; opening of a door 

instead of outer frame; and so on). The Tab key is also used to select chains of connected 

lines and walls.

Figure 2.75

Type and instance 
parameters

A window as a type parameter A window as an instance parameter has arrows to 
dynamically modify its size
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Shift+Tab  ​This shortcut reverses the default order in which the Tab command cycles.

Ctrl  ​The Ctrl key is used to add multiple objects to a selection at the same time.

Ctrl+Tab  ​This keyboard shortcut will cycle through open views. Use this to quickly move 

from view to view.

Shift  ​Unlike Microsoft conventions, which use the Ctrl key to deselect, Revit uses the 

Shift key to deselect an element. For example, some elements in Revit are constrained to 

move horizontally or vertically only. Revit gives you visual clues indicating which way a 

selected element can move. You can remove this constraint by holding the Shift key while 

repositioning the element. 

At the same time, some elements can move in any direction by default, but holding 

the Shift key while moving them constrains their direction. To illustrate, you can move a 

window freely in any direction in an elevation or a 3D view, but holding down the Shift 

key constrains the movement of the window so that it moves only horizontally. Likewise, 

you can normally move walls, lines, or gridlines freely in any direction, but the Shift key 

lets you constrain their movement to directions perpendicular to the wall or line.

Delete  ​The Delete key is used to delete selected elements from the model. You can also 

use the Backspace key to delete elements.

Undo and Redo  ​Commands can be undone and restored using Ctrl+Z (undo) and Ctrl+Y 

(redo). These shortcuts are standard in many Windows applications. 

Multiple undo operations (Figure 2.76) can also be performed from the 

quick-access toolbar using the list of recent commands. Dragging the mouse 

down this list undoes all selected commands in one step.

Spacebar  ​The spacebar is mostly used to cycle through rotation of an element 

during or after placement. For instance, when you set a door in a wall, you can 

use the spacebar to cycle through choices, including having the door open into 

or out of the room, and having it open from the left or right. The spacebar is 

also used to identify the direction in which walls will be placed and to edit their 

position after placement.

F1  ​This is a quick way to call the Help function. (Revit’s embedded help menus 

are getting better with each release!)

Setting Up Your Project Environment
Now that you have an initial idea about the user interface and the tools available, let’s 

look at how to predefine some settings in Revit. Many definitions and global settings are 

stored under the Settings menu. We’ll cover some of the more important settings in this 

section.

Figure 2.76

Multiple undo
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Project Units
Revit has its default units fairly well defined; how-

ever, local standards or various projects may ask for 

different ways of documenting length, area, and 

other measurements. From the Manage tab in the 

Project Settings panel, choose Project Units to open 

the dialog box shown in Figure 2.77, where you can 

set the measurement units, rounding convention 

(number of decimals), and suffixes for length, area, 

volume, and angle. You can also define the way you 

measure slopes — in rise or angle degrees — as well 

as the symbol used for the decimal division (point 

or comma).

As a rule, you should define all your units prior 

to starting a project, but if necessary, you can 

change any of them on the fly later in the develop-

ment of the project.

Slope

Various settings for slope are in the Format column in 

the Project Units dialog box accessible from the Manage 

tab in the Project Settings panel. You can control units, 

rounding, and digit grouping, as shown in Figure 2.78.

Ratio, rise, decimal degrees, and percentage are the 

available options for units.

Currency

When making schedules, architects often have the 

need to add currency information when calculating 

cost, and this improvement accommodates that need. 

Currency formatting allows you to format costs using 

common currency symbols.

In the Format dialog box, you can choose any of the 

10-plus major worldwide currencies, suppress trailing 

zeros, and decide to use grouping that replaces deci-

mal symbol setting (comma separators in 1,234,567).

You will access the same settings when you make a 

cost schedule. You can access the Field Format setting 

on the Format tab of the schedule (Figure 2.79).

Figure 2.77

The Project Units 
dialog box

Figure 2.78

Slope settings in 
the Project Units 
dialog box

Figure 2.79

All major currency 
symbols are pro-
vided for the new 
currency settings
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Additional Formatting

Suppressing zeros is often desirable. For example, if the value of a cost item is 2756.400, 

checking the suppressing trailing zeros will result in 2756.4. For drawings, you can sup-

press spaces — for example, in the value 1′ - 2″, the result is 1′–2″.
Digit grouping options set the separator, the decimal symbol, and how many digits to 

group by.

Snaps
Snaps are a great help for precise placement and modification of elements. In Revit, you can 

define snaps by choosing the Manage tab, Project Settings panel and expand the Settings but-

ton to find the Snaps settings. In the resulting dialog box, you can 

turn the snaps on or off globally, set a variety of snap types, and spec-

ify the angular and length increments at which the system will snap. 

For the most part, these settings are adequate. Although they aren’t 

represented in this dialog box (Figure 2.80), different graphics and 

tooltips for each snap type appear in the view when you’re drawing.

There is a Snap Overrides submenu available during creation of 

elements. Right-click when drawing a wall, and you can override any 

of the project definitions for Snap by choosing Snap Overrides and 

selecting the option you need. See Figure 2.81.

By default, Revit inputs and displays in feet (U.S. imperial units) or millimeters (metric). To 

change the input value to something you may be more familiar with, go to the Manage tab 

and in the Project Settings panel, click the Project Units button. In the resulting dialog box, 

choose Length and change the setting to fractional inches. Click OK. Next, on the Annotate 

tab, choose any of the Dimension tools (Linear, let’s say), and click the Element Properties 

button. In the Instance Properties dialog box, click Edit Type. Then, choose Units Format. 

Deselect the Use Project Settings option, and change the units to read Feet and Fractional 

Inches using the drop-down list at the top.

Figure 2.80

The Snaps dialog box

Figure 2.81

Snap Overrides appears in the 
context menu
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Close
If an element you’re drawing is part of a chain (connected lines or walls) and is a valid 

open loop, you can close it by selecting the Close command from the context menu: Snap 

Shortcuts ➔ Close. 

You can access the same function with the keyboard shortcut SZ.

Line Weights
Revit has a global setting for displaying line thicknesses on the screen and the printed page. 

Revit provides independent control over cut and projected line weights on a per-category 

basis, giving you a great deal of flexibility. For example, cut lines for walls are often repre-

sented with thicker lines than walls in elevation. You can choose from 16 preset line weights 

that range from very thin to very thick.

Revit does an excellent job of presetting these line weights to produce a good graphi-

cal display of your model on the printed page. We don’t recommend manipulating the 

dialog box shown in Figure 2.82; however, if 

you’re unhappy with the print quality of the line 

weights, you can access the values in this dialog 

box and make changes by selecting the Manage 

tab and in the Project Settings panel, click 

Settings and then click Line Weights.

Revit has a limitation that you should be aware of: the system is preset to straighten out 

lines or walls drawn in small angles. This is helpful when creating new projects, but it can be 

an issue when you’re working with existing projects, especially surveyed properties or old 

buildings. If you import a .dwg from such a project, Revit will automatically make something 

like a 0.00005-degree angle into a 0- or 90-degree angle, and this might affect the final preci-

sion of your outcome. To avoid surprises, be aware of this characteristic. Another helpful hint: 

Snap is on by default. If you are creating a project of an existing building and are drawing 

it directly in Revit, turning off Snap will be helpful; otherwise, Revit will force you to round 

angles to the first minimum snap angle defined.

Figure 2.82

The Line Weights 
dialog box
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Object Styles
Line colors and styles are defined in the Object Styles dialog box (shown in Figure 2.83). 

To access this dialog box, select the Manage tab, and in the Project Settings panel click 

Settings and then click Object Styles. 

As you’ll notice in the Object Styles 

dialog box, each Revit element has 

an assigned line weight number that 

corresponds to what is defined in the 

Line Weights dialog box. The line 

weights chosen for Projection (eleva-

tion) and Cut can vary depending 

on your requirements. You can also 

define line color and line pattern for 

each category here. We’ll dig deeper 

into these settings in the next few 

chapters. Keep in mind that line 

weights do not adjust in direct pro-

portion to scale; the results would 

not be desirable.

Options
The Options button in previous versions of Revit was also located under Settings, but in the 

new Revit 2010 UI it has been moved to the Application Menu. In the Options dialog box 

you will find a variety of other options for using Revit (Figure 2.84). 

The tabs for this function include the following:

General  ​Here you can set your save-reminder intervals and your 

username. By default, your username is the same as your Windows 

login name.

Graphics  ​This is where you can change some of the settings for your 

graphics card and the screen colors in Revit. As you may have noticed, 

Revit by default has a white screen with black lines (the inverse of 

AutoCAD). You can also specify selection and highlight colors, and 

enable anti-aliasing for 3D views.

File Locations  ​This tab stores the location of your default paths 

for templates, user files, and most important, paths to your family 

Figure 2.83

The Object Styles 
dialog box

Figure 2.84

The Options 
dialog box
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libraries. The path you defined for your Revit families is the one that you will be linked to 

when you choose the Load Family option, which becomes available upon selection or cre-

ation of any of the Revit elements (try Window as an example). You can add new links to 

personal library folders as well. 

Rendering   ​This tab shows you the default installation path to the new rendering library, 

used when you render views. This is also where you can add additional material libraries, 

as well as licensed ArchVision (photorealistic rendering entourage) content.

Spelling  ​This tab allows you to specify various settings for automated spelling and indi-

cate the dictionary that you want to be used. You can leave the default Revit dictionary or 

switch to a Microsoft Office dictionary, change the language settings, and add other 

dictionaries.

SteeringWheels  ​This tab offers various controls over the visibility of the SteeringWheel, 

its size and opacity on the screen, and some additional settings, such as the Zoom and 

Orbit settings. You can also access these settings by clicking Options in the Wheel con-

text menu (the Options dialog box opens with the SteeringWheels tab selected). You can 

adjust any of the parameters shown in Figure 2.85.

ViewCube  ​This tab allows you to set the appearance of the ViewCube as well as some 

behavioral and scene settings, as shown in Figure 2.86.

Figure 2.85

The SteeringWheels tab allows you to control var-
ious aspects of the visibility of the wheels as well 
as additional Zoom and Orbit settings

Figure 2.86

The ViewCube tab lets you specify appearance 
and behavioral settings of the ViewCube
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Revit File Formats
There are five Revit-specific file formats:

RVT•	

RFA•	

RVG•	

RFT•	

RTE•	

RVT: Revit File
Each Revit project is saved with the file extension .rvt. When you save a project using the 

.rvt extension, all project information is saved in that one file. This file includes all library 

components used in the project and imported DWG, DGN, or image files. Don’t be too 

surprised to see the size of your project file grow significantly as you begin adding more 

details to the model. It isn’t unusual for file sizes to exceed 50MB or even 100MB. If you 

want to share your project with another person or office, you won’t need to send them 

any files other than your project *.rvt file. 

Note that all flavors of Revit (Revit Architecture, Revit MEP, and Revit Structure) use the same 

file format (.rvt).

If you have linked files to a project, regardless of whether they are DWG or RVT files, you will 

need to send them along with the project if you are sending files.

RFA: Revit Family
The RFA file format is used for Revit library elements that can be loaded into a project. 

These are also referred to as families in the Project Browser. A small subset of loaded fam-

ilies is already available in the templates that come with Revit out of the box. Another, big-

ger library of loadable content has been provided with the standard Revit installation and 

is accessible from the Insert tab, Load Family button. These libraries are starting points, 

and represent only a small sampling of what is possible to create in Revit. 

All these library elements have been created in a designated content-creation environ-

ment known as the Family Editor. The Family Editor comes along with the installation of 

Revit and is an integral part of it. You don’t need any other software or knowledge of script-

ing or programming languages to build your own content in the Revit Family Editor. Once 

created, Revit families are loaded into a project, where you can edit and make modifications 

to them from within the project environment at any time, thus minimizing workflow 

interruptions.
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Unless you changed the default installation, Revit installs all library objects in the folder 

C:\Documents and Settings\All Users\Application Data\Autodesk\Revit Architecture 2010. 

This is the location of the default content that ships with Revit, and where the Load Family 

dialog box will take you (see Figure 2.87).

You can also browse for, and download content from, the Autodesk Seek website 

(Figure 2.88). Type in a search term in the Search field in the main toolbar and click the 

magnifying glass icon. You will be taken to a website where you can search for a wide 

range of content in various formats, including RFA files.

Figure 2.87

Revit library folder

Figure 2.88

Autodesk content 
website
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Revit families can be two-dimensional (2D) or three-dimensional (3D). Annotations 

and title blocks are obviously 2D, but you’re welcome to create (or reuse from your CAD 

libraries) 2D symbols for real objects as well (toilets, furniture, and so on).

Double-clicking an RFA file from Windows opens the family file in the Revit Family Editor.

RVG: Revit Group
The Revit Group file format was made obsolete with the Revit 2008 release. We mention 

it here, however, so that if you use a project created in an earlier release of Revit, you 

understand what to do with any .rvg file that is included.

To group elements together and repeat them throughout a project (imagine a table 

with chairs, or typical bathroom or hotel room fixtures), Revit has a tool called Model 

Group . It’s somewhat similar to the Block concept in AutoCAD, but 

with a higher level of intelligent behavior. You create a group in Revit by selecting several 

objects and then clicking the Group button on the menu bar. The file extension in which 

Revit groups were saved before Revit 2008 was .rvg. When a group is saved in Revit 2008 

and later, it’s saved as an RVT file. However, groups created in previous versions of Revit 

that are still in the RVG file format can be used and loaded in a project.

RFT: Family Template
Family template files are used to create custom families. The family templates are hard-

coded in Revit. To see the full selection of available templates, from the Application Menu 

choose New ➔ Family. The principle is simple: if you wish to create a new table design, you 

use the Furniture template; for a door, use the Door template. These templates have embed-

ded behavior and intelligent parameters relevant to the type of object you’re creating. For 

example, a template for creating a window has a different set of available parameters and 

behaviors than a template for creating a door. You can’t create your own family template 

as you can a project template. If you cannot find an appropriate template for a new object 

you wish to create (a fireplace, for example), you should use the generic family or a more 

appropriate hosted family.

RTE: Revit Template
Templates are preconfigured empty drawings in which standard settings and content can 

be predefined so that each time you start a new project using that template, you have a 

predictable starting point that incorporates your office standards.

A template file allows many users working in the same company to start with a baseline 

set of graphic standards and a preloaded set of commonly used model and annotation 
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elements. This is crucial for achieving a similar look and feel for all documents produced 

by your office. Architectural firms can have one office template or many different ones, 

depending on the type of job they’re engaged in. For example, a residential template may 

have different content preloaded than a commercial template, but the annotation and line 

style standards may be identical. Templates allow this kind of flexibility when defining a 

starting point for any given project. From what we have heard and seen from many offices 

that have used Revit for some time already, they usually stick to one to three templates 

and use more only if the office is not focused on one type of job.

Here’s what you can preset in a template:

Default title blocks used for your sheets•	

Loaded families•	

Line styles•	

Line weights•	

Line patterns•	

Fill patterns•	

Materials•	

Units•	

Snaps•	

Dimension styles•	

Temporary dimensions•	

Object styles•	

You define the location and selection of the default template in Revit From the 

Applications Menu, go to the Options dialog box, as discussed earlier in this chapter.

Only one template at a time can be set as a default template. If you’ve created a few 

templates and you want to start a new project using a template other than the default one, 

you can choose New ➔ Project and select from the drop-down list or browse to another 

template. Revit includes a selection of preloaded templates, but in practice every office 

creates their own custom templates that will also appear in this list. Note that just click-

ing the New button instead of expanding it and choosing Project opens the default tem-

plate and won’t offer you the option of choosing or browsing to a different template file. 

Therefore, we suggest that at the beginning you click the arrow to expand the New button 

and choose Project, which will give you the template selection.

To create and save your own template, open any of the existing template files and save 

it as a new name. Next, modify the settings, units, fonts, and load library objects that you 

want to see each time you open a new project using that template. Starting a new project 
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in Revit is easy. From the Application Menu, choose New ➔ Project, and Revit will open a 

dialog box with the following options:

Browse  ​From here, you can change the default template predefined in the Settings 

options and select another template.

Project  ​This option is selected by default. It means you’re starting a new project using one 

of the templates selected.

Project Template  ​Choose this option if you want to create your own template. Under 

Create New, select Project Template, and under Template File, select the template that is 

most similar to what you want to create so that it serves as a basis for the new template. 

Make additional changes to that template, change settings, add or remove content, and 

save it under another name.
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C hap te r 3

This chapter  discusses how to look at a Revit model using the views set up 

in the default template, as well as how to create new views. We’ll explore how to create 

plan, section, elevation, and 3D views. This chapter also explores how to create simple 

schedules quickly and how to customize a schedule to show a wide range of information 

available in a building information model.

We will cover the following topics:

Visualizing a Revit model■■

Creating views■■

Working with views■■

Schedules■■
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Visualizing a Revit Model
In Chapter 2, “Getting Acquainted — Interface and File Types,” we discussed the basics 

of the Revit interface. Let’s now dive into the primary data visualization components of 

Revit. You’ll notice immediately that Revit is designed with architectural drawing con-

ventions in mind. The various views that Revit generates should be familiar: floor plans, 

sections, elevations, details, perspectives, and even schedules. Each of these is a way to 

display the building model in what Revit calls views. The view typology follows a long 

tradition; however, the act of creating views with Revit is quite new and can be very dif-

ferent from traditional drafting and CAD practices.

There is an important difference between Revit and CAD applications to keep in mind 

as we delve into documenting and viewing a building information model. In Revit, views 

are dynamic, live snapshots taken from the same database that you created as you built 

your model. In CAD, views are represented by line drawings created manually from 

scratch and are independent of one another. Each drawing is a manually generated arti-

fact. In Revit, you build your building by making a digital model. Then when you need to 

create a view, be it plan, section, or whatever, you don’t need to create or redraw; it’s 

already there — available to you. It is as if you’re taking a snapshot of the very same 3D 

model from various vantage points.

As you learned in Chapter 1, “Understanding BIM,” in Revit a wall drawn in any view 

is represented in other views automatically. For example, the wall is drawn in plan view, 

and it shows automatically in 3D, section, and elevation view. There is no need to draw 

the wall multiple times in separate views as you’d need to in CAD. This feature is incred-

ibly powerful because it allows you to rapidly generate your building geometry and have 

all the information necessary to begin laying out a drawing set much earlier in the design 

process. From an early stage, you have enough information to generate plans, sections, 

elevations, and details, and place them onto sheets for documentation. From that point 

forward, sheets on which such views have been placed will update automatically as the 

design progresses and moves through the many changes and iterations that are typical in 

an architecture project. When the design solidifies, you’ll add the necessary level of con-

struction detail and annotations to your views.

Creating Views
Views are best understood as live snapshots of the same 3D model taken from various 

vantage points. There are many view types in Revit: plans, sections, elevations, schedule 

tables, lists, 3D views, and sheets. These are easily recognized and organized in the Project 

Browser. Each view type provides control over values such as view depth, scale, display 

style, visibility of elements, and level of detail. Right-clicking any view in the Project 

Browser lets you access the properties of that view and change any of these values. As 

you’ll see, view properties lets you be extremely versatile in how you represent a view.
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The majority of the tools for view creation can be found under the View tab in the 

Ribbon (shown in Figure 3.1). 

As do all the other Ribbon tabs, the View tab has three states: Minimized to Tabs, 

Minimized to Panel Titles, and Full Ribbon. You can switch among these by selecting the 

little arrow at the far right of the tab. The Minimized to Panel Titles state offers four view 

panels: Graphics, Create, Sheet Composition, and Windows (see Figure 3.2). There you’ll 

find tools for controlling the view graphics, creating new views, managing and modifying 

the current view, and switching views.

There are some additional ways to create views, which we’ll be exploring throughout 

this chapter. Any view can be preset using project templates; this assures consistency across 

teams and projects when new projects are started. When you use Revit’s default templates, 

a number of views are already established when you start a new project. As you develop 

your own graphic standards, you’ll be able to create your own starting project templates. 

However, in this book, we will primarily be using the default templates. Customization of 

templates is covered extensively in the book Mastering Revit Architecture 2010 (Sybex, 2009).

Navigating Between Views
As new views are created, they appear instantly in the Project Browser. When you cre-

ate new views or delete views, they’re added to or removed from this list automatically. 

Double-clicking on the name of any view in the Project Browser opens that view in the 

drawing area and makes it active. An active view can be closed later using the Close but-

ton in the upper-right corner of the view. Note that this will not delete the view — it will 

just close it in the drawing area. To delete a view, use the right-click menu when the mouse 

is over the view name in the Project Browser, or delete the view symbol (such as the sec-

tion mark or elevation tag) in another view where the mark is available.

In addition to using the Project Browser, you can use view reference graphics, including 

section marks, elevation tags, and levels, as hyperlinks to navigate between views. When a 

view such as a section is created, the section view tag in Revit will be displayed in blue in 

other views — floor plans and other sections. You can double-click this blue tag to go 

directly to the view it references. You must double-click the arrow (in the case of eleva-

tions) or the flag (for sections and callouts) to open the view. Figure 3.3 shows that tag in 

black and white.

Figure 3.1

The View tab in 
expanded mode

Figure 3.2

The View tab in 
collapsed mode
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Make sure you double-click within the blue section tag to open the corresponding 

view (see Figure 3.4). Double-clicking the section line will not open the associated sec-

tion. You can also use the right-click menu when hovering your mouse over view tags, 

and choose Go to View (or Go to Specific View when one unique link is available) from 

the context menu to navigate to a new view.

Working with Views
This section discusses a few tasks and challenges you may encounter in your first Revit 

projects when adding or manipulating views.

Creating New Plan Views with Levels
Let’s start with the first view you’ll typically use: a plan view. In Revit, the default plan 

view is referred to as a Level 1 view and is organized under Floor Plans in the Project 

Browser. A level typically represents one story in a building, but as you’ll see later, a level 

can also be used to reference the position or height of other elements (split levels, roof 

edges, and so on). Levels are typically created for each story in the building model.

To toggle through multiple open views, press Ctrl+Tab on the keyboard. To view all open 

views, go to the Switch Windows menu (under the Windows panel) — all available views will 

be listed.

Figure 3.3

Section flag

The hyperlinking of section and elevation tags via double-clicking works only when they 

are not selected or highlighted. If they’re selected (highlighted blue in Revit), no matter how 

many times you double-click, it won’t lead you to another view.

Figure 3.4

Where to click to 
open a section view
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Creating Levels

You can select the Level command from the Datum panel under the Home tab 

(Figure 3.5). When selected, this command allows you to draw a level using two mouse 

clicks to define the start point and endpoint of the level graphics — this will add a new 

level and plan view to the model. It’s important to note that the Level command is dis-

abled unless you’re actively in an elevation or section view.

To create a level using the Level tool, you have to be in section or elevation view. The 

Level tool will be grayed out in any other view. Select the Level tool, click on a point that 

will define the height of the level, and then drag the mouse horizontally to click a second 

point and thus complete the command. The interaction is similar and as simple as 

drawing a line but will create a 3D level (story) in the project. When a level is drawn, 

Revit automatically generates a floor plan and a reflected ceiling plan for that level, and 

lists them in the Project Browser. To add another story, repeat the process.

You can also create a level by copying an existing one. If you are starting with a default 

Revit template, usually at least two levels are predefined. To create additional levels, open 

a section or elevation view; select the level line in the view; and, using the Copy com-

mand, copy the existing level, thus creating a new one.

Copied levels react differently from those drawn with the Level command. The critical 

difference is that the level symbol will appear black instead of blue. This isn’t just a graphic 

difference: the copied level doesn’t automatically create a new view (you will see in the 

Project Browser that no new plan has been added); it only gives you another level graphic 

in the project that shows in elevation or in section. This behavior is intentional, and 

it’s useful when you need another benchmark in elevation to show heights or want 

to associate geometry to a level, but you don’t necessarily want to generate an associ-

ated plan view. A good example is the top of a parapet wall.

Adding a Plan View
What do you do when you have created a level using the copy method and it isn’t 

associated with a plan view, and you later decide that you want it to become a plan 

view? It’s not too late. Go to View tab and under the Create panel, select Plan Views/

Floor Plan. A dialog box opens that allows you to select a level and create a new floor 

plan based on that level (Figure 3.6). Check Do not duplicate existing views at the bot-

tom of the dialog box. (This process is the same for ceiling plans.) The level symbol 

will then change to blue, indicating that it is a hyperlink to a plan view.

Figure 3.5

Choose the Level 
command from the 
Datum panel on the 
Home tab

Figure 3.6

New Plan dialog box
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Duplicating Views
What happens when you want to create a new view based on an existing floor plan? Say 

you already have a design plan of Level 1, but also need a presentation plan and a fully 

annotated plan for your documentation set. You can achieve this in Revit by duplicating 

views. To duplicate a view, right-click the view’s name in the Project Browser (Level 1 for 

example), and choose Duplicate View from the context menu (see Figure 3.7).

Each command on the Duplicate View submenu 

makes a duplicate view of the model from the same 

vantage point. There are three different ways to 

duplicate a view:

Duplicate  Makes a duplicated view in which only 

the model data of that view is copied. This can be 

useful when you don’t wish to copy any tags, dimen-

sions, or annotations from one view to the next. 

Keep in mind that the model is not copied — you’re 

just creating a duplicate view of the model without bringing along any 2D graphics.

Duplicate with Detailing  Makes a copy of the model data and any 2D information (such 

as text, dimensions, or keynotes) in the view. When this method is used, annotations and 

detailing that are added or edited in the original view after the duplication aren’t propa-

gated in the duplicated view. Only model-data modifications are propagated in the dupli-

cated view. The copied annotations are not linked.

Duplicate as a Dependent  Not only creates a duplicate of all the model and drafting data, 

but also creates a dependency between the detailing information of the duplicate view and 

the original view. When this type of duplication is used, changes of both model (3D) and 

drafting (2D) elements in the original view will propagate in the duplicate view. A use 

case for this type of duplication would be a project with a big floor plate that you need to 

split into separate segments for printing. Another one would be a situation where you 

need to place the same view on multiple sheets. 

Types of Views in Revit
Revit provides many types of views for documenting and representing your building 

designs. This section lists the commonly used views.

Figure 3.7

Duplicate View 
submenu

Dependent views created with the third method (Duplicate as a Dependent) must always 

remain in the same scale as the original.
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Plans

All plan views are horizontal slices through the building. Each plan shows the model as 

cut but can also show information above and below the cut. To control how the plan is 

represented, a view range is defined. This is a combination of settings that will help you 

specify exactly what you need when creating a floor plan. Most of the time, Revit’s default 

settings are sufficient. However, there are situations in which you may want (or need) to 

modify the view range settings to get correct representation. 

When working in a modeling environment, a plan view is nothing but a horizontal 

slice of your building. Architects slice the building at what is called a cut plane. The stan-

dard height for a cut plane varies slightly in different regions, but it usually is about 4′–0″ 

(1.20m). So far, so good. But once you cut the building, how deep do you want to see? 

Only to the first floor your eyes hit? Or do you need to see beyond that? How do you want 

to represent the objects below the cut plane? Hidden? Cut through? Dashed? What about 

the objects above you? Do you want to see the beams above your cut height dashed? Or 

not at all? This is where the view range options come in handy.

Understanding View Range

The View Range options are applicable only to floor and ceiling views. Modifying these 

options influences the visibility and appearance of the elements in the plan or ceiling 

views of the project. To access the View Range dialog box, shown in Figure 3.8, right-click 

in the drawing area and choose View Properties ➔ Edit (under Visibility/Graphic 

Overrides) ➔ View Range.

  

Figure 3.8

Accessing the View 
Range dialog box
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The following list describes the Primary Range features in the View Range dialog box 

(see Figure 3.9). These features can be a little complex to understand initially, but as you 

modify them and see the results in your model, they will become easier to understand.

Top plane  The top plane defines the uppermost plane above the cut plane up to which 

elements will be considered. If an element is above the cut plane but still in the primary 

range (partially or fully), the element is visible in the plan view as if it were seen from 

below the element.

Cut plane  The cut plane defines the height at which the 3D elements of the model are 

physically cut, as shown in Figure 3.10.

A cut plane height of 1.90m is above the 
window, so the window is not visible.

A cut plane height of 1.2m passes through 
the window. The window is visible and cut 
through.

A cut plane height of 0.60m is below the 
window. This illustration may seem 
incorrect, but the text explains why it’s 
accurate.

Figure 3.9

View Range 
dialog box

Figure 3.10

The cut plane 
defines the height 

at which 3D 
elements will be cut.
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Bottom plane  By default, the bottom plane is coincident with the view depth plane, but it 

doesn’t have to be. If an element is below the cut plane and is wholly in the primary range, 

it’s still shown. Note that only a few Revit elements are considered here: windows, furni-

ture systems, and generic models.

View depth  View depth defines the extent to which you want to view what is below the 

cut plane.

Various combinations and values set in the View Range dialog box will produce differ-

ent ways of representing the plan and ceiling views of the model. 

Figure 3.11 is a model of a simple space that we 

will use to explain the view range. You can find 

this model on the book’s web page. We have cho-

sen a split-level example to show you the power 

of various settings and how they affect the 

display of the view range parameters. 

Note that the furniture and the chairs 

belong to the Furniture category. The 

wall shelf belongs to the Furniture Systems 

category.

Figures 3.12 through 3.14 demonstrate the use of 

the view range and illustrate how different settings 

for the bottom plane and cut plane result in different plan 

view displays.

Revit doesn’t cut all 3D elements. When you cut furniture, regard-

less of the cut plane, the furniture is not cut. In addition, some Revit families are never 

cut. To understand which Revit elements are cuttable and which are not, choose the 

Manage tab and click Project Settings ➔ Settings ➔ Object Styles. Note that some elements 

are grayed out in the Cut column (see Figure 3.15). These objects aren’t cuttable, meaning 

they are not affected by a change of cut height.

Floor plans  Floor plans are horizontal slices through the building and are associated with 

levels. These views typically cut the model at 4′ (1.2 m) above the level line.

Ceiling plans  Ceiling-plan views behave in a similar fashion to floor plans, with the 

exception that they give a view upward to the ceiling of a level. (You look up instead of 

down as in a standard floor plan.)

Site plans  Site plans by default are at 1″-20′ (1:250) scale and are views from above your 

model. The site plan typically shows the physical and topographic features of the model 

and doesn’t show certain annotations that normally would not appear at scales greater 

than 1⁄16″-1′ 0″ (1:200).

Figure 3.11

A split level requires 
specific view range 
settings to display 
what you need in 
plan view.
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Area plans  Area plans can be used for gross area, rentable, or Building Owners and 

Managers Association (BOMA) area calculations, to name a few. To create one of these 

types of plans, click the Home tab and under the Room and Area panel select Area and then 

Area Plan. Area plans are most effective when you have areas that span multiple rooms.
Figure 3.12

The lower level is 
not displayed at all. 

The bottom plane 
and the view depth 

have been set to 
Level 00. 

Figure 3.13

The lower level is 
displayed along 

with the furniture 
placed on it. The 

bottom plane is set 
to Level 00B and the 

view depth is set to 
the same value as 
the bottom plane 

(Level 00B).

73559c03.indd   84 6/4/09   8:26:16 PM



Working with Views  ■   85

  

Callouts

A callout is a detail view that can be placed in plan, section, or elevation views. For example, 

if you have a plan view of a kitchen and you want to create another plan view that repre-

sents only part of the kitchen at a larger scale to show more detail, you use this command. 

Callouts are used to show a larger-scale cutout of a view that is dependent on the parent 

view from which it was placed. This means that if the parent view is deleted, any callout 

view or views dependent on that parent view will also be deleted. There are two possible 

types of callout views for floor plans (as shown in the Type Selector when you select the 

Callout tool): Floor Plan and Detail View. Similarly, for sections, you can choose either 

Section or Detail View. Once you make a choice, the new callout will show up in the 

Project Browser, either under Floor Plans (Sections) with the prefix Callout before the 

view name, or under the Detail Views folder.

Elevations

Elevations show your model projected onto a vertical plane, so you can evaluate and 

annotate building façades and interior wall elevations. Elevations are created by placing 

elevation tags into your model. These are orthogonal projection views (of the exterior 

Figure 3.14

The lower level is 
displayed. Of all the 
furniture placed 
on the lower level, 
only the chairs are 
visible. The table 
does not show. The 
bottom plane is 
defined at Level 00 
and the view depth 
is set to –1 m below 
Level 00.

Figure 3.15

Some Revit family 
categories are not 
cuttable. Regardless 
of the height set for 
the cut plane, this 
stool (from the Fur-
niture family) will 
be shown the same 
way in all cut plane 
height scenarios.
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façades of the building or of interior elevations). What’s great about Revit is that when 

you insert an elevation tag, it dynamically positions itself perpendicular to any wall. This 

speeds up the process of making as many elevations as you need, even in projects that 

have complex, nonorthogonal floor plans. Once an elevation has been placed, you can 

duplicate any elevation by right-clicking the view name in the Project Browser and choos-

ing Duplicate View ➔ Duplicate. This will make a new nondependent elevation view. 

Each elevation symbol is capable of creating four eleva-
tion views at once, each facing a different direction. This 
is designed for interior elevations. If you place an eleva-
tion symbol in the middle of a room, by inserting the tag 
and then highlighting the center of it, you see check boxes 
that can be used to activate the other elevations. Check or 
uncheck one of the boxes to turn the elevation on or off 
(see Figure 3.16). 

Selecting an activated elevation arrow gives you additional options and displays the 

width and depth of the elevation. In Figure 3.17, the bar represents the width of the eleva-

tion, and the dashed line shows the depth. Both of these properties can be modified either 

in plan or in the actual elevation. The bar also determines the start plane of the cut and 

may be moved independently from the elevation graphic.

Try drawing a few nonorthogonal walls. From the View tab, under the Create panel, select 

Elevation and start placing the elevation tag at various places around the walls, moving the 

mouse around the plan. See how the elevation tag orients itself automatically according to 

the wall that it references or one that is nearby. If you have a series of walls at different angles 

to each other, it selects the one most nearly perpendicular to it.

Figure 3.16

A highlighted 
elevation tag. 
Note that the 

active elevations’ 
associated boxes 

are checked.

Revit understands the differences between interior and exterior elevations. When creating 

interior elevations (placing an elevation tag in the middle of a room), Revit draws the eleva-

tion of the room in a way that it cuts it where the bounding walls, floors, and ceilings are 

located. The interior elevation tags in Revit are capable of generating four orthogonal eleva-

tions at a time. To do that, select the tag and check all four sides of the elevation arrows.

Figure 3.17

Elevation width  
and depth
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You can double-click any of the elevation arrows to navigate directly to the cor-

responding elevation view, or you can open the elevation views from the Project 

Browser. Once the elevation is placed on a sheet, the sheet number appears inside 

the elevation box (Figure 3.18), and the view number appears in the elevation 

arrow. Deleting the elevation tag deletes all the corresponding elevations from the model.

Sections

Sections show a vertical slice through the model. The properties of section tags are simi-

lar to those of elevation tags, except the cut plane of the section graphic cannot be moved 

independently from the section graphic (as with 

elevation symbols). The view width and depth 

are defined by the dashed lines when a section is 

selected, as in the elevation. Use the opposing 

arrow drag controls to adjust the crop boundary 

of the section (Figure 3.19).

You often need a jointed section cut through 

a project — for example, when you want to cut through a building but want to jog the 

section line to pass through a staircase that isn’t in the cut line of the initially desired sec-

tion. To accommodate this, the Section tool has the capability of splitting so that it allows 

for staggered section lines.

To stagger a section line, first draw a section line where you need to establish a view. 

Next, select the section, and choose Split Segment from the Section panel of the Modify 

Views tab. This enables the Split tool and allows you to split the section line at any point. 

Note that now each segment of the section cut can be adjusted for location and depth. Grab 

a portion of a section line that you’ve segmented, and move it up or down to achieve the 

desired position. A section line can be cut multiple times if need be.

Drafting Views

Drafting views are 2D views specifically designed to show information that is not gener-

ated directly from the model. They’re usually used to show standardized details or infor-

mation that is typical of a certain area but doesn’t necessarily have a connection with the 

model. Drafting views can also be used to display detailed 2D information about some-

thing in the model.

Figure 3.18

Elevation tag with 
its corresponding 
sheet marker

Figure 3.19

A typical section 
symbol

For best performance, be sure to limit the depth of your section and elevation cuts only to 

what you really want to see. For example, if you are cutting a wall section, there is no reason 

to set the section depth past the back wall of the room in which you are cutting the section. 

Revit will calculate all of the information whether or not you see it, so make your section depth 

as shallow as possible in order to gain in performance and not force Revit to calculate what 

you do not need to see.
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A range of 2D details and elements by various manufacturers is available on the Web, 

usually in DWG or DXF format. You can use these resources to enrich your Revit model. 

You can also reuse 2D details from previous CAD projects. Drafting views let you import 

CAD files of standard details or create 2D details by drawing with drafting tools such as 

lines and fill patterns.

It is important to understand that drafting views created separately from the model or 

imported can be referenced in the model and linked to a callout so your drawing sheets 

always maintain a parametric relationship to their associated details. You should also 

understand that using the Callout Detail tool allows you to create dynamic details that 

are generated out of the model with 2D drafting elements overlaid on top. Unlike drafting 

details, these details are connected with the model elements, so any model changes are 

reflected in the details.

Drafting views can be inserted onto sheets and can also be referenced to sections or 

elevations as a similar (SIM) condition. To reference a drafting view to a model, follow 

these steps:

	 1.	 Create your new drafting view: switch to the View tab, and in the Create panel select 

Drafting View. 

	 2.	 Import a DWG file, or use detail lines, filled regions, and other drafting tools from 

the Annotate tab to create the 2D detail.

	 3.	 Switch to a view where you want to indicate a callout that will reference this newly 

created drafting view.

	 4.	 Select the View tab again, and from the Create panel choose Callout . 

	 5.	 Prior to drawing the callout bubble in the model where the detail explains the condi-

tion, from the Options bar check the Reference Other View option in the Options bar 

and choose the drafting view you just created (see Figure 3.20). Now draw the callout 

bubble where you wish the drafting view to be referenced.

The resulting reference brings you to more detailed 

information about the portion of the model that you 

describe in the drafting view. 

As discussed in Chapter 1,“Understanding BIM,” you don’t need to model every detail 

of the building. Each project needs to define an acceptable level of detail to model, based 

on the project parameters.

We’ve just covered the main types of views in Revit. Now let’s take a look at some 

additional tools that fine-tune how we look at the model.

Legends
Legends are a special type of view in Revit that allow you to place graphic representations 

of elements in the model to explain the symbology used in the project. Examples include 

a key to symbols in a site plan; typical wall, door, or window types used in a project; or 

Figure 3.20

Reference Other 
View option
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demolition notes on a title block. Unlike all other views, which you can place only once on 

a sheet, legends are used for views you want to have appear on multiple sheets. Legends are 

2D elements derived from the components used in your project. Elements in a legend have 

no effect on scheduling quantities of elements. For example, adding a door symbol to a 

legend view will not increase the number of instances of that door in the overall project 

and thus won’t be reflected in the schedule of the door totals. This is one of Revit’s more 

sophisticated and unique features (see Figures 3.21 and 3.22).

To create a legend view, first click the View tab. On the Create panel, click the Legends 

button and select Legend. You can then give the legend view a name and associated scale, 

and you will be presented with an empty view window. To start creating the legend and 

add content to this view, go to the Annotate tab, and under the Detail panel, click the 

Component button. Then select Legend Components and start generating the legend.

3D View — Axonometric Views
Axonometric views of the entire project model can be generated by clicking the 3D button 

(the house icon) on the Quick Access toolbar located at the top left of the application 

(Figure 3.23) or by selecting the 3D View tool, located on the Create panel of the View tab.

Legends are the only view type in Revit that can be placed on multiple sheets.

Figure 3.21

Legend with plain 
notes

Figure 3.22

Door legend
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Once a 3D view is created, you can orbit around the model to get a visual feel for your 

building. Once you like the view, rename it so it gets stored under a recognizable name in 

the Project Browser, by right-clicking on the {3D} name; that way, you can easily come 

back to it later. Once you’ve renamed the default {3D}, any time you click the 3D button 

from the toolbar, it will create a new default {3D} 

view for you to use again (Figure 3.23). To orbit 

and pan around the model, use the ViewCube (see 

Figure 3.24) that appears in the top-right corner of 

any 3D view. Clicking on faces, edges, and corners 

of the ViewCube will spin the model (actually the 

camera) accordingly.

The Steering Wheel is another tool that helps 

you navigate through the model. By default, it is 

positioned on the far right of the drawing area, 

just below the ViewCube. 

Details of how to use the mouse, the ViewCube, and the Steering Wheel are covered in 

Chapter 2, “Getting Acquainted —  Interface and File Types.” 

The visibility of these navigation tools can be controlled from the View toolbar. In 

the Windows panel, under User Interface, you specify whether you want a tool to be vis-

ible or not. 

Figure 3.25 shows an axonometric view of a house.

Figure 3.23

Click the 3D button 
on the Quick Access 

toolbar to create 
a 3D view of the 

model on the fly.

Figure 3.24

The ViewCube 
facilitates easy 

orbiting and 
viewing of the 

model.

Figure 3.25

Axonometric view 
of a house
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3D View — Perspective (Camera) Views
Another type of 3D view is the perspective view (Figure 3.26). You create a perspective 

view by using the Camera tool. Once created, these views also appear under the 3D Views 

folder in the Project Browser. When creating perspective views, be sure to give your 

views unique and descriptive names, as you will find yourself creating many perspective 

views in a project. This approach will save time later when you are hunting for views to 

open or place on sheets.

To create a perspective (camera) view, you will need to place a camera in a view. The 

typical approach is to position the camera in a floor plan view. By default, the camera 

view is 5′–6″ (1,750 mm) above the floor and looks straight ahead.

To create a camera view, follow these steps:

	 1.	 Make sure you’re in a floor plan view. Click the View tab, and in the Create panel, 

under 3D choose Camera.

	 2.	 Click on the location where you’d stand in the model and then click again to set the 

direction in which you want to look. The second click will determine the visual 

focal point and the center of rotation for the camera when you orbit the view. You 

can manipulate the view size, width, height, and clipping plane once the camera is 

placed. Figure 3.27 shows the camera after it has been placed in a view.

	 3.	 When your camera is placed, it automatically opens the 3D view of the model that 

you just created. At this point, you can expand the view boundary vertically and 

horizontally using the blue drag grips to show more or less of the model.

Figure 3.26

Perspective view of 
a house
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	 4.	 Once you are in a perspective view, the camera you have placed will not be visible in 

other views. To see the camera placement in other views, open the perspective view 

and select the crop region surrounding the view (the border of the view), or right-

click the view name in the Project Browser and choose Show Camera. Back in the 

plan where you created the camera view, the camera will be highlighted in red. The 

extent of the new view range is shown graphically in this view.

	 5.	 To modify it numerically, select the camera, right-click, and select Properties. Doing 

so opens the properties dialog box for the view and allows you to modify the cam-

era’s head height, target height, and far clipping. (This sets the farthest point to 

which the camera can see.)

Walkthroughs
A walkthrough is an animation of a camera that follows a path. It’s an effective method 

that creates a sense of walking through a building, and a good way to communicate your 

ideas to a client.

You create a walkthrough by placing a series of keyframes (camera positions) in a cho-

sen order along a path in plan view. You can then walk through each keyframe and adjust 

the camera to change where the view is being directed. Once the keyframes have been set, 

you can export an animation that takes the camera along the path. Revit automatically 

makes transitions between keyframes smooth and seamless. You can export the walk-

through view as an AVI file to share with your clients or team members.

The Walkthrough tool is accessible from the same location as the Camera tool: go to 

the Create panel of the View tab and, under 3D View, select Walkthrough. 

Figure 3.27

A camera view 
placed within the 

model
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Schedules
Schedules are lists of entities and objects within the model. They enumerate things that 

can range from building objects such as walls, doors, and windows, to drawing sheets, text 

notes, and keynotes. The ability to dynamically create and update schedules, as well as drive 

or locate model information from within a schedule, is a core aspect of BIM and Revit.

Creating schedules of objects, areas, or material quantities in a project is one of the 

most painful tasks for architects. A manual calculation takes a long time and can result in 

errors. And those painfully created manual calculations are good until the next change, 

when the work needs to start over. Using CAD systems, this process may be partially auto-

mated, but the calculation can only reflect the number of blocks that are predefined in a 

file. In Revit, all elements have information about their physical properties, and you can 

add information to individual elements. For example, doors can have properties like width 

and height, as well as material, color, fire rating, exterior or interior, and so forth.

Revit lets you schedule any element based on the properties of the element. Any geo-

metric element placed in a Revit view can be scheduled. Additionally, because the sched-

ule is linked to the objects in the model, you can use the schedule to locate objects within 

the model and change their types or properties. As we often state, it does not matter in 

which view you add or change something in Revit; the changes will be reflected in all the 

views. Schedules are easy to create and use, and they are intuitive.

Uses of Schedules 
You can use a schedule to document doors and windows within a project, but you can also 

use a schedule to look for inconsistencies within your model. For instance, you can keep a 

schedule of text notes only within a model and not use them on sheets. This schedule can 

then be used to look for odd items inserted into the model. You can schedule the text note 

name and the number of times it appears in the model. Perhaps the schedule indicates that 

a particular note is used only one or two times in the model. You can then decide if the note 

was inserted incorrectly into the project and determine whether it’s inconsistent with the 

other notes in the model. The same thing can be done for wall types or anything else you 

can schedule.

Creating Schedules

To create a schedule, select the View tab and in the Create panel, choose the Schedule 

button and select Schedule/Quantities. 

This will open a dialog box that lists several possibilities, starting with the following:

Multi-category  This schedule is for objects that don’t normally appear together. For 

example, you may want to create a schedule of fire-rated windows and doors combined. 

You may also want a schedule showing all the casework and furniture in a project. A 

multi-category schedule allows you to combine a number of different items in separate 
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categories into one schedule. (Keep in mind that multi-category schedules only schedule 

component families, not host families.) 

Area (Gross Building)  This schedule lists the gross building areas created with the area plans.

Areas (Rentable)  Rentable area plans can be created with a rentable plans schedule. The 

categories that you can schedule in Revit are as follows:

Areas (Rentable) Gutters Rooms
Casework Lighting Fixtures Site
Ceilings Mass Slab Edges
Curtain Panels Mass Floor Specialty Equipment
Curtain Systems Mechanical Equipment Stairs
Curtain Wall Mullions Parking Structural Columns
Doors Planting Structural Foundations
Electrical Equipment Plumbing Fixtures Structural Framing
Electrical Fixtures Property Line Segments Topography
Fascias Property Lines Wall Sweeps
Floors Railings Walls
Furniture Ramps Windows
Furniture Systems Roofs

Following in the same New Schedule dialog box you will find all other Revit categories of 

which you can get quantities and make schedules in Revit.

But there are other types of schedules in Revit accessible from the same Schedules but-

ton in the Create panel of the View tab. Here is what can you do with them:

Material Take-off  This type of schedule can list all the materials and subcomponents of 

any Revit family and allow an enhanced level of detail for each assembly. You can use a 

material take-off to schedule any material that is placed in a component. For example, 

you might want to know the cubic yardage of concrete within the model. Regardless of 

whether the concrete is in a wall, a floor, or a column, you can tell the schedule to report 

the total amount of that material in the project.

View List  This schedule shows a list of all the views in the Project Browser and their 

properties.

Drawing List  This schedule shows a list of all the sheets in the project, sorted alphabetically.

The drawing list can also be used as a sheet index to the documents. Because Revit sorts 

sheets alphabetically, it’s typically not desirable to prepare the sheet index in the traditional 

fashion, with civil sheets first, then architectural, and so on. One way to customize sheet sort -

ing is to add a field to the schedule and number the sheets so civil is 1, architectural 2, and so 

on. You can then sort by that number column.
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Note Block  This schedule lists the notes that are applied to elements and assemblies in 

your project. You can also use a note block to list the annotation symbols (center lines, 

north arrows) used in a project.

Keynote Legend  For users of previous versions of Revit: the Keynote Legend previously 

grouped with the ones listed here is now available under a separate button called Legends, 

also available in the View tab. This schedule lists all the keynotes that have been applied 

to materials and objects in the model. You can either use this list as a complete index of 

all the notes in the drawing set or filter it by sheet. This legend can then be placed on 

multiple sheets. For more about keynote legends, see Chapter 10, “Annotations.”

Making a Simple Schedule

Now that we’ve discussed the variety of schedule types, let’s make a simple schedule. 

When you begin a new schedule, you’re presented with a number of format and selection 

choices. These will help you organize and filter the data shown in the schedule, but also 

set the graphical aspects of the schedule, such as font style and text alignment. Remember 

that Revit at its core is a database, so many of the same functionalities that are available 

in database queries are also available in Revit. If you’re unfamiliar with database con-

cepts, don’t worry; we’ll explain the options as 

they appear in the New Schedule dialog box. 

The choices available for a new schedule in 

Revit are shown in Figure 3.28.

You’re first given the option of choosing a 

category to schedule from the menu. You’re 

also prompted for a name for the schedule (you 

can change this later) and given the option of a 

phase filter. This filter allows you to schedule 

new construction or existing construction in 

conditions where you may be working on a renovation and want to schedule only the new 

or existing materials.

The following example of creating a new door schedule walks through the options in 

the New Schedule dialog box:

	 1.	 Open the Station.rvt file found on the book’s companion web page, www.wiley.com/

go/introducingrevit2010.

	 2.	 Go to the View tab and from the Create panel, choose Schedules. 

	 3.	 Choose Doors from the Category menu, and name the schedule Door Schedule.

	 4.	 Click OK. You’ll see a series of tabs that allow you to choose the graphics of the 

schedule and exactly what data is shown. We’ll discuss these tabs and how they con-

trol the information and visibility in the schedule in Chapter 10. For the time being, 

we’ll only discuss the use of the Fields tab.

Figure 3.28

New Schedule 
dialog box
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	 5.	 You can add fields either by double-clicking the name of the field or by highlighting 

the field and clicking the Add button. Doing so moves the field from the left to the 

right column. You can also remove a field by highlighting it in the right column and 

clicking Remove.

	 6.	 Choose the fields Family and Type, Type Mark, and Level, described in Table 3.1.

	 7.	 Click OK. Revit will show you the complete schedule in table form (see Figure 3.29).

You’ve just created a schedule that shows 

all the doors in the project and the levels they 

appear on. As you can see, it is very easy to 

create simple schedules in Revit. These 

schedules can be modified, re-sorted, fil-

tered, or copied at any time in the process, 

and they will always be up to date.

F I E L D D E S C R I P T I O N

Family and Type The name of the door family and its type name
Type Mark The number or letter that appears in the door tag
Level The level of the model on which the door appears

Table 3.1

Some Door 
Schedule Fields

Figure 3.29

Schedule in  
table form
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Modeling Basics

C hap te r 4

This chapter  focuses on the creation of the basic modeling elements — 

walls, f loors, and roofs, as well as windows, curtain walls, doors, stairs, and railings. 

We’ll take you through an exercise where you’ll build a small house. This will give us an 

opportunity to present the following basics:

Levels and grids■■

Basic walls■■

Floors, roofs, and ceilings■■

Doors and windows■■

Components■■

Stairs and railings■■

Starting a project■■
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Levels and Grids
Levels and grids are the horizontal and vertical planes that represent major floor-to-floor 

divisions (levels) in a building as well as the vertical division of the building into struc-

tural bays (grids). In Revit Architecture, levels are powerful elements, as just about every 

model element in Revit has a relationship to a level. When a level elevation is changed, all 

elements associated with that level also change. Elements such as walls have top and bottom 

relationships to levels, so that when floor-to-floor heights change in the model, walls won’t 

start to stick through floors or appear too short but will instead adjust to the new base or 

height of the floor. These smart relationships with the levels reduce the need to manage the 

vertical position of elements in the model on an individual basis (see Figure 4.1).

To find out what level an element is associated with, select the element and check its 

element properties. The word Level will appear for most content in the Instance 

Properties dialog box. You can see this readily by looking at the instance properties of 

walls, where there are two constraints to levels: one for the base of the wall and one for 

the top. These parameters are named Base Constraint and Top Constraint, as shown in 

Figure 4.2. 

Furniture and fixtures all have a relationship to a level as well. Figure 4.3 shows the 

instance properties of a lamp family and its constraint to Level 1.

Figure 4.1

Levels drive  
floor-to-floor 

heights
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Creating Levels and Grids
Levels generate new plan and ceiling views 

when created using the Level tool  located 

in the Datum panel on the Home tab. Levels 

are displayed and created in the model in sec-

tion and elevation views as horizontal lines 

with a symbol, name, and height attached to 

them. To draw a level, you’ll need to be in a 

section or elevation view. When you click the 

level tool, you’ll enter a two-click placement 

mode: your first click defines the beginning 

of the level graphic, and your second click 

defines the end. At the end of the level, you’ll 

see a symbol with the level name and an ele-

vation value. Clicking on either the name or 

the elevation will allow you to change these 

values directly.

Grids are created using the same method. 

The Grid tool  is also located in the 

Datum panel on the Home tab. Grids, unlike 

levels, can be created in plan as well as sec-

tion or elevation views.

Graphical Editing Controls

When a level or grid is selected, some text 

turns blue and additional controls appear:

Blue text   ​A blue font indicates that text is editable. Clicking the text allows you to edit 

values directly.

Drag controls  ​Drag controls are blue dots that allow you to drag elements interactively, 

and are used throughout Revit. With your cursor over the control dot, drag the mouse. 

The level line will dynamically adjust its length with the mouse movements. With levels 

and grids, dragging a control often drags other aligned levels and grids.

Break controls  ​Break controls  allow you to break lines and adjust the graphic rep-

resentation of the line. For levels and grids, this will allow you to kink the end of the line 

(make an elbow) to make room for symbols. This control is also used for section lines, 

but clicking the break will remove the middle segment of the section line, not kink it.

Locks and implicit alignment lines   ​Locks and implicit alignment lines  are used to keep 

elements aligned when dragged. When something is locked, then when one control dot is 

Figure 4.2

Base and top 
constraints of a wall

Figure 4.3

Level parameter for 
a lamp
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dragged, other controls will also move with it. You will see a dashed blue line when ele-

ments are in alignment. To free a level from this implicit constraint, click the lock icon.

Check box icons  ​Check box icons  turn the symbol and associated text on or off. You 

can turn the symbol on or off at either end of the level line using the check box, as shown 

in Figure 4.4. The same icon can be found on grids, where it will toggle the grid bubble 

on or off. These check boxes appear in section and elevation views for grids. (In pre-2009 

releases, the grid bubbles in section view were always there and had limited controls.)

The 2D/3D extents icon   ​The 2D/3D extents icon  icon is a toggle that lets you 

control either the 2D or 3D end of the line. When the toggle is set to 2D, the changes to 

the line length are only applied to the view you are actively working on. When you toggle 

to the 3D extents and change the line, the line will change in all views. In general, plan 

and elevation views use 3D extents, while sections, callouts, and details use 2D extents.

Grids and Structural Elements
Grids are vertical planes used as standard references in the construction industry for cre-

ating location grids on the site. These construction planes are used to accurately define 

locations for elements such as columns and beams. In 

Revit, when columns and beams are placed on grids, 

they’re automatically constrained to grids and grid inter-

sections. As with a level, when a grid is moved, associated 

elements move with the grid. As you can see, the creation, 

graphic representation, and control editing of grids is 

similar to that of levels (Figure 4.5).

A grid is composed of a line, a symbol, and a unique grid number or letter. Revit does not let 

you give two separate grids the same name, just as it won’t let you assign the same name to 

two separate levels. This reduces the possibility of generating uncoordinated data.

Basic Walls
Walls are one of the basic building blocks of architecture, and are easily constructed with 

Revit. Walls are built from layers of materials that give the wall thickness — they aren’t a 

mere collection of parallel lines. Each material has a user-definable representation for cut 

and projected geometry, which makes it possible for walls to be represented properly 

depending on the type of view the wall appears in. For example, when you draw walls in 

plan view (see Figure 4.6), you see the wall as if it were being cut, with materials repre-

sented as abstract hatch patterns. When you look at the same wall from an elevation or in 

3D view, you see materials represented with a more realistic expression. You can see how 

materials are defined by opening the Materials dialog box from the Manage tab. You’ll 

Figure 4.4

Symbol visibility

Figure 4.5

A selected grid 
symbol
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see that each material has a projection and cut pattern associated with it. Any of these 

materials can be used in the construction of your walls. You can also define your own 

custom materials here.

The materials in walls can be designed to provide automatic layer routing, thus greatly 

reducing the need to manually deal with wall intersections. For example, the stud layers 

connect with other stud layers and bypass finish layers, creating clean join representations 

automatically.

Wall layers are properties of each wall type (see Figure 4.7) and can be accessed 

through the Type Properties dialog box.
Figure 4.6

Wall 
representations

Figure 4.7

Wall properties
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When the Instance Properties dialog box is open, click 

the Edit Type button to access the type properties. In this 

dialog box, you can then access the Edit Wall Assembly 

dialog box by editing the Structure parameter (see 

Figure 4.8).

These properties allow you to define a hierarchy of mate-

rials so that when the walls in Revit dynamically join (see 

Figure 4.9), Revit knows how to properly show the joint 

condition.

Curtain Walls
Curtain walls are a special type of wall (usually known as a hung façade) that allows you 

to divide the wall into a grid that regulates panel and mullion placement. An example 

curtain wall is shown in Figure 4.10. Panels and mullions can be customized to meet most 

design requirements, from metal panels to structural glazing. As with basic walls, curtain 

wall height is controlled by setting base and top constraints to levels or offsets from spe-

cific levels. You can also attach the top and bottom of curtain walls to floors and roof, 

and may also have top/bottom attached. See Chapter 6, “Extended Modeling,” for more 

details on curtain walls.

Figure 4.8

Wall layers and 
materials

Figure 4.9

A stud wall  
joining to a brick 

wall in plan

73559c04.indd   102 6/4/09   8:11:49 PM



Basic Walls  ■   103

Creating Walls
The Wall tool is located in the Build panel of the Home tab. With this tool, you can create 

basic walls, curtain walls, and stacked walls in plan and 3D views. Making a wall involves 

using the Draw panel, which provides several methods for making walls:

Drawing lines Picking lines Picking faces

The most common method is to draw walls using a multipick interaction — defining 

a start and end point for each wall as if you were drawing it. In the Draw panel, you’ll 

see some standard drawing tools that will let you draw arcs, circles, rectangles, and 

polygons. You can also pick existing lines and generate walls with a single pick. Using 

the pick face method, it’s possible to place walls on more complex geometric massing 

shapes with a single pick. We cover the specific methodologies in more detail in exer-

cises throughout this book.

Figure 4.10

A customized 
curtain wall
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Floors, Roofs, and Ceilings
Floors, roofs, and ceilings are similar to walls in that they’re built of layers of materials 

and are constrained to levels. The interface for creating and editing layers of construction 

is nearly identical to that of walls, as you’ll see in this chapter’s exercises. Floors and roofs 

also use the same material layer routing as walls, making connections between walls, 

floors, and roofs appear correctly (shown in Figure 4.11).

Creating Floors, Roofs, and Ceilings
These tools are found in the Build panel on the Home tab. All of these elements are 

sketch-based elements made by defining a 2D boundary in a boundary edit mode. When 

you activate these tools, a contextual tab will appear with a set of tools specific to sketch-

ing 2D shapes. In this mode, you draw lines that represent the extent of the element as if 

it were projected onto a 2D plane. When you draw a closed loop of lines and finish the 

boundary, Revit generates 3D geometry for you.

In the case of floors, the geometry is coplanar with the boundary and has a predictable 

outcome. With more complex forms, such as hipped roof configurations, the resulting 

geometry is less obvious from within the boundary edit mode. The underlying 2D lines are 

always just a click away and can be easily manipulated to achieve your design objectives. 

To change the shape of an already created floor, roof, or ceiling, you need to get back 

to its boundary lines: to do that, select the element, then click the Edit Boundary button 

in the contextual tab. 

 Figure 4.12 shows some common roof forms that can be made using Sketch mode.

Figure 4.11

Walls join with 
floors and roofs

Figure 4.12

The left lower part 
of the building 

has a roof created 
with the footprint 

method whereas 
the arc roof on the 
right is created as 
roof by extrusion
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Doors and Windows
Revit makes adding doors and windows to your model a snap. 

The key thing to understand about windows and doors is that 

they’re hosted by walls. Without a host wall, doors and windows 

can’t exist in your model. Figure 4.13 shows a window hosted by 

a wall.

Windows and doors always stay in line with a wall; when the 

wall is moved or rotated, the windows and doors also move and 

rotate. Likewise, if a wall is copied, all hosted elements in the 

wall are copied. Like everything else in Revit, windows and 

doors are associated with a level in order to streamline the 

design process and remove obstacles to iteration by reducing 

the need to manually fix the model. Changing floor-to-floor 

heights will always keep your windows and doors in proper 

relation to the floor they belong to.

Windows and doors have specialized representations that 

are specific to the view in which they’re placed. For example, in 

plan view, a door can be shown as open with an abstract door-swing 

graphic, whereas in elevation it appears closed and the door swing is shown as diago-

nal lines indicating the hinge side (see Figure 4.14). Given the fact that graphical symbol-

ogy varies across the world, Revit is designed to allow you to represent these however you 

see fit; whether you want a door swing to be an arc or a straight line, or to be shown at all, 

is at your discretion. Customizing content to suit your needs is always just a few clicks 

away.

Creating Doors and Windows
To place a window or door, use the tools in the Build panel on the 

Home tab. Windows and doors can be placed in any view except per-

spective view. Move your cursor into the view. A preview graphic of the 

element appears on your cursor when it hovers over valid hosts. Pressing 

the spacebar will rotate the element prior to placement. When you’re 

ready to place the window, click to place it; it will automatically cut out 

material from the host wall. If you need to change the swing direction, 

press the spacebar when the door is selected, and it will cycle through 

all possible configurations.

Roofs can also be made by picking faces or by extrusion. These methods are suited for arc 

roof forms and more complex shapes that cannot be reduced to a 2D projected sketch plane. 

Figure 4.13

Example showing a 
window hosted  
by a wall

Figure 4.14

Door 
representations
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Components
Windows and doors are just a subset of the possible components that can be created 

using Revit. Revit allows you to design, create, and place just about any kind of compo-

nent you can dream up. The predefined categories of component types include everything 

from casework to structural framing. Components are a bit 

more flexible than windows and doors in that they do not have 

to be hosted by a wall in order to exist in the model. A piece of 

furniture, for example, does not need a wall in order to be 

placed. At the same time, you can design components with the 

same dependency as windows or doors. For example, with a 

wall-mounted light fixture (Figure 4.15), you’d expect it to 

move with the wall and be deleted with the wall just like a 

window or door would. Revit allows for this flexibility when 

designing components.

To place components, use the Component tool in the Build 

panel on the Home tab. You can also drag and drop compo-

nents from the Families node in the Project Browser. When 

placing components, you’ll get helpful snapping and align-

ment graphics. Pressing the spacebar before placing a compo-

nent will rotate it.

Stairs and Railings
Most buildings have stairs, and where there is a stair, you’re likely to encounter a railing. 

Revit provides specially designed tools for the creation of stairs, ramps, and railings that 

give you control over their basic constructive parts. With 

stairs, you set up design rules for elements such as stringers, 

treads, and risers; then Revit goes to work building the 3D 

geometry for you. You create stairs in Revit using Sketch 

mode, where you can define stair boundaries, risers, and runs by 

drawing 2D lines for the boundary and risers. The lines are then 

used to automatically generate a smart parametric 3D stair element 

of nearly any level of complexity. The same is true for railings. 

Using design rules, you establish a pattern of rails and balusters and 

then draw a simple 2D path. Revit fills in the path with 3D geom-

etry based on the rules you establish. Figure 4.16 shows a typi-

cal Revit stair.

The Railing, Ramp, and Stairs tools are located in the Circulation 

panel on the Home tab. When you activate these tools, you enter a 

Figure 4.15

Wall-mounted light 
fixture

Figure 4.16

A stair
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special Sketch mode where you sketch 2D lines. The lines used to construct stairs define 

the boundary and the risers. When you finish, Revit builds the 3D geometry for you. 

Changing the appearance and design rules for stairs and railings is done through the 

Type Properties dialog box. Ramps use the same creation method as stairs, and will slope 

between landings. 

Stairs can be set to be multistory, so that if your building is a six-story building and 

five have the same floor-to-floor height, you can draw the stair and the railing once and 

have it automatically repeat through mul-

tiple levels. This is an instance property of 

any stair (see Figure 4.17). 

If the stair is drawn with a railing, the 

railing is also drawn on all multistory stairs. 

If you later decide to make any changes to 

the stair, you’ll need to change it only once, 

and the change will propagate throughout 

all floors. Figure 4.18 shows a staircase (one 

element) spanning multiple floors.

Figure 4.17

The Multistory 
parameter

Figure 4.18

A multistory stair 
example

73559c04.indd   107 6/4/09   8:11:49 PM



108  ■   Chapter 4 : Modeling Basics

Getting Started with a Project
In the following exercise, you’ll use some predrawn lines to help you begin laying out 

exterior and interior walls. This does not mean that you’ll always need or have such lines 

to begin using Revit. We do it here so you can move through the exercise efficiently and 

to avoid burdening you with typing in every dimension value. In real life, there are many 

different ways to start a project — from an existing 2D import (covered in Chapter 7, 

“Working with Other Applications”), from a conceptual massing form, from an imported 

image, or from scratch. As you will see, Revit has many useful features when laying out 

walls, especially the smart temporary dimensions that let you see and edit dimensions of 

elements before and during creation.

In the exercise, we will start with a set of lines and construct 3D walls using these lines 

as guides. The lines are named guides, and their graphic appearance is managed from the 

Line Styles dialog box accessible from the Manage tab, in the Settings fly-out menu. To 

follow along with the process of building exterior and interior walls throughout the rest 

of this chapter, open the exercise base file named Source_House_Walls_Start.rvt at the 

book’s companion web page, www.wiley.com/go/introducingrevit2010. The model opens 

with the Level 1 plan view active. Several levels are predefined for first and second floors 

as well as for some roof planes.

The Place Wall Tab and Options Bar
Click the Wall tool in the Build panel on the Home tab to begin the process of drawing a 

wall. Before you start drawing anything, notice that a new tab, Place Wall, has focus. 

Check the horizontal Options bar (Figure 4.19) just above the view. The options you see 

here are always specific to the selected tool — in this 

case, the Wall tool. Become accustomed to looking  

at the Ribbon for contextual tabs, as well as using  

the Options bar for tool-specific options. We cov-

ered some of the basics of the available options in 

Chapter 2, “Getting Acquainted: Interface and File 

Types,” but here we’ll talk more about the wall-spe-

cific options.

The first part of the Place Wall tab is accessible upon 

expanding the Change Element Type button, which lets 

you choose the type of wall element to create. Go ahead 

and choose the Basic Wall: Exterior Wall.

The nice thing about the type selection list is that 

even if you place a generic wall initially, you can 

change the type of wall later by selecting it and 

changing the type with the same mechanism. 

Figure 4.19

Wall Options bar

Figure 4.20

The Type Selector 
on the Wall tab
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The next set of options is the gallery of methods for making the wall. You’ll use the 

default option, which uses a drawing metaphor and allows you to draw walls as you 

would lines. Near the bottom of the gallery are two options that let you select existing 

lines or geometric faces to autogenerate a wall without drawing. These options are gener-

ally used if you’re working from an imported set of lines, an imported solid geometry, or 

a massing form made of geometric faces.

Next you define the height of your wall using the Options bar. You define which 

level the top of the wall is constrained to, or if you want the wall to have a specific fixed 

height that isn’t tied to a level. In Revit, when the top of a wall is not tied to a level, this is 

referred to as its unconnected height. A knee wall is an example of a wall that isn’t neces-

sarily tied to a level at the top but needs an explicit height from the base level.

The next feature on the Options bar is the Location Line parameter, which is really the 

wall’s justification. The location line allows you to set a fixed axis for the wall based on 

the built-up construction of the wall. The most common use of this is to draw with either 

the interior or exterior core boundary (as in Figure 4.21) or structural layer when laying 

out walls. For example, you can draw walls relative to the stud face, rather than the finish 

face, of gypsum board. Whatever is set here determines where your cursor is relative to 

the wall construction during creation. You’ll notice this when walls are selected as well: 

the drag control is located at the location line. Note that you can change the wall location 

line at any point using the Element Properties dialog box for walls.

When new users start using Revit, they often wonder what level of detail they should model 

to when starting out. It’s okay not to know that right from the start. Revit is designed to eas-

ily change any wall type to another later in the process without losing any intelligence or 

relationships with other elements. It’s natural to use more generic, abstract wall types when 

beginning a design process and refine the model later. At the same time, Revit also allows 

you to be specific from the get-go. If you know your interior walls are wood studs with gyp-

sum wallboard, you can start placing those immediately.

Figure 4.21

This wall has 
Location Line set to 
Finish Face: Exterior
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Next is the Chain check box. When this is selected, it means you can keep making 

connected walls after every click of the mouse. When it’s deselected, extra clicks are 

needed to snap to the end of the previous wall in order to start the next wall. Chain is 

selected by default, based on the assumption that when you’re making walls (and, as 

you’ll see later, this is the case for sketch lines as well), you generally make a series of con-

nected walls. If this isn’t the case, deselect the box, and Revit will remember this setting 

the next time you use the Wall tool.

Exterior Walls: Drawing Exterior Walls
Let’s start the exercise. For the remainder of this chapter you’ll make the small house shown 

in Figure 4.22. Make sure you’ve got the file, Source_House_Walls_Start.rvt, open. Follow 

these steps:

	 1.	 Select the Wall tool from the Build panel on the Home tab. Using the Type Selector, 

set the wall type to Basic Wall: Exterior Wall.

	 2.	 Using the Options bar, set Location Line to Core Face: Exterior. This will allow you 

to draw the wall using the structural core edge as a baseline, rather than a finish 

layer or wall centerline.
Figure 4.22

Here’s the house 
you’ll be designing
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	 3.	 Starting in the upper-left corner of the sketch, begin tracing the outer edge of lines 

with your wall. Move in a clockwise direction, drawing walls from left to right (see 

Figure 4.23). As you do this, take note of snapping as you move the cursor from point 

to point. Snap your walls to intersection points of the guidelines. Zoom and pan while 

drawing walls — try this by scrolling the middle mouse button zoom, and holding 

the middle mouse button down to pan while drawing your walls. To avoid snapping 

to the wrong points, zoom in and trace the sketch. Revit provides snapping that lets 

you be precise in your wall creation by looking for endpoints, midpoints, and per-

pendicular edges (among others).

Notice the dimension strings that appear as you draw the 

walls. These are temporary dimensions that indicate the 

dimensions of the objects you’re drawing and, more important, 

can be used to specify explicit length and angular values. (To 

try them, click one point as the start of a wall and start typing a 

value on the keyboard. Revit won’t need any units or X–Y coor-

dinates.) Use snap intersections to place walls. Temporary 

dimensions can be used to get a more precise placement, as 

shown in Figure 4.24.

Figure 4.23

Starting a sketch

Figure 4.24

Snaps and temporary 
dimensions
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Note that the blue guidelines are obscured by the wall as you draw the walls. This 

is because the walls you’re drawing have a physical height in the model and are being 

represented as if cut at 4′ (1.2 m) above Level 1. What you see isn’t just lines, but the 

cut face of the wall geometry, which obscures the lines below. This type of display is 

called hidden line. It means that geometry is displayed relative to your point of view: 

elements closer to you will obscure elements farther away.

	 4.	 Continue drawing walls until you complete a circuit of lines around the perimeter. 

If you want to stop drawing walls, press the Esc key twice, or click the Modify tool 

in the Place Wall tab. If you misdraw a wall, you can select the wall and use the drag 

controls to snap it to the correct location.

Drawing walls from left to right on the screen places the exterior face of the wall facing the top 

of your screen by default. If this isn’t the desired orientation, press the spacebar while drawing 

the wall, and it will flip. The flip controls are always drawn on the exterior side of walls.

	5.	 Once you complete the walls around the perimeter, toggle the view dis-

play to Shading with Edges using the keyboard shortcut SD (press S, 

then D); the display mode will change to Shading with Edges. This 

option also appears at the bottom of each view in the View Control 

bar, as shown in Figure 4.25.

	 6.	 Use the Tab-selection method by hovering the cursor over one of the walls without 

clicking it, and then press the Tab key once. You’ll see the chain of connected walls 

highlight. Click once to select the walls. Use this method to quickly select connected 

walls rather than picking walls individually (see Figure 4.26).

Figure 4.25

View-display modes 
can be changed 

using the View 
Control bar

Figure 4.26

Connected walls can 
be selected by using 

the Tab key prior to 
selecting
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	 7.	 Now that all these walls are selected, you can change the wall type with one click 

(Figure 4.27). To see this, Tab-select all exterior walls, and then use the Type Selector 

and change them from Basic: Exterior Wall to Basic: Exterior — Brick on Mtl. Stud.

	 8.	 All the walls should have become thicker. This isn't the effect we want to have, so 

press Ctrl+Z to undo the type change.

Drawing the Fireplace Walls
Let’s use a similar method to make the fireplace walls:

	 1.	 Zoom into the area between gridlines 4 and 5, where we will put the fireplace (see 

Figure 4.28). Hold down the Ctrl key and select the three walls. Note that the cursor 

changes to show a plus symbol (+), indicating that each selection will add to the cur-

rent selection.

Figure 4.27

Swapping wall 
types

Figure 4.28

Selecting walls

To remove elements from a selection, press Shift and then pick elements that are already 

selected. To add new elements to a selection, use the Ctrl key when making selections.
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	 2.	 Use the Type Selector to change the walls to Generic – 8″ (20 cm) Masonry. The walls 

maintain their exterior face justification and expand inward. Notice that the cut 

graphic changes as well — to a diagonal crosshatch. See Figure 4.29.

	 3.	 Select the far-left shortest segment of the fireplace wall and extend it by dragging 

the blue end grip control (Figure 4.30).

	 4.	 Continue by selecting each wall individually and dragging the end controls until 

they snap to the guideline intersections (Figure 4.30). 

	 5.	 All that’s left to do is draw the last segment and close the fireplace walls. To do that, 

select only one of the masonry walls of the fireplace, right-click to open the context 

menu, and select Create Similar (Figure 4.31). 

This command puts you directly into drawing mode. Note that the Create Similar 

tool also appears on the Modify Wall tab when a wall is selected. Draw the remaining 

section of the fireplace. If you start drawing from the left corner, the wall is drawn 

inside-out. To resolve this, press the spacebar to flip the wall on its location line 

while drawing. Figure 4.32 shows the wall before it’s flipped and after it has been 

corrected.

Figure 4.29

The wall type has changed
Figure 4.30

Extending walls

Figure 4.31

Choose Create 
Similar from the 

Modify Walls 
context menu

Figure 4.32

Flipping a wall
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	 6.	 Let’s change the height of the fireplace walls to go up to a predefined level in the 

model. Using the chain selection method described earlier, hover the cursor over one 

of the masonry walls and press Tab once. The four walls forming the fireplace high-

light. (If this doesn’t happen, select the walls individually by pressing the Ctrl key or 

box-select them — whichever method works best for you.) Click to select them.

	 7.	 Right-click the fireplace walls and choose Element Properties from the context menu.

	 8.	 Change the top constraint parameter to T.O. Chimney, as shown in Figure 4.33. 

Click OK to commit the change.

	 9.	 Click the Modify button, or press the Esc key twice to exit the wall creation mode.

Changing Wall Types
Let’s assume you are now at a stage in the design where you know exactly which type of 

walls you are using. You’ll be able to change some walls to more specific types using the 

Type Selector. You’ll see how easy it is to deal with design changes using Revit. Follow 

these steps:

	 1.	 Select the walls as indicated in Figure 4.34, and change them from Basic Wall: Exte-

rior to Basic Wall: Panelized Wall using the Type Selector.

Even if you draw the wall inside-out to begin with, you can always flip it later by selecting it 

and pressing the spacebar. The spacebar is a generic method for rotating objects about one 

or more axes. This is one of the beauties of Revit: there are no rules for when you do what; 

everything is changeable and replaceable later.

Figure 4.33

Select T.O. Chimney 
in the Element 
Properties dialog box
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	 2.	 Let’s see what the 3D view looks like. From the Quick access toolbar, click the 3D 

button  to open the default 3D view (see Figure 4.35).

Exterior Walls: Level 2
You will now move to the second level. Start by adding exterior walls to it:

	 1.	 From the 3D view, select the wall running into the fireplace, as shown earlier in Fig-

ure 4.31. Open the Element Properties dialog box, and change the top constraint to 

Figure 4.34

Changing to 
panelized walls

Figure 4.35

The default 3D view
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Level 2. You do this because the bedroom on Level 2 needs to cantilever over Level 1, 

and you don’t want that wall going through the bedroom. Figure 4.36 shows the wall 

before and after the constraints have been changed.

	 2.	 You can add some walls to the model directly from the 3D view — a nice benefit 

of working with a building model. Activate the Wall tool and choose Basic Wall: 

Exterior Wall. Using the Options bar, set the level to Level 2, and set the height to 

T.O. Roof 3 (see Figure 4.37). Make sure the Location Line is still set to Core Face: 

Exterior.

Figure 4.36

Modifying the top 
constraint

Figure 4.37

Set the wall 
parameters before 
drawing the wall
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	 3.	 Start drawing the wall from the intersection of the guideline and the fireplace, and 

turn the corner to meet the other wall, as shown in Figure 4.38.

	 4.	 Perform a similar operation to create a bump-out for the master bedroom; this will 

become a closet later (see Figure 4.39). Before you start drawing, make the wall type 

Basic Wall: Panelized Wall, and draw it from right to left so that the panel material 

faces the exterior.

Figure 4.38

Adding walls to 
Level 2

Figure 4.39

Adding closet walls
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	 5.	 To give the house a bit more variation, let’s bring down the height of walls for the 

front entry and the walls in the back, as shown in Figure 4.40. Multiselect the walls 

as indicated, using the Ctrl key, and then open the Element Properties dialog box and 

change the top constraint to T.O. Roof 2. Click OK to commit the changes and dis-

miss the dialog box.
Figure 4.40

Modifying wall 
height
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Interior Walls: Level 1
Everything’s looking good so far. Now you’ll add some interior walls to the project:

	 1.	 Open the Level 1 plan. 

	 2.	 Select the Wall tool and choose Basic Wall: Interior – Thin. 

	 3.	 In the Options bar, set the height to Level 2 and Location Line to Wall Centerline. 

Begin laying out the interior walls using the guidelines provided in the view, as 

shown in Figure 4.41.

Wall Join and Face Resolution
Not all of the interior walls are lining up neatly with exterior walls. Let’s fix that. You’ll 

first change to a thicker wall and then unjoin the wall. You’ll use the Align tool to make 

things line up, and then rejoin the walls. Follow these steps:

	 1.	 Zoom into the grid 2 join condition where the interior wall hits the exterior, as 

shown in Figure 4.42. You need to clean this up.

	 2.	 Change the wall type to Basic Wall: Interior Wall – Thick. You do so because this 

wall will span two levels and also act as a plumbing cavity.

	 3.	 Grab the wall-end control and drag it away from the join, as shown in Figure 4.43.

If you don’t detach the join, then you won’t be able to realign the walls to the finish face. 

When you’re dealing with complex joins such as this, the best practice is to pull the walls 

away from the join, make proper alignments, and then rejoin the walls.

Figure 4.41

Creating interior 
walls
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	 4.	 Select the Align tool from the Edit panel on the Modify tab. You’ll use it to align 

the finish faces of the two walls. This tool allows you to make alignments between 

elements and constrain that alignment if you desire. Walls that are connected 

automatically attempt to stay aligned. (Users often comment that the Align tool is 

one of the most useful tools in Revit. The thing to remember is that the first pick 

Figure 4.42

An example of a bad 
wall join

Figure 4.43

Modifying the 
wall join
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is where you want to align to, and the second pick chooses which element you want 

to move [align].)

	 5.	 Select the geometry (the horizontal wall) that you want to align. This is the target 

that you want other geometry to align with. Then, choose the geometric edge that 

you want to align, as shown in Figure 4.44 — in this case, the thick interior wall face.

	 6.	 Drag the wall end back into the join. The walls clean up, and you get a nice-looking 

image like the one in Figure 4.45.

Figure 4.44

Aligning the wall

Figure 4.45

Finished walls
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	 7.	 Now that the wall looks good, change its height so that its top constraint is T.O. Roof 

3 using the Element Properties dialog box. Check out your results in the 3D view; see 

Figure 4.46.

	 8.	 Using the technique you just went through, clean up the condition shown in Figure 4.47.

Figure 4.46

Interior walls 
extending to T.O. 
Roof 3

Figure 4.47

Clean up this join 
condition also
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Interior Walls: Level 2
Now you will continue to add interior walls, this time to Level 2:

	 1.	 Open the Level 2 Floor plan and place Basic Wall: Interior Wall – Thin walls using 

the guidelines as placement aids.

	 2.	 Using the Basic Wall: Interior Wall – Thin wall type and the Pick tool located at the 

bottom of the Draw panel, pick the lines in the view. Before picking, use the Options 

bar to set Location Line to Wall Centerline and Height to T.O. Roof 3.

	 3.	 Be sure to clean up the walls highlighted in Figure 4.48 to achieve aligned walls and 

clean joins. Use the same technique used in Level 1 by pulling the join apart and then 

using the Align tool as shown in the figure.

	 4.	 The model has a large double-height volume for the main living space. A knee wall 

will be used to bridge the two bedrooms on either side of the volume. Using the Ele-

ment Properties dialog box (see Figure 4.49), select the wall and change its top con-

straint from T.O. Roof 3 to Unconnected.

	 5.	 Set the Unconnected parameter value to 3′-0″ (1 m). Click OK to commit the change.

Excellent job! Now you have the beginnings of a small house (see Figure 4.50). The next 

exercise will pick up from this point and continue to add more detail to the model.
Figure 4.48

Align the finished 
faces of these walls
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Figure 4.49

Change the wall 
height

Figure 4.50

The walls of the 
house
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Adding a Floor to Level 1
Now that you’ve built the exterior and interior walls, you’ll add floors and roofs. You can con-

tinue where you stopped on your file, or open the file Source_House_Floor-Roofs_Start.rvt.

	 1.	 Open floor plan Level 1. From the Build panel in the Home tab, select the Floor tool. 

The view and interface change into the Create Floor Boundary mode.

In this mode, the model becomes halftone and noneditable. A specialized set of contex-

tual tools appear as a new tab named Create Floor Boundary tab, as shown in Figure 4.51.

The default state puts you into the Pick Walls command. This allows you to create 

the boundary of the floor by picking walls in the model to create a parametrically 

associated floor boundary. A boundary is a series of connected lines that form closed 

shapes. Boundaries can form multiple closed shapes, but lines can’t intersect or be 

left unconnected at an end. Revit uses the term loop to define a closed boundary.

A boundary must follow some basic rules in order to generate geometry. It needs to form 

a closed loop of lines that do not overlap or have unconnected ends. Lines cannot be left 

floating around, overlapped, or disconnected; otherwise, the sketch cannot be finished. If 

your boundary is invalid, Revit will warn you and even highlight the problem areas so that 

you can fix them on the fly (close the loop) and finish your sketch. 

	 2.	 Using the Pick Walls option, hover your cursor over an exterior wall but don’t click 

on it. Press the Tab key; the chain of all connected walls highlights. Now click once 

on the wall. Lines will be generated from the walls, as shown in Figure 4.52.

Figure 4.51

Create Floor 
Boundary tab for 

floors

Figure 4.52

Walls used 
to generate 

boundary lines
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	 3.	 Not all the walls along the perimeter were selected. This is 

because the fireplace walls aren’t connected at their ends with 

other walls in the selection. To finish the floor boundary into a 

closed loop of connected, you need to select the fireplace walls; 

this will generate lines over those walls. Finally you will need 

to clean up the lines. Trim the lines so they don’t overlap and 

trim perfectly in a closed loop. If you attempt to finish without 

adding lines around the fireplace or without trimming and connecting them, your 

boundary will be invalid and you’ll get the warning shown in Figure 4.53.

	 4.	 The final boundary lines should look like Figure 4.54.

The lines intersect and will need to be cleaned up in order to  

complete the floor boundary. The Trim tool is great for these con-

ditions. Let’s continue:

	 5.	 Select the Trim tool from the Edit panel on the Modify tab.

	 6.	 Select pairs of lines to trim. The first pick is any line you want to trim. The second  

pick is the line you want to trim to; you’ll see a preview of the result, as shown in Fig-

ure 4.55.

	 7.	 Do the same for the other overlapping lines to complete the f loor boundary 

(see Figure 4.56).

Figure 4.53

The warning you’ll 
see if lines don’t 
form closed loops

	 8.	 Now that the boundary lines look good, click the Finish Floor button located at the 

far-right of the Ribbon. A 3D floor will be generated.

	 9.	 Open the 3D view and you’ll see the floor. Select it by hovering the cursor over an 

edge of the floor and clicking when it highlights. (You can press Tab to select it if it 

doesn’t highlight immediately.) The floor can be reedited using the Edit Boundary 

button on the Modify Floors contextual tab. Figure 4.57 shows the floor in 3D.

Figure 4.54

Pick the remaining exterior walls

Figure 4.55

Trimming lines
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Copying Floors from Level 1 to Level 2
Revit has some great copy and paste features that allow you to paste elements from one 

view into another with relative ease and also keep elements lined up in 3D space. In this 

section, you’ll copy and paste the floor from Level 1 into Level 2 and then edit the floor 

boundary lines to match the design:

	 1.	 Select the floor in the 3D view, and copy it to the clipboard using Ctrl+C.

	 2.	 To paste the floor, choose Paste Aligned from the Clipboard panel on the Modify 

Floors tab. Choose Levels by Name from the drop-down list and select Level 2, and 

click OK (see Figure 4.58). The floor is pasted into Level 2.

Figure 4.56

A closed-loop 
sketch

Figure 4.57

The 2D boundary 
lines generate a 

3D floor
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	 3.	 Select the floor you just pasted, and click the Edit Boundary button on the Modify 

Floors tab. This will put you back in Modify Floor Boundary mode, where you can 

amend the lines to accommodate the new shape of the floor plate on Level 2.

	 4.	 Switch the view to Level 2 plan so that it’s easier to visualize the relationship of the 

lines to the walls (see Figure 4.59).

Figure 4.58

Pasting Level 2 in a 
3D view

Figure 4.59

Use these walls to 
define the floor for 
the Level 2 floor plan
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	 5.	 As the floor plans for each level are not the same, you’ll need to adapt the lines to 

meet the shape of the second floor. To do this, start by adding lines to the interior to 

make way for the double-height living room. Using the Pick Walls tool, select the two 

interior walls  

shown in Figure 4.59.

	 6.	 Do the same for the walls that cantilever over Level 1. You’ll get a warning about 

keeping elements joined when picking the cantilevered wall (see Figure 4.60). Click 

the Unjoin Elements button in the warning dialog box to continue.

	 7.	 Using the Trim tool, clean up the sketch lines to form a continuous loop of lines.  

The untrimmed lines are shown in Figure 4.61. After trimming the lines, delete the 

leftovers.

	 8.	 You need to continue editing the boundary lines to include the bump-out in the 

lower-left corner of the model and account for the stairwell. To do this, first pick the 

bump-out walls using the Pick Walls tool. If the pick puts the line on the inside of a 

Figure 4.60

Error message

Figure 4.61

Before the lines are 
trimmed
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wall, click Flip Arrows to toggle the line to the outside face. For the stairs, delete lines 

that you don’t need.

Next, you’ll clean up the lines to form a closed loop. Here are the steps:

	 1.	 Use the Split tool to split the horizontal line into two segments, as shown in Figure 4.62.

	 2.	 Complete the loop by trimming the lines to one another.

	 3.	 Click Finish Floor in Ribbon. A dialog 

box opens, asking if you want the walls to 

attach to the bottom of the floor (see Fig-

ure 4.63).

	 4.	 Click Yes. The interior walls will connect to the bottom of the floor. This ensures that 

section views of the model look correct. When walls are attached to floors, they dynam-

ically adjust their height to match the bottom of the floor, even when floor thickness is 

changed or given an offset from a level.

	 5.	 The next dialog box asks if you want to join the floor with wall geometry (see 

Figure 4.64). Click Yes.

This option automatically joins walls that overlap with the floor — in this case, 

the exterior walls. The resulting graphics manifest in section views, producing a 

cleaned-up relationship between the layers in the walls and floors.

Figure 4.62

Split the lines, and 
then trim

Figure 4.63

Dialog box asking if 
you want to attach 
the walls to levels
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Adding the Main Roof
Now that you’ve created the basic floors, you’ll add some roofs to the house. Roofs are 

created in the same manner as floors: as boundary lines that relate to a level in the project 

and that define the base shape of the roof. As you’ll see, roofs allow you to specify slopes 

for each line in the sketch, which lets you rapidly create hipped, gable, shed, and flat roof 

configurations. Follow these steps:

	 1.	 Open the Level 2 floor plan.

	 2.	 From the Build panel on the Home tab, select the Roof tool. A flyout menu appears. 

Select the option Roof by Footprint. Just as with floors, you’re placed in a line-edit-

ing mode where you can use existing geometry to construct the roof boundary lines 

or draw the desired shape with lines. Since you are working on a flat roof, make sure 

the Define Slope option is unchecked in the Options bar before you start drawing.

	 3.	 Use the Pick Walls option in the Draw panel. Look at the Options bar, and set the 

roof overhang to 1′–0″ (30 cm). This will offset the roof boundary line from the wall 

to produce a parametrically associated overhang.

	 4.	 Hover the cursor over an exterior wall and press Tab. When the perimeter walls are 

highlighted, click to select them. The beginning of the roof boundary is created, as 

shown in Figure 4.65.

Figure 4.64

Joining floor and 
wall geometry

Figure 4.65

Use the Tab key to 
select sketch lines
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	 5.	 Add lines for the cutout around the fireplace.

	 6.	 Delete lines over the staircase — you’ll add a separate roof over that area later. Fig-

ure 4.66 shows the lines to delete. 

Use the Trim tool to form a closed loop and get the sketch to look like that in 

Figure 4.67.
Figure 4.66

Initial lines created 
from a Tab-selection 
of the exterior walls
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	 7.	 Before finishing the roof boundary, set 

the base constraint using the Roof Proper-

ties button located in the Ribbon. Set Base 

Level to T.O. Roof 3 (see Figure 4.68) and 

click OK. 

	 8.	 You’ve just created a boundary for a flat roof. 

However, you want the roof to have a slight 

slope, creating a gently sloping shed. Select 

the bottom horizontal boundary line. In 

the Options bar is a toggle for setting lines 

to define slope: toggle it. An icon appears 

beside the sketch line indicating that it’s 

slope-defining. Select the line and change 

the slope value from 9 ½″ to 1″ (Figure 4.69). 

Finish the roof using the Finish Roof button 

at the far-right side of the Ribbon. If you get 

an error that you have overlapping 

lines, check where Revit indicates 

the problem and clean up the lines.

Once you’ve defined a slope in a roof, this can be changed from outside 

of Roof Boundary edit mode. Simply select the roof, open the Element 

Properties dialog box, and then change the Slope parameter value.

Figure 4.67

The final sketch 
should look like this

Figure 4.68

Roof properties

Figure 4.69

Changing the roof 
pitch

	 9.	 Look at the model in 3D.
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	10.	 Select the roof, and use the type selector to change its type from Basic Roof: Generic 

– 12″ to Basic Roof: Metal Roof. The metal roof has a pattern of lines that represents 

standing seam roof panels defined in the type properties of that roof type (see Fig-

ure 4.70).

If you spin the model to the side, you’ll notice a gap between the top of the walls 

and the roof. This is easily rectified using the Top/Base Attach options available in 

the Modify Wall panel when walls are selected. In Figure 4.71, you can see where the 

walls aren’t attached to the roof.

Figure 4.70

Modifying the 
roof type

Figure 4.71

Walls before being 
attached to the roof
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	11.	 Spin the model a bit, and then use the Tab-selection method to select the exterior walls.

	12.	 Click the Top/Base: Attach button in the Modify Wall panel, and then select the 

main roof. The walls extend up to meet the underside of the roof. When you get the 

warning message shown in Figure 4.72, click Detach Target(s). This detaches walls 

that aren’t entirely below the roof (the walls in the foreground). 

The resulting geometry should look like Figure 4.73.

The great thing about the Top/Base: Attach tool is that if the roof pitch is changed, the 

walls will parametrically adapt to the new slope! To experiment with this, select the roof 

and open the Element Properties dialog box. Change the roof slope, and watch as the 

walls dynamically update.

Figure 4.72

Warning message

Figure 4.73

Walls are now 
attached to the roof
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Creating Additional Roofs
You’ll now add the remaining roofs and make walls attach to them:

	 1.	 Open the plan view T.O. Roof 2 using the Project Browser.

	 2.	 Start with the roof in the lower left in Figure 4.74. Use Roof by Footprint, pick 

the three exterior walls, and then draw the last line to make a closed rectangle. Also 

using the Options bar, set the overhang to 0′-0″, and make sure all the lines are non-

slope-defining.

	 3.	 When you’ve got a closed loop of lines, click Finish Roof.

	 4.	 Create additional roofs over the entry and the main living space (see Figure 4.75) 

using the same techniques. Make one roof for each condition.

Figure 4.74

Adding a roof with 
no slope

Here are some best practices for roof creation. When walls are already created in your design, 

use the Pick Walls tool in the draw panel. Then, switch to drawing lines to finish drawing 

the roof boundary. Use the Trim tool to clean lines and get rid of any overlapping or uncon-

nected lines. When no walls are present or the base geometry of the roof doesn’t match the 

geometry that the exterior walls create, go directly to drawing the shape of the roof.
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Modifying an Existing Roof

Making changes to an existing roof is simple — you edit the boundary lines to match 

your design intent, then finish the roof to pop it into 3D. Go to the 3D view. If the roofs 

aren’t already the Metal roof type, you need to change them. Using selection (picking the 

roofs) and the Type Selector (changing to the type you want) is a common method, but 

there is also a nice tool that lets you pick a type and then apply that type to other ele-

ments with a few clicks.

Figure 4.75

Adding more roofs
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This tool is called Match Type, and it’s located in the Clipboard panel on the Modify 

tab. To use the Match Type tool, click the tool, then select the type of element you want to 

convert other elements into. You then select elements of the same category, and they will 

change type with each subsequent mouse click. This tool works for the majority of exist-

ing Revit elements. Try it out:

	 1.	 Select the Match Type tool found in the Modify tab.

	 2.	 Select the main roof. Note that the cursor appears filled — as if you sucked that type 

into your dropper. With each selection, you can change types belonging to the same 

category (in this case, the category Roof; see Figure 4.76). Press the Esc key twice to 

exit the command.

	 3.	 Select the three roofs whose type you wish to change. 

Next, you’ll give these roofs a negative offset from the level to make room for 

some clerestory windows.

	 4.	 Select all three roofs by holding down Ctrl and selecting them. Open the roofs’ 

Instance Properties dialog box, as shown in Figure 4.77.

	 5.	 Change the Base Offset to –1′-3½″ (40cm), the thickness of the roof.

Figure 4.76

Select the roof with 
the Match Type tool
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	 6.	 Select the walls below the roofs you just created, and attach them to the roof as 

shown in Figure 4.78.
Figure 4.77

The remaining roofs 
modified

Figure 4.78

Attach the walls to 
the roof
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	 7.	 When you get the error message shown in Figure 4.79, click the 

Detach Target(s) button. This changes the attachment of the 

wall so that it connects with the lower roof.

Attaching Interior Walls to the Roof
To attach the tops of the interior walls to the underside of a roof, 

you need to be able to select them first. With the roof in the way, 

this might appear to be a problem. To resolve this issue, you can tem-

porarily make the roof transparent, select the walls through the roof, and then attach the 

walls. When you are done, reset the roof graphics to clear the transparency override.

	 1.	 Select the main roof, right-click, and select Override Graphics in View by Element 

from the context menu. Check the option to make the roof transparent, then open 

the Surface Patterns node and uncheck the Visible option. The roof will turn 100 

percent transparent, and the surface patterns will be turned off (Figure 4.80).

	 2.	 Select the interior walls on Level 2 by holding down the Ctrl key when picking.

	 3.	 With walls still selected, click the Top/Base: Attach button in the Modify Walls tab, 

then select the roof. 

Figure 4.79

Detach Target(s) 
error message

Figure 4.80

Model with the roof 
made transparent 
and surface patterns 
turned off
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	 4.	 Select the roof, and open the Element Overrides dialog box again using the con-

text menu. Click the Reset button to clear all the overrides (Figure 4.81) and click OK 

to finish.

A T i p ab o u t S k e tc h D e s i g n

With a sketch-based design, an element is created from a closed loop of lines. More than one 

loop is allowed. If you draw a loop of lines within the boundary of another loop, then the 

shape defined by the interior loop will be negative space. This makes it easy to create open-

ings for stairs, chimneys, and so on — just draw a second loop of lines in the shape of the 

opening, and voilà!

Making Curtain Walls
To add some clerestory windows to the design, you have two options: you can create a 

new window type or, even faster, you can use the Curtain Wall tool. Curtain walls are a 

special wall type that lets you place mullions and panels on a grid surface. Each gridline 

divides the wall into sections, which become panels. Mullions separate individual panels 

and are placed on curtain grids. For this exercise, you’ll use a curtain wall where the mul-

lions and panels are predefined in the wall type, and automatically embed themselves 

into basic walls when drawn on top of a basic wall. This makes layout extremely quick 

and easy to manage. You can continue with the file you created so far, or open the file 

Source_House_CurtainWall_Start.rvt. Follow these steps:

	 1.	 In the default 3D view, hide the main roof using the Temporary Hide/Isolate control 

located in the View Control bar. Select the roof, and then choose the option Hide 

Element from the View Control bar (see Figure 4.82).

Figure 4.81

Resetting the Hide 
command

To see the effect of the wall meeting the roof, you can temporarily hide the roof using the 

temporary hide/isolate tool in the View control . Select the roof and then choose Hide 

Element from the flyout menu.

Figure 4.82

The Hide Element 
option for the roof
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	 2.	 Once the roof is hidden, use the Wall tool in the Build panel on the Home tab and set 

the wall type to Curtain Wall: Storefront using the Type Selector. In the Options bar, 

set Level to T.O. Roof 2 and Height to T.O. Roof 3.

	 3.	 Draw the curtain wall, as shown in Figure 4.83. Use snapping to get the correct 

placement.

	 4.	 Add a similar curtain wall to the opposite side of the model (see Figure 4.84).

Figure 4.83

Draw the curtain 
wall as shown

Figure 4.84

Clerestory 
curtain walls
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	 5.	 Choose Reset Temporary Hide/Isolate from the View Control bar so the roof 

reappears.

	 6.	 Select the curtain wall at the back of the house, and attach it to the roof above using 

the Attach tool in the Modify Walls tab.

	 7.	 You’ll get a message about elements 

becoming invalid. Click the Delete 

Element(s) button (see Figure 4.85). 

This isn’t a problem; Revit is just let-

ting you know that it needs to delete 

the elements in order to re-create 

them. The mullions will be regenerated 

once the curtain wall is attached to the 

roof.

Adding Curtain Walls to the North Façade

Now that you have the clerestory windows in place, use the same tool to add a glass wall 

to the façade:

	 1.	 Open the Level 1 plan view and choose the Storefront curtain wall type again.

	 2.	 Set the Height to T.O. Roof 2 in the Options bar.

	 3.	 Draw the wall from the edge of the fireplace to the center of the wall (see Fig-

ure 4.86). A triangle snap icon appears when the wall’s end hits the center.

Figure 4.85

Warning dialog box with option to delete 
elements message

Figure 4.86

Draw a curtain wall 
from the chimney to 

the wall midpoint
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	 4.	 Add a curtain wall on the other side  

of the fireplace as well, as shown in  

Figure 4.87. Set this wall’s height to  

Level 2.

	 5.	 Open the north elevation. In this 

view, you can see the effect of the 

curtain walls you just made, as 

shown in Figure 4.88.

	 6.	 Select each curtain wall, and attach 

each to the roof above using the 

Top/Base Attach tool you used for 

the interior and exterior walls (the 

button on the Modify Walls tab). 

To select the curtain wall, hover the 

cursor over an outer boundary of the 

curtain wall until a dashed frame 

appears. Note that selecting a mul-

lion or panel doesn’t select the curtain wall.

H ow H i g h? H ow Low ?

As a best practice when attaching walls or curtain walls to host elements above or below, 

the wall should be taller than the object that it needs to attach to so that it moves down to 

connect, or lower than the object it needs to connect to and then moves up to connect. In 

the event your wall becomes detached from its host, objects that are hosted by the wall or 

curtain wall are not deleted.

Figure 4.87

Adding the second 
curtain wall

Figure 4.88

The north elevation
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	 7.	 You’ll get the message shown in Figure 4.89  

about mullions being removed. Again, this  

isn’t an error; it’s Revit alerting you to its  

process. Click the Delete Element(s) button  

to continue.

Changing the Grid Pattern

The curtain walls you’ve been placing pre-

set the spacing of grids, which in turn determines the spacing of mullions and panels. 

You can deviate from the pattern interactively to make patterns that are more irregular.

	 1.	 To align the curtain wall on the north façade with the clerestory windows, activate the 

Align tool from the Modify tab. Select a curtain grid in the clerestory first, and then 

select the edge of the curtain wall. When selecting a grid, make sure you select a grid, 

not a mullion (press Tab when the mouse is over a mullion until the dashed line repre-

senting the grid shows up and then click). The two curtain walls should now be aligned.

	 2.	 Remove some grid segments and mullions to give the wall more interest. To do so, 

hover the cursor over the vertical mullion nearest gridline 4. Press the Tab key to 

cycle the selection until a curtain gridline highlights (be careful — not the mullion, 

but the curtain grid). Select this grid.

	 3.	 Note that the gridline has a pin icon 

associated with it. This indicates that 

the grid is locked into place and can’t be 

moved interactively. This is because the 

grid is defined in the wall type — as a 

spacing rule. However, the grid can be 

unpinned and then moved interactively 

if you desire. Click the pin to unlock it, 

and drag the grid. For now, let’s leave the 

grid pinned and only deal with remov-

ing segments of grids. You can see the 

pins in Figure 4.90.

	 4.	 With the curtain grid selected, click the 

Add or Remove Segments button located 

on the Curtain Grid panel on the Modify Wall tab. You can now add and remove 

segments of grid that span between other grids. Remove the bottom grid segment 

by selecting it. You’ll notice that the mullions are also removed. Do the same for the 

adjacent grids until the picture looks like Figure 4.91 (two bottom grid segments and 

two top segments removed).

Figure 4.89

Mullions being removed

Figure 4.90

Curtain wall modifications
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	 5.	 To replace grids and mullions on the curtain wall, select a curtain gridline and use 

the Add/Remove tool again. Selecting on a dashed grid segment puts back the seg-

ment as well as the mullion.

	 6.	 Open the Exterior Perspective 3D view, and look at your model in 3D (see Figure 4.92). 

Remember, you can use Shift+middle mouse button to orbit the model in 3D.
Figure 4.91

The completed 
curtain wall

Figure 4.92

The completed 
curtain wall in the 
3D model
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Adding Doors and Windows
Now that you’ve constructed the basic envelope of a small house, let’s move back to the 

inside and place some windows and doors. Follow these steps:

	 1.	 Go to the Level 1 floor plan.

	 2.	 From the Build panel on the Home tab, select the Door tool.

	 3.	 Set the door type using the Type Selector to Single-Flush 34″ × 84″ (85 × 210 cm).

	 4.	 Move your cursor over walls in the model — note that the door previews before it’s 

placed. If the mouse isn’t over a wall, no preview appears, and the door can’t be placed.

	 5.	 Place the door as shown in Figure 4.93.

Note the helpful dimensions that appear during placement.

Temporary dimensions show up during and after placement to aid you in locating the 

door. Once the door has been placed, the dimensions become active controls that you can 

use to precisely position the door relative to nearby references, such as walls, grids, or 

other doors:

	 1.	 To edit a dimension value, click the numeric value, and it becomes an editable 

text field.

	 2.	 Clicking the blue squares of the temporary dimension cycles the dimension between 

centerlines and opening conditions.

Figure 4.93

Adding a door
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For example, after placing the door, select the blue control for the tempo-

rary dimension that snaps to the door centerline, and move it toward the door 

leaf. Note that the dimension jumps to a new location. Now, click the dimen-

sion value and set the distance to be 6″ (15 cm). See Figure 4.94.

You’ll notice that the door was given a tag when it was placed. This is an 

option available in the Options bar during placement. For this exercise, you 

don’t need to see tags yet. Go ahead and delete the tag (hover the cursor over the 

tag; if you can’t select it, use the Tab key to cycle to it), and select the Door tool 

again. This time, uncheck the option Tag on Placement in the Options bar. This 

will prevent the doors from being tagged automatically from here on out.

Continue to place doors. When you’re placing doors, get accustomed to using the 

spacebar to flip the door orientation and make the door face correctly. If you don’t place a 

door correctly, it’s no problem — select the door and press the spacebar until the door 

looks right. For now, place the same 

door so the image looks roughly like 

Figure 4.95.

Once the doors are placed, you can 

create constraints between the doors 

and nearby walls. This is useful if you 

want to maintain a specific relation-

ship between a door and a wall so that 

if the wall moves, the door moves 

with it.

To do this, you’ll convert a tempo-

rary dimension into a permanent 

dimension and then lock the dimen-

sion to create a constraint. You’ll then 

delete the dimension but leave the constraint in place. Here are the steps:

	 1.	 Open the Manage tab, and then open the Settings drop-down and open the Tempo-

rary Dimensions Properties dialog box. 

	 2.	 In the Walls options, select Faces of Core; in the Doors and Windows 

options, select Openings, as shown in Figure 4.96. Click OK to finish.

	 3.	 Go back to the view and select a door; notice that the behavior of the 

temporary dimensions is different — the dimensions follow your 

new rules when initialized. This will let you set distances between 

door openings and the stud faces in your walls with a few clicks.

	 4.	 Use the temporary dimensions to get the door opening 6″ (15 cm) 

from the stud face of the wall, as shown in Figure 4.97.

Figure 4.94

Locating the door

Figure 4.95

Placing more doors

Figure 4.96

Change the tem
porary dimensions 
for walls to Faces of 
Core; for doors and 
windows, change 
them to Openings
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	 5.	 Click the icon that looks like a blue dimension string. This converts the temporary 

dimension into a regular dimension.

	 6.	 Select the dimension and click the lock icon. This creates a fixed constraint between 

the door and the wall (Figure 4.98).

	 7.	 Now, let’s say you don’t want to 

have that dimension when you print 

later — you just used it to set a rule. 

In this case, you’d like to delete the 

dimension but keep the rule you 

defined. When you select and delete 

the dimension, you’ll get a warning 

message (see Figure 4.99); you can 

either unconstrain the condition or 

click OK and keep the constraint but  

still delete the dimension. Click OK.

	 8.	 Do the same thing for the door on the other side of the wall.

	 9.	 Select the wall, and the locks show up again, indicating the presence of a constraint. 

Clicking the lock (unlocking it) deletes the constraint. Figure 4.100 shows the  

constraints.

	10.	 If you move the wall by dragging it or using the temporary dimension, the doors will 

also move. Go ahead and change the temporary dimension from 4′-8″ to 5′-0″ (130 cm 

to 150 cm) to see this work.

Figure 4.97

Temporary dimensions at the door

Figure 4.98

Use the lock icon to create a constraint

Figure 4.99

Revit allows you to keep or remove your 
constraints
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	11.	 Place more doors in the project: glass doors for the exterior doors and smaller doors 

for the bathroom and the closet near front entry. Figure 4.101 shows additional door 

locations.
Figure 4.100

Locks indicate a 
constraint

Figure 4.101

Additional door 
locations
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	12.	 Changing door types is just like changing wall types. Select the door and use the 

Type Selector to swap the door with a different type.

For the moment, don’t worry if you don’t find the exact type of door you wish to 

use. We’ll explain later how you can find more doors or adjust existing ones to serve 

your needs.

Adding Doors to Level 2
Let’s continue to place doors in the model.

	 1.	 Open the Level 2 plan view.

	 2.	 Place the following types of doors in Level 2, as shown in Figure 4.102:

By-pass sliders•	

Single flush 34•	 ″ × 84″ (85 cm × 210 cm)

A pocket door•	

Use temporary dimensions to place door openings 6″ (15 cm) from stud faces, as 

you did on Level 1.

Placing Windows
Placing windows is just like placing doors. Use the Window tool in the Build panel on 

the Home tab. You’ll start by placing some sliders and then some fixed openings. The 

sliders have a fixed-size set in the type properties, and the fixed windows have instance-

based sizes. We’ll explore the behavior of both type and instance families. Start by plac-

ing windows:

Figure 4.102

Place these second-
floor doors
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	 1.	 In the Level 2 plan view, select the Window tool from the Home tab. Choose the 

type Slider with Trim: 7′0″ × 4′0″ (215 cm × 120 cm). Uncheck the Tag on Placement 

option. Place windows in the walls as indicated in Figure 4.103. 

	 2.	 Place windows of type Fixed – Varied Size in the locations shown in Figure 4.104.

Figure 4.103

Placing slider 
windows

Figure 4.104

Placing the 
remaining windows
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Resizing Windows Dynamically

The Fixed – Varied Size window is designed so that its width and height are set to be 

instance parameters as opposed to the window you previously used, whose width and 

height were set to be type parameters. Setting the dimensions of an object to be instance 

parameters gives you the advantage of working with more flexible, directly editable ele-

ments; you can modify them with the blue grips that display when they’re selected.

To see how to dynamically size a window using the blue grips, select the window and 

make it wider.

Feel free to change the sizes of the other windows you just 

placed by opening each elevation and making adjustments, 

as shown in Figure 4.105. 

Let’s place one more window. Open the South Elevation, 

select the Window tool, and choose the Fixed – Size Varies 

type. Place the window in the façade and adjust its size as 

shown in Figure 4.106.

Let’s place one more window. Open the South Elevation, 

select the Window tool, and choose the Fixed – Size Varies 

type. Place the window in the façade and adjust its size as 

shown in Figure 4.106.

Be aware that instance parameters, when changed, don’t propagate that change throughout 

all similar elements in the project. The change is applicable only to that one instance of the 

element.

Figure 4.105

Changing the sizes 
of the windows

Figure 4.106

Placing windows 
in elevation by 

instance
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Getting Additional Content Online
The windows you’ve placed are fairly generic. The beauty of Revit is that these windows can be 

swapped out with different window types on the fly at any stage of the project. Remember, it’s 

never too late to do any changes in Revit. Content from the default libraries or from the Web, 

or your own custom-made elements can be loaded into the project and swapped. Try searching 

the web library for additional window and door types, and load them into the project:

	 1.	 Go to the Insert tab, then type your search into the Autodesk Seek search field.

	 2.	 Your browser will launch and take you to the Autodesk Seek site, where you can 

browse for content and save it to disk.

	 3.	 Browse for content and save it to your hard drive or other media (see Figure 4.107).

	 4.	 Once you’ve saved the content, select the Window tool and click the Load button 

located in the drop-down. This will take you to a file browser. Locate the files you 

downloaded and click Open.

If you create library elements on your own or download them from the Web, make sure you 

create a separate folder to store these in. You can then specify this location as an additional 

path when loading content that shows up in the left pane of the Load Family dialog box. To 

add a new library, use the Options dialog box located on the Application Menu, at the lower 

right. Open the File Locations tab and click the Places button. Use the resulting dialog box to 

add a new Library location.

Revit families can be dragged and dropped from Windows Explorer but not from the Web. If 

you have Windows Explorer open, try dragging and dropping a family (.rfa) file directly into 

your Revit project. You can also open a family directly using the Open option when down­

loading families. Doing so opens the family in the Family Editor — the tool used to design 

and build families. To get the family into your project, you can then use the Load Into Pro­

jects button located at the far-right side of the Ribbon.

Figure 4.107

Autodesk online 
families
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Placing Components
For the next step, you’re going to add furniture, plumbing fixtures, and other interior 

equipment in the building. You can use the file that you have created until now or open 

the file named Source_House_Components_Start.rvt from the book’s companion web page.

Placing Furniture

Placing freestanding furniture is simple. Using the Component Placement tool in the 

Build panel on the Home tab populates the Type Selector with available components. The 

list doesn’t include windows and doors, but it does have a mixture of other categories of 

elements. For example, furniture, plumbing fixtures, and plantings appear on the list. An 

example is shown in Figure 4.108.

If you can locate the type of family you want to place, this method works fine:

	 1.	 Open the Level 1 plan view.

	 2.	 Choose the Dining Table and Chairs family from the drop-down list.

	 3.	 Move the cursor into the view. A temporary graphic representing the table and chairs 

appears on the cursor (Figure 4.109).

	 4.	 Press the spacebar prior to placement to rotate the table by 90°.

Next, continue placing more furniture components in the model: couches and tables. 

Follow these steps:

Figure 4.108

Content in the Type 
Selector

As this list is really long (and full of elements from multiple categories), you may find it easier 

to drag from the Family list in the Project Browser.

Figure 4.109

Inserting a dining 
room table
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	 1.	 Place the Sofa Loveseat, Sofa Couch, and Coffee Table using the Component tool. 

Create the furniture arrangement in the living space.

	 2.	 To mirror the Loveseat across from the Coffee Table, select the Loveseat, and then 

select the Mirror tool in the Modify Furniture tab.

	 3.	 Select the center reference of the table as the mirror axis. The Loveseat mirrors across 

this axis, creating a new instance (see Figure 4.110).

To place additional furniture elements, such as beds and nightstands, use the same 

technique. Use the Component tool, and choose appropriate families from the Type 

Selector. New to Revit 2010, the Type Selector shows visual previews of the content, which 

helps you make selections from the list. Open the Level 2 plan view, and place some beds 

to get familiar with this behavior.

Placing Plumbing Fixtures

Placing plumbing fixtures follows the same paradigm as placing other components. 

However, for this exercise, you’ll use the Project Browser rather than the Component tool 

to place your components:

	 1.	 Open the Families node in the Project Browser.

	 2.	 Open the Plumbing Fixtures node: this represents the category of element you wish 

to place.

Figure 4.110

Furniture placement
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	 3.	 Open the Shower Stall-2D node: this is the family name. The family types show up 

under this node (see Figure 4.111).

	 4.	 To place a component from the browser, drag the family type from the browser 

into the view. The visual feedback is exactly as if you chose the type from the Type 

Selector — the element appears on your cursor, ready for placement.

	 5.	 Drag the family into the view, and press the spacebar to rotate it.

	 6.	 Place it so that it snap-aligns to a wall. To see this, hover the component over a wall: 

the wall edge highlights.

	 7.	 Using the same method, place the sink (Sink-Hand) and toilet (Domestic-Low pro-

file). The completed bathroom looks like Figure 4.112.

Using the same technique, you can finish the other bathrooms in the model (Fig

ure 4.113). Be sure to take advantage of the Place Similar tool by first selecting the com-

ponent you want to duplicate (such as a sink or toilet) and then clicking the Place Similar 

tool that shows up in the active contextual tab. This puts the component onto your cur-

sor, and you can bypass the need to search for content in the Type Selector or family 

browser.

Some additional families are loaded into the project, which you can experiment with. 

Using the furniture components in the project, attempt to create a kitchen configuration.

Figure 4.111

Fixtures under the 
Families node

Figure 4.112

The finished 
bathroom layout

Remember to use the spacebar before placement, and hover the cursor near walls to orient 

the object correctly.

Figure 4.113

The finished 
bathroom layout on 

Level 2
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Adding Stairs 
Figure 4.114 shows a stair in Sketch mode and 3D view. Different colors are automatically 

assigned to risers, boundary, and runs.
Figure 4.114

Stairs in Sketch 
mode and in 3D view
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Stairs are considered complex architectural elements because their construction is 

dependent on local building rules defined in building codes. Revit allows you to set dif-

ferent rules based on your building code requirements. Just as with walls and floors, 

stairs are constructed using relationships to levels: all stairs have a base level and a top 

level that are used to calculate tread depth and height based on min–max rules. These 

parameters, shown in Figure 4.115, change 

from stair to stair and are the most important 

parameters used for constructing stairs.

Geometric variation of the individual ele-

ments of a stair (tread, riser, stringer, and so 

on) is managed with type properties that pro-

vide dimensional and material parameters. 

Figure 4.116 shows those type values.

The most important parameters are rules 

that establish minimum tread depth and maxi-

mum riser height. These values are used to 

automatically guarantee minimum and maxi-

mum distances to keep your stairs within the 

constraints of what your building codes dictate. 

Revit won’t break these rules. Your stairs start 

and end where you want them, and the correct 

number of risers and treads are autogenerated 

for you when making the stair. You’ll see this in 

the exercise later in this chapter.

Creating a Stair

You need to create a stair from Level 1 to Level 2 in your model. From the Chapter 4 

folder on the book’s companion web page, open Source_House_Stairs-Railings_Start.rvt. 

You’ll start by sketching the stair in Level 1 and making sure it’s going up to Level 2. You’ll 

then look at the stair using a 3D sectional view and change the type.

Select the Stairs tool from Circulation panel on the Home tab . You’ll enter the Create 

Stair Sketch mode. Note that the tab is replaced with a new one with options specific to 

stair creation (shown in Figure 4.117).

Revit puts you into the Run tool by default. This tool autocreates boundary and riser 

lines as you draw a run line.

Figure 4.115

Stair levels

Figure 4.116

Stair properties

Figure 4.117

Stair design tools
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Now, let’s discuss something briefly. When Revit prompts you to draw a stair run, it 

always uses the middle of the run as a justification point. Often, however, you won’t have 

a reference to the location of the stair centerline. So, you need to either draw help lines at 

the distance from the wall that represents half the stair width or draw the stair in an 

approximate location and then move it into place.

To make this exercise useful for teaching you about other Revit editing tools along 

with the Stairs tool, you won’t use a help line; instead, you’ll draw the stair in a position 

close to the correct one and then adjust it to the right location using other tools. Follow 

these steps:

	 1.	 Start drawing the riser line by snap-aligning to the 

horizontal gridline to begin the run. (The blue dashed 

line indicates that snap.) As mentioned, the line is 

drawn through the center of the stair, with boundaries 

shown offset. A halftone text graphic also appears as 

you drag the run line. The text shows how many ris-

ers have been created and how many remain to get the 

stair from Level 1 to Level 2.

	 2.	 Drag the line until the text shows 8 RISERS CRE-

ATED, 8 REMAINING, and click the mouse once. 

This is where you’ll break the stair for a landing. It 

should look similar to Figure 4.118.

	 3.	 Begin a new run line to the left of the first stair; snap 

the beginning of the run to the end of the last riser.

	 4.	 Draw the run until you see 16 RISERS CREATED, 0 

REMAINING. This should be a point that is aligned with where you started the stair. 

You’ve created a stair return; your drawing should appear similar to Figure 4.119.

Figure 4.118

Starting the stair

Figure 4.119

Starting the return 
run; at right, 
the completed 
command
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	 5.	 By default, railings are added to stairs when created. You can preset a railing type, or 

choose to not autogenerate railings. While still in Sketch mode, from the Tool panel, 

select Railing Type, and set it to None.

In order for the railings to work properly, you need to adjust the sketch a bit. Let’s add 

a riser to the bottom of the stair and remove one from the beginning of the next run:

	 1.	 Drag the blue run line at the bottom segment of the stair until another riser appears. 

Revit will tell you that an additional riser is present (–1 REMAINING).

	 2.	 Delete the riser at the top of the first run of stairs, as shown in Figure 4.120.

There is a gap between the outer boundary of the stair and the bounding walls. 

You need to adjust the boundary lines to fit the model.

	 3.	 To make the stair fit between the walls, align the outer boundary lines to the bound-

ing walls. Still in Stair Sketch mode, align the landing by selecting the Align tool, 

then the interior side of the wall at the bottom of Figure 4.121, and finally the land-

ing boundary.

Next, you’ll move the stair so it’s centered in the stairwell. Using a crossing selection, 

select all lines in the sketch. Because you’re in Sketch mode, no other model elements 

are selected, so you don’t have to be too careful about what you select — Revit will grab 

only what’s in the sketch. Now, follow these steps:

	 1.	 With the sketch lines of the stair selected, click the Move tool that is available in the 

Ribbon.

Figure 4.120

Extending the 
run line and the 

resulting lines after 
adjusting the risers 

and treads

The initial width of the run is set in the stair properties. This stair is set to 3′-0″ (90 cm), but you 

could change that to any value prior to drawing the run lines.
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	 2.	 With the first pick, select the center of the stair boundary by the landing side, and 

then select the middle point of the wall. This should place the stair in the center 

between the two walls. You’ll know you’ve found the center of the stair line and the 

wall when you see the triangular snap shown in Figure 4.122.

	 3.	 Use the Align tool to align the left and 

right boundaries to the wall. Select the 

Align tool, and then pick the inside 

edge of the wall on the right, and 

then the right boundary line of the 

stairs. Doing so aligns the right run 

to the wall. Repeat for the left run. 

Figure 4.123 shows the stairs, properly 

located.

	 4.	 You can also preset a railing type to be 

added to the stair and drawn automat-

ically when you finish the stair sketch. 

Click the Railing Type button located 

on the Create Stairs Sketch tab , and then choose Handrail – Pipe from the Rail-

ing Type dialog box.

	 5.	 Finish the sketch to see the resulting geometry. To do that, click the Finish Sketch 

button. To visualize the stair in 3D view, go on to the next steps.

Figure 4.121

Align the stair boundary to the wall
Figure 4.122

Center the stair

Figure 4.123

The located 
staircase
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3D Sectional View of the Stair

A great way to see the stair in an isolated 3D view is to create a section through the stair 

and then orient a 3D view to the section view. Here are the steps:

	 1.	 Use the Section tool in the View tab to draw a section, as shown in Figure 4.124.

	 2.	 Right-click the section, and choose Element Properties. Rename the view by chang-

ing the View Name property from Section 2 to Stair Section.

	 3.	 Open the default 3D view by clicking the 3D button at the top left of the application 

frame.

	 4.	 Click the Finish Stairs button on the Create Stairs Sketch tab.

	 5.	 Select the section that you just created: Section: Stair Section.

Users often forget to finish a sketch; then, they wonder why everything is grayed out and not 

all the tools are available. Always check on the left side to see whether the Finish Sketch but-

ton is available. If it is, click it to finish the operation.

Figure 4.124

Cutting a section through the stair
Figure 4.125

The completed section view
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The 3D view reorients and becomes cropped 

to the same crop extents as the section view. The 

view you see looks like a section through the 

stair, but it’s a 3D cropped portion of the entire 

stair. Figure 4.125 shows the finished view.

	 6.	 To see the stair in 3D, press Shift+middle mouse 

button, and slowly spin the model (see Fig-

ure 4.126).

	 7.	 Right-click the view name 3D in the Project 

Browser and rename the view 3D Stair.

Saving with a new name saves the view as a 

unique view. The next time you click the 3D but-

ton in the toolbar, a new default 3D view that 

shows extents of the model will be generated  

for you.

Adding Railings
Railings are also sketch-based elements that are generated  

from a 2D path (sketched line) and a set of design rules. 

Figure 4.127 shows some of the elements of a railing; the 

primary ones are the path, rails, and balusters. The path is 

made from 2D lines, the rails are made from 2D profiles, 

and the balusters and corner posts are made from 3D solid 

geometry.

Rails are simply 2D profiles that sweep along the length 

of the railing path. There can be many horizontal rails in a 

railing, and they can each be given a horizontal offset from 

the path to accommodate handrails and other more com-

plex scenarios.

Balusters are 3D families that get arrayed along the length  

of the path. Don’t think of a baluster as something that has  

always to be vertical and rectangular. In Revit, a baluster can  

be any geometry you wish to repeat at a regular interval. 

Figure 4.128 shows a post family and repeating baluster 

pattern.

Figure 4.126

Resulting 3D image

Figure 4.127

Railing elements

Post Rails
Balusters

Figure 4.128

Baluster pattern
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Balusters consist of a main pattern (a unit that is repeatable) and posts. Posts can be 

start, corner, or end posts. They can also have varying geometry.

Creating a Railing in the Model

Railings can be freestanding elements or hosted by another element such as a stair or 

floor. To draw a freestanding railing, use the Railing tool located in the Circulation panel 

on the Home tab . You’ll be put into a Railing path mode in which the path is 

drawn. The path can be composed of multiple lines, and all lines must be connected. If 

you draw a path with lines that aren’t connected, Revit will give you a warning.

You can have a single line as a railing (imagine a railing in the middle of a stair). But 

the moment you draw a second segment in the same sketch, Revit will expect you to con-

nect them in a chain.

Once you’ve drawn the path and finished it, the rail geometry is constructed and con-

forms to the path. An endless number of railings can be defined using the combination of 

custom profiles and balusters. For this exercise, you’ll add a predefined rail to the project 

and then change the type to make a different configuration. Follow these steps:

	 1.	 Open the Level 2 plan and start the Railing tool.

	 2.	 You will be put into Path creation mode. Using the  

Lines tool , draw a railing along the edges of the  

exterior deck, as shown in Figure 4.129.

	 3.	 Click the Finish Railing button to complete the railing. 

	 4.	 Open the 3D view and spin the model to see the railing.

	 5.	 Select the railing and change its type to CABLE RAIL — CABLES using the Type 

Selector. The railing changes to a cable-style rail and looks like the railing in  

Figure 4.130.

Figure 4.129

The railing path

Figure 4.130

Cable railing
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Modifying Existing Railings

Looking at the model, you can see the result of your railing path. Note also the presence 

of railings; Revit automatically places railings on stairs. The railings can then be changed 

or deleted as desired, independently of the stair. However, if you delete a stair with an 

associated railing, the railing will also be deleted. You’ll also notice some modeling issues 

that need to be resolved. For example, the stringers are embedded in the wall, and you 

don’t need that railing along the outside edge where you have the wall.

To fix the railing problem, select the railing in the wall and delete it (make sure you’re 

selecting the railing, not the wall or the stair; help yourself using the almighty Tab key). 

Don’t delete the internal railing.

To fix the stringer problem, let’s change the construction a bit. Rather than have the 

stringers on the outside edge of the treads, you can move them under the treads — a 

more typical method for wood construction:

	 1.	 Select the stair, and open the Type Properties dialog box.

	 2.	 Scroll down to the Stringers parameters.

	 3.	 Change Right Stringer and Left Stringer from Closed to Open (see Figure 4.131).

	 4.	 Click Apply to see the effect in the model. The stringer geometry changes.

Feel free to experiment with other parameters available in the stair type properties. It’s 

possible to create treads with nosing profiles or that have slanted risers, and to change the 

materials of each subelement in a stair or change the construction of the stair to monolithic.

Note that you’re editing type properties when changing how treads, risers, and stringers are 

defined — meaning that other instances of that stair (if you’ve drawn a couple of staircases in 

the building) will update as a result of type changes. To avoid undesirable changes, duplicate 

the stair first, name the new type, and then begin your experiments.

Figure 4.131

Modified stair 
stringers
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Setting Hosts for Railings

Railings can be freestanding or hosted by floors and stairs. Often, a railing that was origi-

nally hosted by a stair needs to be deleted and later redrawn. You can become confused 

trying to place the railing on the stair, because it always ends up on the floor below the 

stairs. To re-place a rail so that it’s hosted by a stair, select the Railing tool and sketch a 

railing path that is on top of the stair. Use the Set Railing Host tool in the Railing path edit 

mode to attach the railing to the stair. Do this before finishing the railing 

path. When you finish the path, the rail will wind its way up the staircase. 

Figure 4.132 shows what happens when you don’t set the stair to host the 

railing.

Your Model Is Started…Now Have Some Fun!
We just went through a series of exercises meant to get you familiar with 

the basic modeling tools available in Revit. The graphic below shows a 

final perspective view of the model you have created. Obviously, we did 

not get into the nuts and bolts of every tool, but with time you will begin 

to dig deeper and experiment with more of the features. Also, we will 

revisit some of these tools in Chapter 6, “Extended Modeling.” Now that 

you have a basic model started, feel free to experiment with it: change the 

roof, lay out a kitchen, load some additional doors and windows. Most of 

all, have fun, be creative, and be patient with yourself and the software.
Figure 4.132

The stair without 
the railing hosted
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Modifying Elements

C hap te r 5

Once you’ve started modeling  with Revit Architecture, you’ll 

probably need to make changes to the model as your design evolves and becomes more 

refined. You’ll need to move, mirror, and array elements; change properties of elements; 

apply different graphics to various elements; and even hide and unhide elements. This is 

where the editing tools and graphic override features come into play. The basics of these 

tools will be explained in this chapter.

This chapter reviews the essential modification tools available in Revit. Topics we’ll 

cover include:

Standard editing tools■■

Additional editing tools■■

Graphic and visual overrides■■
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Standard Editing Tools
This section describes some of the standard editing tools in Revit. For each of these tools, 

you first need to select elements, and then invoke the appropriate command:

Copy, paste, and cut•	

Move•	

Copy•	

Rotate•	

Array•	

Mirror•	

Resize•	

Copy, Paste, and Cut
Copy, paste, and cut are familiar tools used in almost all software applications, and Revit 

has the basic shortcuts that you’d expect for these interactions (Ctrl+C for copy, Ctrl+V 

for paste, and Ctrl+X for cut). It also has some surprising timesaving options that you 

can use when you’re pasting elements that are driven by the nature of a building model.

To copy any element to the clipboard, select it and press Ctrl+C to copy or Ctrl+X to 

cut. Elements are now ready to be pasted. To paste, press Ctrl+V. In the majority of cases, 

Revit will place your selection on your cursor, with a dashed box that represents the size 

of the bounding box containing your to-be-pasted elements. Clicking anywhere in the 

model will place the elements.

In addition to the familiar copy and paste tools, Revit offers some other paste options 

that can be used with elements copied to the Windows clipboard.

Paste Aligned

Once elements have been copied to the clipboard, they can be pasted into other views 

with a variety of options. This allows you to quickly duplicate elements from one view to 

another (from one floor to another floor, for example) while maintaining a consistent 

location in the X–Y coordinate plane. After selecting elements and copying them to the 

clipboard using Ctrl+C, choose the Paste Aligned drop-down options in the Contextual 

tab, as shown in Figure 5.1.

Five options are available. Depending on the view from which you copy and what ele-

ments you copy, the availability of these options will change. For example, if you select a 

model element in a plan view, you’ll have all the options shown in Figure 5.1. Let’s look at 

all five options:

Current View  ​This option pastes the elements on the clipboard in the currently active 

view, in the same relative spatial location. For example, if you copy a series of walls in a 

view, Revit remembers the walls and their location. Using this feature, you can copy 

Figure 5.1

The Paste Aligned 
submenu
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elements from one view (level 1) and then switch to another view (level 2) of the same type 

and paste the elements into that view. This can be particularly useful if you’d like to copy 

walls and other elements between different floors. Open a restroom plan on one floor, 

copy it to the clipboard, open the second floor, and then choose Paste Aligned ➔ Current 

View. This will duplicate those elements to the open floor plan in the identical location 

vertically.

Same Place  ​This option places an element from the clipboard into the exact same place on 

the same level from which it was copied or cut. One use for this tool is copying elements 

into a design option. Design options allow you to iterate on multiple designs in the context 

of one file. They also allow you to save portions of the design while you manipulate other 

sections. Using this feature, you can “remove” portions of the project, make other 

changes, and then restore those elements cleanly to their previous location.

Pick Level Graphics  ​You can use this option to copy and paste elements between different 

levels. Once you select the elements, you’re placed into a pick mode, where you can select 

a level in section or elevation. You must be in elevation or section view to have this option 

available. The level you select determines the Z location of the paste and preserves the 

X–Y location. You might use this method to copy balconies on a façade from one floor to 

another in an elevation view.

Select Levels by Name  ​This method is similar to the previous one, but the selection of 

levels doesn’t happen graphically. Instead, you choose levels from a list in a dialog box 

and you can paste to multiple levels at once. This is useful when you have a multistory 

tower; in such a case, manually selecting levels in a view can be tedious. Similar to other 

options, the X–Y position is maintained, and the pasted elements are copied in the verti-

cal dimension. This is useful for pasting groups on multiple levels simultaneously.

Select Views by Name  ​This option lets you copy elements to other views by selecting 

views from a dialog box. A list of parallel views is provided, and you choose which views 

you want to paste the element into. For example, if elements are copied from a plan view, 

only other plan views will be listed. Likewise, if you copy from an elevation view, only 

elevation views appear as possible views to paste into. 

Move
Your projects will be changing constantly as the design takes shape and adapts to 

requirements. You will often need to move and reshuffle elements from one place to 

another, especially in the initial phases of a project. Thanks to parametric constraints in 

Revit, many objects move in relation to other objects in an automatic manner, but you 

If you press 0 (zero) and  then the Enter key, Revit will allow you to paste to the same 

XY coordinate.
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also need the ability to move things manually. There are a couple of ways to accomplish 

this in Revit: using an explicit two-click Move command or using the keyboard arrows to 

Nudge elements.

The Move tool is located in the toolbar and becomes active when elements are selected. 

Once you’ve selected an element and activated the Move tool, you select a start point (often 

a point on the element itself for easier referencing) and end point to determine the move 

distance and vector. The start and end points can be anywhere in your active view; these 

picks establish the distance and direction of the move. For example, to move a desk to the 

left by 3′–0″ (1 m), you select the desk, click the Move tool, pick a start point, and then 

drag the mouse to the left 3′–0″ (1 m) using the temporary dimension as a reference. 

You then click to finish the command. If you know the distance you want to move, you 

can also type in the value — just be sure you give the move a vector by dragging the mouse 

in the direction you want to move — and then start typing a value. Revit automatically 

understands that you’re telling the element to move by the distance you type and will fin-

ish the command when you press Enter on the keyboard, as shown in Figure 5.2.

When the Move command is active, several options are available in the Options bar:

Constrain  ​When this option is selected, it constrains movement to horizontal and vertical 

directions. Use this to guarantee elements don’t get placed off axis.

Disjoin  ​Hosted elements such as windows and doors can’t change a host (a wall, for 

example) and move to another host without explicitly being disjoined from their host. 

This tool allows that disjoin. If you need to move a door from one wall to another, select 

the door, select the Move tool, check the Disjoin option in the Options bar, and move the 

door to another host element.

Copy  ​This option makes a copy of the selected element and then moves that copy to the 

desired location. The original element stays in place.

Nudge

Use the nudge command when you need to move an element incrementally. Any time an 

element is selected, you can use the arrow keys on the keyboard to move the element hor-

izontally and vertically in very small increments. Each press of an arrow key nudges the 

element a specific distance based on your current zoom factor. So, if you are zoomed way 

out, it will move elements farther than if zoomed in tight.

Copy
Copy is an interactive tool that is nearly identical to the Move tool but makes a copy of 

the selected element at the location of the second pick. Note that this isn’t the same Copy 

tool as Ctrl+C (the one found in the Edit menu that copies elements to a clipboard). This 

tool doesn’t copy anything to the clipboard; it copies an instance of an element or selection 

Figure 5.2

Using the Move tool
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of elements in the same view exclusively. To activate this tool, first choose the elements 

you want to duplicate, and then select the tool.

Rotate
There are two ways to rotate elements in Revit: using the Rotate tool and using the spacebar.

Rotate Tool

To rotate an element, select it and click the Rotate tool. A round rotate icon indicates the 

center of the rotation and appears at the center of the element’s bounding box (Figure 5.3). 

This icon can be repositioned to set the desired center of rotation.

More often than not, the center of the element isn’t 

the point around which you want to rotate. If this is the 

case, you need to reposition the center of rotation. To do 

this, select the icon and drag it to the point you wish 

before rotating the element — this temporarily relocates 

the origin. Once the origin is established, begin rotating 

the element using the temporary dimensions as a refer-

ence or typing in the angle of rotation explicitly.

Spacebar

Many family components (furniture, casework, doors, 

windows, etc.) can be rotated in 90-degree increments 

by selecting the element, then pressing the spacebar 

(rotating with the spacebar also works during creation of 

an element). This is a quick way to lay out room configu-

rations. If the element you are rotating is near a reference 

that is not horizontal or vertical (an off-axis wall under 

30 degrees, for example), the spacebar will pick up that 

reference as you cycle through possible positions. 

Press the spacebar until you get the right orienta-

tion, then exit the command by either clicking the 

Modify button or pressing the Esc key twice. If you 

press the spacebar as you start to sketch a wall or after 

you select a wall that has already been sketched, the  

wall will flip with respect to its location line.

You can also make copies of elements by selecting them, then pressing the Ctrl key and 

dragging your mouse. Once you release the mouse button, a copy of selected elements will 

be placed in the model. With this method, you’ll see a preview of the element being copied, 

not an empty boundary box.

Figure 5.3

The Rotate command
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Array
An array is a way to make multiple instances of an element with consistent spacing between 

elements. Revit arrays are much more intelligent compared with array tools from other 

CAD or BIM packages, and can be parametrically grouped and associated so that the array 

spacing and number of elements in the array can be modified after you make the initial 

array. The Array tool is one of the standard tools available for model and drafting elements.

The steps to create an array depend on the settings on the Options bar (see Figure 5.4).

You can create two types of array: linear and radial. Linear is set as the default. A linear 

array puts a series of elements on a straight 

segment of a line; that line can either use a set 

distance between elements or equally space a number of elements over a given distance. 

The radial array works in a similar fashion, but it revolves elements around a center point.

The Group and Associate option lets you treat the array as a group that can be modi-

fied later to adjust the number or spacing of the array. If this is unchecked, then the array 

is a one-off operation similar to Copy, and you'll have no means of adjusting the array 

after you create it.

In the Number field, set the number of elements to be arrayed. This option is active 

when Move To: 2nd is checked. For example, if you type 7 as the number and check Move 

To: 2nd, the element will be arrayed seven times. The distance between elements is deter-

mined by the distance between two subsequent mouse clicks in the view.

Figure 5.5 shows two arrays drawn from A to B, number 5, illustrating the difference 

between choosing Move To: 2nd and Move To: Last.

In both examples, Group and Associate were activated. When an element in the array 

is selected (after the array has been placed), a numeric control similar to a temporary 

dimension appears, indicating the number of elements in the array (shown as a 5 in the 

center of the array in the previous figures). This allows you to change the number of ele-

ments in the array by directly editing the number. Revit will maintain an associated array 

Figure 5.4

The Array settings 
on the Options bar

Figure 5.5

Top: Array by 
number; Bottom: An 

array between two 
points
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as long as all the original members of the array still exist and are equally spaced. If you 

wish to change the position or delete just one of the arrayed elements, you will need to 

select the element, select Ungroup from the Options bar to deactivate (break) the associa-

tion between the arrayed elements, and only then perform individual actions with that 

element.

Mirror
The Mirror tool allows you to mirror elements across an axis to create a mirror image of 

an element, like the chairs in Figure 5.6. This tool lets you either pick an existing refer-

ence in the model (the arrow icon) or draw the axis interactively (pencil icon).

 

Use the pick method when you have an existing element with a meaningful center 

axis. If nothing in the model exists to pick as a mirror axis, use the Draw mode and draw 

your own axis, as shown in Figure 5.7.

Certain real-world objects are not meant to be mirrored, such as mechanical equipment, 

specialty equipment, and plumbing fixtures. These objects may look graphically correct 

when mirrored, but doing so may adversely modify the element’s analytical data. For 

example, mirroring a piece of medical equipment may result in the mechanical engineer 

proposing utility connections at an inappropriate location. The same applies for doors.

Figure 5.6

Mirroring chairs 
using the middle of 
the table as an axis

To mirror doors and windows in a wall, it is faster and more intuitive to use the spacebar or 

the blue flip arrows after selecting an element. You can of course also use the Mirror com-

mand, but the methods mentioned previously are specifically designed to address this.
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Scale
The Scale tool is well suited for working with imported images that need to be scaled to 

match real-world dimensions. Say you’ve scanned a drawing of an existing building that 

you wish to convert into a model. 

Chances are, the image isn’t at 

any reasonable scale when 

imported and needs to be scaled 

relative to some model element. 

Resize also lets you modify the 

relative size of a sketch created 

during Sketch mode, or a selec-

tion of lines or detail lines.

The Scale tool will become active in the Contextual tab 

once you select an imported image. After you select the tool, 

click a point to enter an origin (say, the left corner of the 

image); the second point you click is the width of the image 

that you want to fit within a certain size; finally, the third 

click is the new length you want (see Figure 5.8).

Figure 5.7

Mirroring the table 
using a chosen axis

Figure 5.8

Resize an image 
using the Scale tool
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Additional Editing Tools
An additional set of editing tools is available in Revit for editing your design. You’ll find 

them in the Edit panel on the Modify tab. From a workflow perspective, these tools work 

by first selecting the tool and then selecting the elements on which you want to perform 

operations. 

Aligning Elements
When you’re placing and dragging elements, Revit automatically creates temporary align-

ment lines to similar types of elements in the model. Use these alignment lines to place 

elements in relation to other elements. When you drag ele-

ments around, take note of these helpful alignment lines,  

and use them to line things up. This works for all categories 

of elements, including annotations. Figure 5.9 shows 

autoalignment lines when placing a tag.

These alignments are great for lining up annotations such as room tags. Select a tag and 

drag it — note how it aligns to other tags in the view, making it a snap to create organized 

drawings. Figure 5.10 shows the alignment lines while interactively dragging.

Figure 5.9

Alignment of a room tag during 
placement

Figure 5.10

Alignment of a room tag during editing
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In addition to the alignment graphics, the Align tool is one of the favorites among 

Revit users. It makes lots of common manipulations easy and precise. The Align tool 

matches the edge of one element precisely to another. In some cases, this will move an 

element more accurately than measuring the distance that an object needs to move and 

then moving the object that distance.

Auto-alignment

Revit has embedded placement and can modify the alignment between elements of the 

same category. That is to say, when you drag elements around, they locate nearby similar 

elements, and alignment graphics are drawn to aid you when laying out the model or 

adding annotations. Figure 5.9 shows auto-alignment during tag placement.

If you wish to put room tags in order on your drawing, and you start moving one to 

align with another, Revit shows an alignment line and snaps to the other tag. Figure 5.10 

shows auto-alignment during editing. 

Manual Alignment

You can explicitly align references from one element to another using the Align tool. For 

example, you can align windows in a façade in an elevation view to line up their center 

lines. To use the Align tool, select a target line and then select what you want to align to 

that first pick. The second element picked moves into alignment. Whenever an alignment 

is made, a blue lock icon will appear. Clicking that icon locks the alignment, creating a 

constraint between the two elements. Once constrained, if either element is moved, both 

elements will move together.

Locking elements together is a powerful part of Revit. However, locking too many ele-

ments together can overconstrain your model. Be careful when you choose to use this tool 

and lock objects sparingly until you have a good grasp of the resulting constraints.

Figure 5.11 shows the use of the Align tool to align windows on a façade. The top win-

dow’s mid-axis is selected as the alignment reference. After that, the mid-axes of the lower 

windows are clicked, and the lower windows automatically align to the top window.

The Align tool also works for aligning geometry with surface patterns like brick or 

stone. Figure 5.12 shows how you can align the edge of a window to an expansion gap.

The Align tool is useful in the Family Editor environment, where you can align an ele-

ment to a reference plane that will control the behavior of that element and lock it.
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Figure 5.11

Manual alignment

Figure 5.12

Aligning windows 
and patterns
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Split
The Split tool is used only on lines and walls and is used to split these elements into sepa-

rate entities. When activated, place the mouse over a wall or line. A knife icon will appear; 

clicking will split the wall or line into two separate segments. If you need to make two 

splits, with the intention of removing the segment between the two splits, click the check 

box Delete Inner Segment on the Options bar. See Figure 5.13.

Trim and Extend
Use the Trim tool and Extend tool to trim and extend lines and walls to one another. The 

first option is the default, Trim to Corner. It trims elements to one another, creating a 

connected end-join condition when you finish. For example, to clean up the T intersec-

tion shown in Figure 5.14, use the Trim tool.

Figure 5.13

Splitting the wall 
where the two 
perpendicular 

walls intersect will 
produce the fol-

lowing image with 
just two clicks when 

the Delete Inner 
Segment option is 

checked
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Figure 5.15 shows two walls before and after using the Extend Single Element tool.

Figure 5.16 shows multiple walls before and after using the Extend Multiple 

Elements tool.

Figure 5.14

Trim/Extend to 
Corner

Figure 5.15

Trimming a single element

Figure 5.16

Extending multiple elements

Figure 5.17

The Offset tool
The Offset tool is similar to the Move and Copy tools: it makes a copy of a selected 

element parallel to the edge you select as a reference for offset. You can find the Offset 

tool either on the Edit tab or on the Options bar (Figure 5.17) when you’re sketching 

lines or walls.

This tool is particularly useful in the Family Editor when you’re making shapes that 

are a consistent thickness in profile, such as an extruded steel shape. Offset is also handy 

when you’re making roof forms or soffits with known offsets from a wall. You can either 

offset a line and maintain the original (copy) or offset the line and remove the original. 

Figure 5.18 shows the offset of a loop of lines using the Copy option.
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Figure 5.19 shows how you can use the Offset command to make the roof boundary 

wider in every direction.

Graphic and Visual Overrides
Revit provides a rich set of controls that allow you to change the graphic appearance of 

elements on a view-by-view basis. Every element belongs to a category, which provides a 

baseline graphic appearance for any given element. However, the category graphics may 

need to deviate, depending on what you’re trying to convey in a drawing. For example, the 

furniture category uses a solid black line by default. Set this on Manage tab by choosing 

Settings ➔ Object Styles. Changing the default 

values in the Object Styles dialog box affects 

furniture in all views, as shown in Figure 5.20.

Let’s say you need to create a plan view where 

all furniture is shown as halftone, dashed, or 

hatched. No problem. With Revit, this is han-

dled with view-specific graphic overrides that 

can be applied to entire categories or individual 

elements.

Each view is a unique view of the model that 

can be graphically tailored to meet your needs. 

Graphically overriding an element or a category 

Figure 5.18

Using the Offset tool

Figure 5.19

Offsetting a roof sketch

Figure 5.20

Object Styles 
dialog box
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doesn’t mean you’re changing the element — you’re changing its appearance. To override 

graphics in a view, you can use the Visibility/Graphic Overrides dialog box or the view-

specific element overrides dialog box:

To access the Visibility/Graphic Overrides dialog box, you can either go directly to •	

the dialog box from the View tab, or right-click in the view and choose View Proper-

ties from the context menu. You’ll see the Visibility/Graphics Overrides parameter in 

this dialog box as well.

You can also access the dialog box when an element is selected using •	

the right-click menu. Select an element, and choose Override Graph-

ics in View ➔ By Category (Figure 5.21).

When you use the context menu, the dialog box preselects the category 

for you based on the elements you selected. For example, to override the 

furniture category, select a piece of furniture and use the right-click menu 

to access the override options.

Figure 5.22 shows a chaise lounge chair in elevation, in the default 

mode and with lines overridden using dashed lines. 

Once you’re in the Visibility/Graphic Overrides dialog box, you’ll see a 

list of all the categories and the various ways of manipulating the graphics. 

To get a handle on this, we’ll walk through 

the override options from left to right, as 

they appear in the dialog box.

Categories

Top-level tabs divide elements based on 

type: Model, Annotation, and Imported. 

The Filters tab is also available as a way to 

manipulate graphics based on parameter 

criteria. If a view includes imported or 

linked files, there will be tabs for those as 

well, which will allow you to change the vis-

ibility and appearance of imported layers. 

This dialog box is powerful and allows for 

total control over the graphics of anything 

in your view.

Visibility

The first column combines a list of catego-

ries and subcategories with a visibility  

Figure 5.21

When an element 
is selected, you can 
access the Visibility/
Graphics setting 
from the right-click 
menu

Figure 5.22

Overriding an 
element
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toggle. To turn off the visibility of a category in the view, uncheck the box next to the cat-

egory, as shown in Figure 5.23.

Each category has a list of subcategories; to turn off any particular subcategory, 

uncheck it.

Figure 5.24 shows an example of controlling visibility by unchecking subcategories 

from the Visibility/Graphic Overrides dialog box. The first image shows the view with 

the doors turned on, the second image shows what subcategory is unchecked, and the 

final image shows the result.

The lines and surfaces of elements in projection can be overridden. With these con-

trols, you can change the line style of any element and also apply hatches to surfaces.

Figure 5.23

Controlling visibility

Figure 5.24

Visibility examples
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Line and Pattern Overrides

For most model categories, you can apply overrides to projected and cut lines as well as 

surface and cut patterns (shown in Figure 5.25). Using these overrides allows you to alter 

line color, thickness, and pattern. You can also apply a hatch pattern override to any sur-

face, whether projected or cut.

To add an override, click the desired override for the category you want to change. The 

row will then display a series of buttons, as shown in Figure 5.26.

Clicking Override takes you to dialog boxes where graphics can be overridden. 

Figure 5.27 shows the Line Graphics override dialog box and the Fill Pattern Graphics 

override dialog box. Note that the options in the dialog boxes vary based on what you’re 

trying to manipulate.

The controls are fairly self-explanatory. Feel free to experiment with the behavior.

Figure 5.25

Line and pattern 
overrides

Figure 5.26

Element choices

Figure 5.27

Line Graphics and 
Fill Pattern
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Halftone and Transparent

These columns (shown in Figure 5.28) are check box controls that change lines and sur-

faces. The Halftone option takes the line color and tones it down by 50 percent. The 

Transparent check box makes all surfaces of the category 100 percent transparent, so 

that you can see through these elements in the view.

Detail Level

The last column controls the detail level appearance for categories. This allows you to 

show fine levels of detail for some categories, even if the view is set to coarse. Until you 

get into sophisticated content creation, this level of override can be safely ignored.

Here’s something important to know about the Fill Pattern Graphics dialog box: if you want 

to hide the pattern of a category, use the Visible check box in the Pattern Overrides options. 

Don’t change the pattern color to white, because doing so can cause problems if you end up 

exporting the view. The lines are still there — they just don’t appear, due to the screen back-

ground color.

Figure 5.28

Halftone and Trans-
parent overrides
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Override Host Layers

The Visibility/Graphic Overrides dialog box contains an additional override feature spe-

cific to layers that make up walls, floors, and roofs (in Revit terms, these are considered 

“host” elements). You can see it at the lower right: the Override Host Layers section. Using 

this edit control, it’s possible to override individual layers within wall, floor, and roof ele-

ments. For example, this will let you make the structural stud layer of walls appear in a 

heavier line weight than the finish layer.

Element Overrides
When elements are selected, you can hide them in the view and also override their graphics. 

This allows you to change the visibility of individual elements, not just entire categories. 

To do so, right-click any element, and then use the context menu option Hide in View ➔ 

Elements, as shown in Figure 5.29. To unhide elements, use the Reveal Hidden Elements 

mode, located in the view control tools at bottom of the view. This will reveal hidden ele-

ments in a red color, and allow you to unhide them. When elements are selected, you can 

use the buttons in the Contextual tab to unhide them.

The selected elements are hidden in the view. Figure 5.30 shows an 

example of hiding only a few elements of a category in a view. In this case, 

the trees are obstructing the camera view, so a few of them have been 

overridden to improve legibility of the view.

To override the graphics of a selected element, choose Override Graphics in View ➔ By 

Elements from the context menu. Doing so brings up a dialog box with the same graphic 

overrides available in the Visibility/Graphic Overrides dialog box, but in a collapsed state 

(see Figure 5.31).

Along the top of this dialog box are check boxes for making an element visible, half-

tone, or transparent. Below that are groups of controls for overriding lines and patterns. 

Clicking the small arrow button opens and closes groups of controls for each kind of 

override. Figure 5.32 shows the dialog box with Projection Lines expanded.

Figure 5.33 shows various element overrides; the bed is set to transparent, the doors to 

halftone, and the shower to invisible.

Figure 5.34 shows an example using a transparent override per element in a 3D view; 

the roof and the front wall are transparent.

Graphic overrides applied on a per-view basis allow you to quickly turn a working 

drawing into a presentation drawing. For example, you can override all elements that are 

cut with a solid fill color with a few simple clicks, to get another style of presentation 

drawing. Figure 5.35 shows how you can modify the color of the wall in a plan view.

Figure 5.29

Element overrides
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Image courtesy of Ivan Kubík & Marek Németh Architects

Figure 5.30

Hiding elements 
in view
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 Unhiding Elements and Categories
After an element or category has been hidden, you can use the Reveal Hidden Elements 

toggle to see hidden elements and then unhide them. To do this, click the light bulb icon 

in the View Control bar. 

Figure 5.31

View-Specific Element Graphics

Figure 5.32

Projection Lines override group 
expanded

Figure 5.33

Overriding various 
elements
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Figure 5.34

Graphic overrides 
using transparency
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The view halftones all visible elements and draws hidden elements with magenta color. 

A magenta border is also drawn around the entire view to make it more obvious that 

you’re in a special mode. Hovering the mouse over hidden elements displays a tooltip that 

explains how the element is being hidden: Hidden Category or Hidden Element. 

Figure 5.36 shows some examples of hidden elements and categories.

To unhide the element, use the buttons in the Options bar or the right-click option 

Unhide in View ➔ Element. To reset the view to its normal display, click the light bulb 

icon again.

Figure 5.35

Graphic overrides 
for walls
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As you can see, Revit provides a full range of tools that give you control over how your 

model looks and feels. Using the interactive editing tools, you can manipulate elements 

spatially and then make decisions about how elements should be displayed, depending on 

what you’re trying to convey with your drawings.

Figure 5.36

Hidden elements 
and categories
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Extended Modeling

C hap te r 6

In the previous chapters  we covered basic modeling techniques 

to construct a simple building. We skipped over many additional features so that you can 

get a handle on essential workflows, the user interface, and making modifications to the 

model. In this chapter we’ll cover more advanced features that are available any time 

you’re modeling in Revit. As you’ll see, with a little refinement and creativity, you can 

make almost anything using standard creation tools. Topics we’ll cover include:

Walls: advanced modeling features■■

Curtain walls: advanced design techniques■■

Roofs and floors: advanced shape editing■■
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Walls: Advanced Modeling Features
With Revit, walls are made from layers of materials that represent the construction mate-

rials used to build real walls. These layers can be assigned functions, allowing them to 

join and react to other similar layers in the model when walls, floors, and roofs meet. The 

wall core is one of these special layers, and understanding it will help you when you’re 

designing your walls.

Revit has a unique ability to identify a wall core that is much more than a layer of 

material. The core influences the behavior of the wall and how the wall interacts with 

other elements in the model. Every wall type in Revit has a core material with a boundary 

on either side of it. These core boundaries can be dimensioned and snapped to. When 

other host elements (walls, floors, ceilings, roofs) are drawn, you can use wall-core bound-

aries to maintain critical relationships. For example, a floor sketch can be constrained to 

the structural stud layer of walls by using the wall-core boundary to create the sketch. If 

walls change size or are swapped, the floor sketch maintains its relationship to the core 

boundary and will adjust automatically.

To access and edit wall-core boundaries and material layers, select a 

wall, select Element Properties and in the Instance Properties dialog 

box, click Edit Type to open Type Properties, and then click the 

Structure parameter. This will open a new Edit Assembly dialog box. 

Here you can define materials, move layers in and out of the core 

boundary, and assign functions to each layer (see Figure 6.1).

To get a feel for how core layers are used in relation to a floor, start a 

new Revit session and follow these steps:

	 1.	 Open a new project, and draw a simple floor plan using the Wall tool. Select a mul-

tilayered wall type in order to understand the value of the exercise — the Brick on 

CMU wall type works well. Draw some walls in the shape shown in Figure 6.2.

	 2.	 Use the View Control bar to switch to fine or medium level of detail so you can see 

all wall layers. (In coarse views, wall layers are never displayed.)

	 3.	 On the Build panel of the Home tab, select the Floor tool, keep the default selected 

Pick Walls tool in the Draw panel, and in the Options bar (Figure 6.3) check the 

Extend into Wall (To core) option.

	 4.	 Position your mouse over an edge of the wall (do not click the mouse yet), press Tab 

to highlight all the walls, and then click to select. Zoom in. A sketch line indicating 

the shape of the f loor will be created. This sketch line indicates the position of the 

floor relative to the wall — it’s drawn at the exterior edge of the wall core. Make sure 

you’ve selected all walls as a reference to create the floor, and click Finish Sketch.

Figure 6.1

Wall assembly 
materials
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	 5.	 From the View tab, select the Section tool, create a section through the wall, and open 

the section view. Again, make sure your view is set to medium or fine level of detail. 

You’ll see the edge of the floor and how it aligns with the wall construction (Figure 6.4).

	 6.	 Go back to the floor plan, and select all elements in the view. Click the Filter button 

on the Multi-Select tab, and uncheck all but the Floor category. Click OK. To edit the 

floor sketch, select the Edit Sketch tool from the Edit panel of the Modify tab. Revit 

returns you to Sketch mode.

Figure 6.2

Draw Brick on CMU 
walls in this shape

Figure 6.3

The Extend into 
Wall (To core) 
option allows 
you to constrain 
lines to wall-core 
boundaries

Figure 6.4

On the left, the floor 
sketch in plan view; 
on the right, how 
the floor looks in 
section in relation 
to the wall.
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	 7.	 Tab-select the floor lines to pick all lines in the sketch. In the Options bar, set an off-

set of 6″ (150 mm).

	 8.	 Finish the sketch by clicking the Finish Floor button in the Create Floor Boundary tab.

	 9.	 Switch back to the section view (Figure 6.5). The floor now extends 6″ (150 mm) 

beyond the edge of the core.

	10.	 You can continue by changing the wall type to another type and see that the floor 

always maintains its position relative to the core of the new wall. If you change your 

design and move your walls to make the floor plan bigger or smaller, the floor will 

always adjust with the change.

Layer Join Cleanup
As mentioned in Chapter 4, “Modeling Basics,” the wall-layer priority determines the 

interaction and cleanup of joins between walls of different types. There are six functions 

(levels of priority of wall layers), with Structure 

having the highest priority (as shown in 

Figure 6.6).

When you create a new wall type and begin 

adding material layers to the wall, you need to 

assign a material, thickness, and priority to the 

layers. When you’re assigning a priority, think 

about the function of the layer in the wall — is 

it finish? Substrate? Structure? This decision will help clean up your walls down the road.

If you encounter situations where the automated wall cleanup doesn’t correspond to 

your expectations, Revit will let you cycle through a range of possible layer configurations 

using the Wall Joins tool, located in the Edit Geometry panel of the Modify tab.

Figure 6.5

Floor with offset 
from the wall-core 

boundary

Figure 6.6

Wall functions
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Editing Wall Joins

The Wall Joins tool lets you edit wall-join configurations. The default wall join is set to butt 

join. Activate the Wall Joins tool, and place your mouse over a wall join. (This can be a cor-

ner where two walls meet.) The Options bar shows some alternative configuration options: 

Miter and Square. A miter join is shown in 

Figure 6.7.

Disjoining Walls

Disallow Join is another tool designed to 

provide more flexibility in wall-join behav-

ior. If you select a partition wall that cleans 

up with your exterior wall but that isn’t 

the desired behavior for that partition wall, 

you can right-click the blue control dot at 

the end of the wall and select Disallow 

Join from the context menu. Doing so 

breaks the autojoin cleanup. Figure 6.8 

shows the walls intersecting in a Disallow 

Join condition. Note that once a join has been disallowed, a re-allow join icon will appear 

when the wall that is disjoined is selected. Clicking this icon will rejoin the two walls. 

Note that the controls are available at wall ends (T-join of walls) and mid-end joins (ver-

tical lines in elevation profile in the middle of the wall or in wall opening); and they only 

appear when a single wall is selected.

Stacked Walls
Walls in a building, especially exterior walls, are often composed of different wall types 

that vertically stack on top of one another over the height of the façade. At the very least, 

most walls sit on top of a foundation wall. To guarantee that in case the foundation wall 

Figure 6.7

A miter wall join

Figure 6.8

Disallow Join
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changes position, the walls above it also move, you can create a special wall type in Revit: 

Stacked Wall. (See Figure 6.11 later in this section for the final look of a stacked wall.) All 

individual walls stacked on top of each other in a stacked wall will behave as one entity.

Stacked walls allow you to create a single wall entity composed of vertically stacked 

different wall types. The wall types that make up the stacked wall need to be existing 

types already available in the project. Note that stacked walls may only be composed of 

basic walls — single or multilayered — but not of curtain walls or other stacked walls.

To understand how stacked walls work and how to modify one, follow these steps:

	 1.	 Open a new session of Revit, and make sure three levels are defined (if you don’t have 

three levels defined, go to an elevation view, add a third level, and then go back to 

your Level 1 floor plan view).

	 2.	 Select the Wall tool, and then click on the Change Element type: this opens the Type 

Selector list. Select the Stacked Wall: Exterior – Brick Over CMU with Metal Stud 

(located at the bottom of the list). Click the Element Properties button to open the 

Instance Properties dialog box, then click the Edit Type button to open the Type 

Properties dialog box, and then duplicate the wall type to create a new stacked wall 

(Figure 6.9).

	 3.	 Edit the Structure parameter, and click the Preview button to see the wall in section 

(Figure 6.10). When you’re editing the stacked wall type, you’ll notice that the dia-

log box is slightly different than when you’re working with a basic wall. Rather than 

editing individual wall layers, this dialog box allows you to stack predefined wall 

types on top of each other.

	 4.	 Click the Insert button to add a new wall. A new row appears in the list and allows 

you to select a new wall. Select the Generic wall type from the Name list, and set the 

Height value; you also may need to define an Offset value to make the three walls 

f lush with the interior face. With a new row selected, click the Variable button. This 

will allow the wall to vary in height to adjust with levels.

	 5.	 Go back to your plan view and draw the new wall, making sure that you set its top 

constraint to Level 3. In 3D, the wall should look similar to Figure 6.11.

Figure 6.9

In the Type 
Properties dialog 

box, duplicate the 
wall type to create a 

new stacked wall
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Figure 6.10

The Edit Assembly 
dialog box allows 
you to configure a 
stacked wall

Figure 6.11

A finished 
stacked wall

73559c06.indd   199 6/2/09   1:52:20 PM



200  ■   Chapter 6 : Extended Modeling

	 6.	 Cut a section through the model and change the heights of Level 1 and Level 3 to 

see the effect this has on the wall. (Make sure the level of detail is set to medium/fine 

to see the wall layers.) You’ll see that changing Level 2 does not change the bottom 

walls, as they are fixed in height. However, changing the height of Level 3 will change 

the height of the variable wall (see Figure 6.12).

In Revit it is never too late to add or change something. There is no need to rearrange things 

to accommodate late changes to the project, because that is exactly where Revit excels — it 

revises instantly when you apply a change to one place.

Walls with Integrated Sweeps and Reveals
Walls are often complex, highly articulated compositions. Cornices, reveals, corrugated 

metal finish, and other projections are used all the time to give texture and delineate 

space. Revit can accommodate any of these types of design elements. Four examples of 

so-called compound walls are shown in Figure 6.13. 

Figure 6.12

Variable instance in 
a stacked wall

Use these walls sparingly if you have really large projects or underpowered hardware. Model 

patterns are computationally much lighter than geometry.
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Figure 6.13

Compound 
wall types
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In the Edit Assembly dialog box of 

any basic wall, you can enable a preview 

of the wall. This preview allows you to 

view the wall in either plan or section. 

When the section preview is active, 

additional tools also become active and 

allow you to place geometric sweep and 

reveal components on the wall (see 

Figure 6.14).

Sweeps and Reveals

Clicking the Sweeps or Reveals button 

in the Edit Assembly dialog box opens a 

new dialog box where you can define 

profile families to use as sweeps or 

reveals. These profiles, which are no 

more than 2D shapes made out of sim-

ple lines, are then swept along the length of the wall at a specified height. Many profiles 

representing cornices, skirting, and chair rails are included as part of the Revit installa-

tion; but if you need to create a custom profile of your choice, you can create one using 

the Family Editor and the Profile Family template. To do that, open the Application 

Menu and choose New ➔ Family, and then choose the profile template (Profile.rft or 

Metric Profile.rft). The Revit Family Editor opens with the correct template for creating 

your own profile; you draw one closed loop of lines at the desired real-world scale, save 

the family, and then load the profile back into your project. (Note that you cannot have 

more than one closed loop of lines when creating profiles in the Family Editor.) 

Revit offers two different techniques of creating wall sweeps and reveals. In the follow-

ing example, we will cover the first one, called integrated wall sweeps and reveals. Later 

in this chapter we will discuss the host sweeps and reveals. 

To place an integrated wall sweep onto a wall type, follow these steps:

	 1.	 From the Home tab, click the Wall tool and select a Generic wall from the type selector.

	 2.	 Select Element Properties to open the Instance Properties dialog box, click Edit Type, 

and click Duplicate. Give the wall a new name.

	 3.	 Using the Insert button, add new layers as shown in Figure 6.15. Use the Up and 

Down buttons to move layers in the assembly.

	 4.	 If not already in section view, switch the wall preview using the View drop-down 

menu in this dialog box. The six Modify Vertical Structure options become active at 

the bottom of the dialog box, as shown in Figure 6.16.

Figure 6.14

Wall-section preview 
in the Edit Assembly 

dialog box
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Figure 6.15

Layers in the wall

Figure 6.16

The wall in 
section view
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	 5.	 Click the Sweeps tool to open the dialog box shown in Figure 6.17. At present, no 

sweeps are defined in your wall, so let’s add some.

	 6.	 Click the Load Profile button, browse to the Profiles folder, and load these two pro-

files, as shown in Figure 6.18:

Cornice : Metal Panel.rfa•	

Base 2.rfa•	

Note that selecting those two profiles loaded them in your project, but you still 

have to add them to the wall sweep in order to actually use them.	

	 7.	 Click the Add button. This adds a row in the dialog box in which the current profile 

is a Default profile. Click in the first row on the Default profile. When a little arrow 

appears, click the arrow, and from the list of available loaded profiles, select the Cor-

nice profile. Repeat the same in the second row and select the Base profile. 

Figure 6.17

Wall sweeps

Figure 6.18

Load these wall 
profiles
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	 8.	 Set the Cornice profile’s From value to Top and the Base profile’s From value to Base. 

Doing so attaches the profiles to the top and bottom of your wall. Figure 6.19 shows 

the profiles loaded in the wall. 

	 9.	 Click OK. Figure 6.20 shows the profiles attached to the top and bottom of the wall. 

	10.	 Back in the main window (the drawing area), draw a segment of this wall. Make a 

section through the wall and check out the wall in section and 3D views to see the 

resulting wall. Figure 6.21 shows the final result of the wall.

Figure 6.19

Adding the profiles 
to the wall

Figure 6.20

The profiles on 
the wall
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Extending Wall Material Components

In real practice, not all layers in a single wall extend all 

the way from the bottom to the top of the wall: in a bath-

room the tiles sometimes only go up to 5′-0″ (1.50 m) 

and a façade finish material may start at 20″ / 50 cm off 

the ground. To make it possible to have wall compo-

nents finish earlier or start later within the height of 

the wall, there is another useful feature that enables 

you to unlock wall layers and manipulate their 

heights. Here’s how to do this:

Figure 6.21

Wall with applied 
integral sweeps

	 1.	 Switch to the section preview in the Edit Assembly 

dialog box, click Modify, and using the Steering-

Wheels icon, zoom in to the bottom of the wall. 

Hover the mouse over the bottom edges of the lay-

ers in the preview, and they will highlight.

	 2.	 With the help of the Tab key, select one of the bot-

tom edges of one of the wall layers and a lock icon 

will appear. By default, all top and bottom edges of layers are locked into place; how-

ever, if you unlock this edge it becomes free to move up and down. 

Once the wall is placed in a project, you can manipulate individual layers dynamically 

in a section view or with parameters. When you unlock layers, the instance parameters 

for Base and Top Extension Distance become enabled. Figure 6.22 shows the lock and the 

ability to unlock the material and extend it further than the wall base.

Using the same principles outlined for adding traditional-looking elements, you can 

get creative and add any type of profile you want. Figure 6.23 shows a wall with a corru-

gated siding added as an integrated wall sweep.

Note that once you have unlocked a wall layer, you can do the actual changing of its height 

only in the project environment once you place a wall. This editing can’t be done in the 

Assembly dialog box. This is why the unlocked component may not move up or down as 

expected. 

Use caution when pressing the Esc button while in the Edit Assembly dialog box. This will 

exit you from the dialog box and you will lose all the work you just did on the wall.
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Figure 6.22

Unlock a wall layer 
component in the 
Edit Assembly 
dialog box and 
start moving their 
start end points 
in a section view 
in the project 
environment

Figure 6.23

A corrugated metal 
wall created using 
the integral sweep 
technique

The profile The wall in Edit Assembly The finished wall
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Reveals

Reveals can be added to a wall using the same workflow as with sweeps; the only difference 

is that the profile is subtractive rather than additive. Note that the profile must overlap 

the geometry of the wall when used to create a wall reveal. Paradoxically, in many cases 

using reveals to remove geometry can result in more predictable behavior than adding 

sweeps to create geometry, particularly in the case of attached top/bottom wall joins. 

Wall Sweep Returns

When you’re working on traditional architectural projects, the wall sweeps usually wrap 

around door openings in thick walls. This is a detail that rarely any software will help you 

do without too much hassle. Revit can accommodate this using a specifically designed tool 

for the job: the Modify Returns tool available in the Modify tab, under the Wall Sweep 

panel. Note that this tool will only work for wall sweeps created with the second method, 

explained in the example that follows. It will not work with integral wall sweeps or reveals.

To understand this feature, follow this simple exercise:

	 1.	 Open a new session of Revit and place a generic wall.

	 2.	 Rather than placing an integral sweep in the wall type, we can use another method 

for placing sweeps; the Wall Sweep tool that is available when you expand the Wall 

tool in the Build panel of the Home tab (shown in Figure 6.24).

	 3.	 Select the Wall Sweep, and then click Change Element Type to select a wall sweep 

from the Type Selector. These sweeps can be placed either vertically or horizontally 

using options in the Place Wall Sweep tab.

	 4.	 Add a horizontal sweep to the middle of the wall. Use the temporary dimensions to 

place the sweep at the desired height.

	 5.	 Switch to the Modify tab, select the Openings tool, pick the wall, and draw an open-

ing that intersects the sweep, as shown in Figure 6.25.

	 6.	 Select the sweep — it will display a blue grip at the end (the edge of the opening). 

Click the Modify Returns command on the Modify Wall Sweeps tab; the cursor 

turns into a knife symbol, and when you click somewhere on the profile, it creates a 

new segment that wraps around the edge of the opening. Press Esc or use the Modify 

tool to exit the command. You will need to zoom in close to the end of the sweep to 

really see the effect. If you zoom very closely, the lines might become very thick and 

will not look great — in that case, click the Thin Lines button located in the View tab 

under the Graphics panel. 

	 7.	 Select the sweep again, and drag the control to adjust the length of the sweep. Fig-

ure 6.26 shows some examples of modifying an instance of a host sweep.

Figure 6.24

Host wall sweep and 
reveal tools
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Creating Special Walls Using the Create Tool (Walls In-Place)
When you’re working on traditional architecture or restoration of historic buildings, 

you’ll often need to create walls that are irregular in shape. The Component – Model 

In-Place tool, located on the Build panel of the Home tab, lets you address such wall 

styles. Figure 6.27 shows an example.

Figure 6.25

Wall with a sweep 
and opening, prior 
to applying the 
Modify Return 
functionality

Figure 6.26

Modifying a return 
of a wall sweep

Wall sweeps created as host sweeps using the Wall Sweep tool from the Build panel of the 

Home tab can be scheduled in Revit. Integral wall sweeps created from within the wall prop-

erties cannot be scheduled in Revit at present. That and the ability to manipulate directly 

the position of a wall sweep that you created in this last example are the main differences 

between wall sweeps created with these two methods. 
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This tool allows you to create a family using solid or void geometry that can be made 

from extrusions, sweeps, revolves, blends and swept blends. Each in-place model can be 

assigned a specific category that is later used to control visibility and behavior in the model. 

For example, assigning the family to the Wall category allows the wall to host inserts such 

as windows and doors, as well as schedule a wall. Figure 6.28 shows the available model-

ing techniques for modeling in-place.

For example, Figure 6.29 shows an example of the type of forms you can create using 

this Swept Blend modeling tool. 

Let’s look once more at the wall in Figure 6.27, which was created using a series of 

blends assigned to the wall category. It still behaves as a wall: you can make doors and 

windows, and they cut through the geometry of the wall as with standard walls. Various 

wall types can be created using this method.

Figure 6.27

Wall In-Place 
showing a series of 

connected blends

The finished wall The two wall blends combined 
to make the wallFigure 6.28

The available tools 
for Model In-Place
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Figure 6.29

An example of a 
shape created with 

the swept blend 
method
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The beauty of Revit modeling tools is that you can always go back to the sketch and 

change your base idea (the sketch), and all related changes will happen automatically. You 

do not need to redraw the profile. The same applies for the sweep path — if you used the 

sweep technique, you can edit the path at any point while keeping the profile. Figure 6.30 

demonstrates various types of irregularly shaped walls created using techniques similar 

to the ones described before.
Figure 6.30

Examples of walls 
in-place created 
using sweep, 
blend, or extrusion 
technique

A wall created using the sweep modeling technique

A wall with various thicknesses created using the extrusion method

A twisted wall created using the blend technique—drawing the base and the top 
shape, and setting a distance between them
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Curtain Walls: Advanced Design Techniques
The Curtain Wall tool is designed with flexibility in mind. You can use it to generate any-

thing from simple storefronts to highly articulated structural glass façades. In this sec-

tion, we’ll look at the basic principles and how to extend these principles to create a range 

of designs.

As we mentioned in Chapter 4, “Modeling Basics,” the composition of a curtain wall is 

divided into the three primary elements shown in Figure 6.31 — curtain grids, mullions, 

and curtain panels — plus the entire curtain wall unit and its geometric extents.

Curtain wall  ​A curtain wall is drawn like a basic wall and is available in the Type Selector 

when you click the Change Element Type button when the Wall tool is active or a wall in 

a project is selected. It has top and bottom constraints, can be attached to roofs, can have 

its elevation profile sketch edited, and schedules as a wall type. 

Curtain grid  ​The curtain grid is the layout grid that defines the divisions of the curtain 

wall facade, which is used to set panel sizes and mullion placement. The layout grid can 

be designed freely as a combination of horizontal and vertical segments or can be a type 

with embedded rules that specify regular divisions. Figure 6.32 shows two dramatically 

different types of curtain wall systems.

Figure 6.31

Taxonomy of a 
curtain wall

Curtain grids

Mullions

Curtain panels
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Mullions  ​The mullions represent wood, metal, or PVC profiles on a glass or any panelized 

façade, and in Revit they follow the geometry of the grid. They can have any shape that is 

based on a mullion profile family.

Curtain panels  ​The curtain panels fill in the space between gridlines and are always one 

of the following:

Empty panels  ​No panel is placed in the mullions.

Glazed panels  ​These panels can be made out of different types of glass that can have 

any color or transparency.

Solid panels and panels with wall types  ​These panels can take on any geometry you 

wish, allowing the creation of interesting structures like the one shown in Figure 6.33.

Courtesy of Phil Read

Figure 6.32

Curtain wall 
examples

Figure 6.33

A curtain wall 
system with formed 
panels
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Selecting the Elements within the Curtain Wall

Revit provides specially tailored selection options in the context menu to aid with work-

flow and interaction when working with curtain walls. When you hover over or select an 

element in a curtain wall, take note of the status bar in the lower left of the screen; it tells 

you exactly the type of element you’re about to select or have already selected. Depending 

on what the mouse is hovering over, and with the help of the Tab key, you can cycle 

through various selection options. The elements you can select include the following:

The entire curtain-wall entity (this selection is indicated by a green, dashed line sur-•	

rounding the curtain wall)

A gridline•	

A mullion•	

A curtain panel•	

To select the element you want, use the Tab key until the element of choice is 

highlighted.

Designing a Curtain Wall
In this exercise, we’ll walk through the creation of a simple curtain wall. To draw a cur-

tain wall, you can either draw a standard wall and then change its type to Curtain Wall, 

or select the Wall tool and then select a Curtain Wall type from the Wall Type Selector 

available when choosing the Change Element Type button. Follow these steps:

	 1.	 On the Home tab, in the Build panel, select the Wall tool.

	 2.	 From the Element panel, click Change Element Type and, from the Type Selector list, 

select Curtain Wall.

	 3.	 In the Level 1 plan view, draw a curtain wall. Use the wall type Curtain Wall 1.

	 4.	 Once you’ve drawn the curtain wall, press Esc to finish the command, and from the 

Quick Access toolbar in the top left of the screen, click the 3D icon to toggle the view 

to 3D.

	 5.	 To divide the wall into panels, use the Curtain Grid tool, also available in the Build 

panel of the Home tab. Mouse over the edges of the wall to get a preview of where the 

grid will be placed. Revit has some intelligent snapping built into grid placement that 

looks for midpoints and points that will divide the panel into thirds.

	 6.	 You can then start placing mullions using the Mullion tool located on the Home tab. 

Place one mullion at a time by selecting separate segments; or, if you want to apply 

the same mullion on all segments, hold the Ctrl key and click a gridline to select 

all segments and apply the mullions. The series of images in Figure 6.34 shows the 

approximate results you should get.
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	 7.	 Let’s say you want to add more mullions, but this time you don’t want 

them to extend the entire height of the curtain wall. Select the Curtain 

Grid Line tool, and place new grids as shown in Figure 6.35.

	 8.	 Before applying a mullion to the new curtain grid, delete the segments 

of the curtain grid where you don’t wish the mullion to occur. Exit the 

grid-placement tool, and select the newly created curtain grid. Click 

the Add/Remove Segments button, available in the Modify 

Curtain Wall Grids menu that shows up when you select a 

curtain grid, and click the segment you want removed. 

Remove the top and bottom segments; you should 

have an image similar to Figure 6.36. Place mul-

lions on the curtain grid to finish.

	 9.	 To change mullion types — in this case, the bor-

der mullions — use the context menu to isolate 

mullions for selection. Hover the cursor over a 

mullion, right-click, and select Mullions ➔ Border 

Mullions to select all border mullions.

	10.	 Swap them for another type using the Change 

Element Type option that appears when you select 

the mullion. If you don’t find a mullion type with 

the dimensions you need, no worries — it’s easy 

to create a new one on the fly:

	 A.	 Open the mullion’s element properties.

	 B.	 Select Edit Type, and then click Duplicate.

Figure 6.34

Making the curtain 
wall and adding 
mullions

Figure 6.35

Adding another grid

Figure 6.36

Removing portions 
of the grid and 
applying mullions
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	 C.	 Name the mullion type. In the Type Properties, change the thickness to the new 

value to 8″ (200 mm) and the two parameters for width (this represents half the 

width of the mullion) to 1.25″ (35mm). Figure 6.37 shows the finished exterior 

mullions.

The result shows thicker mullions on the border 

of your curtain wall.

Curtain mullions are usually rectangular, and 

you can make new types of different sizes on the fly, 

as shown in the previous exercise. However, not all 

mullions are simple rectangles. With Revit, you can 

use complex profile shapes as extruded mullions. 

Mullion profile families can be made with the 

Family Editor.

The default library provides some mullions that 

use custom profiles. To use these, load them into your 

project, duplicate an existing mullion type, and set 

the type parameter profile to one of the newly loaded 

profiles. A list of available 

profiles loaded into the 

project appears in the field 

shown in Figure 6.38.

Curtain Panels
Curtain panels fill the space between the curtain grids or between the mullions. These 

elements are created in the Family Editor using the Curtain Panels family template. You 

can create a new curtain wall panel any time by going to the Application menu and 

choosing New ➔ Family  and from the list of Family Templates, select the Curtain Wall 

Panel.rft. The Revit default project template has a couple of curtain panels preloaded for 

you: System Panel Glazed and System Panel Solid.

You can duplicate different types of these families and change the material, thickness, 

and offset to customize the appearance.

By default, Revit applies glazed curtain panels as panels for the curtain wall. Using the 

method explained earlier, select one of the curtain panels and use the Change Element 

Type command to open the Type Selector and select System Panel Solid. Your curtain 

wall panel will look like Figure 6.39.

Figure 6.37

Applying a thicker border mullion

Figure 6.38

Modifying the 
mullion profile In reality, curtain-wall mullions can have complex internal details from a manufacturing per-

spective. Many curtain-wall manufacturers provide DWG details showing the actual manufac-

tured look of the mullions. You’ll probably want to show more of those details when you do 

detailed drawings.
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Doors and Windows in Curtain Walls

Curtain walls can host specially designed doors and windows. Keep in 

mind that standard doors and windows cannot be hosted by a curtain 

wall. These specially designed curtain wall elements are recognizable 

by their name, indicating that they are curtain wall doors or windows 

and that they schedule as doors and windows, but that their behavior 

is dependent on the curtain wall. Curtain-wall doors and windows 

adapt their width and height to fill in grid cells. Essentially, they 

behave exactly like panels — they’ve just been made to appear and 

schedule as doors or windows.

To insert a door within a curtain wall, you will first need to load 

one in your project: in the Build panel of the Home tab, expand the 

Component button and choose Place a component. From the Model 

panel, select Load Family. Navigate to the Doors folder, and select a 

Curtain Wall Door (Single or Double). After loading the curtain door 

family, tab-select a curtain panel you want to exchange with the door. Then 

click Change Element Type and select the loaded door family. A door is added to the 

curtain wall, as shown in Figure 6.40.

Parametric Behavior
You can edit the profile shape of a curtain wall, just like a basic wall. 

Select the curtain wall assembly (make sure you cycle with the Tab key 

until you select the entire assembly represented with dashed lines) and 

click the Edit Profile button in the Modify Wall panel to start editing 

the sketch outline of the wall. Follow these steps:

	 1.	 Select the curtain wall you created in the previous steps.

	 2.	 Click the Edit Profile button in the Modify Wall panel. You will 

be switched to a Sketch mode in which the outer shape of the 

curtain is represented as a sketch of connected lines. Change the 

sketch similar to the final image shown in Figure 6.41.

	 3.	 Switch to 3D view.

	 4.	 The resulting curtain wall should look like the one in Figure 6.41.

Figure 6.39

Changing a 
panel within the 
curtain wall

Figure 6.40

A curtain wall with 
an inserted door

Be sure you make the distance between gridlines or between mullions reflect a standard 

door size. You can do this before or after the placement of the door. The curtain wall is highly 

parametric, so changes are allowed at any time during the design process.
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To prepare for the next exercise, undo this last profile edit.

Attaching the Curtain Wall to a Roof

Curtain walls have a highly parametric relationship with other modeling elements. Like 

a basic wall, when a curtain wall is attached to a roof, it maintains its connection 

to the roof as the roof shape adjusts. To see how this works, start a new ses-

sion of Revit and follow these steps:

Figure 6.41

Editing the curtain 
wall profile

	 1.	 Draw four generic walls on Level 1, similar to the ones shown in 

Figure 6.42.

	 2.	 Add a Roof by Footprint on Level 2, picking all four walls with the 

Tab key. By default all four sides will have slope assigned.

	 3.	 While still in Sketch mode, select one of the sketch lines and on 

the Options bar uncheck the Defines Slope option for it. Repeat 

the same for the opposite side of the roof sketch. Finish the sketch. 

This will generate a gable roof. 

	 4.	 Switch to 3D view.

	 5.	 Change one wall to the Curtain Wall: Storefront type by selecting it and clicking the 

Change Element Type option.

	 6.	 Tab-select all four walls, and attach them to the roof using the Top/Base Attach but-

ton located in the Modify Wall panel of the Modify tab.

	 7.	 Select the roof and drag the blue arrow on the top to make the roof pitch higher. The 

curtain wall automatically readjust its size and shape to accommodate the change, as 

shown in Figure 6.42.

Figure 6.42

Curtain wall 
conforming to roof 

changes
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Curtain walls can also use standard wall types in lieu of panels. Using the same 

method described previously, select a curtain panel and exchange it with a basic wall 

using the Channel Element Type tool.

Complex Curtain-Wall Panel Possibilities 
Look at the complex-shaped curtain panels in Figure 6.43. You may think, “Oh, I can 

never do that!” Well, Revit can help you do it — and do it easily. To be fair, you’ll need to 

have some mileage in using Revit before you can create such a curtain wall. But isn’t it 

inspiring to look at all the possibilities that you’ll be able to master one day?

The creation principle behind any of these types of curtain walls is the same as we just 

reviewed. All that differs is the geometry of the curtain panel.

The curtain walls in Figure 6.44 were created with curtain panels that — instead of a 

standard rectangular solid shape — are made of a solid extrusion that is perforated with 

four corner openings. An additional solid geometry represents one quarter of the spider 

clamp. Put all together, it creates a powerful, fully parametric curtain wall!

It’s really important to make the wall higher (or lower) than you need and attach it “down” 

to the roof or “up” to the floor. This prevents hosted elements from getting lost if the wall 

becomes detached. For example, suppose a 10′ wall is attached to the roof 100′ above Level 

1. Windows and other hosted elements are then placed in the wall throughout the eleva-

tion. Then someone deletes or modifies the roof so that the wall becomes detached. All the 

hosted elements are deleted as well. Very bad.

Figure 6.43

A complex curtain 
wall designed 
in Revit
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Roofs and Floors: Advanced Shape Editing
No flat roof is ever really flat! And Revit is equipped with smart tools that allow for 

tapered insulation over a flat roof and similar conditions. A rich set of shape editing tools 

for roofs and floors help create and modify such conditions in no time. These powerful 

tools are modifiers that are applicable to roofs and floors and will allow you to model 

concrete slabs with multiple slopes, often referred to as warped slabs (see Figure 6.45).

The set of tools available for editing floor and roof shapes are called Shape Editing 

tools and are available in the Shape Editing panel of the Modify Floors tab upon selection 

of a floor.

Figure 6.44

A spider-clamp 
curtain wall

Figure 6.45

Sloped roof with 
drainage
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Here is what each tool is meant to do (left to right):

Modify Sub Elements  ​This tool allows you to direct edit element geometry using selection 

and modification of points (vertices) and edges.

Add Point   ​This tool allows you to add points on the top face of a roof or floor. Points can 

be added on edges or surfaces. 

Add Split Line   ​This tool allows you to sketch directly on the top face of the element, 

which adds split lines to the floor and roof so that hips and valleys can be created.

Pick Supports   ​This tool allows you to pick linear beams and walls to create new split 

edges at the correct elevation automatically.

As you will see, once any of these modifiers are applied to a floor or roof, a new Reset 

Shape button appears in the tab. When you click it, this button will remove all modifiers 

applied to the floor or roof that you have selected.

Sloped Roofs
Let’s do a short exercise that shows how to make a sloped roof like the one in Figure 6.46 

(shown in plan view).

Follow these steps:

	 1.	 Open Modifying Roof Shape start.rvt from the book’s companion web page  

(www.sybex.com/go/masteringrevit2010). 

	 2.	 Select the roof that has already been prepared for you.

	 3.	 From the Shape Editing panel, click the Add Split Line tool (note that the color of the 

rest of the model grays out while the roof lines are dashed green).

	 4.	 Sketch ridge lines to divide the roof into areas that will be independently drained. 

The ridge lines will be drawn in blue color.

	 5.	 Using the same tool, draw diagonal lines within those areas to create the valleys. 

Zoom in closely when drawing the diagonal lines to be sure that you are snapping in 

the exact same diving points. (If you notice that you have not snapped well, select the 

Modify Sub Elements tool, delete the incorrect segments, and try again.)

Figure 6.46

A roof plan showing 
a roof divided in 
segments, with 
drainage points
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You have split the roof surfaces into many subfloors, but they are still all at the 

same height and inclination. You should have a roof that looks like Figure 6.47. Press 

Esc to stop the editing mode.

	 6.	 Switch to a 3D view.

	 7.	 To add a slope, you need to edit the height of the drainage points. Tab-select the 

crossing point of the diagonals. New controls that allow you to edit the text appear, 

and you can either move the arrows up and down or type in a value for the point 

height. As shown in Figure 6.48, type in –0′5″ (–13 cm).

	 8.	 Repeat steps 1–7 for all three drainage points.

	 9.	 If you need to move the point to another position (perhaps to accommodate what’s 

happening in the room below the roof), select the point and drag it, as shown in 

Figure 6.48.

	10.	 Make a section through the roof — if possible, somewhere through the drainage 

point. Open the section; change the detail level to Fine to see all layers. The entire 

roof structure is now sloped toward the drainage point, as shown here:

Figure 6.47

A roof plan showing 
a roof divided in 

segments, with 
drainage points

Figure 6.48

Drag the drainage 
points to change 
their height or type 
in a new value in the 
numerical field
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What if you wanted the insulation to be tapered but not the structure? For that, the 

layers of the roofs can now have variable thickness. Let’s see how to apply a variable 

thickness to a layer.

	 1.	 Select the roof, and navigate to its type properties to edit its structure.

	 2.	 Activate the preview. You will notice that in the roof structure preview, you do not 

see any slopes. That is correct and will not change. This preview is just a schematic 

preview of the structure and does not show the exact sloping. Look for the Variable 

column under Layers (see Figure 6.49). This allows layers of the roof to vary in thick-

ness when slopes are present. Check Variable for the insulation material.

	 3.	 Go back to section view and take a look at the difference that this change pro-

voked. As you can see here, only the insulation is tapered now, while the structure 

remains f lat:

Figure 6.49

The Edit Assembly 
dialog box for the 
roof structure
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Warped Surfaces
Warped surfaces can also be created using this tool. Using the Roof by Footprint method, 

draw a flat roof (no slopes) and then select the roof. Using the Modify Sub Elements tool 

from the Shape Editing panel, you can start moving edge points up and down (Figure 6.50).
Figure 6.50

Warped roof
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Working with Other Applications

Now that we have developed  a language for working within 

Revit, let’s look at how you can use it to work and communicate with others. The build-

ing industry is a complex organism with many moving parts and participants. Partners, 

consultants, contractors, subcontractors, and owners are all involved in the process and 

need the ability to exchange vital design information. Because of the robustness of infor-

mation within the Revit model, it’s possible to do things with data that weren’t possible 

with basic 2D drafting. Even so, data exchange with other applications is still a require-

ment. Revit provides tools to import and export a wide range of information.

In this chapter, we’ll show you how to export your Revit model in forms that others  

can read and how to import information that is relevant to your project from other 

sources. We’ll first review all the possible export and import file formats, and then we’ll 

dig into more detailed use cases. Topics we’ll cover include:

Exporting your data■■

Exporting DWG drawings■■

Importing and linking ■■

Working with imported files■■

Working with civil engineering DWG files■■

Converting 2D drawings into a 3D BIM model■■

Starting a new project■■

Starting a model from a scanned drawing■■
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Exporting Your Data
You can find the Export options under the Application menu R ➔ Export. Revit offers sev-

eral export formats depending on the format and type of data you want to export.

Here’s a list of the types of files that Revit can export using information from the Revit 

model:

CAD formats•	

DWF•	

Building Site•	

Images and Animations•	

Reports•	

FBX•	

gbXML•	

IFC•	

ODBC Database•	

At the end of the Export file list you will also find an Options button—here you will 

find exporting options relevant to exporting Revit categories to layers (DWG or DGN) as 

well as an IFC mapping file.

CAD Formats
Export CAD Formats lets you export a view or sheet of the model into a 2D or 3D CAD 

format. The following CAD file formats can be exported directly from Revit: .dwg, .dxf, 

.dgn, and .sat.

DWG

DWG refers to the original patented Autodesk exchange format, RealDWG. DWG has 

been the established standard for exchange of digital data in the construction industry 

for the last 20-plus years. Revit can export a part of or an entire project, collections of 

sheets and views, or any individual sheet or view to the DWG format.

Revit exports views to DWG in two different manners: it exports a 2D DWG drafting 

format (from a majority of the views) and 3D DWGs (from the 3D views). The 3D DWG 

exports can be viewed in a 3D environment in AutoCAD or any other application that 

reads DWG. When exporting to DWG, some of the metadata (property information) of 

elements is also exported and can be read within AutoCAD.

Exporting DWG files is discussed in more detail later in this chapter (see “Exporting 

DWG Drawings”).
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DXF

Data Exchange Format (DXF) is an open format for storing vector data supported by 

many CAD applications. DXF is regarded as a legacy standard and is almost out of use 

in the industry. However, in some parts of the world or with some strongly established 

practices, it still finds its use, and for those reasons Revit supports exchange with DXF. If 

you haven’t used DXF files in the past, be careful exporting 3D data to DXF. A file can get 

very large very quickly!

DGN

DGN is the name used for CAD file formats supported by Bentley Systems’s MicroStation 

and Intergraph’s Interactive Graphics Design System (IGDS) CAD programs. Note that 

Revit supports export to DGN file formats only up to MicroStation V7.

SAT

SAT stands for Standard ACIS Text and it’s a format for ACIS, a solid modeling technol-

ogy supported by many design applications. ACIS can store modeling information in 

external files called save files. These files have an open format so that external applica-

tions, even those not based on ACIS, can have access to the ACIS geometric model. Revit 

exports to version 7 of SAT. 

DWF
The DWFx format allows you to share your project documents with others who do not 

own or know how to use Revit but need to examine or review your design. DWF files are 

a way to share rich geometry and metadata while maintaining ownership of the intellec-

tual property in your files. The exported DWF files are small, which makes them easy to 

email, something you cannot do with a large Revit file. 

You can export to DWF any view/sheet in Revit, regardless of whether the contain-

ing information is 3D or orthogonal 2D views. To export your active view, simply open 

the Application Menu and choose Export ➔ DWF. The DWF Export Settings dialog 

box (Figure 7.1) will open and let you choose which views/sheets to export. The default 

is your current view. After selecting what you wish to export, give your file a unique 

name and save it. The recipient of the DWF file can then open it with Autodesk® Design 

Review, free to download from www.autodesk.com, to see the result and make any further 

comments and markups as you review the files. 

You can also publish the exported DWF files directly from Revit to Autodesk® 

Buzzsaw®, a free, integrated, all-digital way to view, print, mark up, and compare ver-

sions of drawings, maps, and models—an on-demand collaborative project management 

solution for organization of construction-related documents. To access that option, go to 

the Application menu and select Publish ➔ DWF to Buzzsaw.
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Building Site
Sharing a rich 3D BIM model with other professionals can prove to be problematic because 

of its complexity and size. Depending on the professionals you need to share BIM geom-

etry and information with, they usually need just a subset of the rich information con-

tained in the BIM model but have little flexibility to control this on their end. 

To accommodate this, Revit 2010 has introduced a new smart way of sharing a BIM 

model made by architects using Revit with civil engineers using AutoCAD Civil 3D soft-

ware: the BIM model is shared in a way that’s simplified and relevant to civil engineers. 

With the help of this new functionality, you can export the following types of infor-

mation relevant to the civil engineers who work on developing the site around your proj-

ect and need a certain set of information about your building as a context for their work:

Building footprint and its area•	

Building location•	

Simplified 3D model•	

Roof, door, f loor, site, and utilities data•	

Project information•	

Building with appropriate level of simplicity•	

The Export Building Site functionality can be found in the Application menu, under 

the Export Building Site option. To make a meaningful export to a building site, you will 

need to make some preparations in your model. At a minimum you will need to have 

at least one gross area defined—the one that represents the building footprint. If you 

initiated the export to the building site without having defined a gross area, you will be 

Figure 7.1

DWF Export  
Settings dialog box
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prompted to do so. You should export as little data as possible and choose what will be 

most meaningful for the civil engineers. For example, there will be many doors in your 

project, so you will need to assign to the doors a Type property that defines whether they 

are exterior or interior and then filter out (turn off by type) the interior doors so that you 

export only the exterior doors to your civil engineers. The rest of the exported informa-

tion, such as the finished floor height, roof slope and area, and property line information 

will be reported directly from the parameters of your building elements. 

Once you select Export to Building Site, the Building Site Export Settings dialog box 

opens and informs you about your current export settings (Figure 7.2).

The exported file formats are new to the industry and announce new ways in smart 

interoperability with applications such as AutoCAD Civil 3D:

Civil Design Exchange File (•	 .adsk)

Civil Design Package File (•	 .adpx)

Images and Animations
It’s possible to export any of the views within Revit to an image file. You can also create 

walkthrough animations and animated solar studies in Revit and save them as .avi files. 

Figure 7.2

Building Site Export 
Settings dialog box
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Exporting Images 

To export a Revit view to an image file, open the desired view, and from the Application 

menu choose Export ➔ Images and Animations ➔ Image.

In the Export Image dialog box (Figure 7.3), many of the options are similar to the 

other export and printing functions. Export Range, for example, gives you the option to 

export either the current view or a series of views, similar to the Print dialog box.

The Name field allows you to browse to a path in any of your folder directories to  

place the image. By default, the image name is the same as the view name. Similar to 

the options available when printing, you can choose to exclude elements such as crop 

boundaries, scope boxes, and work planes. This will give you nice results without having 

to worry about turning categories on and off every time you want to print or export an 

image.

Revit can export any view or sheet in several image file formats: .bmp, .tif, .tga, .png, 

or .jpg. 

Cr eating     a B r owsab  l e W ebsite     fr o m t h e Re  v it  M o de  l 

When more than one view is selected for export to image, pick Selected Views/Sheets 

under Export Range, and an option becomes active in the Output section of the Export 

Image dialog box that lets you create a browsable website with a linked HTML page for 

each view, as shown in Figure 7.4.

Revit exports every view as an image and links to them with an HTML file, all pack-

aged neatly into a folder. This allows you (or someone else) to scroll through the project 

views quickly and easily.

Figure 7.3

Export Image  
dialog box
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I mage   S iz e

This section in the Export Image dialog box allows you to set the size of the exported 

image. You can either fit it to specific pixel dimensions or zoom the image to a proportion 

of its actual size. Keep in mind that this is a proportion of the view size, not the model. 

So, if your view dimensions are 10” x 10” (25 x 25 cm), and you’re zooming to 50 percent, 

your exported image will be at 72 pixels per inch (ppi) and 5” x 5” (10 x 10 cm), not at  

1:2 scale.

Fo r mat

This section in the Export Image dialog box allows you to choose your export file type 

from the list shown earlier in Figure 7.3. It also gives you the option to raise the pixels per 

inch (ppi) exported from 72 ppi to a higher density. The more ppi, the longer the export 

time will be, and the larger the final image file. As a general rule of thumb, use 72 ppi for 

images that will be viewed only on a monitor or screen. Use 150 ppi for images that will 

be sent to a laser printer and 300 ppi for any image printed by an offset press or when 

there’s a need for high-resolution imagery. Figure 7.5 shows an example of an exported 

image.

Figure 7.4

Browsable  
website page

This technique is practical when you create PowerPoint slides for a project presentation and 

need all views exported in image formats.
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Exporting Animations
To export a walkthrough, from the Application menu choose Export ➔ Images and 

Animations ➔ Walkthrough. You’ll find the Walkthrough tool on the View tab, in the 

Create panel under 3D View.

Revit lets you make animated solar studies, and those can also be exported as .avi 

files. To export an animated solar study, use the same location: from the Application 

menu choose Export ➔ Images and Animations ➔ Solar Study. Creation of solar studies is 

covered in Chapter 8.

ODBC Database Tables
You can export almost all the information embedded in your Revit model to an ODBC 

table. Doing so creates a link between your Revit file and another external database such 

as Excel, Access, FileMaker Pro, or SQL Server. ODBC gives you the opportunity to 

download data from any of the tables in Revit directly to a database using the Microsoft 

ODBC connector. An example of this functionality is a cost-estimating software add-on 

package that gets material quantity take-offs directly from the model.

ODBC is an advanced topic that we won’t cover in depth in this book. However, if you 

do need to export to a database, here’s how to use the Microsoft ODBC connector:

	 1.	 Open the file Station.rvt at the book’s companion web page, www.wiley.com/go/

introducingrevit2010.

Figure 7.5

Exported image
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	 2.	 Select Application menu ➔ Export ➔ ODBC Database (you will have to scroll the 

menu down—by default the ODBC Database export option might not be visible  

as it is at the end of the list).

	 3.	 Click New to create a new data source name (DSN).

	 4.	 Select a driver. This driver will normally be associated with the software program 

you export to, for example, Microsoft Access, dBase, or Paradox.

	 5.	 Click Next.

	 6.	 Type a DSN name, and, if necessary, navigate to the directory where you wish to save 

it. Click Next. A confirmation dialog box appears. If any information is incorrect, 

click Back and correct it.

	 7.	 Click Finish.

Next, create the database file:

	 1.	 Click Create in the ODBC Microsoft Setup dialog box.

	 2.	 Navigate to the directory where you’re saving the database, type the database name, 

and click OK.

	 3.	 Click OK in the confirmation dialog box.

	 4.	 Click OK in the ODBC Microsoft Access Setup dialog box.

You just created a database output out of your Revit model. If you chose Microsoft 

Access as a driver, you can open the .mdb file you created in Microsoft Access and view  

the database of all Revit elements in the project.

Reports

Schedules 

Revit will let you export schedule tables, view lists, material take-offs, key legends, and 

note blocks as a tab-delimited text (.txt format) file that can then be read by Excel or any 

other spreadsheet/database application. Note that none of the formatting created within 

a Revit schedule, such as column spacing or font style, will be maintained. To export 

to .txt, open the schedule you want to export, and from the Application Menu, choose 

Export ➔ Reports ➔ Schedules. To make an .xls file out of it, open the .txt file in Excel 

and save as .xls.

Room/Area Report 

Room/Area Report is a tool that creates a graphical and mathematical HTML report as a 

proof of the digital calculation of rooms in your project. Some authorities in Europe and 

Asia require these area reports as a part of permit documentation. Each room surface 
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is divided into basic geometrical shapes (triangles, rectangles, arc segments), and each 

shape is described with a name that, in the table, has the geometrical formula used to 

calculate area.

You have the option to report the window area as a percentage of the room area. To 

comply with certain standards in different countries, you can choose to exclude columns 

from the total room area calculations by making your columns non-room-bounding. 

This is done through the Element Properties dialog box of individual columns.

To create such reports, from the Application menu select Export ➔ Reports ➔Room 

Area Report, select the view or project, and define your graphic settings. You’ll receive an 

HTML page of the report. A sample report is shown in Figure 7.6. These reports are not 

parametrically connected with the Revit model. If you make changes in the model, you 

will need to re-create (re-export) the report.

FBX
The FBX is a  widely used and supported platform-independent 3D data exchange plat-

forms. It enables export of a 3D model and all the material definitions, so you can open 

the file in 3ds Max or other modeling/rendering applications and do more advanced ren-

derings and animations. All the materials assigned in the Revit model will translate 100 

percent into 3ds Max.

gbXML
Green Building XML (gbXML) is an XML data type that was created to support the 

growing trend of sustainability and green building design. As a data type specific to the 

building industry, gbXML is an export function within Revit and other BIM applications 

Figure 7.6

Room area report 
example
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that allows you to export specific data about a model for the purpose of performing 

energy analysis and evaluating building performance. A number of different applica-

tions are available that can read gbXML-formatted files. These applications are primarily 

designed around performing energy analysis using the Revit model as a basis. This saves 

a tremendous amount of time, allowing you to reuse your model geometry instead of 

re-creating it in another analysis application. Some of these energy analysis applications 

are Autodesk Green Building Studio (www.greenbuildingstudio.com), Autodesk Ecotect 

(http://ecotect.com), and IES <VE> (www.iesve.com). You can find more information 

on them at www.gbxml.org. (At the time of publication, these URLs are still correct, even 

though Autodesk bought the products.)

Improvements to the gbXML import in this release of Revit Architecture 2010 are as 

follows: 

Preview analytical model•	

Isolate individual rooms•	

Color code analytical surfaces•	

Review room warnings•	

Define energy data and project•	

To export to gbXML, go to the Application menu, choose Export, and select gbXML. 

The Export gbXML dialog box (Figure 7.7) will open, showing the analytical preview of 

your model and displaying all settings that are relevant to this export.
Figure 7.7

The Export gbXML 
dialog box
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Industry Foundation Class (IFC)
Industry foundation classes (IFCs) allow for exchange of intelligent data between archi-

tectural and downstream applications, based on the STEP application protocol. IFC is a 

nonproprietary file format that has been recently resurrected as a possible BIM interop-

erability standard. The goal is to allow the transfer of information between models that 

have been created using different BIM authoring packages. More information on IFCs 

and their current and future uses can be found at www.iai-international.org.

Revit Architecture 2010 supports first-stage IFC 2x-3 certification import and export. 

Revit also has full (second-stage) IFC Singapore Code Checking (BCA) certification, 

which is export only. IFC can be imported into any other BIM or CAD application that 

accepts IFC class files.

If you decide to use the IFC for import or export of data, there are a few items to keep 

in mind. Although multiple industries have made great advances with the IFC 2x-2 data 

exchange standards, no IFC file will be as robust as the parent file from which it was created. 

There will always be some data loss as you migrate your data to a more uniform data type.

Exporting DWG Drawings
DWG is the  exchange file standard in the AEC industry and is used by the majority of 

applications as a data exchange method. We’ll review some of the specific options and use 

cases for DWG exports.

In the majority of cases, you’ll need to export 2D DWG drawings for owners and con-

sultants or other engineers who are still not on a BIM platform, are not using Revit, and 

will work with the file directly or use it as an underlay. Let’s review all the options you 

should be aware of when exporting to DWG.

Select CAD Formats from the Export options, and you’ll see a dialog box like that 

shown in Figure 7.8.

You will notice that the dialog box has two tabs: the View/Sheet Set tab and the DWG 

Properties tab.

The View/Sheet Set tab
In the View/Sheet Set tab you can manage the sheet sets (add, remove, rename, and so 

on) or define what exactly will you be exporting. The latter is done in the Export drop-

down list (up to this release this functionality was described as Range). 

Export (Range)  ​The Range box in the Export dialog box allows you to select either your 

current view or a range of selected views and sheets. If you choose the latter, Revit opens a 

dialog box showing all of the views and sheets currently in the model. After you select the 

views or sheets you want to export, you have the option to name and save that selection 

so you can quickly export those same sheets again later on in the design process.
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Click the Export button to select to export to an AutoCAD 2010, 2007, 2004, or 2000 

file format (Figure 7.9). After you select an export file type, you have a few additional 

options.

Naming   ​This section allows Revit to name the file for you in a short or long format. 

Alternatively, you can name it yourself with the Manual option:

Automatic (Long Specify Prefix)  ​If you choose the Automatic (Long Specify Prefix) 

option, the Short format grays out the File Name text box and applies the view name 

or sheet name (depending on what you’re exporting) to each of the exported views. 

This option activates the File Name text box and allows you to put in a prefix for all the 

files you export. You can enter a project name, a date, or something else as a prefix. 

Figure 7.8

The Export CAD  
Formats dialog box

Figure 7.9

Export options
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Automatic (Short)  ​With the Automatic (Short) option, you can choose to add a short 

system-defined prefix or a long user-defined prefix to the export file.

Manual (Specify Name)  ​If you choose this option, you must name the exported file, 

because the Name field will be empty upon selection of this option.

XREF Views on Sheets  ​When you deselect this option, Revit combines each view on the 

sheet into a single file. This option is automatically deselected for DXF files and isn’t 

available for DGN or SAT files.

With this box checked, Revit exports each view on a sheet into a separate file and cre-

ates a cross-reference (XREF) to the files. If you’re exporting a single view, using this 

feature won’t make much difference, but if you’re exporting a series of sheets with a 

number of views on each sheet, this feature will have a very different effect. In this case, 

with the box checked Revit exports each sheet as a separate file as 2D vector-type views, 

and then those separate files are combined via XREF within a parent file. For example, if 

you start with a sheet with four views on it, five DWGs will be exported. With this option 

unchecked, the views and parent sheet will be a single file with all of the views in the 

drawing as blocks. In other words, the XREFs will be “bound” on the sheet. 

The second tab in the Export CAD Formats dialog box is the DWG Properties tab.

DWG Properties
The DWG Properties tab of the Export CAD Formats dialog box, shown in Figure 7.10, 

gives you some advanced options for exporting to CAD formats:

Layers and Properties  ​The Layers and Properties setting determines what happens to a 

Revit element if it has attributes that differ from those defined for its object style cat-

egory. In AutoCAD 2010 and in Revit Architecture 2010, view-specific element graphics 

are referred to as overrides. This option allows you to control how categories are exported 

and to specify their layer controls. The override options depend on the overrides you’ve 

set in the individual views you’re exporting. If no view overrides are defined in your 

exported views, this menu won’t change your export.

Linetype Scaling  ​This control sets your paper space line type setting in AutoCAD 

(PSLTSCALE) to either 1 or 0 or scales the line types by definition. This setting ensures 

visual fidelity between the line type scales used in Revit and those in the exported  

DWG file.

Coordinate System Basis  ​This option lets you choose between a project-internal or 

shared-coordinate system. It ultimately sets a 0,0,0 point for your CAD file based on the 

selected coordinate system (either by the internal project 0,0,0 point or by the shared 

coordinates between multiple project files).
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One DWG Unit Is  ​CAD packages typically deal with measurements in units, unlike Revit, 

which builds the model in real dimensions. This menu allows you to correlate export 

units with Revit data. You can specify the export units: inches, feet, millimeters, centi-

meters, or meters.

Solids (3D Views Only)  ​To export 3D solids, you need to have a 3D view active. Revit pro-

vides two types of solid exports: as Polymesh or as ACIS solids.

Export Rooms and Areas as Polylines  ​If you’re exporting area or room plans, checking 

this option means that in AutoCAD, the room and area bounding lines will be polylines 

rather than normal lines (the default option).

In previous releases of Revit, there were some additional options and advanced 

settings in this dialog box that now have been moved and are accessible from the 

Application menu under Export, at the very bottom of the list (Options). There you  

will find the following settings:

Export Layers DWG/DXF  ​Revit automatically maps categories and subcategories to precon-

figured layer names for export to DWG, and you can see those in this dialog box.

By default, the U.S. version of Revit shows an export list linked to the standard AIA 

layering schema. If you scroll down this list (see Figure 7.11), you’ll notice that you can 

define the layer name and color for each of the categories and some subcategories of the 

elements in your model. It’s important to point out that this list is dynamic. As you add 

Figure 7.10

The DWG Properties 
tab of the Export 
CAD Formats dialog 
box lets you access 
advanced options 
for exporting

The Shared option isn’t available for MicroStation files; only the Project Internal option is 

available for SAT files.
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elements and entities to the Revit model, this list will grow to include them as well as 

linked and imported CAD and Revit files. 

You can access a few preset export layer standards by clicking the Standard button. The 

predefined standards options are shown in Figure 7.12. Once you’ve gone through this list 

and specified the layers to which you want your Revit file to export, you can save the list 

to a separate .txt file to be used in other projects. Alternatively, you can load other .txt 

files into your project that have been exported from other projects.

In a default template file, go through the export list and modify it to suit your standard layer 

settings. Then, perform a Save As to a .txt file, and keep that as an export template for other 

projects.

Export Layers DGN  ​This option is available only when you’re 

exporting to a .dgn format. This means you can include a .dgn 

template file in the exported .dgn. Thus you can export to a 

MicroStation template file to control the levels at which objects 

and components export.

IFC Options  ​Before exporting a Revit project to IFC, you will 

need to make sure that Revit Architecture supports the desired 

IFC classes. Use this option to see a complete list of classes.

Figure 7.11

Export Layers  
dialog box

Figure 7.12

Export layer  
standards

73559c07.indd   240 6/4/09   8:04:27 PM



Importing and Linking  ■   241

Importing and Linking
Now that you know what you can export from the Revit model, let’s discuss the types of 

files you can import or link into Revit.

The import and link tools and options in Revit are located in the Insert tab and split 

between the Link panel and the Import panel 

(Figure 7.13). You select Import or Link depending 

of what your intention is and pick the option that 

corresponds to which file type you are importing or 

linking. 

You can both import and link the following file types:

CAD formats: •	 .dwg, .dxf, .dgn, .sat, and .skp files

Image formats: •	 .jpg, .bmp, .gif, .tif, and .pgn files

You can only link the following file types:

Revit: •	 .rvt files

Link DWF Markup Set: single- or multipaged •	 .dwf files

We’ll explore the uses of each of these options. However, before drilling into details, 

we want to make clear the distinction between importing and linking.

Linking
Linking creates a live connection to another file stored somewhere else. This allows you 

to work on the linked file separately and then have the Revit model update to reflect the 

changes in the link. This behavior is similar to an XREF in AutoCAD.

Linking CAD Formats

The ability to link one file into another can be helpful in a collaborative environment. 

Perhaps someone on your team—a person working on details within your office or an 

external consultant—is working in an AutoCAD environment while you build up the 

project in Revit. Linking lets you have her latest work updated in your Revit model. If you 

import without linking, you get a static file that will not update. When you link, it’s pos-

sible to always get the latest state of the DWG by updating the link within Revit.

Figure 7.13

Import and Link 
functionality 
located in the  
Insert tab

Revit can read one other very important file format: Industry Foundation Class (IFC) files. Up 

to this release, one could import IFC files through the File/Import command. In 2010, the 

location for this has been changed. To open/import IFC in an empty file, go to the Applica-

tion menu and select Open ➔ IFC.
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Switch to the Manage tab and, in the Manage Project panel, select Manage Links. 

Here you can reload, unload, import, or remove a CAD link or see what is already loaded 

(Figure 7.14).

Linking Other Revit Models

You can link other Revit files in your Revit project either for a large campus project where 

buildings are distributed among separate project teams or for one project that is being 

worked on by multiple teams in the same office.

When you’re working on a campus-style project that contains more than one building, 

consider making separate models for each building and later connecting them in one file 

via the linking method. Doing so gives you some flexibility to model individual build-

ings in individual files without the burden of the rest of the buildings, while still having 

the versatility to see the campus or building groupings in a file that combines all linked 

buildings. You can also cut sections or make elevations in which you can see all the 

buildings or schedule elements across all linked files.

When you’re doing campus-style projects, linking optimizes system performance. Working 

on several smaller files for individual buildings is less memory intensive than working on one 

large file with many buildings.

Another use of linking is for collaboration in a full BIM project team where the struc-

tural engineer is using Revit Structure and the mechanical, engineering, and plumbing 

(MEP) engineer is using Revit MEP. Using the linking methodology, you can view their 

Figure 7.14

Managing links
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models within yours. You can even select and read the properties of the structural or 

MEP elements from your model, although you can’t modify them.

In addition, these three discipline-specific BIM products—Revit Architecture, Revit 

Structure, and Revit MEP—incorporate tools that let you copy and monitor changes 

among linked models. This, however, is an advanced topic not covered in this book.

When you link two or more Revit models together, you’re linking more than just the 

model geometry. Linking Revit models allows you to do the following:

View the content of a Revit file that comes from another discipline (such as an engi-•	

neering drawing of the structure made with Revit Structure or a piping system made 

with Revit Systems). 

Combine scheduled elements of your building in a single schedule, regardless of •	

whether they come from the parent file or from linked files.

Control the visibility of what is displayed from the linked file or imported DWG files •	

in the linked file.

Schedule elements by link instance name so that if an element appears in multiple •	

instances of identical buildings, Revit can identify which instance comes from  

which link.

Dimension to or from elements and objects in the linked or parent file and establish •	

user-defined relationships and constraints between the two (such as the distance 

between a property line that is in the main file and the edge of the building that is 

linked).

Copy and paste elements from the linked to the parent file.•	

Control and change the visibility properties not only of the linked file but of the •	

nested links as well, without modifying the primary file.

Display nested links (a linked file in a Revit file that is linked into another Revit file) •	

in the host file in two different states: attach and overlay.

Bind a Revit link within the parent model (this is similar functionality to the Bind •	

option in AutoCAD: when using the Bind option, the Revit link turns into a group 

and becomes fully integrated in the host model).

Copy Revit links across documents.•	

Display areas and area boundaries in linked files, schedule them, and apply color fill •	

to rooms.

See linked as well as nested links in the Project Browser, where you can unload, •	

reload, open and unload, copy to another level by drag and drop, and access the 

Manage Links dialog box.
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Editing a Linked File

If you’ve linked a Revit file into your model, you cannot open that link file and start 

working on it in the same session of Revit. However, if you launch another session of 

Revit, you can open and edit the linked files. Each session of Revit will show up as a  

separate application running on your machine.

How to Link Files in Revit
To link an RVT file, go to the Insert tab and under the Link panel, choose Link Revit. 

The resulting dialog box looks like Figure 7.15. This dialog is a standard file-open format, 

with a few options specific to Revit: Open Worksets and Positioning. We’ll look at each 

option and explain what it means.

Positioning

The Positioning drop-down list provides options for linking the model. You can choose 

Auto or Manual placement methods, as shown in Figure 7.16.

The Auto placement options will do the following:

Center to Center  ​Aligns the 3D center points of both models.

Origin to Origin  ​Places the world origin of the linked file at the model’s ori-

gin point. If the linked model was created far from the origin point, linking 

with this option may put the linked file far away from the main model.

By Shared Coordinates  ​Places the linked file geometry according to the 

shared coordinate system created between the two files. If no shared coordi-

nate file has been created, Revit will alert you.

Figure 7.15

Import/Link RVT 
dialog box

Figure 7.16

Positioning options
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W h at A r e S h ar e d Co o r d i n at e s?

Every Revit project has an internal origin that can be related to other projects. When a 

project location is moved or rotated, this information is used to create relative positioning 

between files. Basically, a shared parameter is a user-defined origin.

Acquire Coordinates  ​Allows you to take the coordinates of the linked file into the host 

model. There is no change to the host model’s internal coordinates; however, the host 

model acquires the true north of the linked model and its origin point.

Publish Coordinates  ​Allows you to publish the origin and true north settings to your 

linked model. Revit understands that there may be other things in your linked file and 

you may not want this to be a global change to the linked file. An additional dialog box 

appears that gives you the option to name separate locations for each set of coordinates.

Specify Coordinates at a Point  ​Allows you to manually key in X, Y, and Z coordinates rela-

tive to the origin point or define where you want your 0,0,0 point to be.

Report Shared Coordinates  ​Shows the E/W (east–

west, or X), N/S (north–south, or Y), and Elevation 

(Z) coordinates of any point in the model (see 

Figure 7.17).

The Manual placement options for links do the following:

Cursor at Origin   ​Puts the origin point of the linked model at your cursor location.

Cursor at Base Point   ​Puts the base point of the document at your cursor location. This is 

primarily used for files that have a base point, such as CAD files.

Cursor at Center   ​Puts the 3D center of the building at your cursor location.

Open Worksets

Worksets are used to divide a model into user-defined groups so that a team of collabora-

tors can simultaneously work on the same Revit project. Worksets can be used to cluster 

chunks of a building together, and the Open Worksets option lets you choose which 

worksets to link in. This technique is practical when you’re working on big projects where 

performance may be an issue. By linking in only a subset of a linked file, you ensure that 

the graphical and memory resources are not taxed as much.

Importing or Linking CAD Formats
Site plans, consultant files, and details or drawings done with CAD technologies on prior 

projects all are examples of information you may want to link or import into Revit from a 

CAD format. This isn’t limited to 2D data; you can link 3D files and data as well.

Figure 7.17

Reported  
coordinates
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The data you import or link into your model can be view specific (imported and visi-

ble in one view only, as opposed to all views), so start by opening the view into which you 

want to bring data. In this release of Revit, the import and link of CAD formats is sepa-

rated into two commands located in the Insert tab: the Link CAD command is located 

under the Link panel, and the Import CAD command is located under the Import panel.

As discussed previously in this chapter, you can link or import five types of CAD files 

in 2D or 3D in Revit:

.dwg  ​Files made from AutoCAD or other applications that can export to this standard 

format

.dxf  ​Drawing Exchange Format files (most software packages write to a .dxf format)

.dgn  ​MicroStation native files

.sat  ​Standard ACIS text files (many modeling and fabrication applications can write to 

this file type)

.skp  ​SketchUp native files

Here are the most common use cases for importing CAD files:

To import contextual data about the project’s surroundings, such as streets and •	

buildings

To import a civil engineering file with your topography•	

To use CAD detail previously created for another project or directly dragged and •	

dropped from the manufacturer’s web catalog

To use Revit to continue a previous stage of the project that you did in CAD, building •	

a 3D model based on the 2D imported CAD file

To work with colleagues who deal with certain aspects of the project in another envi-•	

ronment (such as CAD drafters working on details or principals working on massing 

studies with SketchUp, Rhino, or some other modeling tool)

Import or Link – Pros and Cons

As explained earlier, there are some pros and cons to each option:

Linking  ​If you link a file, any changes made in that original file will be apparent in the 

Revit file in which it was linked. If your office or team workflow has personnel who are 

dedicated to working solely on details, they can continue creating and changing the details 

in AutoCAD, for example, and you can update the link to reflect the changes automati-

cally. You can also manipulate the linked file through the Manage Links dialog box (in 

the Manage tab, go to the Manage Project panel and select Manage Links).
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Importing  ​An import is not tied to the original external file, so you can explode the file 

and modify the CAD drawing directly in Revit. By contrast, you cannot explode or mod-

ify lines of a linked import. Once an import has been exploded, the import ceases to exist 

as a recognizable file but is reduced to lines and becomes a part of the main file. These 

lines are just that—lines, with no inherent intelligence. You can change their line type, 

thus changing their graphic appearance.

Regardless of whether you link or import a CAD file, you can always control the vis-

ibility of the lines in any view through the Visibility/Graphic Overrides dialog box. For 

linked files or CAD files that have been imported but not exploded, the lines appear in 

their own tab under Imported Categories. If the file has been exploded, the CAD lines 

are integrated into the model (in the case of files not linked with Current View Only) and 

appear on the Model Categories tab, under the Lines subcategory. If the CAD file was 

linked with Current View Only, the linework will become detail lines.

The Import and Link CAD Formats dialog boxes are identical and have some addi-

tional options to choose from to specify the import/link (Figure 7.18).

Current View Only  ​Selecting the Current View Only check box brings the linked or 

imported file only into the view that is currently active. It’s not always desirable to see 

your CAD files in all the views in your model. More often than not, you’ll want to select 

this check box. Remember, if you import with this unchecked, the file will be visible in  

all of your views, and you’ll need to manage its visibility via the Visibility/Graphic 

Overrides dialog or with view templates. 

One of the primary uses for importing CAD files is to use them as details in the Revit model. 

If possible, clean up your CAD file, eliminating all the unneeded linework, before you import 

it into Revit. We suggest cleaning up your CAD details in the native format first and then 

importing rather than exploding your details in Revit and then cleaning up lines.

Keep in mind that if you do need to see the CAD file in more than one view (but not every 

view), you can associate the linked file to a workset that is turned off by default in all other 

views. This will allow you to turn on the CAD file when needed.

If you’re importing a CAD file you want to use as a site, make sure you’re importing it into all 

views; otherwise, you won’t be able to convert it into a toposurface. It’s now possible to con-

vert any solid geometry created in other software packages into a toposurface.
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Layers  ​The Layers drop-down menu gives you the option to import or link in all the lay-

ers, only the layers that were visible at the time the CAD file was last saved, or a selected 

group of layers. (Layers are a DWG-based naming convention. Revit allows the same 

functionality with layers from DGN drawings.)

Layer/Level Colors  ​The default view background in AutoCAD is usually black. So, the col-

ors used in AutoCAD are easily visible on a black background. When you import a DWG 

file in Revit, which has a white background, many of the colors usually used in AutoCAD 

(yellow, light green, magenta, cyan) are difficult to read. Revit recognizes this issue, and 

in the Layer/Level Colors section of the Import/Link dialog box, it gives you the option to 

invert these colors into colors that are easier to read on a white background. It also gives 

you the option not to change the colors, if you prefer, or to convert them to black and 

white, which is Revit’s default approach.

Import Units  ​The Import Units drop-down menu lets Revit autodetect the scale at which 

the imported or linked drawing was created and convert it accordingly. Or, you can apply 

your own custom scale factor and type it in manually.

Positioning  ​This drop-down list is the same as the Revit Link dialog box but with the 

option to choose what level to place the link at in the Revit model and the option to ori-

ent the link relative to the view.

Importing Images
In every project, you’ll need to import an image—be it a photograph of the site and its 

surroundings; background information, such as scanned hand drawings of a historic 

building; or images that can represent advertising or marketing material (see Figure 7.19).

Figure 7.18

Link CAD Formats 
dialog box
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Courtesy of James A. O’Toole.

To import an image into Revit, switch to the Insert tab and, from the Import panel, 

select Image. Navigate to the appropriate folder, and choose your image file. You can also 

drag and drop an image file directly from Windows Explorer into a Revit view. Imported 

images are specific to the particular view you’ve imported them into.

Once you’ve inserted the image, you have a few options to edit its size and proportion. 

Selecting the image highlights the corner grips and lets you resize the image dynami-

cally. Doing so also highlights the Options bar. The Options bar allows you to push the 

image forward or backward or bring it all the way to the front or back. The Background/

Foreground selection tells the image that you want it above or below the model geometry. 

You can also change the shape of the image by deselecting the Lock Proportions check box.

Once you select an imported image, you can enable the Type Selector by clicking the 

Change Element Type button. The Type Selector will let you toggle between different 

imported images just as you would for any component family.

The Instance Properties dialog box shown in Figure 7.20 controls the same element 

parameters that appear in the Options bar when an image is selected but provides a 

bit more precision. From here you can set the exact size of the image in project units. 

Figure 7.20 shows how the image looks when the Draw Order property is set to Background.

Figure 7.19

Inserted image

Figure 7.20

Image proper-
ties and an image 
placed in the back-
ground of  
the model
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Working with Imported Files
You just learned how to import and export drawings with Revit, but now what do you do 

with them? In this section, we’ll explore the use of the various tools used to manage CAD 

files when they’re in Revit.

As we’ve discussed a number of times, Revit doesn’t build the model based on layers 

like other CAD packages do. Although layers offer an easy way to control the visibility of 

objects, they’re also the reason other software packages can’t guarantee quantities. Layers 

make it possible for an object to be duplicated on many layers and therefore appear more 

than once in the database. In Revit, every object can exist once and only once. As men-

tioned previously, Revit uses categories and subcategories for objects that exist in real life 

and uses annotation elements that describe them to control the visibility of what is pre-

sented where.

That may be good, but you work with—and need to exchange digital files with—

people who give you information in a DWG layers structure. Therefore, you need to give 

them layer-structured drawings. Revit can understand imported drawings with layer 

structures and can also export drawings with a customized layer structure. When you 

import a file in DWG or other CAD formats in Revit, you can do the following:

Turn layers on or off in imported CAD files•	

Change the default color of a layer•	

Delete a layer•	

Explode a DWG file so you can modify or delete elements from the imported file•	

Managing Layers
Once your CAD file is imported into Revit, either as a link or as an import, you can begin 

to manage the layers and colors of the CAD objects as they appear in Revit. To do this, use  

the Visibility/Graphic Overrides dialog box. You can access this dialog box in three ways:

Press VG on the keyboard.•	

Switch to the View tab and, from the Graphics panel, click the Visibility/Graphics •	

button.

Use the context menu by right-clicking in a View Properties •	 ➔ Visibility/Graphics 

Overrides ➔ Edit. 

If you import a CAD file into your view, Revit adds an Imported Categories tab to this 

dialog box. Selecting that tab, shown in Figure 7.21, gives you a list of all the CAD files 

imported into this particular view. Remember that this list is view specific; Revit changes 

the list as you add or remove CAD files from the model and from this view.

Selecting the check box next to the name of your CAD file displays a list of every layer 

present in the file. Use the check box in front of the layer name to control its visibility. 

Here you can also override the line color and pattern of the layer or turn it to halftone.
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Modifying a CAD File
Often, you’ll need to modify or delete some of the geometry in a CAD file that has been 

imported into Revit in order to simplify it and prepare it for use in your project. Let’s 

review how this works and all the options available. To start, open the view your DWG 

is imported into, and click the DWG to select it. Let’s take a look at the opened Modify 

demo and the Import Instance panel (shown in Figure 7.22).

Delete Layers

This tool lets you delete an entire layer from the imported file. With the DWG selected, 

click Delete Layer, and select from the list of displayed layers those you wish to delete. A 

sample dialog box with its associated layers is shown in Figure 7.23. As with most Revit 

dialog box lists, you have the option to select all or to select none as well as to invert the 

order of choices.

Explode

An imported DWG behaves as one entity when brought into Revit. If 

you want to modify any of the imported geometry in Revit, you need to 

perform an explode. Clicking the Explode button will give you the option 

to select which explode type you want to perform. 

Depending on what you wish to modify, you might 

choose to do a partial or full explode. Let’s review the 

differences between the two Explode types.

Figure 7.21

Visibility/Graphic 
Overrides  
dialog box

Figure 7.22

DWG Import 
Instance panel

Figure 7.23

Select Layers/Levels 
to Delete dialog box
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Pa r tia   l E xp lo de  

The Partial Explode option disassembles the imported file into the first and highest 

level of entities: blocks, attributes, unassociated lines, arcs, and circles. Blocks remain as 

blocks and aren’t converted to individual lines. In cases where you have blocks within 

blocks in your inserted CAD file, a first partial explode explodes the drawing, leaving the 

nested blocks combined. A second partial explode explodes the nested block, leaving the 

block within that block intact. A third partial explode turns everything into lines.

Fu l l E xp lo de

The Full Explode option disassembles the entity as well as any blocks or attributes and 

simplifies it to the lowest level of lines, arcs, texts, and hatches (filled regions). Note that 

Revit doesn’t allow linework or other elements smaller than 1/32” in length (0.8 mm). If 

you explode a CAD file with line elements shorter than these lengths, they will be deleted.

Given the fact that exploding DWGs can produce a multitude of elements that pollute the 

database and may affect the performance of the overall application, it’s strongly recom-

mended that you consider exploding only when you need to modify the imported DWG. As 

an alternative, consider using Partial Explode, which may be sufficient to achieve the desired 

modifications.

Query

The purpose of the Query tool is to find the attributes of individual blocks and layers 

without having to explode the DWG. After you import a drawing into a project, you can 

query the inserted object for information about entities contained in the drawing. After 

you click Query and click an entity, Revit first highlights the lowest-level entities. To 

select a block within the CAD file, use the Tab key to cycle through your selection options 

(see Figure 7.24).

Selecting an entity causes the following information about that block or line to be 

displayed:

Type  ​Information about the type of the entity selected (line, text)

Block Name  ​The name of the block that contains the entity, if applicable (N/A means 

“isn’t available”; the entity doesn’t belong to any block)

Layer  ​The name of the layer containing the entity

Style By  ​Indicates whether the entity style comes from the layer or is 

defined by color

These results are reflected in an Import Instance Query dialog box 

(Figure 7.25).

Figure 7.24

Query selection

Text query selection Block query selection
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To find out the property informa-

tion of the layer or instance, select 

the DWG, click the Query tool 

located on the Import Instance panel, 

and click the object or geometry that 

you want additional information 

about.

Once you have this information, you can do two things:

Delete the layer on which that instance belongs•	

Hide the layer in that particular view•	

Working with Civil Engineering DWG Files
Civil engineering plans are usually rich in data and information, not all of which is 

needed by architects. Architects constantly need to clean up civil engineering drawings, 

retaining only the data that is of importance to the architect for display in their drawings. 

Revit has a great way to import site information created by civil engineers in DWG file 

format and turn it smoothly into Revit topography.

Cleanup is one of the challenges when you import civil engineering data. DWGs have 

numerous layers on which different data is placed (roads, utilities, vegetation, and topo-

graphic information). You need to know which layers contain the topographic informa-

tion and select only those when creating the topography.

Another challenge is that the coordinate worlds of civil engineers and architects often  

differ. Creating a link between the two coordinate systems is important for a seamless  

workflow. Engineers typically orient their maps to the north, whereas architects either  

orient them in whatever way is the most practical to work with or lay them out horizontally.

Transforming DWG Site Info into Topography
In this exercise, you’ll transfer an imported DWG data into Revit and make it into a Revit 

toposurface:

	 1.	 Start a new drawing (go to the Application menu ➔ New ➔ Project).

	 2.	 Activate the site view by selecting Site in the Project Browser. 

Figure 7.25

Import Instance 
Query dialog box

Once you delete a layer, you can’t recover it from anywhere unless you use the Undo func-

tion or re-import the DWG.

To turn the visibility of a layer back on after using the Hide in View command, choose  

Visibility/Graphics ➔ DWG/DXF/DGN Categories.
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	 3.	 To import the DWG, begin by switching to the Insert tab, and from the Import 

panel, select Import CAD. Select the file provided on the book’s companion web 

page named SitePlan.dwg. 

Make sure you do not select the Current View Only option available in the Import 

dialog box, and click OK (see Figure 7.26).

	 4.	 Switch to the Massing & Site tab, and from the Model Site panel, select  

Toposurface.

	 5.	 Select Create from Import ➔ Select Import Instance. 

	 6.	 Remember that you need to import topography information into the site view. 

In Revit versions 9.1 and later, you have to import the site in all views. If you select the option 

Current View Only, you won’t be able to convert the DWG into a topography.

Figure 7.26

Importing the  
site DWG

Figure 7.27

Toposurface creation 
tools located in the 
Model Site panel

Figure 7.28

Select only the layers with contours when 
converting the DWG to a  toposurface.
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	 7.	 Open the Massing & Site tab, and from the Model Site panel, select the Toposurface 

tool. From the new content menu under the Tools panel, click Create from Import (Fig-

ure 7.27) and then choose Select Import Instance. Click somewhere over the DWG in 

your drawing area to highlight the site DWG. A dialog box (Figure 7.28) will open, and 

you’ll see a list of all the layers included in the DWG. You need to know the layers on 

which the topography information is stored and select only those layers. In this case, 

click Check None, and select the layers called 3D-CONTOURS. Click OK. A toposurface 

will be generated from the imported geometry. Click Finish Surface to complete the task.

After you select the correct layers, Revit will highlight the points on the contours, 

and your drawing will appear as shown in Figure 7.29.

	 8.	 Select Finish Surface from the Create Topography Surface tab. You’ll see the image 

shown in Figure 7.30.

Now, this might be very confusing, as Figure 7.30 doesn’t look much different from the 

DWG you started with. Switch to a 3D view, and activate the shaded view. Now you can 

see the topography you’ve created (see Figure 7.31).

Should you fail to do this and select all layers, Revit will probably fail to create a toposurface.

If you don’t have a convention of layer naming with your civil engineer, and you’re unsure 

which layer your contour lines lie on, you can find out by toggling various layers on and off 

using the Visibility/Graphics dialog box.

Figure 7.29

Highlighted topog-
raphy points
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The default material for the topography is Site – Earth, as defined in the Object Styles 

dialog box shown in Figure 7.32.
Figure 7.30

Finished toposur-
face in site and  

3D view

Figure 7.31

Shaded toposurface
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If you want to change the material of the topography, select the topography and click 

the Elements Properties button. In the Instance Properties dialog box, under Material, 

choose another material (try Site – Grass). The topography will turn green.

If you want to change the default material of the topography, switch to the Manage 

tab, and under Settings select Object Styles. In the Object Styles dialog box, change the 

default material for the Site category.

You’ll notice that there are many 2D lines on your toposurface that you don’t need. 

Those come either from the contour lines from the imported DWG or from the Revit 

toposurface primary and secondary contours. Revit allows you to control the visibility  

of those separately using the Visibility/Graphic Overrides dialog box.

Open the Visibility/Graphic Overrides dialog box, scroll to the Topography Model 

Category node, as shown in Figure 7.33, and uncheck all subcategories of Topography. 

You have thus made the primary and secondary contours of the topography invisible in 

this view.

Now, switch to the Imported Categories tab, and uncheck the entire imported site. To 

uncheck all the subcategories at once, you can deselect the parent heading, as shown in 

Figure 7.34. Click OK. Doing this should remove the now-unnecessary DWG line work  

of the site so it looks much better: You now should see a nice, smooth topography covered 

with grass.

Figure 7.32

Object styles for 
topography

All the site-related materials are listed under Site in the materials table found in the Manage 

tab, in the Project Settings panel ➔ Materials. In that list, Earth is labeled as Site — Earth, grass 

as Site — Grass, and so on.
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Figure 7.33

Visibility/Graphic 
Overrides for  

topography

Figure 7.34

Visibility/Graphic 
Overrides for 

imported files
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Other Ways to Create Topography
There are two other ways to create topography in Revit besides using an imported DWG:

You can create a toposurface using an imported points file.•	

You can create a toposurface from scratch.•	

Importing a Points File

You can automatically generate a toposurface based on a points file. A points file is a list 

of points described with their X, Y, and Z coordinates. It must contain X, Y, and Z coor-

dinate numbers and be in a comma-delimited file format (.csv or .txt). If you receive a 

points file from a civil engineer, you can view it in Notepad or Microsoft Excel. Here is an 

example of creating a toposurface from a points file:

To create a toposurface from a points file, follow these steps:

	 1.	 Switch to the Massing & Site tab.

	 2.	 From the Modeling Site panel, select the Toposurface tool.

	 3.	 From the Tools panel, expand the Create from Import button and select Specify 

Points File. 

	 4.	 In the Open dialog box, select the Points.csv file from the book’s companion web 

page under Chapter 7. (Note that only .csv and .txt file formats are recognized.)

	 5.	 On the Format tab, set the units in which the points file needs to be imported (see 

Figure 7.35).

	 6.	 Click the Finish Toposurface button. Figure 7.36 represents an editable toposurface 

in Revit and the completed toposurface.

Figure 7.35

Setting the unit 
format

Depending on the file you import, after the import you may not see anything on the screen. 

This means your site is outside of the crop region predefined for the site. To find your site, 

deactivate the crop region and choose Zoom to Fit All to find the site.

Figure 7.36

Left, an editable 
toposurface; right, 
the finished  
toposurface

73559c07.indd   259 6/4/09   8:04:30 PM



260  ■   Chapter 7: Working with Other Applications

Creating Topography from Scratch: Drawing Points

When you don’t have any civil engineering data to import and convert to topography but 

you do have a paper drawing with points information, you can create your toposurface  

by drawing points and defining their heights. Revit will create a smooth toposurface out 

of them.

	 1.	 Create a new project and switch to a site view.

	 2.	 Switch to the Massing & Site tab, and from the Create Site panel, click the Toposur-

face button.

	 3.	 From the Tools panel, select Place Point.

	 4.	 Start drawing points that define your site contour. (Try it with four points to start 

with, as shown in Figure 7.37.)

	 5.	 Revit closes the points into a loop.

If you don’t change anything and just draw four points, all points have the same 

elevation of zero (Z coordinate = 0). You can give them a height coordinate during 

the drawing by typing their elevations in the Options bar ( ).

Alternatively, after you’ve defined the shape in plan view, you can start reselecting 

and defining elevation coordinates. For the moment, leave the four initial points at 0.

	 6.	 Without finishing the toposurface, draw an additional four points, select them all, 

and change their elevation to 20” in the Options bar (see Figure 7.38).

	 7.	 In the Surface panel, select Finish Surface. Revit will grade the distance between the 

elevations with contour lines, as shown in Figure 7.39. If you zoom in, you’ll notice 

that some lines are stronger and some are lighter. Those that appear stronger are the 

primary contours. The lighter ones are the secondary contours.

Figure 7.37

Creating your own toposurface from points

Figure 7.38

Adding contours to a toposurface
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	 8.	 From the Quick Access toolbar select the 3D icon to switch to 3D view, and from the 

View toolbar activate the shaded view or click the shortcut SD (Figure 7.40).

As with any other preset, you define the distance at which the secondary contours are 

placed: switch to the Massing & Site tab and expand the Modeling Site panel (click the 

little arrow on the right of the panel). You will get the Site Settings dialog box shown in 

Figure 7.41. 

In this dialog box, you can also define or change the material that appears in sec-

tion when the toposurface is cut. It’s also where you can control the height in elevation 

where the base of the toposurface begins to show in section view—if you make a section 

through the site, you should see what’s shown in Figure 7.42.

Figure 7.39

The graded toposurface

Figure 7.40

Completed toposurface

Figure 7.41

Site Settings

Figure 7.42

A toposurface in section
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The default settings place the primary contour lines at 10’ (3 m) intervals. If you 

change that to 5´ (1.5 m), you’ll see a site similar to that shown in Figure 7.43.

Notice the placement of the secondary contour lines. Revit’s default settings place 

them at 1´ intervals. Change that to 2´ and note the differences in the contours displayed  

in the model (Figure 7.44).

The contours can also be labeled to indicate their elevation. To label the contour eleva-

tions, switch back to site view, select the site and from the Massing & Site tab, under the 

Modify Site panel select Label Contours ( ), and click two points as if to create a sec-

tion through the topography. Figure 7.45 shows what you’ll see. Note that the contour 

labels are always inserted perpendicular to the slope of the site.

As with everything in Revit, you can edit the topography at any point 

later in the process. To do so, select the topography so that it becomes 

red, click the Edit Surface button on the Surface panel, and modify the 

site as needed.

All three of the methods described show you how to create a toposur-

face in Revit. Of course, creating the toposurface is only the beginning. 

You still have to position your building at the correct location and eleva-

tion, create a pad for the building to sit on, and position the parking lot, 

the walkways, and other contextual features (Figure 7.46). Dealing with 

site tools, however, is a more advanced topic that won’t be covered fur-

ther in this book.

Figure 7.43

Toposurface with 10’ primary contours

Figure 7.44

Toposurface with 2’ secondary contours

Figure 7.45

Toposurface with 
contour labels
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Converting 2D Drawings into a 3D BIM Model
Often when you are working on a project, you will already have 2D plans, sections, and 

elevations that you wish to use as a base to create a 3D building information model. Or, 

perhaps, when you first started to work on the project, you created DWGs. Maybe your 

firm has just started using Revit, so the project was begun in AutoCAD; or maybe you’re 

working with an existing building created by another architect. In all of these cases, Revit 

offers you the flexibility to incorporate legacy material in your model.

The development and adoption of intelligent software means that someday redrawing 

will no longer be a necessity. Revit offers ways to maximize the reuse and referencing of 

existing data. Converting existing DWGs so they can be used in a Revit model isn’t ter-

ribly complicated and avoids the need to retrace entire drawings.

You can create Revit objects three ways:

Drawing•	

Picking references (lines) out of which the object can be created•	

Picking a face (this is an advanced topic not covered in this book)•	

These buttons are available in the Draw panel of any element you wish to create. Let’s 

analyze the first two approaches.

The default mode for all Revit tools that require you to draw something is the Drawing 

mode. You can draw the shape of the object that will be created using standard drawing 

options. 

Figure 7.46

There’s a long way 
to go from topo-
surface creation to 
finished site

73559c07.indd   263 6/4/09   8:04:31 PM



264  ■   Chapter 7: Working with Other Applications

The second option, denoted with the arrow symbol, is Pick Lines. Instead of manually 

drawing, this option gives you the ability to create elements by picking references. This 

means you can pick (and thus convert) any line of an imported drawing into an object. 

Note that the original line remains available.

Using a 2D DWG floor plan as starting point for generating a 3D BIM model is best 

explained using a concrete example, so let’s do an exercise. Figure 7.47 shows a series of 

2D AutoCAD files set on their corresponding levels in a Revit model and the 3D BIM 

model created from those plans and elevations.

Here’s our strategy for this approach. Import the DWG of each floor into the cor-

responding level/view in Revit. In the Import CAD Formats dialog box, select the 

Current View Only option (see Figure 7.48). Note that if you forget to select this  

option, your imported DWG will appear in every level, and that is not what you want. 

You want the First Floor DWG to be imported in Level 1 in Revit, the Second Floor 

DWG in Level 2, and so on. Thus, checking the Current View Only option is very 

important.

A tip before you start: AutoCAD drawings can be busy, containing a lot of information that 

isn’t always relevant or needed, and this can create visual clutter. When you want to quickly 

convert them to a 3D model, it helps to turn off the visibility of some of the DWG layers using 

Visibility Graphics/Imported Categories. Uncheck the layers you don’t need, such as dimen-

sions, text, hatches, and so on. Doing so will speed up object selection and facilitate the 

conversion process.

Figure 7.47

Converting  
2D CAD files  

to a Revit model

The completed Revit modelThe inserted CAD files

Figure 7.48

Using Current View 
Only during import 

of the CAD files
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Starting a New Project
Start by defining the number of stories (levels) that your building will have and giving 

the levels floor-to-floor heights. To do this, open a new project, go to any elevation view 

(let’s say south), and modify the project so it has three levels (if you’re opening the default 

Revit template, you’ll need to add one level). As we previously discussed, you do that by 

selecting the Level tool, drawing three levels, and placing them 10´ (3 m) apart.

You are now ready to import some DWGs into the corresponding levels. Follow these 

steps:  

	 1.	 Activate Level 1, and import the DWG Level 1 .dwg file found at the book’s compan-

ion web page in the Imports folder.

	 2.	 On Level 2, import the DWG Level 2 file.

	 3.	 Open a south elevation, and import the DWG Elevation South file.

	 4.	 After the import, you may get a notification that none of the imported elements are 

visible in this view. As previously mentioned, this means the import is somewhere 

outside the boundaries of the crop region. To remedy this situation, turn off the crop 

region. Zoom all, and you’ll find your DWG.

	 5.	 Reposition the DWG as needed using the Move command.

	 6.	 In the south elevation view, you will need to reposition the levels so that they match 

the level lines in the DWG import. (Level 1 matches with Level 1-A from the DWG, 

and so on. If needed, rename the levels to match the naming of the levels in the DWG 

drawing.)

Figure 7.49 shows approximately what the resulting 

drawing should look like.

Converting DWG Gridlines into  
Smart Revit Gridlines
Most of the floor plans that you have imported as reference 

drawings will have gridlines. Generating Revit gridlines 

from imported lines is simple: in the Home tab, from the 

Datum panel, select the Grid tool and set the creation 

method to Pick Lines in the Draw panel. Next, pick any 

gridline from the imported DWG. Revit will create a 

gridline on top of the DWG gridline and number it. Revit 

usually starts with the number 1, but if the DWG grid uses 

lettered coordinates, you can change the Revit gridline on 

the first one you create. The remainder will number (or 

letter) in incremental sequence, so they should append cor-

rectly. Otherwise, you can renumber them later. 

Figure 7.49

CAD files inserted 
into Revit
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B e war e t h e O f f -A x i s War n i n g

When using the Pick tool (for lines/walls/grids/etc.), it’s common to get the “(object) is slightly 

off axis” warning. If you get this warning, you should undo your work and draw/sketch rather 

than pick. If ignored, these warnings can result in many downstream errors that are very 

troublesome and nearly impossible to repair.

Figure 7.50 shows an imported DWG image. In the second image, the gridlines have 

been converted to Revit grids using the pick method. Note that the grid bubbles in Revit 

change dynamically with the view scale. If the bubble sizes don’t match, don’t panic—just 

check your scale factor.
Figure 7.50

The image on the 
top shows the view 

with DWG import; 
the bottom image 

shows Revit grid-
lines created using 

the import lines
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Working with Scope Boxes
If you have multiple floor plans where the gridlines aren’t the same for all levels, you need 

to use the Scope Box tool. This tool limits the range in which datums (grids, levels, and 

reference lines) appear, which by default is across the entire project and throughout all 

levels. Imagine that you have a building with a shopping center on the first three floors 

and a hotel tower above. The grid systems for the lower and upper parts of the build-

ing will be different, and you do not wish to see the grid system of the lower building in 

the floor plans of the upper building and vice versa. You need to create two scope boxes, 

assign the grids from the first three levels to one scope box and the rest to the other, and 

control the area covered by each scope box so they show up correctly. Figure 7.51 shows 

how scope boxes work in a 3D view.

Scope boxes are also visible in 3D views (although not in perspective views), and 

you can easily manipulate their extent directly using the grips. Assigning grids or other 

datums to a scope box is easy: select the grids, choose Element Properties, and in the 

Instance Properties dialog box under Scope Box select the scope box where the datums 

should belong. Figure 7.52 shows the Instance Properties dialog box for the grids and the 

associated scope box.

You need to convert CAD gridlines to Revit gridlines in one level only. Gridlines in Revit span 

the entire building because they’re datums that show up in every level. This is practical when 

the grid system is the same for each level.

Figure 7.51

Scope boxes can be 
seen in 3D
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Using DWG Lines to Create Revit Walls

In a 2D CAD application, walls are represented with two parallel lines. You can use one 

of these two lines as your reference line for creating Revit walls. Create a wall type that is 

the same thickness as the one used in the DWG. Select the Wall tool and from the Draw 

menu choose the Pick Lines option when placing new walls, and 

pick on lines in the import. Be sure to set the Wall Location line to a 

meaningful value (Exterior Core or Center Line, for example) to get 

correct alignment.

A rule of thumb when following this creation approach is to set 

your exterior and shaft walls’ top constraint to the top of the build-

ing and set your interior partitions to go up only to the next level. If 

you have repetitive floors with identical or similar floor plans, create 

the walls once, and then leverage the Copy and Paste functionality 

to repeat the walls.

Figure 7.53 shows the beginning of a Revit model created using DWG floor plans as a 

base. DWG wall lines were used as a reference to create the walls with the pick method, 

and the wall location line was set to the exterior face.

Using DWG Lines as a Reference to Create Revit Floors

After you create the walls, the next step is to create floors. To create floors, select Floor 

from the Build panel of the Home tab and select the Pick Lines from the Draw panel. 

Hover your cursor over the outer edge of the floor or walls and press the Tab key until the 

DWG floor lines are highlighted. Click to generate sketch lines. If the shape of the floor 

isn’t the shape you want, make corrections using the Edit tools. Remember, a sketch is a 

line drawing that has to form a closed loop so Revit can create an object out of it.

Figure 7.52

A scope box can be 
assigned to grids 

using the Instance 
Properties  
dialog box

Figure 7.53

Beginning  
the conversion  
process – DWG  

linework is used  
as reference to  

create Walls
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In Figure 7.54, the lines in the DWG that represent the outer wall faces have been 

selected, the magenta lines have been adjusted to a rectangular shape (using trim lines), 

and the floor has been created.

Once you have your wall and floor structure, it’s easy to start adding windows, doors, 

and other elements.

If your workflow permits, draw interior walls before you create the floors so that when you 

create a floor, it will be attached to the walls and have a relationship with them.

Figure 7.54

Creating floors from 
DWG linework
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Working with Imported Library Components in DWG Format
Autodesk’s i-drop technology allows you to drag and drop content (drawings) from the 

Web directly into a Revit drawing. This corresponds to the DWG import process and 

utilizes Revit’s default import settings. From a workflow perspective, it’s practical. As 

you work on your project, you can quickly go to the Web and search for a detail or piece 

of content in DWG format. Once you find what you need, you can drag and drop it into 

your Revit file.

Many manufacturers now have their content in i-droppable 2D or 3D DWG format. 

Figure 7.55 shows some sample i-drop content. 

Importing Library Components in SketchUp (.skp) Format
Another source of downloadable library components that can be useful in Revit is 

Google’s 3D Warehouse, which offers files in SketchUp (.skp) format. Revit can read SKP 

files, and you can import SKP files into an RFA (Revit family file) to create content. These 

families aren’t always parametric—many families don’t need to be parametric—because 

certain manufacturer content exists only in single dimensions and shapes. Figure 7.56 

shows some samples of SketchUp content.

The best way to utilize this 3D content is to create a new family (from the Application 

Menu, choose New ➔ Family) and select a family type, such as furniture or plumbing 

fixtures. You then can import a 3D SketchUp model into this family. If needed, you can 

quickly create simplified orthographic projections using the Linework tool instead of 

using a 3D object to generate those projections. This is useful if you need to show simpli-

fied versions of the 3D object in plan, elevation, or another orthogonal view. More details 

about family generation are covered later in this book.

You can learn more about 3D Warehouse at http://sketchup.google.com/3dwarehouse.

Figure 7.55

i-drop examples

Figure 7.56

Sample SketchUp 
content
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Starting a Model from a Scanned Drawing
There are various ways for an architect to start a project. We have reviewed two of them: 

starting from scratch and starting from an available 2D digital document (CAD file). 

However, you may have old paper documents of the building that you need to work on.

This happens a lot on smaller projects, usually restorations or additions. Architects 

may get a few floor plans and elevations that they need to redraw before starting a new 

project. Let’s review how you can use them as a basis to begin a new project.

You start by scanning the floor plan and importing it into Revit as an image in the 

level relevant to the drawing. Any of the image types we discussed earlier will work fine 

for your scanned image. An example of a scanned floor plan is shown in Figure 7.57. 

Follow these steps:

	 1.	 Import and position the scanned image into the appropriate level or view. So, if you 

have a first f loor plan, insert it into your Level 1 view.
Figure 7.57

An example of a 
scanned plan
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	 2.	 Scanned images are usually never perfectly orthogonal, so you need to rotate the 

image to square the lines of the walls. Use the Rotation tool from the Modify panel, 

and try to rotate the image as close to orthogonal as possible. To do that, select the 

image, click the Rotate button, and rotate the image. The rotated image is shown in  

Figure 7.58.

	 3.	 You need to verify the drawing scale or adjust the scan to fit the scale you’re working 

in. To do so, zoom in on the image, and find at least one wall that has a dimensioned 

length. In this example, the original drawing was done in metric units.

	 4.	 Still with the image selected and using the Scale tool ( ), also located in the 

Modify panel, measure the length of the wall. The tool prompts you to choose 

two points, and a temporary dimension will show up indicating the length (see 

Figure 7.59). Make your first two picks correspond to the length of the wall in the 

image, and then select a third point to resize the image. Use the temporary dimen-

sions to help visualize the change.
Figure 7.58

The rotated image
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	 5.	 Click the wall and then across to the right to the end of the wall. The wall length  

in the scan is 160 cm and measures 3,200 cm in the drawing. Bring your mouse  

back to the left, and watch the temporary dimension numbers get smaller (as  

shown in Figure 7.60). When they reach 160 cm, click again, and your image will  

be resized.
Figure 7.59

Scaling the  
scanned image

Figure 7.60

Finishing the  
image edits
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You can now start tracing over the imported image and create the framework for your 

project. Obviously, scanned drawings can never result in total accuracy, so you’ll prob-

ably want to field-verify your dimensions. However, this is a good way to get started. 

Figure 7.61 shows the project with all of the new walls located over the scanned image. 

You just scaled the drawing. If you dimension the piece of wall, it should show 160 cm.

Once you’ve finished referencing the scanned image, you can delete it or hide it in  

the view.
Figure 7.61

The scanned image 
with Revit walls 

traced over
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C hap te r 8

There are many points  in the design process where it’s necessary 

to convey your ideas to others. As architects, we use a wide range of representational 

techniques, from the loose napkin sketch to the photorealistic rendering. We use 2D 

diagrams to convey plans and sections, and perspective views to convey a more human-

scaled expression. This chapter will focus on a few techniques that you can use directly 

with Revit. We’ll look specifically at creating color-coded area plans, presentation tech-

niques for plans and sections, animated sun studies, and simple renderings that let you 

explore materials and lighting. Topics we’ll cover include:

Creating color-coded drawings■■

Creating presentation graphics■■

Using shadows and solar studies ■■

Rendering a perspective■■
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Color-Coded Drawings
In this section, we’ll discuss two common types of graphical documents: color-filled plans 

and sections. These types of views take advantage of a feature called color fill schemes, 

which allow you to assign colors to room and area parameter values and display them in 

the view.

Color fill plans and sections are basically standard views that are color-coded to repre-

sent room properties such as department, name, and usage. Area plans are used to convey 

building usage that extends beyond the shape and size of individual rooms, such as rentable 

area, office space, and circulation. While plans that are color-coded will appear under the 

Plans or Sections branch in the Project Browser, area plans have their own branch in the 

Project Browser, shown in Figure 8.1.

A color fill scheme is a fast, easy, and smart method for generating color-coded plans. It 

lets you apply color to room and area parameter values to help graphically illustrate spatial 

organization. For example, you may want to create a colored plan that represents units in 

an apartment complex, or show various departments in different colors (Figure 8.2) to dis-

tinguish space usage such as office, storage, and corridor. You may want to show the same 

information in a section view to see how your program is distributed vertically.

One of the benefits of using color schemes in Revit is that the colors dynamically adjust 

as changes are made in the model. If a new department is added, a new color is automati-

cally assigned, and the plan view updates immediately to reflect the change. Revit also 

makes it easy to change colors to match your aesthetic requirements if the autocolor isn’t 

what you want. You can apply color fills to plan view in two ways — by using the View 

Properties dialog box or by placing a room/area color fill legend into the view. Right-click 

in a plan view and select View Properties from the context menu. In the View Properties 

dialog box, you will see the Color Scheme setting, with the option to edit it. Click the Edit 

button, and the Color Fill Schemes dialog box opens. Here you can assign an existing 

scheme to the view or create a new one. The other option is to place a room/area color 

scheme into a plan or section view from the Room & Area panel on the Home tab.

Figure 8.1

Area plans branch in 
the Project Browser

Figure 8.2

Color-coded plan
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Defining a Color Scheme
Once you define a color scheme, you can apply it to multiple views in a project. Using the 

Transfer Project Standards feature, you can also transfer color schemes from project to 

project to maintain a consistent color palette across projects.

To define and edit color schemes, click the drop-down arrow in the Room & Area panel 

to expand it and select the Color Schemes option to launch the Edit Color Scheme dialog 

box, shown in Figure 8.3. This dialog box has a number of options to help you format your 

color scheme.

The right pane of this dialog box, labeled Scheme Definition, allows you to specify 

what information you want to color-code:

Title  ​This text box lets you name your color-fill legend. You will probably use the same 

name that you gave the scheme. The title is what appears in color-fill legends.

Color  ​This drop-down list allows you to choose the criteria by which you’ll color-code 

the view from a list of all the room properties. By default this goes to Department, but 

you will probably not have Department defined in your rooms, so change it to Name to 

see the effect.

By Value  ​This option is checked by default and uses the value defined in the Color field to 

list and sort the rooms. For example, if you color by Name, it will list all names used in 

the project alphabetically and assign a color to each unique name.

By Range  ​This is a second option (see Figure 8.4) for sorting a scheme definition and is 

only active when the color criteria are set to Area or Perimeter. In that case, this option 

sorts all the areas by size range (from–to), ranging from smallest to largest. This is practi-

cal when you need to see how well your project matches a program with specific area goals.

Figure 8.3

The Edit Color 
Scheme dialog box
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Let’s review some of the fields available when the option By Value is selected, as that 

will be what you will most often do.

Value  ​This is a noneditable field that displays a list of all the parameter values that will 

appear in your color-fill legend. By default, this column fills up with in-use values based 

on what is present in the model. You can add values to this list by clicking the Add but-

ton. This allows you to set some values and colors that can be used by rooms later in the 

design process. For example, if you had a common list of room names, you could fill out 

this table before starting to model anything, and then use the list when assigning names 

to rooms. 

After you select a row, you can adjust the order of the values using the up and down arrow 

buttons. The order established in this dialog box will be reflected in the color-fill legend.

Visible  ​Although all the names are reported in this dialog box, you may not want the leg-

end to show them all. This check box allows you to turn off individual values. This is 

likewise reflected in the color-fill legend.

Color  ​These colors are customizable and can be changed by clicking the Color button. 

You have the option to define CMYK, RGB, or Pantone values or to choose from the stan-

dard Microsoft color picker.

Fill Pattern  ​This option allows you select the fill pattern from any of the drafting patterns 

available. By default, Revit chooses the Solid Fill pattern. To add or modify fill patterns, 

go to the Manage tab, then choose Fill Patterns from the Settings panel.

Preview  ​This field gives you a visual preview of the color as it will appear on the screen 

in the view.

Figure 8.4

Color by Range
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In Use  ​This field tells you if the particular value is being used in the model. For example, 

if you add a value to the Value column but don’t add it to a room in the model, Revit 

returns “No” in this column. This comes into play if you add rooms to a room schedule 

but don’t add those rooms in the model. The color fill knows if rooms exist or not in the 

model. Note that only values that aren’t in use can be deleted. 

When the By Range option is selected, one more field is available: 

At Least  ​In the At Least column, you can change the minimum area to 1,000 square feet 

or whatever value you want to show. Revit automatically adjusts the colors in the view to 

reflect the changes for the color scheme.

In the lower portion of the right pane of the Edit Color Scheme dialog box (labeled 

Scheme Definition) are the fields shown in Figure 8.5 and described here:

Display Options  ​At the bottom of the dialog box, you can choose to include linked rooms 

so that linked Revit models will also be color-coded.

Color Fill Placement  ​In the view 

properties, you have the option to 

display the color fill in the fore-

ground or the background of the 

view. Displaying color in the 

background puts color beneath 

all model objects, whereas the 

Foreground option colors all 

model objects. Figure 8.6 illus-

trates this effect.

Figure 8.5

Color scheme 
definition

Figure 8.6

Displaying color fill

In background In foreground
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Adding a Color Scheme to a View

In this exercise, you’ll create a color-coded plan and add it to a view:

	 1.	 Open the Station_Start.rvt model found in the Chapter 8 folder on the book’s com-

panion web page, www.wiley.com/go/introducingrevit2010, and open the plan view 

called Level 3 Pres. 

	 2.	 Define a new scheme in which you’ll color the rooms and areas by name. To do that, 

open the Color Schemes dialog box, available when expanding the Room&Area 

panel in the Home tab. 

	 3.	 In the Schemes portion of the dialog box, click the Duplicate button located at the 

top. Name the new scheme Room Name.

	 4.	 In the Scheme Definitions section, give the scheme a title by typing Room Legend, 

then choose Name in the Color drop-down list.

	 5.	 The result will be a list of rooms sorted alphabetically by name. If you wish to change 

the order to be nonalphabetical, use the Move Rows Up or Move Rows Down button 

on the left of the list. These buttons become active when you click on any of the names. 

If you don’t like the automatically assigned colors, change the colors by clicking on 

the color field.

	 6.	 Click OK. 

	 7.	 Now that you are back in the view, select Legend in the Room & Area panel.

	 8.	 The legend shows up on your cursor. Position the color-fill legend somewhere close 

to the plan. You will be prompted to choose a color scheme; choose the scheme you 

just created and name it Room Name. The plan is automatically colored based on the 

names of the rooms in the plan view.

The Color Fill Schemes tool assigns colors to various properties of rooms and thus they will 

appear only if you have created rooms in your project. If you work on a new project but 

have not yet defined rooms and you place a color-fill legend, it will report that no colors are 

defined. What that message means is that there are no rooms defined and the color scheme 

has nothing to refer to. Select the Room tool from the Room & Area panel on the Home tab, 

and start placing rooms in your spaces. As you place each new room and give it a unique 

name, Revit will apply color to it.

The Color Scheme Legend can display the colors used in the current view or all the 

colors used in the project. To toggle between the two, select the legend, open its Element 

Properties dialog box, and in the type properties set the Values Displayed parameters By 

View or All. Typically you will need to set it to By View. The All option can be helpful 

when you make an overview legend for the entire project.

Try a short exercise for color-coding a plan using the Area/By Range option:

	 1.	 Open Level 3 Pres and duplicate the view, giving it a new name. 

	 2.	 Open the Color Schemes dialog box from the Home tab’s Room & Area panel.
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	 3.	 In the Schemes portion of the dialog box, click the Duplicate button located at bot-

tom of the schemes list. Name the new scheme Unit Areas, and change the title to 

Unit Area Legend.

	 4.	 Choose to color Area and click the By Range radio button.

	 5.	 By default, the At Least column reads 20 SF. Highlight that value and change it to 700 SF.

	 6.	 While the At Least column is still highlighted, click the Add button to add a row to 

the column.

	 7.	 The new value defaults to 1400. Change it to 900, and click OK. Add one more row 

using the same method, and set the At Least range to 1100 SF. Your settings should 

be similar to the ones in Figure 8.7.

	 8.	 Close the dialog box. In the View Properties 

dialog box, set Color Scheme Location to 

Foreground (see Figure 8.8).

As the Color Fill Legend is a property of a 

view, you can at any point change the color fill 

from one type to another or set it to None. To 

access the color fill from the view, choose View 

Properties ➔ Color Scheme.

Figure 8.7

Color scheme 
settings

Figure 8.8

Finished  
color-fill view
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Area Plans
Area plans are views of the model used to calculate the areas of rooms according to vari-

ous calculation standards. Some of the standards for area calculations are as follows:

Gross area  ​This is the overall area of a floor or footprint of the building.

Rentable area  ​Different developers and leasing companies have different standards for 

rentable areas. For example, one standard may include all the spaces in a building except 

egress corridors, vertical transportation, and mechanical spaces. However, it will include 

the floor area taken up by columns and some walls.

Usable area  ​This area defines only the usable space in a plan. It doesn’t count areas taken 

up by columns, walls, mechanical rooms, shafts, and other non-usable space.

BOMA area  ​BOMA is the Building Owners and Managers Association standard. Widely 

used in the United States, it was created to help standardize office-building development. 

BOMA has its own set of standards used to calculate areas. More information on BOMA 

standards can be found at www.boma.org.

Revit allows you to choose among several predefined area schemes or to create your 

own scheme based on standard calculation variables. To add or modify the area settings, 

open the Area and Volume Computations dialog box, available when expanding the 

Room&Area panel on the Home tab. Some of those settings, shown in Figure 8.9, control 

boundary locations such as wall finish and wall center and whether or not to calculate 

volumes.

The Area and Volume Computations dialog box gives you the option of calculating room 

volumes. This option is useful in a number of applications, but you should use it only when 

truly necessary, as the additional calculations can create performance issues in more com-

plex projects.

Figure 8.9

Area and Volume 
Computations 

dialog box
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Figure 8.11

New Area Plan 
dialog box

The Computations tab allows you to 

change how areas are calculated in the 

model. The Area Schemes tab, shown in 

Figure 8.10, lets you add different schemes 

to calculate room areas, allowing you to 

calculate multiple area types in Revit.

To add an area plan to your model, click the Area Plan tool 

in the Room & Area panel. Doing so opens the New Area Plan 

dialog box (Figure 8.11), where you select area scheme, level, 

and drawing scale.

Figure 8.10

Area Schemes tab

When you click OK, Revit automatically adds a new node to 

the Project Browser called Area Plans and adds area plans for 

each level you choose. In your view, you’ll see a duplicate plan 

view of the level you selected, with purple lines defining the 

area boundaries. These lines are placed on the walls according 

to the type of area plan you selected (such as gross area or 

rentable area). You can move or delete the lines if they don’t 

appear where you want them to be. To add area boundary 

lines, use the Area Boundary tool available in the Room & 

Area panel.

Area boundaries must be closed loops of lines (see 

Figure 8.12) in order for Revit to be able to calculate the area. 

Any breaks or gaps in the area lines, or lines that intersect, will 

result in Revit returning a Not Enclosed value for the area. 

(Should you get that error message, try trimming the corners.)

Color-Coded Section Views
The same parameters for Color Fill are available in section 

views. Once a room has been placed in the model, it can be 

tagged in both plan and section, and likewise colored. By 

default, rooms will be shown as rectangles, spanning from 

level to level.

To color-fill nonrectangular situations — where the room 

has a barrel vault, or slanted ceiling, for example — you first 

have to change the rule for how Revit calculates rooms so that 

it will calculate volumes. 

To enable room volume calculations and have colors appear 

in sections as well, open the Area and Volume Computations 

dialog box and select the Areas and Volumes option in the 

Volume Computations section (Figure 8.13).
Figure 8.12

Area boundary with 
closed loops
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You can then place rooms and open a section view to see the results. 

Make sure that room visibility is set to On when adding a color fill to section views.

Note that the height of a room can be dragged interactively in the view when rooms 

are visible. Select the room boundary, and then drag the grip arrow to adjust the height 

(Figure 8.14).

Figure 8.13

To color-fill sections 
accurately, you 

need to compute 
room volumes

Figure 8.14

The height of rooms can be dragged interactively in section view
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You can see in Figure 8.14 that the room did not 

respond to the roof angle — this is what you will get 

with default room settings. To clean up that image, 

change the Area and Volume Computations so that 

volumes are calculated to get the right image 

(Figure 8.15).

Creating Presentation Graphics
Creating compelling visual representations of your 

design is an important device for conveying design 

intent and telling the story of your project. As you’ve 

seen, Revit lets you create standard forms of represen-

tation quickly, ranging from floor plans and sections to 

perspectives. Using some simple techniques, you can 

bring these typically flat drawings to life. In this sec-

tion we’ll explore methods to help you make some great-looking drawings. We’ll also 

touch on how to create photorealistic renderings using Revit’s integrated rendering 

engine and interface.

Floor Plans: Accentuating Walls
Making clean, easy-to-read floor plans requires only a few steps. A typical plan view in 

Revit can become cluttered with lots of annotations and doesn’t create striking figure–

ground images. Figure 8.16 shows a typical floor plan in Revit.

Figure 8.15

The completed 
color fill

Figure 8.16

Typical Revit 
floor plan
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To clean up this image, you can hide the annotations and override the cut for all the 

walls with a solid color. To do so, follow these steps:

	 1.	 Open the Visibility/Graphic Overrides dialog 

box from the View tab’s Graphics panel. Click 

the Annotations tab, and deselect the check 

box Show Annotation Categories in This View 

(see Figure 8.17). This hides all annotations 

with a single click.

	 2.	 Go back to the Model Categories tab, and scroll down to the Walls category.

	 3.	 Select the row, and override the Cut Patterns column by clicking the Override but-

ton. In the resulting Fill Pattern Graphics dialog box (shown in Figure 8.18), you 

have options to select pattern and color overrides. Set Color to Black and Pattern to 

Solid Fill.

	 4.	 If you have columns in your project, you may want to do the same for them as well. 

When you’ve finished, click OK to close the dialog box.

The effect on the plan view is immediately obvious, as shown in Figure 8.19.

The same technique can be applied in section views. Be sure to override other catego-

ries relevant to section view, such as Floor, Roof, and Topography. Figure 8.20 shows a 

section with the same graphic overrides. Try these techniques in any of the sample files 

provided on the book’s companion web page to get a feel for the interaction.

Figure 8.17

Uncheck this box to hide all annotations 
in the view

Figure 8.18

Fill Pattern 
overrides
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Figure 8.19

Plan view after applying graphic overrides

Figure 8.20

Section view with cut pattern overrides

Making Elevation Graphics
Colored elevation views are a nice way to convey materiality, even if in the abstract. Change 

your elevation views to Shaded with Edges, using the Shadows On/Off in the View con-

trol at the bottom of the view, to get a feel for this mode. Figure 8.21 shows a sample of 

this view style. 

Figure 8.21

The default shaded view

Figure 8.22

The same elevation with the sun repositioned

Every material used in Revit refers back to an RGB value in shaded view; however, 

many users have noticed that color is rarely matched in the view, and will even look very 

different from view to view. To overcome this effect, and approximate the same colors set 

up in materials in the view, you can use Sun and Shadows Settings to control precisely 

where light is coming from and thus improve the visual fidelity. A sample of this modi-

fied view style is shown in Figure 8.22.

To edit and adjust material colors and patterns, open the Materials dialog box from the Man-

age tab. You can also access this dialog box directly from the Element Properties dialog box 

if the Material parameter is present. For example, if you aren’t sure what material is on the 

exterior of a wall, select the wall in question, go to the Element Properties of the wall, and from 

the Instance Properties dialog box, click Edit Type, and then select the Structure options. From 

here, you can select the finish layers material, and you’ll go directly to the Materials dialog box.
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To get this effect, open the Graphic Display Options dialog box from the View Control 

bar located at the bottom of your view (shown in Figure 8.23). Access to the command to 

open this dialog box is located with shadow controls.

In the Graphic Display Options dialog box, click the ellipsis button  next to the 

Sun and Shadow Settings drop-down box to open the Sun and Shadows Settings dialog 

box. Then, do the following:

	 1.	 Create a new entry by clicking the Duplicate button, and name it True Color.

	 2.	 Set Sun to Directly, Azimuth to 0, and Altitude to 90.

	 3.	 Make sure the Relative to View check box is selected (see Figure 8.24).

	 4.	 Click OK to return to the Graphic Display Options dialog box.

	 5.	 Be sure shadows are enabled. Using the Sun slider in the Intensity section, change the 

setting to 80, and turn Shadow down to 0. This way, no shadows will be cast, and the 

light source will always be directly above the model. The effect is that light won’t 

cause unpredictable effects on material colors.

Using Gradient Backgrounds
New to Revit 2010 is the ability to enable gradient backgrounds in 3D views. This is a quick 

way to add some color to your drawings without having to move the image to another author-

ing tool. To enable gradient backgrounds, open a 3D view, and then orient the view to an ele-

vation using the ViewCube. Using the Graphic Display Options, enable Gradient Backgrounds 

by clicking on the check box. The result can be seen in Figure 8.25. Revit uses predefined col-

ors for Ground, Sky, and Horizon, and you’re free to change these to suit your graphic 

requirements.

Using Images in Elevation Views
Using images in elevation views is a great way to add some visual charac-

ter to your drawings. Two useful techniques involve taking advantage of 

the draw order options for images when placed in a view. When you select 

an image, the Options bar gives you the ability to push the image to the 

foreground (as in Figure 8.25) 

or background (Figure 8.26). If 

you import an image of a tree, 

for example, you can then send 

the image to the back of the 

model and produce high-qual-

ity images right in Revit.

Figure 8.23

Shadow options in 
the View Control bar

Figure 8.24

Set the sun angles 
using the Sun and 
Shadows Settings 

dialog box
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Another great technique is to use the transparency channel available in the PNG for-

mat. By making the background layer transparent in Photoshop and pushing images to 

the foreground in Revit, you can add trees, people, and cars without having the back-

ground mask the model.

Shadows and Solar Studies
Using shadows can help articulate depth in your façade. You can toggle shadows on and 

off in any view using the view controls. A nice feature in Revit is the ability to orient 

shadows consistently from view to view.

Figure 8.25

Use Gradient 
Background to set 
Sky, Horizon, and 
Ground colors

Figure 8.26

There are two 
trees imported 
as separate PNG 
images. The one on 
the right is set to 
Foreground.
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Turn on shadows (using the view controls at the bot-

tom of the view). From the same flyout menu, open the 

Graphic Display Options dialog box. Choose Sunlight 

from Top Right. Close the dialog box to get a feel for the 

behavior. Change your view display to Hidden Line, and 

note that shadows are still cast. Return to the Graphic 

Display Options dialog box and experiment with the Sun and Shadow Intensity settings. 

Increasing Shadow to 100 yields high-contrast images, and dropping the value to 0 essen-

tially turns off the shadow. A hidden-line view of the default sun settings is shown in 

Figure 8.27.

Creating a Solar Study
Understanding the effect your building will have on its environment is an important part 

of a design. Often, architects are required to show how a new building will cast shadows 

on its neighboring buildings and open space. For these purposes, Revit provides a tool 

that lets you generate an animated solar study that can show the effect of shadows over 

time, throughout the year.

To access the feature, you’ll first need to enable shadows in your view, and then set up 

some information about time and location of the project. The steps to create a solar study 

are described next. For the purpose of this exercise, any view can be used, but we suggest 

using a site plan, as it’s a great view to use when visualizing shadows.

	 1.	 Open the Graphic Display Options dialog box, and click the ellipsis button to open 

the Sun and Shadows Settings dialog box.

	 2.	 Choose the Multi-Day tab, shown in Figure 8.28.

Figure 8.27

Hidden-line view 
with shadows 

enabled

Figure 8.28

Click the Multi-Day 
tab to access these 

settings

	 3.	 The predefined options on this tab are good 

starting points. You choose your project’s loca-

tion from a drop-down list of cities, and you 

specify a start date, end date, and time of day. 

Choose a time interval as well. Use the default 

settings for a Multi-day Solar Study, and change 

Place to a city near where you are right now. 

Click OK.

	 4.	 Click OK, and go back to your view.

	 5.	 Once you’ve set up a Multi-day study, a new 

option appears on the View Control bar to pre-

view the animation (see Figure 8.29). Click Pre-

view Solar Study to activate animation controls 

in the Options bar.
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Clicking the Play button starts the animation. In the view, you’ll see a live animation 

of the shadows as the days of the month go by.

Once you’re happy with the results, you can export the view as an animated movie. To 

do so, go to the Application Menu and choose Export ➔ Images and Animations ➔ Solar 

Study. From here, you can choose a location to save the file, change the model graphic 

styles, and choose the size of the image in pixels. To make smaller files, try using the 

Microsoft Video 1 codec and lower the quality settings. The resulting file can be played 

with a standard digital video player such as Windows Media Player.

3D Views
A great way to visualize the model is to use a perspective camera and enable the section 

box. This allows you to create 3D sectional views that slice through the model, providing 

stunning graphics that can help better explain plan, section, and 3D in one view.

To take advantage of this form of representation, open a 

perspective view (or make a new one using the Camera tool in 

the View tab), and open its View Properties dialog box using 

the right-click menu. Enable the Section Box parameter in the 

Extents parameter group, as shown in Figure 8.30.

A new 3D box appears in the view: this is the section box. Select the section box, and 

controls appear that you can use to clip the view from all six directions of the box. To 

experiment, drag the top arrows down until the 

box cuts through the model.

To hide the 3D cropping box, select it, 

and hide it by choosing Hide in View ➔ 

By Element from the right-click menu. 

The same thing works with 3D 

axonometric views, but the 

camera views give different 

dynamics to the graphic pre-

sentation. A sample view of a 3D 

floor plan is shown in Figure 8.31.

Figure 8.29

Previewing the 
solar study provides 
these animation 
controls

Figure 8.30

Enabling the 
Section Box option

Figure 8.31

Perspective view 
with the section box 
enabled
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You can apply the same graphic overrides to a 3D view as we outlined for plan and section 

views. This way, you can graphically override the color of everything that has been cut (walls, 

columns, roofs, etc.) and assign a solid fill color. Take advantage of these techniques to pro-

duce some really slick presentations!

Rendering a Perspective
Revit has an integrated rendering engine that lets you visualize the model with material 

texture maps and more realistic lighting effects. The material library available for render-

ing was designed specifically for architectural renderings, and presents a nice collection 

of common building materials. You’ll be able to generate great-looking images with a rel-

atively minimal investment of time, and you don’t need to be highly skilled in visualiza-

tion techniques and complicated material editing.

If you’re familiar with Autodesk 3ds Max, you will know about FBX: you can now export a 3D 

view of a Revit model to FBX and open that file directly in 3ds Max 2009 or later. This means 

there is no need to translate the Revit file into DWG to be able to render it. FBX is a very pow-

erful exchange format that allows all geometry, materials, lights, and your active camera to 

make it to 3ds Max for further refinement. To export to FBX, go to the Application Menu and 

choose Export ➔ FBX.

Let’s walk through how to render an exterior view. The following exercise will take 

you through a simplified rendering workflow. Many of the materials in the model have 

been predefined for you.

	 1.	 Open the file Source_House_Complete.rvt from the Chapter 8 folder on the compan-

ion web page.

	 2.	 We’ve provided some custom materials for use with this file. In order for the render-

ing to process the files we’ve provided, you need to copy the folder named Materials 

from the web page to your My Documents folder. Be sure to copy the files there, or 

some materials will not render.

	 3.	 To render a view, open or create a new perspective view of the exterior of the build-

ing. Any 3D view can be rendered, but you’ll get the best results from perspective 

(camera) views. 3D View 1 has already been created, so you can open it.

	 4.	 Enable the Rendering dialog box (Figure 8.32) by clicking the Rendering icon (teapot) 

in the View Control bar at bottom of the view . 

This opens the dialog box. 

	5.	 The Rendering dialog box is where you set up quality settings, lighting, and back-

grounds for the rendering. You can also save and export renderings with this dialog 

box. To render the view, click the Render button.

Figure 8.32

The Rendering 
dialog box
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	 6.	 The view will start to render. You’ll see an image begin to appear in your view. You 

can cancel the rendering at any time by clicking the Cancel button at the bottom of 

the screen near the progress meter. When the render is finished, the image should 

look like Figure 8.33.

This rendering, although exceedingly simple, illustrates some of the critical aspects 

of rendering: the camera, lighting, materials, background, and foreground. We’ll walk 

through each of these to give you an idea of where you can find these features in the user 

interface and how to make adjustments.

The Camera
The Revit camera is easy to manipulate. When you’re in a perspective view, clicking the 

SteeringWheel button from the navigation bar brings up the SteeringWheel (Figure 8.34).

Use the Walkthrough options to move the cam-

era in space. The Pan option moves the camera in 

the vertical plane, and Walk will 

move the camera forward and 

backward. Use Look to swing the 

camera from side to side. Use the 

submenu in the SteeringWheel to 

change the focal length of the cam-

era and slide the crop boundary 

around. When you’re changing 

focal length, the camera doesn’t 

move; the zoom factor changes.

If you check the Region option next to the Render button, a rectangle appears in the view 

that can be resized. When you render the view, only the area within this region is rendered. 

Use this to render smaller areas of view to speed up iterations.

Figure 8.33

The finished view

Figure 8.34

The SteeringWheel 
for perspective 
views
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Quality Settings
At the top of the Rendering dialog box is where you set the image quality. Quality settings 

(Figure 8.35) allow you to create quick renderings for early iterations, and then dial up the 

quality when you’re ready to generate a high-quality photorealistic rendering. 

Increasing quality always has an impact on time, so run high-quality render-

ings only if you have time and you’ve got your entire model built and all the 

materials assigned. Use the available presets to start. If you want to experiment, 

click the Edit Custom option in the Rendering dialog box to open the Render 

Settings dialog box.

Output Size
When rendering, you can choose what your target output is. When iterating through a 

rendering, keep Device set to Screen; this renders the view relative to your screen size and 

goes much faster. When you are ready to send a rendering at high resolution 

out of Revit for printing, or for touch-up in a program like Photoshop, change 

Device to Printer and set your desired dpi (Figure 8.36). You will see a rough 

estimate of how large the file will be if uncompressed — basically the size of 

the file if saved as a .tif. 

Lighting
It’s possible to set highly specific date, time, and place information for your rendering. 

This allows you to generate accurate sun studies. All views have a default sun location that 

is stored in the Sun and Shadows Settings dialog box, accessible via the Graphic Display 

Options dialog box. To open this dialog box, use the Shadow menu in the View Control 

bar, open the View Properties dialog box and click the Graphic Display Options button, 

or click the small arrow in the Graphics panel on the View tab. When you’re rendering 

exterior or interior views with natural lighting, the rendering will use infor-

mation from the Sun and Shadows Settings dialog box. When you’re render-

ing interior scenes with only artificial  

lights, only light from lighting fixtures  

will be used (Figures 8.37 and 8.38).

In the Rendering dialog box, you 

can choose the type of lighting scheme for your 

scene from the list. For both exterior and interior 

you have several options to choose from. For our 

rendering of the exterior, the Sun Only option will 

work fine. When rendering, you essentially need to 

choose whether or not you want to see the effect of 

sunlight in the view.

Figure 8.35

Quality options

Figure 8.36

Output options

Figure 8.37

Scheme options

Figure 8.38

Sun position options
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Depending on the type of scene you are ren-

dering, you can make adjustments to the light 

sources. For the sun, choose from the list of sun 

settings in your project. If you are going for 

accurate sun angles, be sure to set the project 

place, using the Manage Place and Locations 

dialog box (Figure 8.39). For artificial lights, 

you can use the Light Groups dialog box to 

group lights and turn lights on and off.

Lights created prior to the 2009 release do 

not automatically upgrade until you open the 

light in the Family Editor, then reload the light. 

Alternatively, you can reload the family from 

2009 family directories. The lighting features 

create more realistic lighting effects, and light 

source can be based on an Illuminating 

Engineering Society (IES) definition 

(Figure 8.40).

To access the Sun and Shadows Settings dia-

log box from the Rendering dialog box, choose 

the Edit/New option from the drop-down list. 

You can then make adjustments or make new 

settings for your scene.

Foreground and Background
Foreground and background are used to help 

give your model some context by premade sky 

and clouds, or by using a solid color. Placing 

trees and bushes and other site entourage such 

as cars and people helps fill in the foreground. 

Plants, trees, people, and cars in Revit render as 

photorealistic images when associated with an 

ArchVision RPC (Rich Photorealistic Content) 

file. These files contain intelligent images that 

orient correctly relative to your camera, and 

they can add some realism and scale to your 

renderings.

Be careful when working with your camera 

so your model doesn’t look like it’s floating in 

an abstract, empty plane. Tighten the shot using 

Figure 8.39

Manage Place and 
Locations dialog box

Figure 8.40

Options for light 
sources in lighting 
family definition
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the field of view, or crop the view to reduce the amount of ground taking up space. To do 

this, select the crop boundary and drag the blue controls. You can also access the exact 

size of the crop boundary from the ribbon by clicking the Size Crop button when the 

crop boundary is selected. Clicking the button will bring up options to resize the 

boundary.

To set up a background for the rendered image (Figure 8.41), use the background 

options in the Rendering dialog box. You can use some sky and cloud settings or a solid 

color. If your building is without a context of other buildings or site, try to add 

elements that will obscure the horizon. Add building masses using in-place 

massing that represent your site conditions, and add trees and topography to 

make the image more realistic.

The sky options for rendering are based on actual colors that are physi-

cally accurate. If your scene is near dusk, the sky will change color to accurately reflect 

sky conditions at that time of day.

Saving Your Image

Once you render a view that you like, you can save the image to your project, export it, or 

both. When saving to your project, be wary of saving huge renderings, as this will bulk up 

the size of your file. The renderings are stored in their own branch of the Project Browser. 

When exporting a PNG, the background saves as transparent, making it easy to replace with 

new images or custom backgrounds in Photoshop. In Figure 8.42, you create a new Layer 1 

and put it behind the default Layer 0. You can then copy and paste a background image into 

Layer 1, and voilà!

On the left of Figure 8.42 is a PNG from Revit; on the right is a custom background 

image. Using layers, you can easily position any image you want behind your model.

Figure 8.41

The Background 
options

Figure 8.42

Positioning a sky
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Materials
Perhaps the most critical aspect of producing a convincing rendering is assigning good 

rendering appearances to your materials. Good materials convey characteristics of tex-

ture, color, reflectivity, and transparency that you expect to see in reality.

All elements in Revit have a material, but some materials may have a generic gray ren-

der appearance assigned. To assign a specific rendering appearance, open the Materials 

dialog box (in which you access using the Manage tab) and select a material from the list 

on the left. On the right, you’ll see a tab called Render Appearance. Select that tab, and 

then click the Replace button to open the Render Appearance Library. From here you can 

choose a new Render Appearance setting, as shown in Figure 8.43. 

Follow these steps:

	 1.	 Select an exterior wood siding wall and open its Type Properties dialog box. Select to 

edit the structure parameter, to change the material for the exterior siding. Then 

select the material name and click the small button next to the name. This will open 

the Materials dialog box (see Figure 8.43).

	 2.	 With the Materials dialog box now open, click the Render Appearance tab. This tab 

has all the information used to render the material. Here you will see the custom tex-

ture and path leading to it. Note the Scale parameter — this is what scales the image 

map to the right size. To change the scale, type in the Sample Size field.

Figure 8.43

Click the Render 
Appearance tab  
in the Materials 
dialog box
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	 3.	 If you want to replace the render appearance and browse the Render Appearance 

Library (Figure 8.44) for additional options, click the Replace button. This allows 

you to search for and select new render materials for use in your project. Use the 

search field to find materials. You can also use the drop-down list of presets to cull 

the list based on some common categories.

	 4.	 Change the texture map you are using by clicking the small browse button  next 

to the path to the image file. 

Browse to C:\My Documents\Materials, choose the file named CLAPBOARD.jpg, and 

click OK.

	 5.	 The scaling looks fine, so click OK through the various dialog boxes to commit to 

the change. This is the basic process for setting up materials.

	 6.	 Re-render the view to see the effect — all the exterior walls should now render with 

the new image map you chose.

	 7.	 Experiment and iterate — get used to browsing for materials and running quick ren-

derings at low- or medium-quality settings.

	 8.	 When you’re ready to crank out a great image, increase the quality and click the Ren-

der button again.

To recap: create a new Revit material by duplicating an existing material. Then use the 

Render Appearance tab to edit or replace rendering appearances. All the materials that 

are included in the materials library are properly scaled to real-world sizes, so you should 

not need to make many edits to those (Figure 8.45). If you choose to use your own tex-

ture maps, be sure to set the scale so that the image looks right when rendered.

Figure 8.44

Render Appearance 
Library
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For materials such as glass, where an image isn’t needed, choose from the default 

materials libraries that ship with Revit. Browse through the Render Appearance Library, 

and you’ll find a set of glass options as well as a host of other materials to choose from 

(see Figure 8.46). For windows, use the Glazing types, as these will work great for exterior 

panes of glass. Play with the materials parameters to see the effect. You’ll see that the 

glazing materials even allow you to specify how many sheets of glass are in the pane!

Figure 8.45

First look to the 
Render Appearance 
Library for a wide 
selection of great 
materials

Figure 8.46

Glass material 
options include 
color, reflectance, 
and sheets of glass
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Sheets

C hap te r 9

In previous chapters,  we discussed how to create a model in Revit 

and how to make standard views to represent the model. We’ve explored how to create 

plans, sections, callouts, elevations, and 3D views of a BIM model. This chapter starts by 

looking at the properties of views and what these all mean. We then move on to sheets, 

and explore how to get your views onto sheets. In Revit, getting your views onto sheets 

is extremely easy: you simply drag and drop views from the Project Browser onto sheet 

views. Because every view has a scale, you see the effect immediately, and if you have to 

change scale or crop the view, you can do so in the context of the sheet. You can then 

print, export, or publish these sheets for use.

Topics we’ll cover include:

Documentation trends■■

Preparing views■■

The sheet■■
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Documentation Trends
Historically, the creation and delivery of document sets has been divided into three 

phases: schematic design, design development, and construction documents. The final 

CD set becomes the legal documents of record and is used by the contractor to physically 

build the building. With the advent of BIM, a discussion is taking place in the industry 

about this traditional division of documents, and new questions are being raised. Is this a 

viable and sustainable practice in the context of a BIM workflow? Can a BIM model rede-

fine the types of documents that are created throughout the life of a project? Do we even 

need paper documents to build the building, or could a live, up-to-date BIM model actu-

ally be the deliverable? The divisions in BIM aren’t as rigid as they have been in a legacy 

2D workflow. An example of BIM deliverable packages might include:

Conceptual model and documents, where the basic geometric forms of the building •	

are created

Design-development model and documents, where the building geometry and major •	

building elements are completely modeled

Construction model and documents, where the design-development model is embel-•	

lished with annotations and dimensions and the construction document set is created

This is more than just an elimination of schematic design. It amounts to a restructur-

ing of project deliverables and more specifically, the deliverable timetable. The traditional 

percentages of time per phase also no longer apply. This is an important point to remember 

as you move forward in documentation, because you’ll need to adjust your expectations 

and timeframe to a different delivery methodology. You’ll find additional information in 

the Integrated Practice and Technology in Practice sections of the American Institute of 

Architects (AIA) website (www.aia.org/contractdocs/AIAS077630 and www.aia.org/TAP, 

respectively.). Recently AIA has produced a guide: Integrated Project Delivery: A Guide, 

www.aia.org/ipdg.

We are confident that this is a trend that will be followed worldwide.

Preparing Views
Now that we’ve covered most types of views you can create with Revit, let’s discuss how 

to place those views on sheets (Figure 9.1). But before you start placing views onto sheets, 

it’s important to know about some critical properties of views that affect how they behave 

when placed on sheets. Preparing views so they look correct can be done at any time in 

the process — either before or after placing a view onto a sheet. The way a view looks is 

largely based on properties of the view, so we’ll start there.
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There are several ways to access view properties. You can get to the View Properties 

dialog box in any of the following ways:

Right-click any view in the Project Browser, and choose Properties from the con-•	

text menu.

Right-click in the active view window, and choose View Properties from the con-•	

text menu.

Right-click any view once it’s placed on a sheet, and choose Element Properties from •	

the context menu.

Select View on the sheet and use the Element Properties button in the Ribbon.•	

Select a view (click it with the mouse) in the Project Browser, and click the Element •	

Properties button in the Ribbon.

Activate a view on the sheet using Activate View, and then use the keyboard shortcut •	

(VP) to go to the View Properties dialog box.

View Properties
Like any other element in Revit, views have their own properties. Many of these proper-

ties can be displayed as parametric information about the view when views are placed on 

sheets. The information from a view can be directly reported in intelligent view titles, 

Figure 9.1

A presentation 
sheet with plan and 
3D stair
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making coordination of data automatic. Other parameters control how the model is displayed 

graphically. Here is a list of common properties (Figure 9.2) and how they affect the view:

View Scale  ​This sets the view scale of the drawing. You can 

similarly set the view scale in the View Control bar in the view 

window.

Scale Value  ​This sets the drawing scale of the view that will be 

represented on the sheet.

Scale Value 1  ​This field is noneditable for the view properties. 

It shows what your scale value would be if it were translated to 

an AutoCAD paper space view. This field dynamically changes 

as you change the View Scale value above it.

Display Model  ​This determines how to show (or not show) all 

model elements of the view. There are three settings for this 

field: Normal, As Underlay, and Do Not Display. In Normal, 

the view is unchanged from its normal graphics. As Underlay 

grays out all the model contents in the view — it doesn’t gray 

out 2D information like annotations, text, or dimensions. Do 

Not Display turns off all the model data and shows only the 2D 

information in the view. This would be used in detail callouts 

where all the lines are 2D, and not from the model.

Detail Level  ​This offers three choices: Coarse, Medium, and 

Fine. Choose one depending on the level of detail you’re trying 

to show in your model.

At larger scales, such as ¼″ = 1′-0″ (1:50), set the detail level 

to Coarse. Typically, plans or sections are printed at medium or fine, but at this scale lines 

are so close together that they can’t be differentiated on the sheet. Also, a medium or fine 

setting on a complex model can drastically affect load time or print time of that view.

Detail Number  ​This sets the detail number (such as A1) on the sheet. This number must 

be unique to each sheet.

Rotation on Sheet  ​This setting gives you the option to rotate the view and view tag to read 

from the right side of the sheet rather than from the bottom. You might use this preference 

if you had a tall building and wall sections didn’t fit in a traditional orientation. Note that 

you’re rotating the view, not the model. Once a view is on a sheet, it can be rotated using 

the Options bar when the view is selected.

Visibility/Graphics Overrides  ​This is an alternate way to access the Visibility/Graphics 

Overrides dialog box for this view. This dialog box controls which elements appear in 

the view.

Figure 9.2

Instance Properties 
dialog box for Views
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Model Graphics Style  ​This controls how your model displays on the screen. By default, it’s 

set to Hidden Line. Other choices are Wireframe, Shaded, and Shaded with Edges. These 

options are discussed in Chapter 3, “Views.”

Graphic Display Options  ​This option brings up the Graphic Display Options dialog box, 

which controls shadows and shading. You can also access this dialog box through the 

View Control bar at the bottom of the view window.

Underlay  ​This option lets you choose another level of the building to be shown in a light 

gray tone as an underlay to this view. This is useful if you’re trying to align walls with a 

floor below or when you want to make a reference to a roof from the level above.

Underlay Orientation  ​This option is available only if you’ve chosen to put an underlay 

into your current view. You can set whether you want to see the floor plan or the ceiling 

plan of your underlay.

Orientation  ​The model is typically shown orthogonal to the view you are working in, 

and this extends to how the view will appear when placed on a sheet. However, in many 

conditions a building doesn’t align with the cardinal directions of your screen and printed 

page. Orientation lets you align your view with either the project north (screen and sheet 

north) or with true north (how the building is located relative to the earth).

Wall Join Display  ​This property is only available in plan views and offers two options: to 

clean up all wall joins or to clean up the same types of wall joins.

Discipline  ​This sets the discipline (architecture, structure, mechanical, electrical, or 

coordination) of the view in the document set. This is useful for sorting views in the 

Project Browser.

Color Scheme Location  ​This puts color fill in either the foreground (in front of model ele-

ments) or background (behind model elements).

Color Scheme  ​This adds a color scheme to the view, and allows you to edit an existing color 

scheme. Use this to create color-coded plan views. This parameter is available in plans, sec-

tions, and elevations, but not for reflected ceiling plans or 3D and perspective views. 

Dependency  ​Views that are made as dependent views report which view they depend on. 

A dependent view displays the annotations of the parent view. If a view is not dependent, 

it’s listed as independent. 

Underlays are thought of in the 2D drafting world as a layer of trace under your current draw-

ing. This view is useful for seeing what is happening in another view while working in your 

active view. In a 3D modeling world, this underlay is a live look at the model — if you delete 

something shown as underlay, you’re deleting the element, not an abstraction.
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Title on Sheet  ​This field allows you to override the name of a view as it appears on the sheet. 

By default, or if this field is left blank, Revit will make the name on the sheet identical to 

the name of the view. This is particularly helpful if a name on a sheet is not unique from 

other views — for example, if many views are simply titled “Detail.” 

Annotation Crop  ​This enables a second crop region that only hides and unhides annota-

tions that are outside of it or intersecting it.

Sheet information  ​The following four fields in the view properties are noneditable in this 

dialog box:

Sheet Number•	

Sheet Name•	

Referencing Sheet•	

Referencing Detail•	

These values are reported from other views in Revit. Sheet Number and Sheet Name 

can be modified from the sheet they reference and tell you what sheet this view has been 

placed on. Referencing Sheet and Referencing Detail report which views this sheet refer-

ences from. In the case of our example plan, we’re referencing an elevation on sheet A200.

If multiple references depend on one view, the first reference created is reported in the View 

Properties dialog box.

Default View Template  ​This sets the default view template for this view. Creating and 

editing view templates is covered later in this chapter.

Crop Region  ​This option activates the crop region for a view, which limits the extent of 

what is visible in the view.

Crop Region Visible  ​This setting makes the crop region visible or invisible for the view. 

Under some circumstances, it can be a good idea to keep the crop region visible to ensure 

the size of the view doesn’t change. The crop region can be hidden in the print dialog box, 

so you don’t have to worry about printing boxes around all your views.

Annotation Crop  ​This shows the crop boundary of a parent view when views are linked.

View Range  ​This opens the View Range dialog box discussed in Chapter 3.

Associated Level  ​If the view is associated with a particular level (in the case of a floor plan 

or enlarged plan), it’s reported here. This isn’t an editable field.

Scope Box  ​A scope box limits the extents of level and grids. If you have scope boxes 

defined, you can apply them to this view.
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Depth Clipping  ​This controls the depth of the Plan clipping and offers the options to not 

clip, to clip without a line, or to clip with a line.

Phase Filter  ​This option lets you control which of the defined phase filters (basically, 

phase combinations) are implemented in this view. You can set the phase filters by choos-

ing Settings ➔ Phases.

Phase  ​If you have phases set up in your project, you can change the phase visibility prop-

erties for the view here and set a specific phase, such as New Construction.

View Templates
View templates are powerful time-savers when you’re working on a project. The purpose 

of a view template is to capture view settings and then apply these settings to many views 

with the same graphical requirements. They are a great way to 

ensure graphical consistency between views. You can find view 

templates in the Graphics panel of the View tab, by clicking on 

the View Templates Settings button in the expanded panel for 

View Templates (Figure 9.3).

Different view templates tend to be used for plans, sections, 

elevations, and details. The View Templates dialog box allows 

you to create a new view template, delete, or modify existing 

ones. You’ll notice that view templates are a subset of view properties. By setting these 

values, you can create standard view characteristics and push them into other views. In 

the View Template dialog box, you can preset the following view properties:

View Scale•	

Display Mode•	

Detail Level•	

Individual visibility and graphic overrides for model categories, annotation categories, •	

imports, filters, and model graphics style

Graphic Display Options•	

Underlay•	

View Range •	

Orientation•	

Phase Filter•	

Discipline•	

Depth Clipping•	

Figure 9.3

View Templates 
pulldown menu
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With view templates, you have the ability to choose which parameters to include (or 

exclude) in the view template. For example, you may not want to apply a view template 

and have it change view scale or detail level, but still make changes to graphic style. To 

exclude a parameter, uncheck the desired parameter in the Include column.

Although it’s possible to preset all your view settings through this dialog box, you may 

find it easier to select the settings interactively in a view. This way, you can see the effects of 

settings immediately. When you like what you’ve set up, you can then create a new view tem-

plate from your active view. Right-clicking any of the views in the Project Browser gives you 

an option, Create View Template from View (see Figure 9.4). 

You can then apply this new view template to any other view. 

Applying a view template to a view is a single instance event. If 

you apply a template to a view and then modify the template, 

the view will not update to match those changes. You will 

need to reapply the view template to that view.

To apply a view template to another view, select one or more views (not sheets) from the 

Project Browser and right-click. Then, choose Apply View Template from the context menu. 

Choose the template you want to apply to the views and Revit will update them all to use 

the same view properties established in the template.

Creating and Applying a View Template

In this exercise, you’ll create a new view template and apply it to a view:

	 1.	 Open the Station_start.rvt model at the book’s companion web page, www.wiley.com/

go/introducingrevit2010, and open the view called Level 3 Pres. Note that there is 

already a Level 3 view, but this view has been set up to be a presentation-styled view. 

You want to create a similar view for Level 4.

	 2.	 In the Project Browser, right-click the view Level 3 Pres, and choose Create View 

Template from View.

Figure 9.4

Select the Create 
View Template from 

View option

	 3.	 Name the view Plan Presentation. Click OK. 

The View Templates dialog box will open and 

the new template will appear in the list of view 

templates (Figure 9.5). From here you can 

make adjustments to the settings if need be. 

Figure 9.5

The new template 
will appear in 

the list of view 
templates

	 4.	 Right-click the Level 4 view, and choose 

Duplicate with Detailing. Doing so creates a 

new view called Copy of Level 4.
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	 5.	 Right-click the view called Copy of Level 4, and rename it Level 4 Pres. It resorts 

itself alphabetically in the Project Browser so it appears below the Level 4 view.

	 6.	 Right-click the new view, Level 4 Pres, and choose Apply View Template. Choose the 

new Plan Presentation view template from the list, and click OK.

Revit allows you to apply templates to schedule views as well. The workflow is the 

same as with any other view, allowing automatic propagation of graphic definitions from 

one schedule to other schedules in the project.

The Sheet
Construction documents are how architects convey their ideas and designs on paper to 

the contractor or builder so that they can build the building. The information conveyed 

must be sufficient and organized well enough for the builder to understand the design 

intent of the documents. Conflicts, errors, omissions, and coordination issues can and 

will occur on any document prepared by human hands. These discrepancies are magnified 

on the job site as cost overruns, RFIs, or lost schedule time. The goal of a good set of doc-

uments is to minimize the number of errors and convey the design clearly. Revit excels in 

this process by automatically managing your views and references and thereby eliminat-

ing many common errors found in traditional document sets.

Perhaps the mostly widely used type of architectural sheet system is the ConDoc system 

supported by the AIA. This system has identifiers for sheet name and numbering formats. 

Most firms have a defined graphic standard for sheet layout. If you’re responsible for 

creating office-standard content, such as sheets, you should take a bit of time to create Revit 

sheets that mirror your firm’s standards before you get started on a project. Not only will 

you then have them when you’re ready to go forward into production, but you’ll gain expe-

rience working with Revit families.

Before you load a sheet into your project, notice the sheet border. In the title block 

exercise in this section, the border is an invisible line that traces the extents of the sheet. 

If you move your mouse over the outside border of the sheet, the invisible lines highlight. 

Invisible lines are a line type that is similar to a nonplot line; they don’t graphically inter-

fere with the view on the screen.

Adding a Title Block to a Sheet
Title blocks in Revit are similar to any other family. You can create and edit them with 

the Family Editor. Like tags, title blocks use intelligent labels built into the family to pull 

data from the Revit model and apply it to the title block. This can be in the form of the 

view scale, project name, project address, or any parameter you see fit to use in your title 
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blocks. To get an idea of how these labels work, you’ll add one to an existing sheet. This 

exercise presents a basic description of how to add labels and other data to your sheets:

	 1.	 Double-click the Presentation - 11 x 17.rfa file found on the book’s companion 

web page. The file automatically opens in the Family Editor.

This is a simple 11″×17″ title block. As with any sheet, you can add as much or as 

little detail as you want. In this sheet, you’ll add a graphic scale.

	 2.	 Click the Label button in the Annotate panel on the Create tab. 

	 3.	 Click to drop the text in the desired location on the sheet.

	 4.	 The Edit Label dialog box (Figure 9.6) opens and asks what kind of label you’d like to 

add. Choose a category parameter from the list, and then click the Add button  

to add it to the label.

With this dialog box you can also add prefix and suffix values to the label, and 

even add more than one parameter to the label.

	 5.	 Add the prefix scale, and add a space after the word. Click OK.

	 6.	 To load the title block into your project, click the Load into Projects button on the 

right side of the Ribbon.

This process adds a label to the sheet and shows its default value (in this example, ⅛″ = 

1′-0″). As you bring views onto the sheet, this value parametrically changes to reflect the 

scale of the views on the sheets.

Figure 9.6

The Edit Label 
dialog box and 
resulting label
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Adding a Revision Schedule to a Title Block

Revit allows you to add revision clouds and tags to sheets for tracking changes in the doc-

ument set. These can be automatically tracked and displayed in a revision schedule on your 

title block. To place a revision schedule into a title block, follow these steps:

	 1.	 Open an existing title block family, or choose to make a new one.

	 2.	 In the View tab, click Revision Schedule. Click OK to accept the defaults, and then 

close the view.

	 3.	 Using the Project Browser, open the Schedules node. You will see a Revision Schedule 

view. Drag and drop this view into your title block.

	 4.	 To modify the graphics and fields used in the revision schedule, right-click on the 

revision schedule in the Project Browser and click Properties. In the Fields param-

eter, you can use common fields such as Revision Number, Description, Date, and 

Issued To (Figure 9.7).

Your sheet border may fluctuate depending on your printer type. For instance, an 11″×17″ 

printer typically has a print range of 10.5″×16.5″, or ¼″ margins around the edges. On some 

printers, printing at paper size can lead to minor distortion of the scale of the printed views. 

Depending on your printer type, you may need to set your sheet size to fit within the printer 

margins rather than set it to the actual paper size. Once the sheet has been created, you can 

load it into your project by clicking the Load into Projects button on the Family tab; or, in your 

project, you can go to the Insert tab, and from the Load From Library panel, select Load Family.

Figure 9.7

Fields available for 
use in a revision 
schedule
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	 5.	 When the title block is loaded into your project and you begin to add revisions to 

your project, the table will automatically fill up (Figure 9.8).

You can have revision tables that build from the bottom up. This is set in the 

Appearance tab of the Revision Properties dialog box (Figure 9.9). You can also set the 

schedule height manually, using the user-defined option. This allows you to graphically 

set up a blank table for your revisions (see Figure 9.10).

Figure 9.8

The revision 
schedule will fill up 

as you add revisions 
to the project

Figure 9.9

Parameters for revision schedules: Bottom-up and user 
defined height

Figure 9.10

A bottom-up schedule for revisions
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View Titles
A key component of a view placed on a sheet is the view title. These elements are tags that 

live on the sheet (see Figure 9.11) and display information about the view. Common infor-

mation includes view name, scale, and detail number.

The view title appears automatically when you place a view on a sheet. When you place 

the view, the labels are automatically populated with the correct information about the 

view. The detail number (in Figure 9.11, it’s 1) automatically increases by 1 for each view 

placed on the sheet. (You can change this number to a letter, or a number–letter sequence, 

like A1.) If the view placed on a sheet is referenced from an elevation, a section, or a call-

out, the detail number is automatically propagated into the view markers in the other 

views. If you change the detail number, it updates the tags in the other views. Basically, 

this means that your references are always correct on any sheet and in any view. It’s 

impossible for views to be out of sync.

View titles are tags that report information about a view. If you select a view title on 

the sheet and open its properties, you’ll see information about the view it is tagging. The 

element is called the viewport. From the type properties of the viewport, you can edit 

some graphic parameters for the view title such as color, whether to show the view title, 

and if the view title has an extension line.

To add revisions to your project, select the Manage tab and choose Settings ➔ Sheet Issues/

Revisions. In this dialog box, you can add revision information that will then show up in the 

revision schedule on your sheets. You can have revisions enumerate on a per-sheet basis or 

on a project-wide basis. When you add revision clouds to your sheets (from the Detail panel 

on the Annotate tab), set which revision it belongs to, and you’ll be good to go.

Figure 9.11

Sample view title

View titles are families like every other element in Revit, but they have a slightly different 

access point for editing the graphics. You can edit most families in Revit on the fly by select-

ing the family and clicking the Edit Family button in the contextual tab that appears. However, 

some families don’t show this button when selected. These include view titles, level tags, 

callout heads, and section heads. To edit one of these types of families, locate it in the Project 

Browser under Families ➔ Annotations. Right-click the family, and select the Edit option from 

the context menu. Doing so opens the family in the Family Editor. Editing options are similar 

to those available for sheets (explained earlier in this chapter) and other tags.

Detail numbers must be unique on each sheet. Revit doesn’t allow for duplicates.
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If you don’t want a view title to display on a sheet (as in a 

presentation drawing), duplicate the view title from the Type 

Selector, and set the view title properties to show no title and 

no extension line (see Figure 9.12). You don’t need to create a 

new view title family for this purpose.

Take care when you modify the properties of a view title. 

Changing a view title type changes all the views on all the sheets 

of that type. That may not necessarily be the desired effect.

Placing Views on Sheets
Placing a view onto a sheet requires a drag and drop from the Project Browser. You can 

drag views from the Project Browser onto a sheet name in the Project Browser, which will 

open the sheet view and let you place the view; or you can first open the sheet view, and 

then drag views onto the sheet from the Project Browser. If you don’t have a sheet view set 

up, create a new sheet from the Sheet Composition panel on the View tab. Doing so opens 

a dialog box where you choose what type of sheet to make. Choose a sheet, and a new sheet 

view is created and opened. You can then start dragging and dropping any view name from 

the Project Browser onto the sheet (as long as the view has not already been placed on a 

sheet). You can place the view anywhere on the sheet, and it will be tagged with a view title.

With the exception of legend views, it’s important to point out that you can’t put a view 

onto more than one sheet. Each view is a unique, living picture of the model. Although 

this may not seem intuitive at first, it makes sense given that all views are guaranteed to 

report correct information about what sheet they’re on. Every view placed on a sheet has 

a unique reference describing name and position on sheet. Schedules may also be placed 

on multiple sheets.

But what do you do when you still need to place the same view or a portion of the 

same view on two sheets? For this purpose there is a special type of a view in Revit called 

a dependent view. This lets you create a duplicate of the view that can then be placed on 

another sheet. This dependent view will follow any change of the original view and the 

two will be identical. For more details, see the section “Splitting Views across Multiple 

Sheets,” later in this chapter.

If views placed on a sheet don’t fit in the space you have available, there are a couple 

of ways to mitigate the situation. The size of the view relative to the sheet is based on 

two things:

View scale•	

View extents•	

The view scale determines the architectural scale and can be modified from view 

properties, or the view controls. In most cases, the scale is correct, but the overall size of 

the view may be too large. If this is the case, there are two ways to solve this problem.

Figure 9.12

Turning off the title
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First, you can move annotations and symbols closer to the model, and tighten up the 

graphics to reduce the amount of empty white space. This approach buys you some pre-

cious sheet real estate. See Figure 9.13 for an example.

Moving a view marker is different from moving the view itself. For example, you can 

move an elevation symbol by grabbing the view tag without moving the front clipping 

plane of the elevation. In Figure 9.14, the physical extent and location of the elevation 

remain the same, but the tag has been repositioned.

Section marks behave in similar fashion. The blue controls at the base of the head and 

tail graphics let you make the graphic footprint of the symbol smaller or larger without 

affecting the extent of the view it’s referencing (shown as 

dashed lines in Figure 9.15).

The second option to make your views fit on the sheet is 

to modify the view’s crop region. Turning the crop region 

on and off was discussed in detail in Chapter 2, “Getting 

Acquainted with the Revit Interface and File Types.”

Modifying the crop region changes the actual size of the 

view and can also hide areas you don’t want to show on a 

particular sheet. In Figure 9.16, the crop region is described 

by the lines bordering the view. Although there is much 

more to see of the model at this floor, the crop region has 

been minimized to show only this unit. By drawing in the 

crop boundaries, you can make the view smaller to display 

only the information necessary for that view.

Figure 9.13

Tightening up 
a view

View before optimizing sheet usage View after optimizing sheet usage

Figure 9.14

Clipping plane 
location in the 
elevation tag

Figure 9.15

Clipping plane 
location in the 
section tag
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From the sheet view, you can edit views 

directly in order to make changes to the view 

in the context of the sheet layout. Select any 

view on a sheet, and either right-click to bring 

up the context menu, or click the Activate View 

button in the contextual tab. Selecting Activate 

View grays out the sheet and other views placed 

on the sheet and lets you directly edit the view 

as if you had opened the view normally. You 

can then manipulate annotations, model data, 

and the crop region. When you’re done editing 

the view, right-click in the view to bring up the 

context menu, and choose Deactivate View. 

This drops you back into sheet view.

Splitting Views across Multiple Sheets

Revit has a specifically designed tool that allows you to split a view that is too large to fit 

on a single sheet, across multiple sheets. Using the duplication method called Duplicate 

as Dependent, available when you right-click a view title in the Project Browser, you will 

be able to make duplicate views that relate to one another so that you can work in one 

primary view and have your work appear in other, dependent views.

To understand this, let’s review in more detail the three methods of duplicating a view 

that we touched on in Chapter 3. Right-clicking on the view names of a view in the Project 

Browser will give you three duplication options: 

Duplicate  ​Makes an exact copy of the model elements in a view and ignores any annota-

tions and view-specific detail work existing in the original view. The resulting duplicated 

view will have no annotations or details in it. It will, however, show 3D annotations such 

as levels, grids, and reference planes. You will select this method of duplication when you 

need to make a presentation drawing of a plan in which you do not wish to see any dimen-

sions, tags, or text existing in the original view. This method is applicable when you need to 

produce nice images of a project for publication purposes or marketing material ordered 

by your client.

Model changes that happen in either the original view or in the duplicated view will 

propagate to the other. Annotations added in either of the two will not propagate to the 

other view.

Figure 9.16

Crop region

While you’re creating documents, you may decide to move a view to a different sheet than 

the one it’s on. To do so, grab it from the sheet list in the Project Browser, and drag and drop 

it to the new sheet name in the list.
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Duplicate with Detailing  ​Makes an exact copy of the model, annotations, and detail ele-

ments. The new view will look exactly like the original. You use this method when you 

wish to continue developing a plan to a different level of detail than the original. Examples 

for this would be when you need to make a detailed plan of a typical hotel room from a 

hotel floor or a technical detail of a how a column penetrates a wall, and so on.

Model changes that happen in either the original view or in the duplicated view will 

propagate to the other. Annotations added in either of the two will not propagate to the 

other view (Figure 9.17).

Duplicate as Dependent  ​Makes an exact copy of the model, annotations, and detail ele-

ments. This type of duplication also maintains a dependency between the view that is 

duplicated and the original view. If an annotation is deleted in either view, it is deleted 

from both views. Any changes that happen in either of the two views (the original or the 

duplicated view) will propagate.

Use this method when you work on very large projects when the plans you want to 

print in a certain scale do not fit the maximum sheet or plot sizes. In this case you’ll split 

the plan in many portions, but they’ll maintain the dependencies with the other parts so 

they are all coordinated in both model and annotation aspect. Another scenario is when 

you need to place the same view on different sheets. Note that when we say same, we really 

mean same: you cannot change scale or any other view properties of a dependent view and 

not have these propagate. The only allowed and possible differences between dependent 

views are per view visual and graphical overrides (hiding an element or category or graph-

ically overriding an element or category).

Figure 9.17

The resulting dupli-
cate view (A) has no 
annotations — only 
the model and grids 
are duplicated in 
the view. Duplicat-
ing with Detailing 
(B) copies all of the 
annotations.

A B
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Use Case Scenario

You have a large project and you wish to create a sheet with your floor plan. You open a 

sheet view and drag the floor plan on the sheet. You realize that the plan is too big for 

that sheet and that splitting it into separate pieces will be necessary.

You choose the Duplicate as Dependent option on the original floor plan. If you need 

to split the view in order to fit the plans onto more than one sheet, then duplicate as many 

views as you think you need. In Figure 9.18, two dependent views will be needed but as 

you can imagine, in bigger projects this could range from to six to eight dependent views. 

Figure 9.19 clearly shows that the entire plan will not fit on the sheet size of choice for the 

scale selected by the user.

After creating duplicate views as dependent views, each view is cropped so that it will 

fit the sheet. You will notice with dependent views that the annotation crop is enabled by 

default. This is to keep annotations from other parts of the parent view from showing up 

in your cropped view. After manipulating the crop region of both views, you will end up 

with two dependent views, each focusing on one section of the building, as shown in 

Figure 9.20.

Figure 9.18

The Dependent 
view functionality 
allows you to split 

views and place 
them on separate 

sheets

73559c09.indd   318 6/2/09   1:54:24 PM



The Sheet  ■   319

Note the double crop region: the outer boundary is the annotation crop; the inner is 

the model crop. When you drag the blue grips of the model crop, the annotation will fol-

low along at a preset offset distance. Manipulating just the annotation crop has no effect 

on the model crop, and you cannot drag the annotation crop inside of the model crop.

If you go back to the original view and click the Show Crop Region toggle  in the 

View Control bar, you will see both the crop regions of the dependent views and thus see 

how they relate to one another (Figure 9.21).

In our example, and this can be quite typical, one wing of the build-

ing (see Figure 9.22) may be at an oblique angle relative to the screen, 

and by extension, the sheet. Revit provides a way to orient each depen-

dent view so that it can better fit a sheet.

To accomplish this task, in sheet view activate the dependent view, select 

the crop region of the dependent view, and rotate it. Figure 9.23 shows the 

process of rotation of the wing. During the rotation, you will notice a 

help line that finds angles of reference and can help you rotate the view 

parallel to the main axis of the wing. Figure 9.24 shows the rotated wing.

Figure 9.19

The plan does not fit 
on one sheet

Figure 9.20

The two 
dependent views
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You can accomplish the same rotation by opening the dependent view itself and then 

rotating the crop region. Do not attempt to rotate dependent view crop regions from the 

original (parent) view.
Figure 9.21

Original view 
with crop region 

visibility turned on

Figure 9.22

This wing of the 
building needs 

to be oriented to 
better fit the sheet

73559c09.indd   320 6/2/09   1:54:24 PM



The Sheet  ■   321

Figure 9.23

The crop region can 
be rotated so that 
the view is rotated 
parallel with the 
model

Figure 9.24

The plan now fits 
the sheet
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You will also notice that rotating a dependent view reorients the tags in the view so they 

remain readable on the sheet (see Figure 9.25).

Whenever you are in any of the dependent views, you can see the other view by 

selecting the Crop View/Do Not Crop View option in the View Control bar . This 

will turn off the cropping and the other views will show up displaying the crop bound-

aries that are inactive.

As you continue working with a project divided among multiple dependent views, you 

will notice that any addition or change to annotation as well as model elements will appear 

in all views associated with the original parent view.

One very neat detail: imagine your project has 20-plus floors and the size was such 

that you needed to divide it into four dependent views. After you have spent time divid-

ing the first four on Level 1, you need to do the same thing for the remaining floors. Revit 

streamlines this process for you. In the right-click menu of the parent view that you made 

the dependent views from, there is an option called Apply Dependent Views that will open 

a dialog box. You can use this dialog box to select all the views you want to apply the same 

dependent view division to. With one click, this will create many dependent views. 

Figure 9.25

Tags have been 
smartly rotated to 

be legible
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Match Lines and View Tags

Match lines are graphic indicators in plan views that depict a split in the drawing because 

the whole building could not fit on a sheet (Figure 9.26). In Revit, the match line is a 3D 

line that extends (as grid lines do) through the entire project.

The Matchline tool can be found in the Sheet Composition panel on the View tab and 

is drawn as you would any other line in Revit. In the properties of a match line you can 

define the top and the bottom constraints. This is needed when the building does not have 

the same floor plan through all floors, and the break line for dependent views might not 

be applicable to all views in the same way.

View References

View references are a special type of annotation applicable to views only. They reference 

other dependent views and hyperlink to them.

You will find the View Reference tool in the Tag panel on the Annotate tab. If you are 

in a dependent view and select a view reference, it will instantly recognize the other 

dependent view and create a reference and hyperlink to it. If you are in the original view 

when more dependent views are present, you can select the View Reference tool, hover the 

cursor over a crop region of a view you want to reference, and place the view reference.

Note that the view reference will be empty if the dependent view is not placed on a sheet. 

The moment you place it on a sheet, it will fill in the number of the reference (Figure 9.27).

Figure 9.26

The match line 
indicates a break in 
the view
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A few more tips about dependent views:

When you select Duplicate as Dependent View, the dependent view will appear as a •	

node under the original view in the Project Browser.

A dependent view can at any point be converted to an independent view. You can do •	

that in two different ways:

Right-click on the dependent view and select Duplicate with Detailing. This will •	

keep the dependent view and create a new independent view.

Right-click on the dependent view and select Convert to Independent View.•	

Figure 9.27

View reference tags 
for two dependent 

views: one placed 
on a sheet and 

another one not
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Annotations

C hap te r 10

No set of documents is complete  without annotations that 

add textual or numeric descriptions to the drawings. The need to add dimensions, tags, 

and textnotes to aid in the communicating design intent is still very much a part of the 

BIM workflow, and Revit is designed to support that workflow with some very intelli-

gent, bidirectional annotation tools.

Topics we’ll cover include:

Annotating your project■■

Tags■■

Dimensions■■

Text and keynotes■■

73559c10.indd   325 6/2/09   1:54:52 PM



326  ■   Chapter 10 : Annotations

Annotating Your Project
In any set of documents, showing geometry alone isn’t sufficient to communicate all the 

information a builder or fabricator needs to construct the building. Tags, keynotes, text, 

and dimensions all need to be added to the drawing in order to clearly and concisely guide 

construction. They assist you in taking your model data and clearly documenting it for 

others to read and understand.

Starting where you left off, with some views placed on sheets, you’ll continue to build 

your set of drawings by adding annotations to the views.

Tags
Tags are textual labels for architectural elements such as doors, walls, windows, rooms, 

and many other objects that architects typically need to reference in a set of drawings. In 

Revit, tags are intelligent bidirectional symbols that report information stored in the prop-

erties of an element. A value can be directly edited from the tag; likewise, editing an ele-

ment’s properties affects the tag. For example, selecting a wall tag (Figure 10.1) returns the 

wall type that is set in the properties of the wall itself. This is a simple, standard-looking 

wall tag. The tag, however, can display richer information, such as the wall’s fire rating or 

manufacturer, or any other value of the wall’s properties. You can design it to suit any 

graphical and informational requirements that you have.

Loading Tags
Revit comes with a variety of predefined generic tags. All of these can be customized to 

meet your office’s graphic requirements. The set of tags preloaded into the default template 

covers many common requirements but is by no means exhaustive. Many firms have cre-

ated their own tags and added them to their project templates so they are available during 

project development.

Most categories of elements in Revit can be tagged, and you can load multiple types of 

tags for each category. Tags are loaded from the Loaded Tags dialog box, which you access 

by expanding the Tag panel options on the Annotate tab. The resulting dialog box lists all 

the Revit categories that can be tagged. Click the Load button to load new tags into your 

project.

In Revit, annotations, dimensions, and tags are placed in the views themselves, not on the 

sheet. This might be different from the way you are used to working in AutoCAD, so remem-

ber this well. This allows you to annotate a view at any point in the process, before or after 

views have been placed on a sheet. 

The exception to this occurs when you’re annotating a perspective view. These views 

don’t allow for text, so you’ll need to place the text outside of the view after it has been 

placed on a sheet. 

Figure 10.1

The default wall 
tag in Revit
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Placing Tags
You can insert tags and load additional tags from the Tag panel on the Annotate tab  

(see Figure 10.2).

The Tag button will put you into a tag placement mode, but you can also access 

the loaded tags dialog box by clicking the Tags button on the Options bar. The tag 

button will only be available in certain types of views (the Tag button is deacti-

vated in 3D views, schedule views, etc.). If you click this button but don’t have a tag 

loaded, you’ll be prompted to load a tag. During tag placement, the Options bar lets you 

position a tag in several ways. Figure 10.3 shows how the Options bar appears.

Tags can have a horizontal or vertical orientation and may or may not have a leader 

line. In the case of a wall tag, you typically have a leader coming from the wall, whereas 

you don’t typically use a leader with a door or window tag.

Tags will also dynamically adjust to the scale of the drawing. If the text of a tag is set 

to read at ⅛″ (3 mm), it appears in the view at such a size to always print in that absolute 

size regardless of the scale (see Figure 10.4). This means that once a tag is placed in a 

view, the view can be resized and the tags will remain the same printing size. Depending 

on the scale of the drawing, you might need to adjust the position or location of the tags 

for better visibility, but once a tag is inserted, you will never have to reinsert a tag simply 

to change scale.

Figure 10.2

The Annotate tab

Figure 10.3

The Options bar 
when a tag is 
inserted

Figure 10.4

Tags dynamically 
adjust to the scale 
of a drawing

1/4′′ scale 1/8′′ scale

You can add tags to your project after the design phase or during the actual creation of the 

elements. It really depends on the workflow you follow. A majority of firms first design and 

then document and annotate later in the process. At the same time, some practices tend to 

annotate during the design phase. In this case, for some elements such as doors and win-

dows, you have the option to tag during placement, which will annotate your drawings right 

from the start. Keep in mind that using the Tag All Not Tagged option allows you to achieve 

rapid tagging of elements in a view in the event that you decide to tag elements long after 

the design process ends.
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The Tag panel presents three options for inserting tags:

Tag By Category  ​This option allows you to tag elements in 

the model by category or type. Examples are doors, walls, win-

dows, and other commonly tagged elements. After you choose 

By Category, the elements you can tag are highlighted as you 

mouse over them in your view. Revit also displays a ghosted 

preview image of the tag you’re inserting and the value in that 

tag, as shown in Figure 10.5.

Multi-Category  ​Use the Multi-Category tag when you want to tag an element across dif-

ferent family types — for instance, when you’re using a similar glazing type in your win-

dows and exterior doors and you want to be able to tag the glazing consistently. The 

Multi-Category tag allows you to have the same tag and tag value for the glazing in both 

families. (Fire rating is another common application of this tag.)

Material  ​The Material tag lets you tag the materials in a given family. For example, tag-

ging a wall by material exposes materials used in the wall construction such as gypsum 

board or metal studs. This allows you to tag these elements separately.

Changing a Tag Value
There are two ways to modify the value text in a tag. Selecting the tag makes the value 

text an active control and turns the text blue; just click the blue text and begin typing. 

You are not only changing the value displayed in the tag but also changing the type prop-

erty of that element (the Type Mark parameter). The second option is to open the proper-

ties of the element being tagged. Using a wall example again, if you select the wall, open 

its type properties, and change the Type Mark field to a new value, the wall tag updates 

instantly and reflects this change. See Figure 10.6 for examples of each location.

Whichever way you choose, it is important to know that you will be changing the 

symbol text for every instance of that element type and thus of its tags. Therefore, if you 

change the wall type mark from A1 to A2, it will change every instance of that wall that 

was previously tagged A1 and all wall tags will thus display A2. If 10 walls were tagged 

A1, all 10 are now A2.

Only if you use the first method to modify text — chang-

ing it directly in the tag — are you notified that you’re making 

a global change (see Figure 10.7). If you choose to change the 

Figure 10.5

Tagging by category

Figure 10.6

Changing the 
wall type

Figure 10.7

Warning when you 
change the wall 
type from a tag
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value in the Type Properties dialog box, Revit assumes you understand this will change 

that property for each of the elements of this type in the model.

Some tags only report instance values — values that are unique to the individual ele-

ment. A room tag or door tag is a common example. In that case, changing the property 

of the room or the tag will have an effect only on that one room. The room tag graphics 

are consistent, but the room name varies from room to room. Doors are often tagged like 

this, with a unique numeric value for each door. With these types of tags, Revit will 

detect if you enter duplicate values and warn you when that happens.

The Tag All Not Tagged Tool
Instead of manually tagging each and every element one by one, in Revit you can tag many 

elements at once using the Tag All tool on the Tag panel of the Annotate tab. This time-

saving feature lets you tag all the elements in a view with a single click. During early phases 

of design, you often aren’t concerned with tags and annotations but are more focused on 

the model. Tags can become graphic clutter that obscures the design at times.

Later in the process, when you’re happy with the design, you may want to annotate the 

drawing quickly. This is where the Tag All tool is helpful. When you select this tool, the 

dialog box shown in Figure 10.8 opens. You can orient your tag or add a 

leader to it before tagging all the listed elements in your current view.

If you have some elements selected, you can choose to tag only those 

selected elements.

In the Source_House_Beginning_Detailing.rvt file at the book’s com-

panion web page, www.wiley.com/go/introducingrevit2010, open the view 

called First Floor Plan. In this view, using the tools mentioned, let’s add 

tags for the doors and walls:

	 1.	 On the Annotate tab’s Tag panel, select Tag by Category.

	 2.	 Move your cursor over a door, and click when it highlights. Make 

sure your leaders are turned off on the Options bar for door tags.

	 3.	 Highlight and select the interior walls. For wall tags, use the 

Options bar to turn on leaders and adjust the leader length from ½″ to ¼″. The fin-

ished floor plan looks like Figure 10.9.

Figure 10.8

Tag All Not Tagged 
dialog box

If you have forgotten to activate leaders when creating the tags, don’t despair — you can 

always add them by selecting the tags, individually or with multiselect, and checking the 

Leader check box in the contextual tab for tags. The same applies if you decide you don’t 

want tags to have leaders.
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Dimensions
Dimensions are used to convey the distance or angle between elements or parts of elements. 

In Revit, a dimension is a bidirectional annotation that essentially tags distance or size. The 

word bidirectional means that you can edit the distance directly when elements are drawn or 

selected; likewise, the dimension updates automatically as the distance between elements 

changes (Figure 10.10). Dimensions are annotations, making them view-specific elements 

that appear only in the view where they’re drawn. If you need to repeat the same dimensions 

from view to view, you can copy and paste dimensions; they will locate the same model ele-

ments. Use the paste-aligned method described in Chapter 5, “Modifying Elements.”

The parametric nature of dimensions in Revit means that dimensions can’t be overrid-

den or cheated numerically as they can be in CAD. This preserves the integrity of the 

model and the design. If you hear that Revit “won’t let you cheat,” it’s true. And trust us, 

this is for your own good! Dimensions in Revit report the actual value of the distance 

they span. If the distance is 4′-0″ (120 cm), the dimension reads 4′-0″ (120 cm). You can’t 

change the numeric value of a dimension without changing the model. For example, if 

the distance between two elements is supposed to be 3′-6″ 

(106 cm), you would need to modify the distance between 

the two elements to get the dimension to report your intent.

Like all annotations in Revit, dimensions adjust to the 

scale of the drawing. They will always appear at the proper 

scale in the view. If you change the view scale, the dimen-

sions automatically resize. In Figure 10.10, the first image 

shows the dimensions at ¼″ (1:50) scale, and the second 

image shows the same dimension string after the scale was 

changed to ⅛″ (1:100) in the View Control bar.

Figure 10.9

Finished floor plan

Figure 10.10

Dimensions 
dynamically change 

by scale

1/4″ scale

1/8′′ scale
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By default, a linear string of dimensions only dimensions parallel entities. 

Nonparallel elements by their very nature have a dynamic dimensional relationship. 

The dimension between nonparallel elements will vary based on where the dimension 

falls between them. Because of this, Revit 

defaults to only allowing parallel objects 

to be dimensioned. Dimensions in Revit 

always read from the bottom or the right. 

This follows standard architectural sheet 

layout conventions. We mentioned that 

you cannot override the numeric value of 

a dimension, but this is not to say you 

cannot override the value with text. You 

have the ability to add text to multiple 

parts of the dimension string, including 

replacing the value with text. 

Figure 10.11 shows some examples of 

dimensions with text integrated.

To add text to a dimension string, select the dimension, then click on the blue dimension 

text. A dialog box will open allowing you to add text above, below, as a prefix, or as a suffix, or 

even replace the value with text (Figure 10.12).

By default, the dimension string will use the actual numeric value, shown in the upper 

portion of the dialog box. You can then add text by typing into the various text fields to 

add above or below or as a prefix or suffix.

To replace the value with text, choose the Replace with Text option. This will disable 

the prefix and suffix fields and allow you to type any text you want. Figure 10.13 shows 

the dialog box, with the text V.I.F typed in.

Figure 10.11

Examples 
of dimensions 
with text

Figure 10.12

The Dimension Text dialog box

Figure 10.13

Use the Replace with Text option to write in a 
text value for the dimension string
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If you try to add a number in this text field and click OK, you’ll get a warning and will 

not be allowed to make that kind of edit. Figure 10.14 shows the result when trying to 

replace 7′-8″ with 8′.

Dimensioning Your Model
You can find the Dimension tools in the Dimension panel on the Annotate tab.

To create dimensions, select the desired dimension tool, and begin picking elements in 

the model to dimension. For linear dimensions, parallel edges (references) of elements will 

highlight as the mouse moves over them, indicating a valid dimension candidate. After two 

references are selected, a preview graphic of the dimension line appears and moves with 

the mouse. When you’ve finished selecting references, move the dimension string to the 

desired location, and click empty screen space to finish the string.

When you add dimensions in Revit, use the Tab key to cycle through the selection options.

Once a dimension tool is activated, the Place Dimensions tab appears, and you’ll be 

able to change the type of dimension here if you need to (see Figure 10.15). Here are the 

buttons in the order in which they’re listed (from left to right) on the Options bar:

Aligned  ​Aligned dimensions are the most common dimension style. It places dimensions 

to elements parallel to the element itself. In the case of an angled wall, the dimension reads 

parallel to the angled wall (the top dimension in Figure 10.16).

Figure 10.14

Replacing a 
dimension value 

with numeric values 
is not allowed

Figure 10.15

Place Dimensions tab
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Linear  ​Linear dimensions are parallel to the sheet 

edges. In the case of your angled wall, the dimen-

sion is parallel to the bottom of the sheet, as shown 

in the bottom dimension of Figure 10.16.

Angular  ​Angular dimensions show the angle 

between two elements.

Radial  ​Radial dimensions are used to dimension to 

the radius of an arc or circle.

Arc Length  ​Arc length dimensions show the length 

of an arc.

The other choices on the Options bar allow you 

to choose your preferred pick points:

Prefer  ​This gives you the option to choose what ref-

erences in walls you want the dimension to prefer 

during placement. You can change what a dimension prefers during placement by using the 

Tab key to cycle through nearby references. The options shown in Figure 10.17 are Wall 

Centerlines, Wall Faces, Center of Core, and Face of Core.

Pick  ​This gives you the option to either choose individual 

references in sequence using the Individual References 

option or use the Entire Wall option, in which case you 

click walls and Revit automatically finds the ends of the 

walls and puts a dimension there. The Entire Wall selec-

tion has additional options — click the Options button on 

the Options bar — that can be further refined so door and 

window openings or even intersecting walls and gridlines 

can be automatically generated. The Auto Dimension 

options are shown in Figure 10.18.

To dimension non-coplanar entities, such as two walls, 

select the first element. Then, before selecting the second 

element, use the Tab key to cycle through the selection 

options until you highlight a point, as shown in the 

enlarged doorjamb in Figure 10.19.

Figure 10.16

Aligned and linear dimensions

Figure 10.17

The Prefer wall 
dimension locations

Figure 10.18

Auto Dimension 
options available 
when using the Pick 
Wall method

Figure 10.19

Points can be 
dimensioned to, 
as shown in this 
enlarged doorjamb
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The finished dimension appears in Figure 10.20.

Baseline and Ordinate Dimensions
There are some additional type parameters for linear and aligned dimensions that will 

allow you to create baseline and ordinate dimension string formats. These tend to be used 

by structural engineers and construction firms, but we’ll explain the behavior for you.

Baseline Dimensions

Baseline dimensions are multiple dimensions measured from the same baseline (see 

Figure 10.21). Some construction firms practice this type of dimensioning, especially 

when nonorthogonal references need to be documented for clearer construction.

Here's how baseline dimensions work: The first selected point or element will be the 

baseline for the dimension. The second reference selected will determine the direction of 

the dimension string, and the following selections will add more dimensions. Note that 

Figure 10.20

The finished 
dimension

Figure 10.21

Baseline dimensions
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the baseline dimension string is a single element; delete it and all of the dimensions in the 

string will be removed.

Creating a Baseline or Ordinate Dimension Style

You will find examples of baseline dimensions in the default template delivered with 

Revit 2010, but you will most probably have your own office template and will need to 

create your own types. To create your own baseline dimension type, follow these steps:

	 1.	 Select any of your existing linear dimension types, click on the Element Properties, 

and in the Instance Properties dialog box, click Edit Type.

	 2.	 Duplicate the type and give it a unique name (we suggest using the word baseline in 

the name).

	 3.	 Select the Dimension String Type property and change it from Continuous to Base-

line (Figure 10.22).

You will notice that once a baseline dimension is created, a flip control symbol shows 

up: this control is located at the origin witness line and lets you flip the dimension base-

line from end to end (Figure 10.23). You can access the same behavior by right-clicking 

and selecting Flip Dimension Direction from the context menu.

If during placement of the dimension string at some point you select a reference on the oppo-

site side of the baseline reference, that new reference will become the new baseline reference, 

the dimension string will restack, and all strings will reference that new baseline reference.

Figure 10.22

Changing the 
Dimension String 
Type property
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Also notice that when selecting a baseline dimension a drag control appears on the 

screen (Figure 10.24) — this will let you drag the entire set of dimensions to modify the 

baseline offset and thus adjust the position of the baseline dimension.

You can change a baseline dimension back to linear dimension using the Type Selector 

when a dimension is selected. Doing so will collapse all of the dimension strings back 

into one string.

Figure 10.23

Flipping baseline 
dimensions

Figure 10.24

Drag control for 
baseline dimension
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Ordinate Dimensions

Ordinate dimensions measure the perpendicular distance from an origin point called the 

datum to a dimensioned element. These types of dimensions are more typically used by 

mechanical and structural engineers. Using the same 

example as in Figure 10.24, Figure 10.25 shows how 

that same dimension looks when converted to an 

ordinate dimension type.

Creating your ordinate dimension type is the 

same as creating the baseline type, as previously 

explained. The difference is that you will select 

Ordinate as the Dimension String Type setting when creating the new dimension type. 

Revit dimensions will recognize the intersection points of reference planes, grids, lev-

els, walls, and lines. This allows for much more effective dimensioning. An intersection 

between these elements is recognized and can be dimensioned to or from. When you 

dimension to an intersection, a green dot will appear, indicating the crossing point as a 

reference. When dimensioning from an intersection point, you’ll need to use the Tab key 

to get to the intersection point.

Modifying Dimension Appearance
By selecting a dimension and opening its properties, you uncover a host of options, as 

shown in Figure 10.26. You can also access this dialog box by clicking on the arrow to 

access the expanded panel for Dimensions. 

Here you can get to the type properties of the 

various dimension styles. 

First, we’ll discuss the parameters for 

which you can set values. These are listed in 

the upper pane of the dialog box.

Dimension String Type  ​This allows you to 

change dimensions from continuous, base-

line, or ordinate dimensions, as we just 

covered.

Tick Mark  ​This option allows you to select 

the style and size of the tick marks in Revit. 

The tick mark is the angled line crossing the 

intersection of the witness and dimension 

lines (shown in Figure 10.27).

Figure 10.25

Ordinate 
dimension type

Figure 10.26

The Type Properties 
dialog box for a 
dimension

Figure 10.27

Tick mark
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Tick Mark Line Weight  ​This option controls the line thickness for the tick mark only.

Dimension Line Extension  ​This option controls the length of the extension to the dimen-

sion line after the tick mark (shown in Figure 10.28). The dimension line is the line the 

dimension text sits on or over.

Flipped Dimension Line Extension  ​This option is available only if Tick Mark is set to 

Arrow. It controls the extent of the dimension line beyond the flipped arrow if the arrow 

flips on the ends of the dimension string.

Witness Line Control  ​A witness line is the line parallel to the elements dimensioned and 

perpendicular to the dimension line. This option toggles the setting to show or not show 

the second witness line. To have both witness lines show, use the Gap to Element setting.

Witness Line Length  ​This field becomes active only if the Witness Line Control is set to 

Fixed Dimension Line. You can set the length of all the witness lines in the dimensions.

Witness Line Gap to Element  ​This option controls the distance between the witness line 

and the element dimensioned.

Witness Line Extension  ​This option controls the length of the witness line after a tick mark.

Centerline Symbol  ​This option shows a symbol if you’ve dimensioned to the centerline of 

an element (see Figure 10.29).

Centerline Pattern  ​This field changes the line style of a centerline.

Center Tick Mark  ​This field by default is blank. It allows you to add a tick mark on the 

inside of the witness lines.

Interior Tick Mark  ​This option is available only when Tick Mark is set to Arrow. It desig-

nates the tick-mark display for inner witness lines when adjacent segments of a dimen-

sion line are too small for arrows to fit.

Color  ​This field changes the color of the dimension strings.

Dimension Line Snap Distance  ​This option aids in the use of stacked dimension strings.

Next, let’s look at the options in the Text pane, which occupies the lower half of the 

Type Properties dialog box:

Text Style Options  ​You can make the text bold, italic, or underlined.

Text Size  ​This field changes the size of the dimension text.

Figure 10.28

Dimension line 
extension

Figure 10.29

Centerline symbol
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Text Offset  ​This option changes the distance the text is placed from the dimension line.

Read Convention  ​This option shows you the default values of the dimension text position. 

In Up, then Left (the default value), the dimension text reads from the bottom of the 

sheet and then from the right of the sheet, appearing above the dimension string depend-

ing on whether it’s horizontal or vertical.

Text Font  ​This field controls the font of the dimension string. It’s possible in Revit to have 

a font for dimensions that’s separate from notes or other text.

Text Background  ​The options for this value are Opaque and Transparent. It changes the 

appearance of the box surrounding the text.

Units Format  ​This option controls the dimension string tolerance and unit displays.

Show Opening Height  ​This option returns the height of an opening below the dimension 

string. In the dimensioned window shown in Figure 10.30, the width is shown as 3′-0″ 

and the height as 4′-0″.
Note that while the position of the dimension text is defined in the properties of the 

dimension type, you can still manually change the position to avoid a clash of informa-

tion and move the text to a more appropriate place in the project. To do that, use the blue 

dot displayed right below the dimension text when a dimension chain is selected, and 

move it around. Notice that when you do that, any text added to the dimension text as 

well as all prefixes, suffixes, the text above, and the text below will also move, as they 

behave like one group of elements. Figure 10.31 shows a dimension value moved away 

from the string. Notice that the automatic leader and all dimension text values are 

preserved.

Dimensioning a Floor Plan
Now that we have covered the basics of dimensioning, let’s try it on the first floor plan 

view you’ve been working on in the Source_House_End_Detailing.rvt file. Using the default 

dimension settings and the linear dimension style, you’ll add dimension strings to the 

walls in the floor plan.

For interior walls, choose the Dimension tool. On the Options bar, select Wall Faces 

from the Prefer menu.

Figure 10.30

Show opening 
height

Figure 10.31

You can move 
dimension values 
interactively
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For the gridlines, choose the Entire Walls option 

from the Pick drop-down menu. Before placing the 

dimensions, click the Options button, and then select 

Intersecting Gridlines. Pick parallel walls that are per-

pendicular to the grids, and you’ll see the ease with 

which a string of dimensions can be generated 

(Figure 10.32).

The finished floor plan should look similar to 

Figure 10.33.

Text and Keynotes
Notes are a critical part of communicating design and construction intent to contractors, 

subs, and owners. No drawing set would be complete without textual definitions and 

instructions on how to assemble the building. Revit has two primary ways of adding this 

information to the sheets: text and keynotes. Text in Revit consists of words arranged in 

paragraphs with or without a leader. Text can be used for specialized annotations, sheet 

notes, legends, and similar applications. Keynotes, the other tool for annotating a drawing, 

are element specific and can be scheduled and standardized in the Revit database. We’ll 

explore the use and function of both tools in this section.

Figure 10.32

The Options bar for 
a dimension

Figure 10.33

The dimensioned 
first-floor plan
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Text
Text is easy to add to your view. You can access the Text tool from the Text panel on the 

Annotate tab. 

Text can be added to any view, including a 3D view. To begin adding text, click the 

Text button after you’ve opened the view of your choice, select where in the view you wish 

to place text, and begin typing. To edit text you’ve already placed, click the text to high-

light it, and then click it again to activate the text box. To move text once you’ve located 

it, select it and drag it, or use the Move command that appears in the Modify Textnotes 

contextual tab. 

When you use the Move command, you move both the text and the leader. When 

you move text by dragging the arrow icon, you move only the text box, leaving the leader 

anchored in its original position.

As with all the tools in Revit, there are ways to change the look and feel of your text 

during creation. Once you’ve selected the Text tool, the options change to give you some 

formatting choices. Figure 10.34 shows the options available with the Text command.

The Type Selector, available when selecting the Change Element Type button, allows 

you to choose a style for the text you’re using. Each text style is managed through the 

familiar Properties dialog box, where you can modify parameters such as font and size. 

To create a new text style from an existing one, click the Element Properties button and 

choose Edit Type in the Instance Properties dialog box. From there, choose Duplicate, give 

the style a new name, and make your adjustments to the properties. This process is iden-

tical to adding a new type to any existing Revit family.

Justification options are displayed as icons, allowing for left-, center-, or right-justified text.

After selecting a textnote, click the blue letters to edit the text. When you’re editing the 

text, you’re given additional formatting in the edit text tab for bold, italic, and underline. 

These apply to whatever text you’ve selected in the note. 

Text Properties

Most text parameters are located in the Type Properties dialog box for text. It’s here that 

you define font, style, and size. Figure 10.35 shows the properties available for text. 

Figure 10.34

Text format tools
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The following list discusses these proper-

ties and explains show you can modify those 

values to customize your text in your project:

Color  ​This is where you can choose the font 

color.

Line Weight  ​This option allows you to choose 

the line weight for the elements associated 

with this text type. This includes the line 

weights of any leaders or arrowheads. Note 

that line weight options for the leader are 

found under Object Styles.

Background  ​This gives you the option to 

have a background for your text box that is 

either opaque or transparent. Opaque creates 

a white box (blotting out the model behind 

it, as shown in Figure 10.36). Transparent 

leaves the text box clear and lets you see the 

model data behind the text (Figure 10.37).

Figure 10.35

The Type Properties 
dialog box for text

Figure 10.36

Opaque text box

Figure 10.37

Transparent text box

Tab Size  ​This option sets the distance your cursor offsets when you use the Tab key in a 

text box.

Bold, Italic, Underline  ​These options mirror the commands available on the Options bar, 

allowing you to bold, italicize, or underline your text.

Width Factor  ​This value lets you control the width of your text. A value less than one 

reduces the width of the text by a factor, and a value greater than one makes the text wider.

After you’ve placed a text box in the drawing, you have the option to go back and 

change some of the parameters. When text is selected, check the contextual tab: you can 

add and remove leaders and change the text justification (see Figure 10.38).

The leader buttons allow you to choose a leader style for your text before you add it to 

the view. From left to right in Figure 10.38, you can choose none, one segment, two seg-

ments, or an arc for a leader line. You can add any number of additional leaders to the left 

Figure 10.38

Adding leaders from 
the Leader panel
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or right of the text box. The first two leader options are for leaders with lines, whereas the 

second two are for leaders with arcs. (You can’t have a text box with both linear and arc 

leaders.) You also have the option to remove leaders you’ve added. Note that leaders will 

be removed in the opposite order in which they were added.

Model Text

Model text is 3D text that appears as a model element in your project. The properties of 

model text are similar to the properties of other model elements, rather than those of 

text. Model text can have thickness, material, keynote, and other common model 

properties.

A classic use for model text is signage for a building entrance (Figure 10.39). Keep in 

mind that model text can also be created in the Family Editor, so that if the signage is 

repetitive, you can create a single signage family and use it several times in a project.

Model text height dimensions are given relative to the model. If you want the text to be 

3′ tall in the model, it stays 3′ tall but becomes larger or smaller in the view depending on 

the view scale.

The Model Text command is located in the Model panel on the Home tab. To add 

model text to your drawing, click the Model Text button. You’ll see a dialog box asking 

you for your text entry. Type your text, and click OK when you’ve finished. At this point, 

you’re asked to place the text in the view you currently have active. If you’re in a 3D view, 

Revit chooses a work plane based on the location of your cursor over model faces. Click to 

Figure 10.39

Model text
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place the model text. After you’ve placed the text, you can select it and use the tools in the 

Modify Model Text contextual tab shown in Figure 10.40 to edit the text or reposition it.

Edit Text  ​This button lets you change the text you typed. You can also edit the work plane 

on which the text was created.

Edit Work Plane  ​This button opens another dia-

log box (Figure 10.41) where you can select a new 

work plane from an existing one or choose a plane 

of an existing Revit element.

Rehost  ​This button allows you to move text 

from the element you’ve selected to another host 

element in the model. (We discussed this feature 

earlier, in the context of windows and doors.)

Keynotes
Keynotes and textnotes textual annotations that relate text strings in an external file to 

specific elements in the model. You can format font style, size, and justification in the same 

manner as for standard text, but keynotes and textnotes behave like a Revit family. This 

means you can insert different family types of text in Revit, just as you would door or 

window families. Changing one instance of the family type changes all the instances in the 

project. Because keynotes and textnotes act as families in Revit, they can also be sched-

uled. It is important to understand the difference between a keynote and a textnote.

Keynotes are a way to annotate elements with references that refer back to another table 

of data. These are typically shown as a number followed by a letter. An example would be 

“03300.AA” and it might refer to a cast-in-place concrete wall. The “03300” portion of the 

note refers to the specification section the note is generated from, and the “AA” portion of 

the note is a sorting mechanism used to differentiate cast-in-place concrete from another 

note in Division 3 of MasterSpec. All of the notes on a given sheet are keyed back to a leg-

end that is typically placed on the right side of a sheet. This reference is an aid to add more 

detail and understanding to the keynote 

without having to directly reference the spec-

ifications. Textnotes are similar to keynotes, 

but combine the text and the key into one 

note. This saves you from having to coordi-

nate the legend on the sheet and puts the note 

right next to the item you are pointing to. See 

Figure 10.42 for examples of textnotes.

No matter which style you prefer, both the 

keynote and the textnote can be created with 

the same command in Revit. Since the Revit 

Figure 10.40

The Modify Generic 
Models context 

bar for modifying 
model text

Figure 10.41

Selecting a work plane

Figure 10.42

Keynotes
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command is called Keynote, we will refer to the process from here on as keynoting 

regardless of the style of keynote (or textnote) you choose to use.

The Keynote command is located in the Tag panel on the Annotate tab. Adding key-

notes in Revit gives you three options for keynoting an element:

Element  ​Allows you to note an element in the model, such as a wall or a floor. This type 

of note is typically used if you want to note an entire assembly, such as a wall assembly. 

You can find this value in the family properties of that element. 

Material  ​Allows you to note a specific material in Revit. For example, this will let you 

annotate materials such as concrete, gypsum board, or acoustical tile.

User  ​Allows you to select any model-based component in Revit and define a custom key-

note for it. Notes defined this way differ from those defined under Element or Material 

because they’re unique to the particular object selected. They can be used in conjunction 

with Element and Material notes.

Keynote Behavior and Editing

A core concept of keynoting is how the notes react in the model. Keynotes are integrated 

into Revit just like any model element. Keynoting an object in Revit lets you associate a 

text value to that family’s keynote parameter. This value is consistent for every identical 

element in the model. For example, all doors have a type parameter that lets you set the 

keynote value. If you keynote that door — anywhere in the model — the keynote will 

show that value. Likewise, if you ever change the value of the keynote for the door type, 

all keynotes will update automatically.

Keynotes are special in that you cannot edit the text of a keynote directly in Revit. All the 

keynotes in Revit are tied to an external text file, which is the only location they can be 

edited. This file can be modified at any point to add or remove values and notes. A sample 

portion of the Revit keynote file, RevitKeynotes_Imperial.txt, is shown here. This external 

.txt file is designed to keep annotations consistent by storing all of them in one repository. 

Every time you add or change the text of an annotation and reload the text file, it dynam-

ically updates all the keynotes of that type used in the project.

03100 Concrete Forms and Accessories 03000
03200 Concrete Reinforcement 03000
03300 Cast-in-Place Concrete 03000
03400 Precast Concrete 03000
03500 Cementitious Decks and Underlayment 03000

You can edit a keynote text file (.txt) or add one to a project at any time. You can have 

multiple text files for various projects, but you can have only one text file per project at a 

time. All the notes are parametric, so changing a note in the text file will change all of the 

notes in the project when the text file is updated.
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Since the keynote .txt file is separate from the Revit file, if you send a project file to 

someone and don’t send the keynote.txt file, that person will be able to see all the keynotes 

you’ve added to the views but won’t be able to add or edit the notes without the .txt file. 

Keynote Filenaming Conventions 

The default .txt file in Revit resides in C:\Documents and Settings\All Users\Application 

Data\Autodesk\RAC 2010\Imperial Library (or Metric). To edit this file, open it in Notepad 

or Excel, and follow the format already established in the file. Let’s look at that format to 

get a better understanding of how to customize keynotes.

The first few rows designate the groupings. They consist of a label (in this case, a num-

ber) followed by a tab and then a description. An example grouping looks like this: 

03000 Division 03 - Concrete

Below the groupings, with no empty lines in the file, are the contents of the groupings. 

These are shown with a minor heading, a tab, a description, a tab, and the original group-

ing header. Here’s an example:

03200 Concrete Reinforcement 03000

Here, 03200 is the subheading, Concrete Reinforcement is the description, and it all 

falls under the 03000 grouping from the previous example.

Using this method, you can add or edit notes and groups of notes to the keynote file. It 

might seem horribly inefficient at the beginning of the process to have to constantly go to 

the keynote text file to edit or add notes. Although this might seem like a burden, it can 

be a blessing as well.

Accessing this file ensures a level of consistency within the keynotes globally on the 

project that is unattainable in most 2D methods of drafting. If you are feeling frustrated 

with having to access this file to make changes, think about all of the time you are saving 

not having to check your set sheet by sheet to verify that all of the notes pointing to a 

material are consistent with each other.

A powerful way to ensure consistent use of notes throughout your office is to create a master 

.txt file for your various project types. These master note lists can be prelinked to materi-

als or assemblies within your project template, allowing you to immediately begin inserting 

common notes into any project. Prelink these settings by opening the Materials dialog box 

from the Manage tab and clicking the Identity tab. In the Keynote field, a predefined note 

can be added to any material.
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Keynote Settings

Once you change a keynote text file, you must reload the file into Revit to update the key-

notes. Access the dialog box to change or update the text file by selecting the arrow in the 

Tag panel to access expanded panel options. Click 

Keynoting Settings to open the dialog box 

(Figure 10.43).

The Keynote Table group lets you define the 

path to the .txt file used for keynoting:

Path Type  ​Defines how Revit looks for your .txt 

file using one of three methods:

Absolute  ​This option follows the UNC nam-

ing conventions and searches across your net-

work or workstation for a specified location. 

Relative  ​This option locates the .txt file relative to the Revit project file. If you move 

the Revit file and the .txt file, and they maintain the same folder structure, Revit 

knows where to look for them. 

At Library Location  ​This option lets you put the .txt file in the default library loca-

tion defined in the File Locations tab of the Options dialog box, accessed from the 

Application menu.

Numbering Method  ​Defines how the keynotes are numbered:

By Keynote  ​Allows you to number keynotes as they come from the associated .txt file. 

By Sheet  ​Numbers the keynotes sequentially on a per-sheet basis.

Adding Keynotes to a View

To add keynotes to a Revit model, choose one of the three keynote types from the Drafting 

tab in the Design bar. In your view, hover the cursor over the various model objects until 

you find the one you wish to note, 

and click to add the keynote to the 

element. Once you’ve placed the 

note, the Keynote dialog box will 

open (Figure 10.44), asking you to 

identify the element you’re trying 

to annotate.

Figure 10.43

The Keynoting 
Settings dialog box

Figure 10.44

Selecting a keynote
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Expand the plus signs until you find your desired 

keynote, and double-click it. Doing so associates 

that particular note with the element or material in 

the model. As mentioned previously, you only need 

to make this association once. For example, if you 

keynote a material called Concrete, then every time 

you hover over that material anywhere else in the model with a keynote tag, you’ll see 

the preview graphic of the tag showing Concrete (Figure 10.45). This way, you can define 

the materials and assemblies in the model and begin your documentation process.

With the exception of detail components (covered later in this chapter), you can’t key-

note lines or other 2D information.

Keynote Legends

Depending on your workflow and style of annotation, you may want to create a legend 

for your keynotes that appears on each sheet so that the legend only shows the keynotes 

used on that sheet. Or you may want to 

have one legend for the entire project and 

show all keynotes used in that project in 

one legend. These legends allow the 

builder to reference the note number 

with the text quickly and easily 

(Figure 10.46). These lists usually reside 

on the side of sheets near the title block 

information and can take on one of two 

forms: inclusive or exclusive.

The first type is all inclusive and will 

show every note used in the project. This 

style has the benefit of being totally consistent from sheet to sheet. The same note will 

always be in the same location in the list. The other type of keynote list shortens the list 

to only contain notes present on the specific sheet. This has the advantage of supplying a 

list of notes customized for each sheet without extraneous information. As you can imag-

ine, this second list can be labor intensive and fraught with opportunities for human 

error. One of the beauties of Revit is its ability to accurately manage this kind of informa-

tion for you. We will review how to create both styles of lists.

Creating a legend in Revit is simple: open the View tab, then choose the Legend drop-

down list and select Keynote Legend. You’ll be prompted to name the legend; enter a 

name, and click OK. 

Figure 10.45

Keynotes preview 
prior to placement

Figure 10.46

A keynote legend
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Only two fields are available in a keynote legend, and by default, they are both loaded 

into the Scheduled Fields panel of the Fields tab in the Keynotes Properties dialog:

Key Value  ​The numeric value of the keynote

Keynote Text  ​The text value for the keynote

This legend works very much 

like any other schedule as far as 

formatting and appearance are 

concerned. By default, the sorting 

and grouping is already estab-

lished by using the key value to 

sort. The one special item to note 

is located on the Filter tab. At the 

bottom of this tab is a feature 

unique to this type of schedule: 

a Filter by Sheet check box 

(Figure 10.47). Checking this 

box will give you the ability to filter the list specifically for each sheet.

Both styles of legend can be placed again and again on every sheet in the project. With 

the filtered legend style, it will dynamically modify the note list based on each sheet and 

the contents on each sheet. As views are added or removed from a sheet or notes are 

added to the project, the keynote legend will update accordingly. So, if the keynote is not 

used in the view placed on the sheet, it will not show up in the legend.

You will see all keynote legends listed in the Project Browser under the Legends node 

(Figure 10.48).

The Keynote Family

Revit comes with a keynote family that allows you to produce both keynotes and textnotes. If 

it is not loaded into your project, you can find it under the Annotations folder of the Imperial 

or Metric libraries. The family name is Keynote 

Tag.rfa. This family has three family types that 

allow you to change note styles within the project. 

You can see the three note styles in Figure 10.49.

The three styles are Keynote Number, 

Keynote Number — Boxed, and Keynote Text. 

Each of the notes shown in Figure 10.49 pulls 

information from the same text file that we dis-

cussed earlier in this chapter. You are simply 

Figure 10.47

Filter options for 
keynote legends

Figure 10.48

Keynote legends 
can be accessed 
from the Project 
Browser

Figure 10.49

Note styles available 
in the default Revit 
keynote tag
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using the flexibility of family types to report different values within the model from the 

same note. As with any other family, you can edit this family to change the note length, 

font style, or other attributes to match your office standards.

Adding Notes to a Wall Section by Material

As we discussed earlier in this chapter, there are three styles of keynotes: Element, 

Material, and User. With all of these styles, there are limits to what you can note within 

Revit. Understanding this is critical to successfully using the keynote system so you can 

optimize the value of your predefined notes.

Nearly all model elements in Revit can be keynoted; the only exceptions are detail lines, 

imports, and groups. This becomes a critical issue when you begin embellishing details 

within a model, drafting them in 2D with a drafting view, or importing standard details 

from CAD and looking to add keynotes to the CAD drawing. As a best practice, we recom-

mend using detail components and embedding them into project families. Detail compo-

nents are families created with 2D lines that can be dropped into any view to represent 

elements that are not modeled as 3D objects. An example would be blocking that appears 

over a window head. This is not something you would create as a model element, but it is 

still necessary to show in a section or detail (see Figure 10.50).

Once you’ve established your keynote style and made your adjustments to font size 

and type, it’s time to add some notes to the drawing. Adding notes to a drawing from this 

point is quite simple: 

	 1.	 From the Tag panel on the Annotate tab, choose the Keynote tool.

	 2.	 Select Element, Material, or User from the drop-down list. For our example, select 

Material.

Figure 10.50

Detail components 
are 2D elements that 
can be embedded in 

3D families

Figure 10.51

Hovering your 
cursor over a 

material gives you 
a preview of the 

keynote

	 3.	 Move the cursor over the model — as 

you mouse over materials, Revit will try 

to identify what material is being used. 

If the material already has a note value 

defined, a floating note identifying the 

material will appear (Figure 10.51). 
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From here, click to place the arrowhead on the note, click again 

to locate the joint in the leader, and then click again to locate the 

text. If the material is unknown, Revit will display a question mark 

to tell you this material has not been identified in the project yet 

(Figure 10.52). Locate the note using the same method for materi-

als that are already defined. Revit will then prompt you to select a 

value from the Keynotes table (Figure 10.53).
Once you’ve selected the note for a material, that same 

note will be applied every time you select that material with 

a keynote in every other view within the project.

By default, Revit does not include an arrowhead with any 

of the keynotes. There is no way to preset arrowhead styles 

for any of the notes. After you first insert a note into Revit, 

you will have to select the note to add an arrowhead. To do 

this, select the note, open its Element Properties dialog box, 

and select Edit Type. Here you can globally set an arrowhead 

style for any of the keynote family types. Most of the com-

mon arrowhead styles can be found in this properties dialog 

box. Selecting one from the list shown in Figure 10.54 will 

change the arrowheads for all of the notes of that type 

within the project.

Once you’ve added a couple of notes, it’s an easy pro-

cess to continue noting the remaining materials in the 

wall section. The completed section with keynotes looks 

like Figure 10.55. Figure 10.53

Choose a keynote value from the list

Figure 10.54

List of arrowhead styles

Figure 10.55

Fully material keynoted wall 
section

Figure 10.52

A question mark shows up if the material has 
not been linked to the keynote table

Adding Notes to a Wall Section by Element

Another way to keynote a drawing is to note by 

element. Keynoting by element means that you 

are not noting the individual materials, as we 

did in our previous example, but the entire ele-

ment assembly at once. So, in lieu of noting indi-

vidual layers of plywood and gypsum board, you 

are noting the entire wall assembly. The process 

to add the notes is similar:

	 1.	 In the Tag panel on the Annotate tab, 

choose the Keynote tool.

	 2.	 Select the Element option from the drop-

down menu.
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	 3.	 Move your cursor over elements in the model, and Revit will try to identify the ele-

ment or assembly. If the element already has a note value defined, a preview note 

identifying the element will display. From here, click to place the arrowhead on the 

note, click again to locate the joint in the leader, then click again to locate the text. If 

the element is unknown, Revit will display a ques-

tion mark to tell you this element has not yet been 

identified in the project. Locate the note using 

the same method as for elements that are already 

defined. After you set the text location, Revit will 

prompt you to select a value from the Keynotes 

table.

A wall section noted by element looks like 

Figure 10.56.

Predefining Keynotes

There are a variety of other ways to add notes to a project without adding them directly 

in a view. Within the properties of elements and materials is a field to predefine a keynote. 

Putting a value in this field before annotating the drawings allows 

you to avoid selecting notes from the keynote list when you are actu-

ally annotating a view. All of the notes would be preselected. 

Depending on the note type, the location for these settings varies.

Element  ​This value can be set in the properties of the various fami-

lies in a Revit project. By selecting a wall, for example, you can 

open this wall’s properties, and then click Edit Type to reach the 

wall type properties. Under Identity Data, you can then define a 

keynote (Figure 10.57). Selecting this field, you will be presented 

with the same Keynote table that you’d receive if noting this element 

in a view. If the note is incorrect for this project or element, you have 

the option to change the note here as well.

Material  ​This value can also be set in the Materials dialog box. By 

selecting a material from this list and then clicking the Identity tab, 

you can add keynote values directly to your materials (see 

Figure 10.58). You will again be presented with the familiar Keynote 

dialog box to select your materials.

Figure 10.56

Wall annotated with 
element keynotes

Element, material, and user notes in Revit are different entities and are allowed their own 

unique notes. You can note by material, by element, and by user within the same project.

Figure 10.57

Type Properties 
of wall showing 

keynote value 
predefined
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User  ​User notes are view specific and cannot be predefined. While it is still only possible to 

annotate model elements and detail components with the user notes, this tool will allow 

you to note the same element with different notes in separate views. This can be dangerous 

to the consistency of your notes in your drawings if used inappropriately. The advantage to 

this note type, however, is if you need to note something differently in one view based on a 

unique condition. Some examples might be a material or color change in a special location, 

or a special flashing or sealant issue around a unique window condition. This means you 

don’t have to re-create a new family type simply to add a different note.

Revit does not support more than one keynote.txt file per project. So if you want to include 

keynotes from different standards, you can simply add more to the one .txt file that you 

have, and they will all be available to be used.

Figure 10.58

Defining keynotes 
for materials
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Construction Documentation

C hap te r 11

Now that we’ve discussed  how to annotate a drawing, be it for 

presentation or production, we will review how to create the set of documents that will 

be used by the contractor and subcontractors to build the project.

In this chapter, we’ll go into detail about preparing the construction document set. 

Topics we’ll cover include:

Formatting your documents■■

Creating schedules■■

Using drafting views ■■

Understanding drafting tools■■

Importing CAD details■■

Reusing details from other projects■■
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Formatting Your Documents
When you begin documenting your project, most of your modeling should be more or 

less complete. That doesn’t necessarily mean that you have all your views established or 

all your sections cut, but it’s helpful if the majority of your building geometry is in place.

To illustrate, let’s go back to the house we’ve been working on. By this point the geom-

etry of the house should be well established. To begin the documents, you’ll create a series 

of views of the model. You’ve already established some views in the model. Some were in 

the Revit template file, and you made others while creating the model. However, the views 

you currently have for the floor plans are set up for presentation purposes and are not 

suitable as construction documents. Therefore, we need to create new views, customize 

their appearance, and place them onto sheets to make digital or paper prints of them.

Laying Out Sheets
The following exercise will help get you started documenting the house. We will begin 

making some views and placing them on construction document sheets.

	 1.	 Open Source_House.rvt in the Chapter 11 folder on the book’s companion web page, 

www.sybex.com/go/introducingrevit2010.

	 2.	 To start, you’ll duplicate both Level 1 and Level 2 using the Project Browser. To do this, 

right-click the view name, and choose Duplicate View ➔ Duplicate. Doing so creates a 

new view called “Copy of (ViewName).” Repeat this step for the second view.

	 3.	 Rename the view Copy of Level 1 to First Floor Plan by right-clicking the view name 

and choosing Rename. Use the same process to rename the view Copy of Level 2 to 

Second Floor Plan.

The First Floor Plan view has a graphical appearance that doesn’t match the Second 

Floor Plan view. Both views need to have a consistent graphical appearance showing the 

necessary information for a documentation set. To do this, you’ll create a new view tem-

plate using the Second Floor Plan view as a baseline. You can then apply this template to 

the first floor plan so the two views have a similar set of graphics.

Before making the view template, follow these steps to make some graphical adjust-

ments to the Second Floor Plan view: 

	 1.	 First, turn on the Sections and Elevations annotations. Open the view Second Floor 

and go to the View Tab, and from the Graphics panel select View Properties. In the 

View Properties dialog box, select Visibility/Graphics Overrides or press VG on the 

keyboard.

	 2.	 Select the Annotation Categories tab. Make sure the Sections and Elevations category 

check boxes are selected. Click OK.

	 3.	 In the Project Browser, right-click the Second Floor Plan view, and choose Create 

View Template from View.
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	 4.	 Name the view template Floor Plan, and click OK. A dialog box appears that allows 

you to adjust any of the many properties available in View Templates. For now, we 

will accept the template as we set it, so click OK again.

	 5.	 Right-click the First Floor Plan view, and choose Apply View Template.

	 6.	 Choose Floor Plan from the list, and click OK. You have just unified the look of the 

First Floor and the Second Floor.

Next, you need to create some additional views of the model: sections and callouts. 

Follow these steps:

	 1.	 Open the Second Floor Plan view, and cut a wall section through the west end of 

the house, as shown in Figure 11.1. After creating this section, it will be pointed in 

the wrong direction. Using the Flip icon, f lip the section cut to point in the other 

direction.

	 2.	 In the Section 3 view, create two callout views using the Callout tool located in the 

Create panel of the View tab. One callout should focus on the south clerestory con-

dition, and the other should focus on the northern window in the stairwell. See 

Figure 11.2 for callout locations. Rename the details you have just created Detail 1 

and Detail 2.

Figure 11.1

Adding sections

Figure 11.2

Adding callouts to the section view

To reposition the callout tag, select any of the callout lines and use the blue grips to reposi-

tion or resize the tag or the box.
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Now that you have created the views needed to document your project clearly, you 

can begin laying them out on sheets. There is a sheet template located on the book’s web 

page, www.sybex.com/go/introducingrevit2010; we will use it as the basis for our sheet set. 

You need one sheet for plans; one for elevations; and one for details, sections, and 3D 

views. To use the sheet templates and create the sheets, follow these steps:

	 1.	 Right-click on Sheets in the Project Browser, and select New Sheet from the context 

menu. In the next dialog box, choose Load and browse to the file named Sheets-CD.rfa. 

Click OK.

	 2.	 The Sheet view will become your active view. Repeat this step two more times, so 

that you have three sheets in the project.

	 3.	 Rename the sheets as follows: A100 Floor Plans, A200 Elevations, and A300 Sec-

tions & 3D views. To do this, right-click the sheet name in the Project Browser and 

choose Rename to bring up a renaming dialog box. You can also rename the sheet 

directly in the view when the sheet is opened. Select the sheet and click the blue text 

of the sheet name or number, and the text becomes an active text field you can then 

edit. Be sure to change the sheet name as well as the sheet number when you’re edit-

ing from the sheet itself (Figure 11.3).

When you add sheets, they appear in the Project Browser under the Sheets node.

As a next step we can begin adding views to the sheet itself. With a sheet view opened, 

you can drag a view from the Project Browser onto the sheet. Here’s how:

	 1.	 In the Project Browser, select a view (click and hold on the view name), and then drag 

it onto the sheet. A preview graphic of the view extents appears to aid in placement.

	 2.	 When you get the view approximately where you want it, release the mouse button. 

The view drops into place.

Each view is assigned a unique number once it’s placed on the sheet. This is referred 

to as the detail number, and it appears as a parameter of the view once it has been placed 

on a sheet.

Figure 11.3

Modifying the 
sheet name within 

the view
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For the next exercise, lay out the sheets with the following views on them:

A100•	  — First f loor plan and second floor plan. These views won’t initially fit on the 

sheet, but we’ll fix that soon enough.

A200•	  — North elevation and south elevation.

A300•	  — Section 1, Section 3, and 3D View 1. Notice that 

on sheet A100, the two plans don’t fit on the sheet; see 

Figure 11.4. Obviously, it’s vital to be able to produce 

drawings that read clearly and easily within the bounds 

of what will be the printed area. Revit provides control 

over the sizes of your views as they appear on the sheets, 

so it’s easy to fix issues like this when they arise.

You can do this directly from the sheet, giving you real-

time feedback about the view and its relation to the sheet.

	 1.	 Open Sheet A100. Mouse over one of the views on the 

sheet, and right-click.

	 2.	 Select Activate View.

	 3.	 Use the View Control bar to select Show 

Crop Region ( ). The light bulb in 

the icon turns yellow, indicating that 

the crop region is on. The view will now 

have a box surrounding the extents of 

the view with blue grips you can use to 

bring the extents of the view within the 

boundaries of the sheet. Once this is 

done, you can then right-click the view 

again and choose Deactivate View from 

the context menu. Note that while the 

crop region is still visible, it will not 

show when printed. You can then place 

the views on sheets in a more organized 

fashion similar to Figure 11.5.

	 4.	 Finish laying out the other two sheets. A200 and A300 should look like Figures 11.6 

and 11.7, respectively.

Figure 11.4

Plans initially don't 
fit on the sheet

Figure 11.5

Floor plans arranged

To make minor adjustments to a view location, select the view and use the arrows on the 

keyboard to nudge it around. The tighter you’re zoomed in on a view, the smaller the incre-

ment of movement.
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In a typical, professional-looking sheet arrangement, especially when you have mul-

tiple views (plans or elevations) on a sheet, it’s common to line up gridlines (in the verti-

cal dimension on the sheet) and levels (in the horizontal). Revit automatically aligns the 

grids and levels between views on the sheet when you drag views onto a sheet. Click and 

drag a view — a green, dotted snap-alignment line appears when grids are aligned with 

grids in the other views (or levels with other levels). This comes in handy when you lay 

out a sheet with multiple wall sections and you want the levels to all be lined up relative 

to one another on the sheet.
Figure 11.6

A200

Figure 11.7

A300
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Schedules
In Chapter 3, “Views,” we explained that schedules are a live, textual view of the model. 

We also discussed the different types of schedules you can create and walked through a 

simple example. For your documentation, you need to know how to modify the graphical 

appearance of a schedule and filter out information you don’t need to show.

Create and Customize a Schedule
When you create a new schedule, you’re presented with a number of format and selection 

choices. These let you organize and filter the data for display in the schedule as well as set 

the font style and text alignment. Let’s explore the options in the New Schedule dialog box.

From the View tab in the Create panel, choose Schedules, then Schedules/Quantities 

to create a new schedule. The New Schedule dialog box (Figure 11.8) first prompts you to 

select the category of elements you want to schedule. You can provide a name for the 

schedule and choose which phase of construction the schedule represents. We’ve left the 

phase as New Construction, because that is what you’re creating with the sample model.

Once you select the schedule you would like 

to create, you will be presented with another 

dialog box that contains the following tabs. 

These tabs are designed to help you format 

your data and its visual presentation:

Fields  ​This tab lets you select the data that 

will appear in your schedule. For the wall 

schedule, it shows all the properties available 

in the wall family.

Filter  ​This tab allows you to filter out the data you don’t wish to show. You’ll use this tab 

to restrict displayed data so that only information about the concrete walls in the project 

appears in the schedule.

Sorting/Grouping  ​This tab lets you control the order in which information is displayed. It 

also allows you to decide whether you want to show every instance of an item or only the 

totals for a given family.

Revit is essentially a database of model objects that are loaded with information; thus many 

of the same functions available in database queries are available in Revit. If you’re unfamiliar 

with database conventions, don’t stress — you don’t need to know about databases to run 

Revit successfully.

Figure 11.8

New Schedule 
dialog box
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Formatting  ​This tab controls the display heading for each field and whether the field is 

visible on the schedule. It’s possible to add fields that are necessary for calculations or 

sorting but don’t show on the printed copy of the schedule. Additionally, this tab can tell 

Revit to calculate the totals for any of the fields.

Appearance  ​This tab controls the graphical aspects of the schedule, including the font size 

and type of text for each of the columns and headers in the schedule. It also allows you to 

turn the grids on and off or modify the line thickness for the grid and boundary lines.

The following example walks through the various options in the Schedule Properties 

dialog box while you create a new wall schedule. In this example, you’ll create the sched-

ule, filter out all but the concrete walls, and calculate the volume of recycled content in 

the walls based on the assumption that you’re using 15 percent recycled content in all the 

concrete poured on the project. When you’ve finished, the schedule should look like 

Figure 11.9.

Follow these steps:

	 1.	 Open the Station.rvt file found in the Chapter 11 folder on the book’s companion 

web page.

	 2.	 Navigate to the View tab, and from the Create panel choose Schedules and then 

Schedule/Quantities.

Figure 11.9

The complete 
schedule
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	 3.	 Choose Walls from the category menu, and name the schedule 

Concrete Walls (see Figure 11.10).

	 4.	 Click OK.

	 5.	 Select the fields to be scheduled (see Figure 11.11). The fields are 

parameters used by the category, and they all appear in the prop-

erties of the element being scheduled. Add a field by double-click-

ing the name of the field in the left pane or by selecting the field 

and clicking the Add button. Doing so moves the field from the 

left to the right column. Or, you can remove a field by selecting it 

in the right column and clicking Remove.

	 6.	 Choose the following fields for the schedule:

Area•	

Description•	

Family and Type•	

Length•	

Volume•	

Width•	

	 7.	 With a field selected, use the Move Up and Move 

Down buttons in the lower-right corner of the dialog 

box to sort the fields in the order you want them to 

appear in the schedule table. For example:

Family and Type•	

Description•	

Width•	

Length•	

Area•	

Volume•	

	 8.	 To make a new field to display information about the recycled content of your walls, 

click the Calculated Value button.

Figure 11.10

Starting a schedule

Figure 11.11

Fields tab

There is no predefined field in Revit for recycled content, but Revit lets you create custom 

fields and custom formulas.
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	 8.	 To make a new field to display information about the recycled content of 

your walls, click the Calculated Value button.

	 9.	 The Calculated Value dialog box opens (Figure 11.12). In this dialog box 

you can create new columns in your schedule based on relationships to 

other fields in the table. Name your new value Recycled Volume. For Type, 

choose Volume from the drop-down list, and in the Formula box, type 

Volume*.15.

	10.	 When you’re done, click OK.

	11.	 Choose the Filter tab (Figure 11.13). Because you want to show only the con-

crete walls, you need to filter out all the other walls in this schedule.

	12.	 From the upper-left Filter By drop-down menu, 

choose Description.

	13.	 The right Filter By menu allows you to select from a 

standard list of database queries: equals, doesn’t 

equal, contains, doesn’t contain, and so on. For this 

schedule, use the default value, which is equals.

	14.	 From the lower-left Filter By menu, choose Cast in 

Place Concrete. (This menu dynamically generates 

from the descriptions given in the properties for the 

element in question. In this example, wall properties 

are displayed.)

	15.	 Select the Sorting/Grouping tab shown in Fig-

ure 11.14. Use these options to sort the walls first by 

Family and Type, and then by Volume.

	16.	 Near the bottom of this tab, select the Grand Totals 

check box. Choose Counts and Totals from the drop-

down menu at the right.

	17.	 At the bottom of this tab is an Itemize Every Instance 

check box. Leave it deselected for now. This makes it 

a hidden field.

	18.	 Select the Formatting tab shown in Figure 11.15. 

Change the Heading value of the Family and Type 

field to Wall Type. To do this, select Family and 

Type in the Fields list, and type Wall Type in the 

Heading box.

Figure 11.12

Adding a calculated 
value

Figure 11.13

Filter tab

Figure 11.14

Sorting/Grouping tab
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T i p s fo r Cu s to m F i e lds

Here are a few things to note when you create custom fields:

You can’t mix field types. This means you can’t select a field type of Area or Number and •	

take a percentage of volume. You need to calculate apples to apples.

The formula area is case sensitive. This is also true for custom family types and other •	

calculated Revit fields.

You can’t calculate with fields that aren’t included in the schedule.•	

Revit’s Help menu lists valid formula syntaxes. You can enter integers, decimals, and •	

fractional values in formulas using normal mathematical syntax, as shown in the follow-

ing examples:

Length = Height + Width + sqrt (Height * Width)•	

Length = Wall 1 (11000 mm) + Wall 2 (15000 mm)•	

Area = Length (500 mm) * Width (300 mm)•	

Volume = Length (500 mm) * Width (300 mm) * Height (800 mm)•	

Width = 100 m * cos (angle)•	

x = 2 * abs(a) + abs(b/2)•	

ArrayNum = Length/Spacing•	

Figure 11.15

Formatting tab

On this tab, choosing Counts and Totals means you’re telling Revit to auto-calculate a few 

things. First, you’re counting all the instances of a type family in the model. You also have the 

option to report totals for those counted types. For example, you may have two sizes of fixed 

windows in a project. The count tells you how many of each type you have. The total gives 

you a sum of all the fixed windows, regardless of size. This count and total relate only to fam-

ily or type quantities.
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	19.	 Select Description in the Fields list, and select the Hidden Field check box.

	20.	 Select each of the remaining fields (Width, Length, Area, Volume, and Recycled Vol-

ume), set their alignment to Right, and select the Calculate Totals check box. This 

option tells Revit to add a list of other values together that aren’t type related (like 

the calculation in step 15). This gives you the ability to calculate values between sim-

ilar fields within Revit and return customized but accurate data. So, in English, this 

means that you can customize your schedules in a variety of ways and know that 

they are always reporting accurate and current information.

You can select fields individually, or you can select them all by holding down the Ctrl key and 

clicking each field name.

If you select Itemize Every Instance, a separate line will appear on the schedule for each 

instance of an object type in the model. This may be useful when you’re listing every door or 

window, but it can make for a long schedule.

Figure 11.16

Appearance tab

	21.	 Select the Appearance tab shown in Figure 11.16. On 

this tab, you define gridlines, outlines, header text, 

and body text. Select the Bold check box to the right 

of Header Text. The rest of the settings are fine, unless 

you feel like experimenting with fonts and size.

	22.	 Click OK. Revit will generate a schedule that shows 

all the information you asked for from the model. At 

the bottom of the schedule, the total for each of the 

fields is displayed. 

Additional Formatting

You can do some additional formatting after you create a 

schedule. By selecting multiple headers, you can group 

them and add secondary tier headers. Let’s combine 

Width, Length, Area, and Volume:

	 1.	 Click in the Width header. Holding down the left 

mouse button, drag your cursor to the left or right, 

selecting additional headers until you’ve selected all 

four (see Figure 11.17).

	 2.	 Click the Group button on the Options bar.

	 3.	 Revit groups all four headers together. Add a title for 

the new grouping: Wall Properties (Figure 11.18).

Figure 11.17

Grouping schedule 
headers

Figure 11.18

Adding headers to 
schedules
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Finding Elements in the Model
Not only do Revit schedules report information about elements in the project but they 

also can be used to control elements. If you decide to exchange one wall type for another, 

you can do so by clicking in the schedule — under wall types, in this example. A menu 

appears, listing all available types currently in the model, and you can choose the type 

you want. Again, this automatically changes the instance of the wall to another wall type 

in all views in which the wall is present.

The schedule you just created lists all concrete walls; you can use the schedule to 

locate any of these walls in the model. To do this, select a wall from the schedule list. 

You can choose to highlight an element in the model and even delete the element using 

the contextual tab that shows up when a row is selected. Be aware that the Delete option 

entirely removes that element from the model and from every single view in which it 

appears. This is the essence of Revit: you don’t need to manually seek all views in which 

this wall appears to delete it, because the element really exists once and only once in 

the model.

When you choose Highlight in Model, Revit opens any view the element can be dis-

played in, zooms in on that element, and highlights it in red. This powerful tool lets you 

find the location of any model element in the project.

The schedule is not only filled by rows automatically generated by the tool; you can 

also add new rows to the schedule manually. There are many cases in which this might be 

useful, such as when you make room schedules and you want to predefine room names 

before adding the tags to the model.

View Templates for Schedules
Revit allows you to save a schedule that you’ve carefully prepared as a view template and 

apply it to other schedules. This is useful in cases when you have many schedules in a proj-

ect and you need them to look alike to maintain visual continuity by using the same font 

and graphical conventions. To create a schedule view template, right-click the schedule in 

the Project Browser, and choose Create View Template From View. Then give the tem-

plate a name.

The Schedule View template allows you to standardize all the font types, styles, and 

any other settings found on the Appearance tab in your schedules. Maybe you’ve 

already created schedules using various graphical styles. It’s never too late to apply a view 

Coordinated documentation is a key value of Revit. After you create a schedule, it doesn’t 

require manual updating. Any time you add or remove content from the model, the sched-

ule dynamically updates itself, even if it’s placed on a sheet. A change you make anywhere in 

the model will be propagated everywhere that change is relevant.
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template and tidy things up. To apply a schedule template to a previously created sched-

ule, follow these steps:

	 1.	 Right-click the schedule in the Project Browser, and choose Select Apply View 

Template.

	 2.	 Select the template you wish to apply, and click OK.

Placing and Handling Schedules on Sheets
To place a schedule on a sheet, follow the same steps you used to place a view on a sheet. 

Drag and drop, and then adjust and nudge until you get the correct layout. Once you’ve 

placed your schedule on a sheet, you can start to take advantage of Revit’s productivity tools.

Traditionally, schedules have been time-consuming and extensive exercises in data entry 

and table manipulation. Schedules are often long lists that are hard to manipulate and that 

need to be updated whenever new content is added to a project. Few applications have an 

intelligent way of doing all this. For example, splitting a schedule usually requires cutting, 

copying, and a lot of rework to achieve the needed appearance and coordinate the data. 

Revit makes this process easy by putting graphical controls directly onto a schedule once 

it’s on a sheet. Click the Split icon ( ), and the schedule splits in half. Drag the blue 

control at the bottom of the schedule to move rows back and forth across the split. If you 

need to un-split the schedule, drag one of the split sections on top of the other one, and 

they merge back together. All graphic edits of the schedule, such as changes in column 

width, propagate to all split segments of the schedule.

Let’s practice by placing a schedule on a sheet in the Station.rvt file where you created 

the Concrete Wall schedule:

	 1.	 Create a new sheet by right-clicking the Sheets group from the Project Browser and 

choosing New Sheet.

	 2.	 Select the Presentation: Presentation sheet.

	 3.	 Drag the Concrete Walls schedule from the Schedule list in the Project Browser onto 

the sheet in the View window.

Figure 11.19

Adding a schedule 
to a sheet

	 4.	 When you drop the schedule onto the sheet, it appears too long for the 

sheet; the text in each cell is returned and wrapped in the cell, further add-

ing to the schedule length (see Figure 11.19). This isn’t the look you’re 

aiming for. To modify it, grab the blue arrows at the top of the schedule 

header, and drag them to the right to enlarge the width of each column. 

Doing this makes the schedule wider and also shortens the column.

	 5.	 Unfortunately, even though the column has been shortened, it still doesn’t fit 

on the 11″×17″ sheet you’ve placed it on. Fortunately, Revit lets you split a 

schedule into multiple segments. To do this, click the blue squiggle that 
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appears in the center of the schedule on the left or right side (shown in Figure 11.20). 

This splits the schedule in the center and adds a new header to the new column.

	 6.	 To finally locate the schedules on the sheet, you can drag each set of columns inde-

pendently by grabbing the blue cross icon in the center of the schedule. (These indi-

vidual segments can’t be placed on separate 

sheets.) The finished schedule on the sheet 

should look like Figure 11.21.

In addition to letting you split a schedule into 

separate segments, Revit allows you to rejoin the 

segments into a single schedule:

	 1.	 Select the blue cross at the middle of the second segment.

	 2.	 Drag it over the first segment of the schedule. Your schedule is complete and displays 

in its original form.

Using Drafting Views
Because it isn’t feasible, or even reasonable, to model every single construction detail in 

3D, Revit provides the means to draft 2D information. Revit’s drafting views are strictly 

2D views used for drawing details for a construction document set. Some examples where 

it might be useful to move from the 3D model to 2D geometry are for things like window 

jamb, head, and sill details, or for reusing details taken from past projects, or from manu-

facturers who supply details in 2D. In our own practice, for teams just starting with Revit, 

it’s a good rule of thumb to figure on creating any drawing at 1½″ = 1′-0″ or larger as only 

2D. This will give you some flexibility starting out in Revit to fine-tune your family mak-

ing skills.

When placed on a sheet, drafting views have the same intelligent referencing as other 

views. This lets you produce coordinated drawings. Even though drafting views present 

only 2D details, because they’re in Revit they can be tied parametrically to sheets, so all 

the references are dynamic.

To create a new drafting view, follow these steps:

	 1.	 Go to the View tab, and from the Create panel choose Drafting View  

( ).

	 2.	 A dialog box opens prompting you for a detail name and scale (Figure 11.22).

	 3.	 Using the Scale drop-down menu, choose from a list of standard and cus-

tom view scales.

Figure 11.20

Splitting a schedule

You can split a schedule as many times as needed to fit it onto a sheet.

Figure 11.21

The schedule on a 
sheet

Figure 11.22

New Drafting dia-
log box
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	 4.	 Click OK. A new node, Drafting Views (Detail), is added to the Project Browser (see 

Figure 11.23). This new drafting view is primed for either drafting a new detail or 

importing existing CAD details.

Understanding Drafting Tools
The drafting tools available in Revit are similar to what you might find in any CAD appli-

cation. You can draw lines, arcs, and circles and create groups of 2D lines to use repeatedly. 

Lines can be drawn, extended, moved, copied, mirrored, arrayed, and trimmed — every-

thing you’d expect to be able to do to lines. These can all be found on the Detail panel in 

the Annotate tab.

To demonstrate Revit’s drafting tools, you’ll work on the house model (from the book’s 

web page, www.sybex.com/go/introducingrevit2010) for the remainder of this chapter. Open 

the file Source_House.rvt, and find the Detail 2 view that you created earlier. This is the 

detail through the window at the clerestory. 

Several different drafting tools are available in Revit. You access them from the bot-

tom of the Annotate ribbon (see Figure 11.24). We’ll explore them here.

Detail Line
Detail Line is the most common drafting tool available in Revit. This tool features view-

specific lines that you can draw in any view and use to create 2D details. When you acti-

vate the Place Detail Line tool, it lets you use the Type Selector to choose from existing 

line styles in Revit, including ones that have been imported from any other Revit families 

or CAD files (Figure 11.25). Line styles are defined by line weight, color, and pattern.

If no existing line style conforms to your needs, if you want to edit the graphic proper-

ties of a line style, or if you want to delete existing line styles, use the Line Styles dialog box 

(from the Manage tab in the Project Settings 

Panel choose Settings and then Line Styles).

The Draw and Elements panels show all 

the drawing styles and line-shape choices 

available in Revit (Figure 11.26).

Figure 11.23

Drafting Views node

Figure 11.24

Drafting tools

Figure 11.25

Line styles in the 
Type Selector

If you’re drawing something with lines that represents an object, consider creating a detail 

component.

Figure 11.26

The Element and Draw panels contain all the line 
styles and shapes for drawing Detail Lines
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The Draw and Pick Lines tools are similar to the tools used to create walls. Draw 

(the default tool) allows you to choose any of the drawing options from the nearby but-

ton menus.

The Line tool (also selected by default) is the most commonly used tool. It’s illustrated 

in Figure 11.27. The Draw panel to the right shows the array of tools you can use in Revit 

to create linework. We will briefly touch on each of these:

Line  ​This is a simple line-creation tool. By default, when you choose the second point of 

your line, Revit automatically begins a new line from that point. You can disable this fea-

ture by deselecting the Chain check box on the Options bar. 

Rectangle  ​This tool draws all four sides of a rectangle or square. It can only draw vertical 

and horizontal lines.

Inscribed Polygon  ​This tool draws multisided shapes from an inside dimension. When 

this tool is selected, a box on the Options bar lets you select the number of sides you want 

for your shape. If you want a rectangle that is nonorthogonal, use the Polygon tool and 

enter 4 for the number of sides.

Circumscribed Polygon  ​This tool draws multisided shapes in a similar fashion as the pre-

vious tool but using an outside dimension.

Circle  ​This tool draws circles by radius.

Arc Passing Through Three Points  ​This tool draws an arc using the following sequence of 

points: first point, last point, midpoint.

Arc from Center and End Points  ​This tool draws an arc using the following sequence of 

points: center point, start point, end point.

Tangent Arc  ​This tool draws an arc from a starting point. You must select a point in the 

view to begin the tangent arc.

Fillet Arc  ​Selecting this tool prompts you to choose two nonparallel lines and create a fil-

let arc between them.

Spline  ​This tool draws a spline. The points of the spline can be edited after the line has 

been drawn, but you can’t fillet or trim a spline.

Ellipse  ​This tool draws ellipses by letting you locate the center and then the major and 

minor radii.

Partial Ellipse  ​This tool draws a half segment of an ellipse using the following sequence of 

points: start point, end point, radius.

Pick Lines  ​This tool allows you to draw lines on top of other lines or other elements sim-

ply by selecting them. This is a handy way to trace roof overhangs or other elements.

Figure 11.27

Draw and pick line 
options
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Model Line
The Model Line tool ( ) (not to be confused with the Detail Line tool) is 

found in the Model panel on the Home tab.

Model lines are model elements (as opposed to detail/annotation elements) and 

appear in every view applicable. This means if you draw a line in an elevation view, it 

appears in every 3D view, elevation view, detail view, and so on, where that portion of the 

elevation is visible. The lines use all the same draw commands as the Detail Line tool; 

however, they’re drawn on a 3D work plane in the model.

If the view you’re in isn’t an active work plane, then when you select the 

Model Line tool it will ask you to define or select a work plane by displaying 

the dialog box shown in Figure 11.28.

Here, you can use the Name option to choose a work plane that is already 

defined, use the Pick a Plane option to choose a face (such as the face of a 

wall or floor) to draw on, or use the Pick a Line and Use the Work Plane It 

Was Sketched In option, which we hope is self-evident.

You may be wondering, “When do I use Model Line, and when do I use Detail Line?” Use 

Detail Line when you’re drawing things in 2D that will appear only in the view they’re cre-

ated in. Some examples are linework in an elevation or something drawn in a drafting view. 

Use Model Line when you want the same line to appear in all views but you don’t necessarily 

need a 3D modeled element to communicate the design intent. Examples for the use of lines 

are control joints or gaps between panels in a façade.

Detail Groups
Detail groups are similar to blocks in AutoCAD. They’re collections of 2D graphics that 

you want to use repeatedly in the same or different views within the project. A classic 

example is a metal stud or wood blocking. You can easily and quickly set up a group and 

use that group over and over in the model. Doing so helps control consistency through-

out the drawing.

To make a detail group, create the detail elements you’d like (make sure they are 2D 

elements), select all the elements, and then group them by using the Group command in 

the contextual tab that appears when detail elements are selected.

Once a group is created, you will be prompted for a group name. We suggest that you 

name the group rather than accepting the default name Revit wants to give it (Group 1, 

Group 2, and so on).

Figure 11.28

Choosing a work 
plane

Keep in mind that if a line occurs on a predictable module, it may be helpful to create 

a filled region.
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To place a detail group, use the Detail Group button in the Detail panel of the 

Annotate tab ( ). Then, use the Type Selector to choose which group 

you want to place, or you can expand the Groups node in the Project Browser and 

insert a group by name (Figure 11.29).

Detail Components
Detail components represent various small-scale building components such as screws, 

blocking, or metal studs, and are parametric 2D families. They’re similar to detail 

groups, but are created in the Family Editor, and can be designed with dimensional varia-

tion built right into the family. In other words, a single detail component can make a full 

range of shapes available in a single component. Because they are families, this also 

means they can be stored in your office library and shared across projects easily.

To add a detail component to your drawing, select the Component button found on 

the Annotate ribbon and choose one from the Type Selector.

If you need to load a new component, click the Load Family button on the Place Detail 

Component ribbon, and browse to the Detail Components folder. Revit has a wide range 

of common detail components in the default library.

To make a new detail component, use the Family Editor, choose the Application but-

ton, and select New ➔ Family ➔ Detail Component.rft. Now you can begin drawing using 

drafting lines, as you did in the project, and then save the file as an independent family 

that can be loaded into any project as a detail component. We’ll go into more depth on 

how to make families in Chapter 13, “Advanced Topics.”

Masking Regions
A masking region is designed to hide portions of the model that you don’t want to see in a 

given view. A Masking Region imposes a 2D shape on top of the model that masks ele-

ments behind it.

Figure 11.29

Groups in the 
Project Browser

A detail component is an incredible feature, not to be underestimated. Not only can you 

insert detail components into a project, but you can also insert them into 2D and 3D families 

and set them to show only at fine levels of detail. One way to use a detail component is to 

insert it into a family and use it to demonstrate a higher level of detail when the family is cut 

in section. An example is the shims and silicone in a window head that you don’t necessarily 

want to model, but that you do want to show in a wall section or detail.

The masking region obscures only the model and other detail components. It can’t mask 

annotations.

73559c11.indd   373 6/2/09   1:55:19 PM



374  ■   Chapter 11 : Construction Documentation

To add a masking region to your view, go to the Annotate tab, and from the Detail 

panel, select Region and choose Masking Region.

This takes you to Sketch mode, where you can draw a closed loop of lines 

to form a masking region. When you draw a masking region, you can assign 

the boundary lines different line styles — check the Type Selector to make 

sure you’re using the line style you want displayed. One of the line styles 

that is particularly useful for the Masking Region tool is the Invisible Line 

style. It allows you to create a borderless region — ideal if you want to truly 

mask an element in the model.

Each line can be given its own line style, making it possible to create a 

shape with different boundary line representations. A masking region is 

shown in Figure 11.30.

To edit a masking region, select the region, and choose the Edit button 

from the Modify Detail Items ribbon. Doing so brings you back to the 

Sketch mode and lets you edit the region.

Adding to the Detail
Now that you have a better understanding of detail components and mask-

ing regions, let’s make an example on the model we have been using. You 

will be adding a gutter to the roof.

	 1.	 Select the Detail Component button, and choose the 4″×4″ gutter that 

has been preloaded into this model.

	 2.	 Open the view Detail 2, go to the View tab, and from the Detail panel 

select Component, Detail Component, and choose Gutter Bevel Section 

4″ × 4″ (15 cm × 15 cm) from the Type Selector.

	 3.	 Use the Mirror tool to flip the gutter. Be sure to uncheck Copy on the 

Options bar. After mirroring the gutter, align it with the roof edge (Fig-

ure 11.31).

You also need to add a fascia board, which is something you didn’t model 

with the Roof family. But before you do that, you need to mask some of the 

rigid insulation in the roof in order to build the fascia board back in from 

the roof edge:

	 1.	 Use the Masking Region tool to draw a box at the roof edge. Make the 

box using four Medium Lines, and draw it 1″ (2.5 cm) wide. Bring it to 

the underside of the roof sheathing, and run it just past the bottom of 

the soffit, as shown in Figure 11.32.

	 2.	 Use the detail component Nominal Cut Lumber-Section 2×4 to build 

out the window heads. You can use the spacebar to rotate the compo-

nent during placement.

Figure 11.30

A masking region

Figure 11.31

Adding a gutter

Figure 11.32

Adding a fascia 
board

73559c11.indd   374 6/2/09   1:55:19 PM



Understanding Drafting Tools  ■   375

	 3.	 Although you could use a detail component to place blocking above the 

window head, let’s use the Detail Line tool instead. Select the Detail 

Line tool and a Medium Line from the Type Selector.

	 4.	 Draw a box from the window head to the bottom of the rigid insula-

tion.

	 5.	 Using a thin line, draw a line from corner to corner in the box. The fin-

ished detail looks like Figure 11.33.

If you decide to move or change those lines you’ve just drawn, you want 

them to all move together. This is a great use for groups. By selecting the 

window head and the blocking, you can use the Group command to group 

those elements into one unit. Another way to group a selection of elements 

is by using the Model Group button located in the Model panel of the Home 

tab. Figure 11.34 shows the elements grouped together.

Creating a Repeating Detail
Repeating details are a common occurrence in architectural projects. Two-

dimensional representations of masonry walls, metal decking, and roof tiles 

all comprise a series of repeating elements. Most of these 

elements aren’t modeled as 3D components in Revit but are 

represented with symbolic detail components.

You create repeating details in Revit by going to the 

Annotate tab, and from the Detail panel select Component 

and then Repeating Detail.

This tool takes a single detail component and arrays it along a straight 

line at regular intervals. Let’s open the properties of a repeating detail to get 

a feel for how it’s laid out. Figure 11.35 shows the Type Properties dialog box 

for a brick repeating detail.

When you select a repeating detail, the Type Selector is activated 

so you can select any repeating detail you’ve already loaded in the 

project. Repeating details are similar to families in that they have 

types and properties. If you don’t have the repeating detail that you 

want loaded, it’s easy enough to create one on the fly. All you need 

is a detail component that you wish to repeat.

Repeating detail placement is similar to placement of a line — the 

repeating detail has a starting point, an end point, and repeating 2D 

geometry in between. Let’s make one to demonstrate this feature:

	 1.	 From the Annotate tab in the Deatil panel, select Component and choose Repeating Detail.

	 2.	 Choose the Element Properties button.

	 3.	 Click Edit Type.

Figure 11.33

Finishing the detail

Figure 11.34

Grouping common 
elements

Figure 11.35

Repeating detail 
properties
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	 4.	 Click Duplicate.

	 5.	 Give your new repeating detail a name.

	 6.	 Now, you need to select a detail component from the Revit library or use one you 

created on your own with the Detail field in the Type Properties dialog box.

The default repeating detail in Revit is a running brick pattern. If you look at it care-

fully, it consists of a brick detail component and a mortar joint (see Figure 11.36).

When you create a repeating detail layout, measure the distance between the beginning 

of the brick and the end of the mortar joint to understand the module on which the detail 

will repeat. When the detail component is inserted, it acts like a Line tool and allows you 

to pull a line of brick, as shown in Figure 11.37. This line can be lengthened, shortened, or 

rotated like any other line.

Let’s take a closer look at the various options you can set in the 

Type Properties for a repeating detail (Figure 11.38):

Detail  ​Here you can select the detail component you wish to have 

repeated.

Figure 11.36

A repeating detail single unit

Figure 11.37

A repeating detail in the 
drawing view

If you’re making a repeating detail from a component that isn’t loaded in your project, you 

won’t find it listed under the Detail item in the Properties dialog box. You first need to load it 

in your project and then make it a repeating detail component.Figure 11.38

Type Properties for 
a repeating detail
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Layout  ​This option offers four different modes:

Fixed Distance  ​The path drawn between the start and end points when drawing the 

repeating detail is the length at which your component repeats at a distance of the 

value set for spacing.

Fixed Number  ​Here you can set how many times a component repeats itself in the 

space between the start and end points (the length of the path).

Fill Available Space  ​Regardless of the value you choose for spacing, the detail compo-

nent is repeated on the path using its actual width as the spacing value.

Maximum Spacing  ​The detail component is repeated using the set spacing, and the 

number of repeated components is set so that only complete components are drawn. 

Revit creates as many as will fit on the path.

Inside  ​This check box adjusts the start point and end point of the detail components that 

make up the repeating detail.

Spacing  ​This value is active only when Fixed Distance or Maximum Spacing is selected as 

the method of repetition. It represents the distance at which you want the repeating detail 

component to repeat. It doesn’t have to be the actual width of the detail component.

Detail Rotation  ​This allows you to rotate the detail component in the repeating detail.

Custom Line Types

You can use the Detail Component tool to create custom line types (lines with letters or 

numbers for various services such as fireproofing, rated walls, fencing, and so on). Note 

that when you create a detail component, you can’t use text for the letters but need to 

draw them using lines.

Figure 11.39 shows the creation of a detail component in the Family Editor and the 

final result used as a repeating detail in the project environment.

Insulation
The Insulation tool ( ) works just like a repeating detail component but 

is specifically designed as a symbolic representation for batt insulation. Due to the fre-

quent use of this pattern, Revit provides a ready-made tool just for insulation. When 

drawn, it has two blue grips that let you change its length. The element properties of the 

insulation include only two changeable parameters:

Width  ​This parameter is used to control the width of the insulation that is used. The 

Width parameter is also available on the Options bar when insulation is selected and is 

specific to each instance of insulation added to the model. Changing the width of one 

Figure 11.39

Making a custom 
repeating detail
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instance of insulation will change only that instance (see 

Figure 11.40).

Insulation Bulge to Width Ratio  ​This parameter is used to control the density of the circles 

used in the insulation line, making the circles for the insulation head wider or flatter.

In most cases, you’ll have two lines representing the space in the wall where the insu-

lation needs to fit. Revit allows you to place the insulation using the centerline of the 

insulation as a location line.

Adding Insulation

Now, let’s add some insulation to your detail:

	 1.	 Select the Insulation tool located on the Detail panel of the Annotate tab.

	 2.	 In the Options bar, set the width to 3½″ (10 cm).

	 3.	 Draw in the insulation below the windowsill. The finished detail will look like  

Figure 11.41.

Filled Region
The Region tool is a 2D drafting tool that can be applied for many different purposes.

It can help you color surfaces or areas for graphic representations during the concep-

tual or design-development phase. It also can be a useful tool to document details and 

show material texture. Figure 11.42 shows how filled regions are used to communicate 

different functional zones in section.

A filled region consists of a boundary, which can use any line type, and a fill pattern 

that fills the area defined in the boundary. Figure 11.43 shows a filled region used with a 

hatch pattern.

Figure 11.40

The Insulation 
Options bar

Figure 11.41

Adding insulation to the detail

Figure 11.42

Filled regions
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Filled regions can also be transparent or opaque 

to show or hide what is behind them. Figure 11.44 

shows two filled regions: the one at left is opaque, 

and the one at right is transparent.

Filled-Region Type Properties

Filled region type properties define how the fill 

appears. This includes pattern, pattern color, and 

transparency (see Figure 11.45).

Should you want to change the line style of the 

region boundary, you need to edit the region and 

then change the line style in Sketch mode. The 

Edit Boundary button appears on the Modify 

Detail Items ribbon when a filled region is selected.

For each filled region that has a different 

pattern, transparency, or other variation in 

appearance, you need to make a new filled 

region type. Remember that type properties 

propagate to all instances within the model, 

so making a change to one type may affect 

many instances in many different views. If 

you want to make a filled region with a new 

pattern, be sure to duplicate an existing type 

Figure 11.43

Filled region with a 
hatch pattern

Figure 11.44

Opaque and trans-
parent filled regions

Figure 11.45

Type Properties for 
a filled region
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before you start changing type parameters (unless, of course, you want them all to 

change).

Revit lets you define different line styles for each boundary segment of a filled region. 

This can be handy depending on how you’re using the filled region. For example, if you’re 

using the filled region with an earth hatch to cover the foundation, you might want a 

heavier line around the footings and slab and a lighter one in other areas.

The effective use of filled regions depends on the fill patterns used in them. Let’s review 

in more detail some basic aspects of fill patterns:

Fill patterns can be drafting or model patterns.•	

Drafting fill patterns are visible only in the view in which they’re created. Drafting •	

view fill patterns are scaled specific to the view. So, a pattern with ¼″ cross-hatching 

will always show with the lines ¼″ apart, regardless of the scale of the view.

Model patterns represent the material characteristics of an element (brick, stone, and •	

so on) and do appear in 3D view. These patterns are model based and will not change 

their dimensions based on scale. So, if you have a standing-seam, metal-roof pattern 

of vertical lines 16″ apart, they will always measure 16″ apart. In a ¼″-scale view, they 

will print twice as far apart as in a 1⁄8″-scale view.

Show/Remove Hidden Lines
In visual communications between architects and engineers, when one element obscures 

another, either partially or fully, the hidden element is usually represented with dashed 

lines. Often, just a portion of an element is hidden. In the CAD world, it can take a lot of 

work to explode a block, split lines, and change many of the line styles to a hidden line type.

Revit has a special tool, called Show/Remove Hidden Lines, for recognizing obscured 

elements and representing the portion that is hidden with dashed lines while still main-

taining the complete object. This tool isn’t located on the Annotate tab; it is a part of the 

Modify tab (see Figure 11.46).

You select the Show Hidden Lines tool, click the element that obscures the object, and 

then click the element that is obscured. The hidden portion of the element becomes dashed. 

If an element is obscured with more than one element, keep repeating this operation until 

you get the desired look. Because Revit is a parametric engine, when you relocate or delete 

the obscuring element, the hidden element responds intelligently to those changes.

Revit comes with a nice selection of both drafting and model patterns, but, as with any 

library, it’s never enough. You’ll often want to create patterns or reuse patterns from other 

projects or applications. Patterns can be imported from any AutoCAD .pat files as well. 

Specify whether the pattern is model or drafting.

Figure 11.46

Show Hidden  
Lines tool
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The first image in Figure 11.47 shows an I-beam hidden by another beam. The second 

image shows the results after the first iteration of the Show Hidden Lines tool, when the 

second beam is selected as an obscuring element and the I-beam is selected as an obscured 

element.

The Show Hidden Lines tool applies to 2D and 3D elements in all possible combina-

tions (detail over detail, detail over model, model over detail, model over model).

Figure 11.47

Using the Show 
Hidden Lines tool
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Beneath the Show Hidden Lines tool is the Remove Hidden Lines tool, which resets 

the graphic display of the elements so they look like they did before you applied the hid-

den line mode. This is the lower button in Figure 11.46.

Importing CAD Details
In Chapter 7, “Working with Other Applications,” we discussed how to import a CAD file 

into Revit. Existing libraries of CAD details or details you receive from a manufacturer 

can also be imported directly into a Revit project. If you’re working with someone who 

only produces details using CAD, you can incorporate their work into your Revit model 

without disrupting workflow.

To prepare a CAD file for import, we recommend that you delete all the superfluous 

data in the file before importing. If your import contains hatches or annotations that you 

don’t intend to use in Revit, delete them first as well in the application where they have been 

created (AutoCAD, for example).

We also recommend that you import only one detail at a time so you can take better 

advantage of Revit’s ability to manage sheet referencing. If you have a series of details orga-

nized in a single CAD file that you’d like to import into Revit, save as one separate file in 

order to isolate each detail, and then import them into separate drafting views within Revit.

Reusing Details from Other Projects
There are many times in a project workflow when you want to grab details made in other 

projects and reuse them. So far we have covered how to do this using CAD files from other 

projects and from manufacturers’ websites. This workflow is also possible using details 

created from other Revit projects. We will also talk about how to take our active project 

file and export key details to our library. In this section, we will discuss how to pull 

details out of a Revit file and put them into our active project.

Exporting Details from Revit Projects
As you create more and more details in Revit, you will inevitably want to save some of them 

to your office’s standard library so that you can reuse them in other projects and save the 

invested work. With Revit, you can save a view out of a project and create a separate .rvt 

file that contains only that view. That file can then be incorporated into new projects. For 

Every time you explode a CAD file in Revit, you add objects to the database. An inserted CAD 

file is one object. An exploded CAD file consists of many objects — maybe thousands of 

objects. For the best performance, explode CAD files as rarely as possible.
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example, if you have a 3D model detail that you embellished with 2D components and 

invested time making it, and would like to save that work for future projects, you can save 

it as a Revit file.

Right-click any drafting view in the Project Browser and choose Save to New File. It 

might take Revit a minute or so to compile the view content, but soon you will be presented 

with a dialog box asking you for a file location to save the view. The default filename will 

be the same as the view name in the project. To bring views from that file into another 

project, open the other project, then choose Insert from File ➔ Views from the Insert tab. 

Choose the file you saved. Soon a dialog box (see Figure 11.48) will open and you can 

choose which views to bring into your project.

Once the view is exported, it is like any .rvt file. Opening the 

view directly will allow you to edit and manipulate any of the ele-

ments you exported in the view. You will also see a streamlined 

version of the Project Browser (Figure 11.49) with only the relative 

views present. These Revit files can be kept in a project library for 

later use.

The second way to export a view from Revit is to choose the Application button and 

select Save As ➔ Library ➔ View. This will open a dialog box of all of the exportable views 

from the project file. Here, you can select any number of views to be simultaneously 

exported into separate library files (Figure 11.50). This is a great way at the end of a 

project to export all of the detail views you would like to keep in a project library. 

Select the desired views by checking the appropriate boxes and click OK.

Figure 11.48

Exporting a view 
from Revit

Figure 11.49

Streamlined Project 
Browser of saved 
Revit views
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Importing Views into Revit Projects

To import any of these files into a new project, navigate to the Insert tab and choose 

Insert from File ➔ Insert Views from File. This will allow you to navigate to your library 

containing your exported details. Choosing the exported detail file opens a dialog box 

(Figure 11.51) that allows you to select the view.

Notice that the view is described as its location within the Project Browser (Drafting 

View) and its view name (Storefront Head Detail). Selecting this view and clicking OK 

Figure 11.50

Multiple views can 
be saved as sepa-

rate Revit files

Figure 11.51

Inserting a view into 
a different project
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will merge the view into your current project (Figure 11.52). The view will appear in the 

location called out by the view name. In this case, you can find this view located in the 

Project Browser under Drafting Views.

Another way to insert content into Revit is to use only 

the drafting views from exported files and not import 

any of the model components. This can be useful in 

many examples where you might want to take a door-

jamb detail or a window head condition. In these 

instances, the detail might be strictly 2D, so you aren’t 

going to import any of the 3D model information. Or 

you might have a wall section where some of the elements are drawn in 2D and 3D. You 

might only want the 2D information (the drafting lines, detail components, and annota-

tions, for example) because you plan to reuse those in a new section in a different project.

To import the 2D content into your view, open the view you want to import into and 

from the Insert tab choose Insert from File ➔ Insert 2D Elements from File. The resulting 

dialog box will look similar to the one for importing the full view but with some slight 

differences (Figure 11.53).

Unlike with the Insert Views, you can only choose one view at a time to insert. There is 

also an option to transfer the view scale with the view elements. Selecting this check box 

will reconfigure the view you are inserting into to match the view that you have inserted. 

Select the drafting view and click OK. This will bring all of the 2D elements in the 

selected view into your active view. You can repeat this command multiple times in the 

same view window if you need to repeat the content.

Figure 11.52

The imported view 
merged into a new 
project

Figure 11.53

Inserting 2D con-
tent from another 
Revit file
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Printing

C hap te r 12

We’ve reviewed how to create  building elements, generate 

views, and get these views onto sheets. We also covered how to export the information 

you create in Revit so that it can be used by other downstream applications.

In this chapter, we’ll review paper printing as well as some lightweight digital outputs 

(PDF and DWF). We’ll also look at how to take advantage of Autodesk Design Review in 

conjunction with Revit as a way to exchange digital markups. We will then offer some 

best-practice tips on printing. Topics we’ll cover include:

Printing your documents■■

Revit printing tips■■

Export your BIM data■■
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Printing Your Documents
In this section, we’ll discuss a few of the specific settings and commands you’ll use to 

print from Revit. If you’ve been working in the Windows environment, you’ll find that 

printing from Revit is straightforward, because it’s very similar to other Windows-based 

applications.

Print
Selecting Application ➔ Print brings you to the dialog box shown in Figure 12.1. All the 

features for printing are found here.

Print to File

Printing to a file allows you to create a printing or plot file (.prn or .plt) that can then be 

sent to a printer independently of the software in which it was created. Creating a .plt or 

.prn file means you can print many copies of the drawing set, at any time, without having 

to interrupt your workflow while you print. To print to file, select the Print to File check 

box below the Properties button.

Selecting the “Create separate files. View/sheet names will be appended to the specified 

name” option creates a separate file for each view or sheet in the selection (Figure 12.2). 

This option is sometimes more practical for printing large sets. If paper runs out in your 

printer or any other interruption happens during the printing process, you can continue 

printing the remainder of the sheets later. By contrast, if you’re printing from a single file, 

you’ll need to start the print job over.

Figure 12.1

Print dialog box
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Print Range

In this section of the Print dialog box, you can define exactly what you want to print. It 

includes these options:

Current Window  ​This option prints the full extent of the open view, regardless of what 

extents of that view are visible currently on your screen. For example, if Figure 12.3 is 

what you see in Revit, Figure 12.4 will be the output when Current Window is selected.

Visible Portion of Current Window  ​This option prints only what you 

see in the frame of the open window framed for the sheet size 

you’ve selected. Figure 12.5 shows a Revit screen (what you see), 

and Figure 12.6 shows what will print if you select Visible Portion 

of Current Window.

Figure 12.2

Multiple sheets 
and views can be 
printed at once

Figure 12.3

3D view zoomed out 
for printing

Figure 12.4

Output when Current  
Window is selected
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Figure 12.5

3D view zoomed in 
for larger printed 

image

Figure 12.6

Output when Visible 
Portion of Current 

Window is selected

Selected Views/Sheets  ​This option allows you to define a reusable list of views, sheets, or 

any combinations of views and sheets. This way, you can essentially batch-print a job by 

sending large quantities of sheets to the printer in one shot. You can also save these selec-

tions for later print jobs. Figure 12.7 shows the View/Sheet Set dialog box.

Another way to print what you see on your screen is to use the Prt Scrn key, typically found 

at the upper right of a Windows keyboard. Pressing this key copies a full image of the screen 

to the clipboard. From there, you can paste it into Photoshop or another image application. If 

you want to print only the active window and not your entire desktop (an example would be 

a dialog box or just the Revit window), use Alt+Prt Scrn. If you have a dual-monitor configura-

tion, use this technique to limit your print screen to the active application frame.

73559c12.indd   390 6/4/09   8:17:06 PM



Printing Your Documents  ■   391

This dialog box lets you pick any view or sheet to include in the View/Sheet Set. If 

you only want to include sheets in a set, use the Show options at the bottom of the dia-

log box to shorten the visible list. This will allow you to select only sheets or only views 

if you so choose.

This is a great tool to help define print lists. Some examples of what you might want 

to use these selections for would be a 100 percent construction document package or a 

specific set of presentation sheets.

Print Setup
The printing environment is set up using the Print Setup dialog box (Figure 12.8). This 

gives you options for selecting a printer and settings for printing. You can save these 

settings with a name so that they can be reused in later sessions of Revit. These settings 

can also be transferred to other Revit projects if need be, using the Transfer Project 

Standards tool located on the Manage tab on the Project Settings panel. Let’s take a look 

at some of the printing options available to you.

Figure 12.7

The View/Sheet Set dialog box

The Show check boxes only control what you see in the sheet/view list. They don’t control 

what will or won’t be printed. In fact, if you have selected something from one of the two 

categories and then turn off the visibility of those items (e.g., if you select a sheet, then 

uncheck Sheets), those selected elements will still print.

To transfer print settings from one project to another, open both in the same session of 

Revit, and choose the manage tab on the project settings panel.

Figure 12.8

The Print Setup dialog box
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Hidden Lines Views

Views in Revit can be displayed in four graphic modes: wireframe, hidden-line, shaded, 

and shaded with edges. The most commonly used type of view is hidden-line. You’ll 

choose this type for floor plans, sections, and elevations, and sometimes even for 3D.

Revit lets you select whether you wish to print this type of view with vector processing 

or raster processing of the hidden lines. Vector is faster; however, you need to be aware of 

some nuances when working with hidden-line views. For example, transparent glass 

material prints transparent with raster processing but opaque with vector processing.

Figure 12.9 shows a perspective in hidden-line mode printed using raster processing. 

Figure 12.10 shows the same perspective printed with vector processing. Note that you 

can’t see through the glass using this setting.
Figure 12.9

Raster print 
example

Figure 12.10

Vector print 
example
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Options

The Options pane is at the lower left in the Print Setup dialog box. It includes these options:

View Links in Blue  ​View links are hyperlinked tags that lead you from one view to another 

or from a sheet to a view. They appear blue in Revit and print black by default, but you 

can specify to print them in blue, which is how they appear on the screen.

Hide Ref/Work Planes; Hide Scope Boxes; Hide Crop Boundaries  ​These three check boxes 

let you decide whether to print various Revit-specific graphics, including reference planes, 

scope boxes, and crop boundaries. Using these options allows you to maintain the  

visibility of crop boundaries during documentation and then hide them en masse  

when printing. This is a significant time-saver as compared to manually turning off 

crop boundaries.

Hide Unreferenced View Tags  ​During the course of a project, you may create a lot of ele-

vation tags, section flags, or detail callouts for working purposes that you don’t wish to 

be printed in the final documents or placed on any sheet. These view tags are referred to 

as unreferenced, and Revit gives you the option to not print them.

In Figure 12.11, note the section lines, callout views, and crop region in the floor plan.

Figure 12.12 shows that when you select Hide Crop Boundaries and Hide 

Unreferenced View Tags, some features from the view don’t appear on the print. These 

will not show up in the Print Preview either.

If you have many views on a sheet, even if only one of them is an image or a shaded view, 

Revit automatically changes the printing to raster processing.

Figure 12.11

The view as it 
appears in Revit
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Revit Printing Tips
Here are some helpful, specific hints about printing from Revit. These tips will help you to 

optimize your print performance whether you are printing to a paper or digital format:

When you’re plotting large-format sheet sizes to plotters such as the HP DesignJet or •	

OCE printer, change the plotter’s settings so the data is processed in the computer. 

(This is probably handled through the printer’s Advanced Settings menu. Each printer 

has its own command sequence.)

Be sure the Far Clip Plane is active for the view and set to a reasonable distance. •	

(Choose the Far Clip Plane option in the View Properties dialog box for each view.) 

Having a distant clip plane can significantly slow your printing process.

Hatches and other types of fill patterns, when used extensively or in high density, can •	

affect performance. (The Sand fill pattern is an example.) If possible, turn them off, 

or exchange them for less performance-intensive patterns.

Level of detail can affect performance. If you don’t need to print in Fine view, reduce •	

it to Medium or Coarse.

A DWG, when mistakenly inserted in all views, can affect printing speed. If you •	

notice that your elevation or section prints slowly, the reason may be a DWG that is 

imported into that view but shows as a single line and thus is unnoticeable because it 

is oriented to plan views. This will happen if you insert a DWG in a plan view, but 

are printing an elevation or section view. You can check which DWGs are showing 

Figure 12.12

The printed view 
with Hide options 

selected
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by opening the Visibility/Graphics dialog box, clicking the Imported Categories tab, 

and deselecting the Show Imported Categories in the This View check box.

For general performance improvements, including when you’re printing, Revit has a •	

3GB switch functionality. You can learn about it by navigating to the Knowledge Base 

area of the Autodesk website. Go to www.autodesk.com/support, and choose Revit Archi-

tecture. The 3GB switch and Revit document is linked on the resulting page. If you are 

using Windows Vista or Windows XP 64 bit, you can use the 64-bit aspects of the OS 

to utilize more RAM by loading the 64-bit version of Revit 2010.

Offices have a finite number of printers. Set up each of your plotters and printers in •	

your Revit template. That way, you don’t have to re-create them for each new project.

Set up some standard sheet sizes: 11•	 ″×17″, 8½″×11″, Size E1, and Full Size E1 are some 

standard architectural sheets. Add these to your template as well.

Keep in mind that some printers are not capable of printing graduated shades of •	

gray — instead, they rely on printing dots (like newsprint). The results can be unde-

sirable for views that need to show solid fills of varying shades of gray (for example, 

when shadows are visible).

Export Your BIM Data
The construction process goes through many iterations and exchanges of information 

among different parties. Exchanging a full-blown, data-rich building information model 

is not always required, and not everyone on the project team will be using Revit. Many 

team members just need to see a drawing to approve or mark up some changes and send 

it back to you. Some team members may be using older computers that can’t handle large 

files effectively (or at all). You may also not be ready to share your intellectual property 

with the world in the form of editable drawings. Finally, you may be concerned about 

unauthorized appropriation or editing of your documents by others. This is where using 

lightweight digital output comes into play.

You need to be able to share drawings and documentation in a safe, noneditable, light-

weight form that can be viewed by others outside the world of Revit. This is the problem 

that some new publishing technologies are trying to solve.

Design Web Format (DWF)
Design Web Format (DWF) is Autodesk’s solution for publishing intel-

ligent data in a light, easy, and secure way while preserving the power of 

the information embedded in the design documents. DWF files are 

highly compressed, and are capable of transmitting big design models 

via e‑mail or other limited-transfer technologies.

Choose Application ➔ Export ➔ DWF (Figure 12.13).

Figure 12.13

Exporting a DWF
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DWF Export Options

You can export a Revit project as a DWF file and send it to various stakeholders in the 

building process. With the latest version of Autodesk Design Review (we will discuss 

Design Review in more detail later in this chapter), it is possible to view and even mark 

up these files. Microsoft Vista also has an embedded DWF viewer, so the receiver won’t 

have to install a separate DWF viewer, as required with machines running Windows XP 

or earlier.

DW F E x port    O ptio    n s

Revit is a BIM modeler with tons of information embedded in it about each element 

within the model. Much of this information is also published into the DWF format. You 

additionally have the option to send model and room data with the DWF. The DWF 

Export settings are available by choosing Application ➔ Export ➔ DWF and selecting the 

DWF Properties tab (Figure 12.14).
Figure 12.14

DWF Export Set-
tings dialog box
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When you select the Element Properties option under Export Object data on the DWF 

Properties tab, all the property information about the model elements in the view that is 

being exported is published to DWF. This allows anyone viewing the DWF to select an 

object in that view and see its properties. Some examples of these properties are area, 

length, family name, and so on.

Selecting the Rooms and Areas check box publishes additional information that isn’t 

included in Model Elements, because in Revit, rooms and areas are objects rather than 

physical elements. Room area and perimeter are two examples of these physical element 

properties. This information can be helpful, especially to facility managers to whom you 

may be sending your DWFs.

E x porti     n g a V iew   or  S heet    a s a S i n g le  File 

When exporting to DWF, you can make separate DWF files for each view or export all 

views into a single DWF file. To do this, select the Export Each View or Sheet As a Single 

File check box in the Export dialog box. Note that even though DWF is a lightweight for-

mat, depending on the size and complexity of the project you’re dealing with or the 

number of sheets (or views) you want to export, a DWF can be large; you may want to 

consider splitting it into a few separate DWFs.

Exporting to 2D DWF

When you export to 2D DWF, the information is exported in 2D flat drawings, regardless 

of the view type. This means that perspective and axonometric views are exported as flat 

images. Figure 12.15 shows a 2D DWF. Note that although the drawing is technically in 

two dimensions, it retains its visibility settings and element properties.
Figure 12.15

Exported DWF file
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Exporting to 3D DWF

Exporting a 3D DWF creates a full-blown 3D DWF model. When it is opened with a 

DWF viewer, you can spin the model around, turn visibility of separate elements on and 

off, slice the model in sections, make elements transparent, and review the model in a 

variety of ways. Figure 12.16 shows some of this functionality.
Figure 12.16

2 3D view of an 
exported DWF
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The cross-section tool lets you slice the model in any direction and reveal the exterior. 

You not only see the 3D information and can easily move around and review parts of the 

building, but you can inspect the properties of any element available in the model.

Sharing digital models using 3D DWF has proven to be of special value for construction 

companies. It both facilitates design visualization in the field and allows builders to do a 

constructability review in the office before problems arise in the field. Also, 3D DWFs are 

useful to owners because they effectively convey the future look and feel of their building.

Figure 12.16

(continued)
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Marking Up Drawings with Design Review

Autodesk Design Review is a free application created by Autodesk that allows you to review, 

mark up, and track changes to 2D and 3D designs. These comments are stored in the DWF 

file, and even show up in your Revit file by linking in a DWF file. Design Review is installed 

automatically when you install Revit, but can also be downloaded separately from Autodesk’s 

website. (www.autodesk.com/designreview). This is a very lightweight application that can be 

easily downloaded, installed, and used by all the stakeholders on the project team.

In the Design Review application, when you select a Revit element, such as a wall in 

the 3D view (Figure 12.17), it displays all its properties in the left pane. Viewing models 

and querying element properties is just one advantage of this tool. The DWF environment 

opens up new, intelligent ways to share information, propose revisions, and discuss docu-

ment changes to the BIM model.

In a time-honored scenario, an architect prints and sends a set of physical drawings to the 

engineer. The engineer reviews them, physically marks with a red pen the necessary changes, 

and sends the drawings back to the architect. The architect reviews the revised drawings and 

re-creates the changes in the digital files. This process is repeated throughout the life of the 

project. Not only is there a lot of room for error with all the transposing of information, but a 

lot of money is spent on printer paper, postage, and shipping. The transmission of black-and-

white, smeared facsimiles or poor penmanship can result in misinterpreted information. 

Using DWF reduces costly errors and omissions in your communications with team mem-

bers and clients. Let’s review how you can leverage these tools.

A Wor  k flow S ce n a rio   :  M a r k i n g U p a 2 D DW F from   a R evit    M odel  

In Revit, the architect opens the sheet they wish to send to a consultant, then exports it to 

2D DWF and sends it via e‑mail.

Figure 12.17

DWF element 
properties
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The consultant opens the DWF in Design Review, reviews the drawings, makes a 

markup with desired changes directly in the digital file, and sends the DWF back to the 

architect (e‑mail again). Figure 12.18 shows a sample marked-up DWF.

The architect links the DWF markup (choose the Insert tab and from the Link panel 

select DWF Markup) into the Revit file from which the DWF was originally generated. The 

red markup shows up on the correct sheet and in the correct position, as shown in 

Figure 12.19.

Each linked markup has a defined status (None, Question, For 

Review, or Done), which is shown in the Element Properties dialog 

box for each markup (Figure 12.20). When initially linked, the 

default status is None, but it can be changed to another status after 

an initial review. Thus, the architects in the team can track whether a 

certain change request has been executed or is still under review or 

discussion.

Figure 12.18

A marked-up DWF

Figure 12.19

Link Markup Page to Revit Sheets window

Markup functionality only works with Revit sheets. Make sure you are publishing sheets, not 

views, when working with the DWF markup features.

Figure 12.20

Element Properties dialog box for a markup
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Design Review lets you mark up and add comments not only to 2D DWF files but also to 3D 

DWF files. The process is the same: you select the Markup tool from the toolbar, click the 

spot that you want to comment on, and type in the text box that opens (see Figure 12.21). 

The marked-up 3D DWF, however, cannot be linked back into the model.

Collaborating through a digital publishing mechanism is of value for many partici-

pants in the building industry because it allows for shorter review cycles; faster decisions; 

better communication of information; better visualization of projects; and better track-

ing, archiving, and documenting of change orders. 

Printing to PDF
Portable Document Format (PDF) is an Adobe-created document format. The main uses 

of PDF in the past were securing documents the originator didn’t wish to have edited and 

putting content into a manageable file size for digital transfer. Today, PDF is also com-

monly used to transfer drawings among team members and reprographic companies. (A 

reprographic company can create large-format copies, which does pages at 30″×42″ (Arch 

E1) or other large-format sheet sizes.)

Revit supports printing to PDF through the use of printer drivers. You need at least 

one PDF driver installed on your machine to be able to create PDFs. If you do not own a 

copy of Adobe Acrobat (Adobe’s PDF creator), there are other solutions currently on the 

Figure 12.21

With Design Review, 
markups can even 

be added to  
3D views
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market that also make PDFs. Pdf995 (www.pdf995.com) is an inexpensive solution that can 

be installed on any workstation. For server-based solutions allowing multiple people to 

print via PDF to a networked printer, Jaws PDF is also available (www.jawspdf.com).

Another printing format to consider adding is EPS. This offers fantastic vector resolu-

tion and is great if you need to open for further postproduction in Photoshop or Adobe 

Acrobat. More information can be found at:

www.adobe.com/support/downloads/product.jsp?product=pdrv&platform=win

Or check out the Autodesk User Group International (AUGI) post at: 

http://forums.augi.com/showthread.php?t=36877&highlight=eps
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C hap te r 13

This chapter  touches on three topics in Revit that are beyond the basics. 

These topics are explored in more detail in our Mastering Revit Architecture 2010 book 

(Sybex, 2009), but knowing the fundamentals about them early on can be useful as you 

gain more experience with Revit.

In this chapter, we will review the basics of the Family Editor, the power of the Design 

Options toolset, and how to implement worksharing across a team. The Family Editor 

allows you to create and edit components in Revit. The Design Options tool lets you make 

design variations and alternatives within the same project in Revit. Worksharing enables 

you to divide Revit’s logical building model in a way that allows more than one person to 

work on it simultaneously. Topics we’ll cover include:

Understanding families■■

Using design options■■

Worksharing — the multiuser environment■■
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Understanding Families
In Revit, components and other content are referred to as families. Some of these elements 

can be created and edited on the fly within the project environment, and some are created 

and edited outside of a project file. Revit comes with a built-in family-editing application 

called the Family Editor that is tailored for making all types of content, from doors and 

windows, to annotation symbols, to stand-alone furniture. Creating your own digital 

library content is a critical aspect of working on projects, and thus creating families is a 

critical aspect of working with Revit, because families make up a vast amount of what 

goes into a model and you cannot expect the delivered library of elements, regardless how 

rich, to cover all you ever need or wish to design. 

Unlike in many other software packages, custom content creation in Revit does not 

require knowledge of any programming language; however, creating and editing of con-

tent is still something you have to sit down and learn properly, and something that you can 

master only after practicing making many families. The process involves using geometry, 

understanding and establishing constraints, and adding parametric variability into your 

components. Those topics do not belong in an introductory book and can’t be covered in 

one chapter, but we will explore the very basics of them so that you can at least get started.

All elements in Revit are considered families. When you open Revit, a standard set of 

architectural objects and annotation symbols is already created and ready to use. These 

are all “families.” Families can be accessed a number of ways:

In the Project Browser Families node, where you can find all loaded families in the •	

project.

In the Type Selector, invoked when using the Change Element Type tool available •	

on the Element panel of the Modify tab when you select any element or the Element 

panel of the Place contextual tab that appears during creation of any element.

By choosing Load Family, which becomes available  during creation of elements •	

when you select certain elements on the Home tab. Here you’ll find all the available 

default families that exist outside the project, in an external library that you can load 

in the project. You can also browse from this location to any custom location where 

you have saved families that you’ve created.

At •	 www.autodesk.com/revitarchitecture. Under Related Information, select Product 

Download and then click Templates & Libraries. You can download thousands of 

families created for different geographic regions.

Revit uses three types of families:

System families (the majority of which are hosts)•	

In-place families•	

Component (standard) families•	

We’ll discuss these next.
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System Families
System families are created in the context of a Revit project on the fly. The only way you 

can create a new type of system family is by duplicating an existing family and then chang-

ing its properties. Here is a list of some of the families that fall into this category:

Walls•	

Roofs•	

Stairs and Railings•	

Floors•	

Ceilings•	

Ramps•	

Mullions•	

Topography •	

To create a new system family, select the one that is most similar to the one you need, 

duplicate its type, rename it, and modify it. Let’s use a wall as an example:

	 1.	 Activate the Wall tool. From the Element panel of the Modify tab, select Change Ele-

ment Type. This invokes the Type Selector, from which you can select a wall that has 

similar properties to the wall you need to create. If none is similar, it’s easiest to use a 

Generic wall.

	 2.	 Click the Element Properties button to open the Instance properties of the wall, click 

the Edit Type button, and then click the Duplicate button.

	 3.	 You’re prompted to give the new 

wall type a name. Rename the wall 

to reflect your design intent.

	 4.	 Start editing the wall by clicking 

the Edit button under Structure. 

Doing so opens another dialog 

box where you can add and mod-

ify layers of the wall structure. 

Don’t forget to activate the pre-

view of the wall on the left side. 

By clicking the fields for Func-

tion, Material, and Thickness, 

you can change the values (see 

Figure 13.1).

Figure 13.1

Modifying 
wall types
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In-Place Families (Model In-Place)
In-place families are the right approach when you are modeling oddly shaped elements 

that cannot be modeled with their standard tolls (wacky wall shapes, irregular organic 

roof shapes, etc.) These types of families are built in the context of your project using the 

Component button available on the Build panel of the Home tab and then selecting the 

Model In-Place option. This allows you to model geometry that represent a special case of 

some element directly in the project, using elements in your project as a reference. These 

families are useful for one-off objects that are highly specific to your project and unlikely 

to be reused in other projects or in the same project (in which case you should make a 

component family instead). Usually they are connected with some complex geometry or 

have complicated shapes, or are tightly coupled with specific geometry in your project and 

need those references to be created.

You create in-place families by clicking the Component button in the Build panel of 

the Home tab and selecting Model In-Place. Revit then lets you draw whatever you want 

as geometry and assign that to whatever category of element you wish. For example, if 

you are making a free-form wall, you assign the family you create to the category Wall, 

and then create your geometry using Revit’s form-making tools (Extrusion, Blend, Sweep, 

Revolve, and Swept Blend). Assigning the elements to the correct category is important 

later in the process for correct reporting in the building database (scheduling) as well as 

for controlling the visibility of those elements.

The list of available categories you can assign the 

geometries to is a fixed, noneditable list — if no cat-

egory maps to what you intend to create, use the 

Generic Model category. For example, if you are cre-

ating a custom fireplace, you will not find a Fireplace 

category in Revit; in that case, use the Generic Model 

category. 

As soon as you make a new in-place family, you 

will be asked to choose your category, as shown in 

Figure 13.2. You can always change the category later, 

if need be, by selecting the family you created, select-

ing Edit In-Place, and then clicking the “Category and 

Parameters” option available in the In-Place Properties 

panel. This will return you to the Family Category and 

Parameters dialog box where you initially set the Wall 

category, and where you can choose a new one.

Using the Preview button at the bottom of this dialog box, you can switch the preview of the 

wall structure from Plan to Section.

Figure 13.2

Family Category 
and Parameters 

dialog box
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The in-place family is good for creating nonstandardly shaped element types such as 

slanted and tapered walls that you cannot create with the standard wall tool, unusual 

roof shapes, furniture, or other building elements that must conform to specific geom-

etry in your model (a bench along a curved wall, for example). Figure 13.3 shows an in-

place wall that follows the shape of a site and has a nonorthogonal profile. 

Having said all that, our advice is to try to use in-place families sparingly. Duplicating 

an in-place family makes unique elements within the model. If an element is becoming 

repetitive, it should be replaced with a standard family and created in the Family Editor.

Component Families
Component families, also called standard families, are created and can be modified in an 

environment outside the Revit project, called the Family Editor. The fact that these types 

of families aren’t created directly within the project environment allows some diversifica-

tion of the project workflow and can help to minimize the number of users working 

directly in a project file on large projects.

Examples of component families are doors, windows, furniture, plumbing fixtures, 

light fixtures, entourage, columns, annotations, title blocks, massing families, structural 

elements, electrical equipment, site equipment, plants, profiles, and so on. Some exam-

ples are shown in Figure 13.4.

Figure 13.3

Sample  
in-place wall
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You will periodically need to open the Family Editor to create a new family. To do so, go 

to the Application Menu and select New ➔ Family. Often, however, you are working within 

a project and need to change a family already inserted into that project. To edit a family 

that is being used in your project, select the family, and then click the Edit Family button 

in the Family panel of the Modify tab. You’ll find yourself in the Family Editor environ-

ment, where you can make any change to the family in question.

Because this is an introductory book about Revit, we can’t explain the Family Editor 

in detail (it deserves an entire, separate book), but we would like to explain its basic 

principles. The Family Editor is designed to do two primary tasks:

Create a new element (family)•	

Modify an existing element (family)•	

The Family Editor is a unique design environment (see Figure 13.5), but it isn’t sepa-

rate software that you have to install. It’s an integrated application that is automatically 

installed when Revit is installed. The Family Editor resembles the Revit project environ-

ment but is tailored for specific tasks and contains only tools relevant to creation of cus-

tom elements.

You can open the Family Editor several ways:

When editing a family directly from within a project, using the Edit Family option •	

after having selected an element in the project

By opening an RFA file (Family file) from Windows Explorer•	

By clicking the Application menu and selecting New •	 ➔ Family (to create a new family) 

or Open ➔ Family (to open an existing family)

When you create a new family, you’re prompted to select a template. The templates are 

predefined files that are set up for the purpose of creating specific content that will behave 

according to the characteristics of the element to be created. For example, the window 

template looks different from the door template. The next section discusses templates in 

more detail.

Figure 13.4

Component  
family examples
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Family Templates
If you’re creating a dining table as an example, you need to start with the furniture template. 

If you wish to create a sink, you start with a plumbing fixture template. To create a new 

door, select a door template. You get the idea. The available templates for creation of cus-

tom elements are listed in Figure 13.6 and can be found in your Libraries folder, located at 

C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 2010\Imperial Library 

or C:\Documents and Settings\All Users\Application Data\Autodesk\RAC 2010\Metric Library.

The family templates are grouped in four categories:

Model templates (the one you see listed when you open this dialog box)•	

Annotation family templates (tags, keynotes, and so on)•	

Concept Model templates. These are new to Revit 2010 and serve as templates to cre-•	

ate Conceptual Mass families.

Title block families (you can create custom title blocks per project or company)•	

Selecting a correct template before you create a family is essential for correct behavior 

of the element to be created. A correct template does the following:

Categorizes the family you create. This ensures that your family is located in the •	

Project Browser and has a graphic appearance that’s consistent with other elements 

of the same category.

Lists that family in the correct Type Selector when elements are selected.•	

Schedules the family according to the type you selected.•	

Enables content-specific parameters and behaviors.•	

Figure 13.5

Component family 
examples
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If you want to create a window but by mistake you choose the door template to start 

with, your window won’t have the parameters necessary to interact properly with the 

model. If you wish to create furniture but you select a generic family template, your fur-

niture piece won’t schedule when you schedule your furniture, and so on.

Rule number one: Decide whether the Family you wish to create will be a hosted or non-

hosted element. Try to use hosted geometry only if the geometry you are hosting to needs 

to be cut for documentation purposes. Examples of this would be windows or doors.

�Rule number two: Select the correct template. In most cases, you’ll be able to change the  

family category later.

�Rule number three: Choose a good insertion point. The default insertion point of a family 

will be the center of the green crosshairs that appear in the family template.

Figure 13.6

The available family 
templates

The family templates are different for metric and imperial content. Make sure you select the 

correct ones when you install Revit.
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If none of the categories match what you’re hoping to create, use the generic family 

template. 

Templates are provided for each category; some additional family templates are also pro-

vided. Depending on the type of element, you’ll notice that some templates are host based. 

(Light fixtures can be wall based, ceiling based, and so on.) Make sure you select the one 

that will make your element behave appropriately. Figure 13.7 shows some hosted families.

Parametric and Nonparametric Family Types
You can create 2D and 3D families in the 

Family Editor. They can be either parametric 

or nonparametric.

 Parametric families allow variation in size 

and material to be captured and edited as 

parameters. Many types of parametric varia-

tions can be stored in a single family as types. 

An example of a parametric object is a table 

that is produced in four different sizes and two 

different wood types, or a window that is man-

ufactured in 20 different sizes. Figure 13.8 

shows a parametric family in two different 

sizes: as the family is changed, the table size 

and chair count increase or decrease.

Nonparametric families do not provide 

changeable dimensions; they may provide vari-

ation in material, if anything. An example is a furniture family that is produced in only 

one size (such as Le Corbusier’s “Chaise Longue” or a designer lamp). You can’t buy it in 

other sizes, and thus there is no need for parametric properties. Note that you can make 

any family parametric at any time by adding a parametric dimension to it. 

Nothing in the family template limits a family to 

being nonparametric. Figure 13.9 shows Le 

Corbusier’s famous Chaise Longue as a perfect 

example of a nonparametric family.

Figure 13.7

Floor-based and 
wall-based lighting 
fixtures

You can, if necessary, change the family type after the creation of the family. To do that, 

open the family in the Family Editor and select the Categories and Properties button 

located in the Family Properties panel. There, change the family to a new category. This  

will categorize your element correctly for scheduling.

Figure 13.8

A parametric family
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A possible scenario for nonparametric families can involve using content previously 

made with other software applications and importing it into the Family Editor. Revit 

allows you to import 2D as well as 3D DWGs coming from any drafting or modeling appli-

cations as well as SKP files (SketchUp files). Revit reads these file types, and you can lever-

age them to extend your Revit library with elements you’ve created with other software 

packages. Figure 13.10 shows an imported wind turbine that was built in SketchUp and 

imported into a Revit family. It can be placed in your Revit models like any other family, 

with one exception — you cannot control faceting or the level of detail. If it’s a compli-

cated family, it’s probably best to create it starting in Revit.

Levels of Detail and View Visibility
Families in Revit let you control the visibility of their individual parts based on the view’s 

detail level. (You can change the detail level in the model using the View Control bar.) 

When you’re working in the Family Editor, you can select any element and choose Visibil

ity Settings located in the Form panel of the Modify tab. The Family Element Visibility 

Settings dialog box (Figure 13.11) allows you to change the elements’ visibility using 

three levels of detail: Coarse, Medium, and Fine. If all levels of detail are selected, then 

the element appears all the time, in each possible level of detail. You can also make ele-

ments appear in different types of views: plan, front/back, and left/right. Elements are 

always visible in 3D views, provided all levels of detail are selected.

If you make a simple table or a chair, you’ll 

probably view the table as a simple rectangle in 

all three levels of detail. If you make a door 

family, however, you’ll want to change the dis-

play at different scales. Figure 13.12 shows the 

three levels of detail. Note that the table doesn’t 

change; the walls get two different representa-

tions, and the door has three.

Figure 13.9

Example of a non-
parametric family: 

Le Corbusier’s 
Chaise Longue

Figure 13.10

Example of a 
nonparametric 
family created 

from an imported 
SketchUp file

Figure 3.11

Family Element 
Visibility Settings 

dialog box
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Revit families are flexible: you can choose to 

display only certain elements of the family in one 

level of detail and a more complicated presentation 

in another. It’s up to you — you have full control.

Family Types and Type Catalogs
The Family Editor allows also for the creation 

of family types. Family types are best applied to 

objects created by manufacturers that come in  

a variety of standard sizes and finishes. Rather 

than creating 60–70 separate families that are 

the same shape and material but have many 

dimensional variations, with Revit you only 

need to model one family and create type cata-

logs for each variation. You can then add these 

types to a type catalog (a simple, comma-delim-

ited .txt file) that makes types of that family,  

as shown in Figure 13.13.

Once the family is loaded into the project 

environment, you can select all available types  

by selecting the Types button in the Family 

Properties panel.

You can design Revit families that use simple 

mathematical formulas to determine rules of 

behavior. For example, a shelving family can be 

set up so that when a shelf span is longer than 

20″ (50cm), it gets another support, as shown in 

Figure 13.14.

All the different family tem-

plates let you use custom fields and 

formulas, so there is no limit to 

what you can create.

Figure 13.12

Top to bottom: 
Coarse, Medium, 
and Fine levels of 
detail of the same 
set of elements

Figure 13.13

A family using 
a type catalog 
that contains all 
variations in which 
that family is 
manufactured
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Visual Control
Each family belongs to a category, but you can create additional subcategories in the 

Family Editor to provide a richer set of controls over the visual and graphic appearance  

of geometry in the family. A door family, for example, can have several meaningful 

subcategories: door leaf, handle, hardware, opening direction, frame, and so on. You  

can control visibility of each of those subcategories by selecting and deselecting them.

Nested Families
Revit lets you combine multiple families into one family. Imagine a door that incorpo-

rates a fixed transom window above it. These can be created as two separate families ini-

tially but combined into one to be inserted into the project. Nesting one family into the 

other, rather than using two, simplifies placement and design management in the final 

project. Revit also allows you to match the parameters of both of the families, so that when 

you change the width of a door, the width of the transom window (that was nested in the 

door family) changes, too. Figure 13.15 shows a door with a nested transom: rectangular 

and arched. An additional dependency between the respective widths has been estab-

lished. Both are separate families combined into one family.

Figure 13.14

Formulas in families 
allow for smart 

behavior.

Figure 13.15

Door transom 
family nested in 

a door family. 
An additional 

dependency 
between the 

respective 
widths has been 

established.
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When dependencies are established, nested fami-

lies change together with the host. Figure 13.16 shows 

the dependency of the width of the door and the tran-

som; any changes to one apply to the other 

automatically.

All these behaviors are defined by you, the user. 

No other software lets you do this without knowing 

some form of programming language. Similar to the 

previous example, Figure 13.17 shows a two-pick 

brise-soleil family with exchangeable lamellas that are 

nested.

The Family Editor also supports shared families: 

one family that repeats as a nested family in many differ-

ent families (a handle can be used on various types of doors, 

windows, and so on). These families can be shared so that when 

one changes, all others change, regardless of the host in which they’re 

nested.

The Revit Family Editor allows for creation of very complex families, from both a geo-

metrical and a behavioral aspect. Figure 13.18 shows some complex nested families that 

you can create in Revit.

Historical architecture is no challenge for Revit; extremely complex content has 

been created using the Family Editor all around the world. Figure 13.19 shows an 

example of some historical windows.

Figure 13.16

When dependencies 
are established, 
nested families 
change together 
with the host (width 
change in this case).

Figure 13.17

Another example of 
nested families—
interchangeable 
lamellas are nested 
in the brise-soleil.
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Upgrading Families
Regardless of which version of Revit you use to create families, you can always open them  

in a version that is the same or higher. Revit automatically upgrades families from previous 

releases. Note that once a family has been upgraded and saved, you can’t reopen that family 

in an older version of Revit.

Figure 13.18

Complex nested 
families
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Figure 13.19

Historical content 
can be easily 

created in Revit.
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Using Design Options
Design iteration is an integral part of a design process, and as architects we’re all famil-

iar with the need for and importance of working through multiple solutions and design 

variations. Design alternatives, schemes, options, versions — whatever you may call 

them — happen throughout the life of a project. During initial feasibility studies, deciding 

how to best orient functional program elements relative to the site is common and often 

involves myriad schemes. Comparing and estimating cost becomes a 

key factor as well. For each proposal, what is the associated cost? 

For example, when you move into a more detailed design 

and want to iterate through a series of entry-canopy 

options, countless sketches and ideas are pro-

cessed, and the ability to visualize and analyze 

multiple solutions is essential to making deci-

sions. Regardless of the stage in the process, 

you often need to create several design 

variations.

A typical method for making mul-

tiple design schemes, if you’re working 

with a legacy CAD application, is to cre-

ate one initial design and then make copies of it. 

Each copy becomes a separate file that is used to 

explore an alternate design solution independently. 

Although this approach can work well initially, the  

downstream effects can be difficult to manage. 

Integrating ideas from one file to another, main-

taining a common set of references, and even 

something as mundane as file-naming schemes 

can be tedious and error prone.

Revit has a tool specifically designed to 

address this problem: Design Options. An 

example of use of the Design Options 

tool is Figure 13.20, which shows varia-

tions of balcony solutions for the same 

residential building.

Revit families are part of the project where they’re used. There’s no need to send out archive 

packages or extra libraries when you share the project with someone else. The families are 

an integral part of the Revit project.

Figure 13.20

Design options  
for balconies
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The Design Options Interface
The Design Options toolset is available in the Manage tab, in the Design Options panel. 

Figure 13.21 shows the available Design Options toolset.

Because this book is an introduction to Revit, we won’t go into the use of design 

options in depth, but we’ll cover the principles behind this tool. Let’s briefly explore a 

scenario for design options. Let’s say you need to create various schemes for laying out 

interior partitions and desks in an office. You want to make two options, which are 

shown in Figure 13.22: an area with private offices and an open office plan.

It’s possible to create both of these options in one Revit file and do so in a very intel-

ligent way so Revit will understand that these are options and not double or triple instances 

of elements to be counted in the database. You can move elements from option to option 

on the fly. You can also generate views that show the two options simultaneously for com-

parison and place these views on sheets to present them for review. You can even schedule 

each of the options for economic review. Here are some steps describing a design options 

workflow in Revit:

	 1.	 Open the Design Options dialog box by clicking the Design Options button.

Figure 13.21

Design Options 
toolset

Figure 3.22

Two design options 
for interior setup  

of the same  
working space

Option 1: Office area with private offices

Option 2: An open office plan
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	 2.	 To create a new option set, click New in the Option Set sec-

tion of the dialog box. Option sets control subsets of options. 

For example, if you want two different entry canopies, the 

option set will be for entry canopies, and the options will be 

for Canopy A and Canopy B.

	 3.	 Using the Rename button, name the option set Canopy 

Alternatives.

	 4.	 Using the New button under the Option section of the dialog 

box, create two options: Option 1 (which you rename as  

Canopy A) and Option 2 (Canopy B) within the Canopy 

Alternatives option set. Your option set and options should 

look like Figure 13.23 when you’re finished.

	 5.	 Click Close to exit the dialog box.

	 6.	N ext, create a duplicate view for comparison. Duplicate any 

view, and then select the View tab. In the Graphics panel, 

click the Visibility/Graphics button to open the Visibility/Graphics Overrides dia-

log box. You will see a new tab, Design Options — select that tab. Change the Design 

Option setting from Automatic to Canopy B.

Setting Your Views

You can customize each view to show different design options. Note that only one option 

from each option set can be viewed at a time. Once you’ve created design options, a new 

Design Options tab shows up in the Visibility/Graphic Overrides dialog box of any view. 

From here, you can specify which option you want to appear in that view. To have the 

same view type show two different options, you must duplicate the view and in the 

Visibility/Graphic Overrides dialog box change the design option that you want to dis-

play. Figure 13.24 shows the option sets in the Visibility/Graphic Overrides dialog box.

By default, the first option you created will be set to Primary, and that will remain so 

unless you specify otherwise. To change the primary option, open the Design Options 

dialog box, select an option on the left, and click the Make Primary button on the right 

side of the dialog box. So, if the first option you created is Canopy A, then that will be the 

primary option and this option will be displayed automatically in each view. To change 

the option you want displayed by default in a view, you can change which option is pri-

mary. To see secondary options in a view, use Visibility/Graphic Overrides and change 

from Automatic to whatever option you want to see.

Figure 13.23

Design Options 
dialog box

You can make as many option sets with as many options in the same model as you need.
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Creating the Elements in the Options

To add elements to an option, click the Main Model button in the Design Options panel, 

and select the option you want to work in. Figure 13.25 shows these selections for the 

example we’ve set up.

Once you’re in the proper view with the correct option set and visibility selected, you 

can start designing for that option. You can tell when an option is active for editing in 

two ways:

You can’t select elements outside the option set.•	

The Main Model button changed to the design option that is active and displays •	

Canopy A (primary) 

With no design options active (you must be in the main model), select all the elements 

for an option, and click the Add to Set button located in the Design Options panel of the 

Figure 13.24

The Visibility/
Graphic Overrides 

dialog box controls 
Design Option 

visibility in a view

Figure 13.25

Activating a  
design option

In practice, you’ll probably start with one design and then realize you want to study some iter-

ations of an element of that design. As an example, let’s consider a canopy. If you’ve already 

modeled a canopy but you want to study some design iterations on it, you need to create 

design options. When you do, be sure to move the current canopy design to one of those 

option sets. If you don’t, you’ll see multiple canopies overlaying each other in your views.
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Manage tab. Move the elements to one design option by selecting the appropriate  

check boxes, as shown in Figure 13.26.

You may want a quantity overview showing how much material one option 

uses versus the other. You can generate a schedule that reports information about 

elements in each specific option. To define what the schedule reports relative to 

what is visible in the model, edit the visibility of the schedule. In the Instance 

Properties dialog box of a schedule, click the Edit button to open the Visibility/

Graphic Overrides dialog box.

Once you’ve made a final decision on which option will be the one built, you will need 

to do the following: first, make the option with which you want to continue the design a 

Primary option (see Figure 13.27). You can do this by selecting the option on the left and 

clicking the Make Primary button in the Design 

Options dialog. Second, and very important, you 

will need to click the Accept Primary button. Keep 

in mind that doing so will eliminate all the other 

options from the Revit project permanently and 

will merge your chosen option back into the 

model.

Worksharing — The Multiuser Environment
Most projects involve more than one person working at any given time. Often, many peo-

ple work in tandem to meet deadlines and produce construction documents. Keeping with 

the theme of an integrated single-file building model, Revit allows for this workflow with-

out breaking apart the model. A complex model can be edited by many people at once 

using what is called worksharing.

There are various ways that you can share work across a team with Revit:

File linking•	

Borrowing elements•	

Worksets•	

We covered the idea of linked file-sharing methodology in Chapter 7, “Working with 

Other Applications.”

In this section, we’ll focus on the other two methods of sharing: borrowing elements 

and using the worksets methodology.

Figure 13.26

Adding elements to 
a design option

Revit won’t report double or triple entities of all options for quantity calculations. 

It reports quantities for only one design option at a time.

Figure 13.27

Make Primary and 
Accept Primary
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Borrowing Elements
This methodology allows team members to work on the same file and take ownership of 

elements to work on. When elements aren’t taken by anyone, they’re free to be taken and 

then edited. When a team member needs to work on an element that belongs to someone 

else, that member gets a message that the element belongs to someone and can then send 

a notification to the current owner of the element requesting access. The owner of the ele-

ment can then grant permission to take ownership — relinquishing elements, as it’s called 

in Revit.

Worksharing Using the Worksets Methodology
A workset is a collection of building elements (floors, roofs, walls, windows, and so on) 

that can be edited by one team member at a time (if the whole workset is checked out)  

or by multiple team members (if only individual elements are checked out). You need  

to understand some core concepts about worksharing before you begin.

By default, worksharing isn’t enabled when you start a project. You share your work 

by first enabling worksets, then creating a central file. Each user then navigates to the 

central file and creates a local copy by dragging and dropping the file to a location on 

their local computer. All work is done from this copied — but still associated — local 

file. This enables every user to open his or her own file simultaneously. The elements in 

each separate file are tied to an ownership rule managed by the central file, making it 

impossible for you to edit an element in your local file if that same element is owned by 

someone else.

Revit is a database. In effect, you’re taking permissions of one or more elements from 

the central database file and copying changes (and permissions) to the central file. If one 

user has ownership over an element, no other user can edit that element until its permis-

sions and changes are reconciled with the central file.

Worksets also let you put collections of elements into a container, which is useful for 

turning off the visibility of elements that aren’t being worked on, or for “closing” parts 

of the model that you’re not working on. When you enable worksharing by clicking the 

Worksharing button on the Collaborate tab, a new tab will appear in the Visibility/Graphics 

Overrides dialog box for the worksets (view). You can turn on or off any workset in any 

view and make those settings part of your view templates. 

Once you enable worksharing in a model, you can’t undo it. Remember that. We suggest 

that you make a copy of your file before you enable worksharing so you keep an unshared 

version as a backup.
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Worksharing Basics

The other team members can view the elements of any workset but can only edit them 

using element borrowing.

Worksharing is designed to accommodate any divi-

sion of labor you see fit. There are no inherent restric-

tions on how you use worksharing to accomplish work. 

For example, if you want to break up a team and have 

one group work on the exterior shell and one work on the interior core, this isn’t a prob-

lem. At any point in a project, you can create or remove worksets.

The Worksharing tools are located on the Collaborate tab. You can start worksharing 

by clicking the Worksets button shown in Figure 13.28.

When you click the Worksets button, a dialog box (Figure 13.29) opens, confirming 

that you’re about to enable worksharing and 

informing you that what you’re doing can’t be 

undone. By default, Revit creates two worksets: 

one contains the levels and grids; the other con-

tains geometry and is named Workset1.

Three other types of worksets are created 

automatically:

View workset  ​Each view in a project has a dedi-

cated view workset. It contains the view’s defini-

tion and any view-specific elements (text, 

dimensions, and so on). View-specific elements 

can’t be moved to another workset.

Family workset  ​For each loaded family in the proj-

ect, an automatic workset is created.

Project standards workset  ​This automatic workset 

covers project settings like materials, line styles, 

and so on.

Once you’ve activated the worksets, you’ll see 

the dialog box shown in Figure 13.30. Here, you 

can add and remove worksets.

When you activate worksets, you’re the owner 

of all of them. This is what the Yes value in the Editable column means.

Figure 13.28

Start worksharing 
by clicking the 
Worksets button

Figure 13.29

Activating worksets 
in a project

Figure 13.30

Worksets dialog box

The activation of worksets is usually done by the team’s project manager, who creates this 

first workset setup, creates user worksets, and assigns people to work on the project.
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Workset Organization
It’s important that you think of your project holistically when dividing it into worksets. 

Some good examples of worksets are Shell and Core, Exterior Skin, and First Floor Interior 

Partitions. Another example is First Floor Interior, which could include partitions, furni-

ture, doors, and so forth. Technically, once you have activated worksharing, you do not 

need to add any more worksets than the ones Revit has generated. This is because Revit 

will automatically manage ownership of elements on a per-element basis and relinquish 

ownership automatically when you save to a central file. Worksets should be used to help 

define visibility and division of labor within the team.

Worksharing Workflow

There is always one central file that spawns local files and manages element ownership. 

This is the file that changes are saved into and from which you get updated versions of the 

model as you work. Work can be done directly in the central file, but that isn’t a suggested 

workflow.

To begin using worksharing, follow these steps:

	 1.	 Activate worksets.

	 2.	 Save the file as a central file. To do so, go to the Application Menu and 

choose Save As, choose Project. In the Save as dialog box click Options. In 

the resulting dialog box (Figure 13.31), select the Make This a Central File 

after Save check box and finish by clicking OK.

	 3.	 Make local copies of the central file. You do this by saving the same file 

from your server where it’s located onto the local machines of the other 

users.

	 4.	 Draw the basic layout of the building, exterior shell, and so on.

	 5.	 Start creating worksets and naming them accordingly. 

	 6.	 Move elements into appropriate worksets (select elements, open the ele-

ment properties, and in the Instance Properties dialog box under Worksets, 

change the workset to which the elements need to belong).

Working in the central file means that you will go against everything any IT manager 

ever yelled at you for. Remember: No one ever works in the central file. Everyone works in 

their local files (which are local copies of the central file) and works directly off their C 

drives. This approach to worksharing has a couple of advantages:

It allows more than one user to make changes to the file.•	

It’s more responsive as the file gets larger, because the access speed to your hard drive •	

is faster than it is to most networks.

Figure 13.31

Saving a central file
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You can make a local copy by dragging and dropping the central file to your desktop 

or anywhere on your C drive. Open that file. You’ll originally see the message shown in 

Figure 13.32, alerting you that you have a local copy of a central file. Revit maintains the 

link between your local copy and the central file provided you don’t move the central file 

from its location on your network.

Once you’re in a worksharing environment, every element 

added to the file belongs to some workset. Try to keep model 

elements in a workset other than shared levels and grids, 

because these worksets may be locked down at some point to 

avoid accidental movement of key datums. To make sure you’re placing elements in the 

proper workset, check the Worksets panel (see Figure 13.33). The workset shown in this 

box is the workset your elements will be drawn on.

A helpful toggle in the Worksets panel is the Gray Inactive Worksets button. It grays 

out all elements that aren’t in the active workset, helping you identify which elements are 

in the workset you’re working on. This is a temporary view state and doesn’t affect print 

output.

Saving Shared Work
There are two ways to save your work when you’re using a workshared file:

Save  ​The Save tool only saves the work you’ve done on your local copy; the work isn’t 

shared. This is useful when you’re in the design phase and trying different designs, and 

you aren’t ready to share your work with others.

Save to Central  ​Next to the Save tool is the Synchronize with Central button. Use it to 

commit your work to the central file. When you do so, your work appears in the central 

file and becomes available to the entire team. Saving to central also acquires the changes 

that others have made and loads them into your model.

Figure 13.32

Warning about 
creating a local file

Figure 13.33

The active workset’s 
name is always 
displayed in the 
Worksets panel

Create a filter that applies a graphic override based on the active workset. Now you can 

quickly identify which elements are on which workset.
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Loading Work from Other Team Members
It’s possible to update your model from the central file without committing your current 

changes to the central file. Think of this process as getting an update of the model. To do 

so, choose Reload Latest from the Synchronize panel of the Collaborate tab. Your file gets 

the latest changes saved from the central file and brings them into your local file.
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Conceptual Modeling

C hap te r 14

This chapter will introduce you  to basic workflow and 

features that support early conceptual design and analysis of buildings. We’ll look at how 

to create basic forms and rationalize those forms with surface divisions using the new 

conceptual design environment. We will then see how to leverage the mass downstream 

in the design process by applying Revit model elements such as walls, f loors, and roofs to 

mass surfaces.

Topics we’ll cover include:

Understanding the conceptual design tools■■

Rationalizing surfaces■■

Using model-by-face tools■■
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Understanding the Conceptual Design Tools
Within Revit, it is possible to carry a model from early conceptual forms through construc-

tion documentation without having to restart the process at each stage in the design process. 

By creating conceptual forms, and then applying intelligent building elements directly 

to the form, you can move your design intent forward in the context of a BIM workflow. 

Revit 2010’s form-making tools are designed to support a wide range of forms — from 

simple boxes to doubly curved surfaces. Regardless of the formal complexity, you’ll be 

able to apply walls, floors, and roofs to those forms and then analyze your design.

Using massing features, parametric capabilities, and integrated scheduling, you can 

represent and quantify information such as area, volume, and program information.

Massing Workflows
The early stages of conceptual design rely heavily on sketches, study models, and diagrams 

to explore ideas before committing to a final concept. With the aid of the computer, these 

concept sketches can be moved into digital 3D models very early in the process. The models 

can be edited quickly, and can be used to generate graphics, create 3D printed prototypes, 

and perform early energy analysis. With a traditional 2D CAD workflow, the work used to 

generate these early models cannot be transferred downstream when design development 

begins. The work starts over, a new model is created, and detailed design begins. If the 

concept undergoes any major revisions, the process starts over again. 

Even if you’re making study models using digital tools such as Rhinoceros, 

SketchUp, Form Z, Maya, or 3ds Max, in order to document your design you still need 

to start from scratch because these tools are 3D modelers — not architectural documen-

tation tools. With the advent of building information modeling, this is all changing, as 

you can now carry a conceptual model through to construction documentation in one 

environment.

BIM provides the ability to move and 

reuse previously created data throughout the 

design process, from start to finish — with-

out having to start over from zero. With the 

Revit massing tools, your model can remain 

integrated. For early concept studies, you 

can create models natively using Revit’s con-

ceptual design tools or by importing geo-

metric massing studies created in other 

applications. Figure 14.1 shows a concept 

model that was taken from simple massing 

shapes to more detailed design, and even 

printed in 3D. Regardless of whether you 

Figure 14.1

Early massing 
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Once you have made a form, you can then freely manipulate it 

using interactive controls, temporary dimensions, and parametric 

dimensions. Click on any surface, edge, or vertex of a form and a 

control will appear. Use this control to adjust the form. Figure 14.6 

shows selection of a vertex, edge, and surface of a form.

The tools for creating conceptual masses are a bit different 

than those used to make other Revit families. The Family Editor 

uses explicit sketch-based tools such as Extrusion, Blend, 

Revolve, Sweep, and Swept Blend. These tools require you to 

enter a Sketch mode to make changes to the geometry and lack 

the ability to interact with the forms directly. With the massing 

tools, there are no Sketch modes, and form can be manipulated 

directly. In fact, you won’t even see tools for creating extrusion, 

sweeps, or revolves. Instead, you’ll see standard line creation 

tools, the Create Form tool, and some datum tools (Figure 14.4). 

Once you make a form, additional tools become available when 

you select the form, including the ability to add new edges, pro-

files, and divide surfaces (Figure 14.5). 

create the concept geometry within or outside of Revit, you can generate building ele-

ments such as walls, floors, and roofs directly from the geometry.

Revit’s Conceptual Massing Tools
The conceptual modeling tools in Revit can be accessed directly 

in the project as in-place family instances, or from a special fam-

ily template, mass.rft. Mass families can be loaded and placed 

into a project like any other family. Each method, in-place or a 

loadable family, offers slightly different behaviors. For example, 

building a context model of abstract building shapes — which is 

generally static — makes the most sense to do in the project 

environment, whereas building multiple concept studies that can 

be swapped in and out of your site model is better handled with 

family instances. 

We’ll look into how to use both methods. If you’re in a proj-

ect file, you can access the massing features in the Conceptual 

Mass panel on the Massing & Site tab (Figure 14.2). You’ll use 

this tab to create in-place masses, control visibility of masses, 

place mass instances, and model Revit elements (walls, roofs, 

curtain systems, and floors) using the surfaces of masses. If you 

want to create a massing family, click the Application menu (R) 

and select New ➔ Conceptual Mass (Figure 14.3). 

Figure 14.5

Tools available after you make a form

Figure 14.4

The new conceptual form making tools

Figure 14.3

A new conceptual mass family can be started 
from the Application menu

Figure 14.2

The Massing & Site tab provides tools 
needed to create a massing study in a 
project
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Once you’ve made a form, you can rationalize it by dividing the surface 

and applying panel families to it directly in the conceptual environment 

(Figure 14.7), or apply walls, floors, and roofs using the Model by Face tools 

and Mass Floors tool available in the project environment (Figure 14.8). 

Dividing a surface always takes place while you are editing the family, and 

modeling by face takes place when you are in the project environment. 

Let’s take a look at some of the Revit massing tools:

In-Place Mass tool  ​To make a mass in a project, use the In-Place Mass  

tool on the Massing & Site tab. This will enable the massing tools in a  

new ribbon tab.

Place Mass tool  ​This tool ( ) allows you to place a massing fam-

ily or load a mass. It lets you place mass family instances that have been 

loaded into your project. We’ll get into how to create your own mass families 

in the next section.

Show Mass tool  ​The Massing category visibility can be turned on and off with 

the Show Mass tool ( ). It is a global toggle (similar to how Thin 

Lines mode works) that will keep you from having to manage mass visibility 

independently for each view. This toggle does not affect final printed output, 

but is rather an in-process tool to aid your workflow. The Show Mass toggle 

will be enabled when you first make a mass. When you try to place mass or 

create mass for the first time, you’ll most likely get the message in Figure 14.9, 

which conveys information about the visibility of mass elements.

Figure 14.6

You can directly 
manipulate vertices, 
edges, and surfaces 

with the form 
control widget

Figure 14.7

Surfaces can be divided and patterned in the 
conceptual modeling environment

Figure 14.8

Using Model by Face and Mass floors, you 
can move from concept mass to building 
elements quickly
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Visibility/Graphics Overrides

To see the mass elements in specific views only, use the 

Visibility/Graphics Overrides settings. When the Show Mass 

button is turned off and you activate the Mass setting in the 

Visibility/Graphic Overrides dialog box, the mass category will 

be visible in that view. Keep in mind that to print and/or 

export massing, you need to turn the Massing category on 

using Visibility/Graphic Overrides.

As your design gets more detailed and starts to incorporate real building components 

such as walls, floors, and roofs, you’ll need a quick way to jump back to just the massing 

forms. A great way to maintain a view where only massing is visible is to create a 3D view 

where all categories are turned off except the Massing category. To do this, first create a new 

3D view, and use the Visibility/Graphics Overrides dialog box.

Figure 14.10 shows two views: one with only the massing category visible and the other 

with all categories visible. This is handy when you want to make adjustments to the basic 

shapes that define the geometry (masses) without being distracted by the presence 

of the building elements. 

Creating a Mass: The Basics
When you select the In-Place Mass tool from the Massing & Site 

tab, you’re first prompted to name the mass you’re about to create. 

Once you provide a name, you will find yourself in the conceptual 

mass-creation environment. Using these tools, you start by drawing 

lines, and then you can create solids, surfaces, or voids. Surfaces 

can then be divided and patterned, and used as a basis for walls, 

floors, and roofs. When in a project, the other tabs are still avail-

able, and various tools will be enabled or disabled depending on 

their relevance to massing tasks. For example, the Edit tools (such 

as Trim and Align) will still be accessible on the Modify tab, and 

Dimension will be available on the Annotate tab. Other tools, such 

as walls, floors, and roofs, will be disabled. If you have already mod-

eled building elements, they will not be editable from the in-place 

massing mode.

Figure 14.9

When you first 
create a mass, the 
category will be 
made visible with 
the Show Mass 
toggle

Figure 14.10

The same view with 
different visibility 
states for massing 
and model elements
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Creating Forms

Start by drawing lines in your view using the draw tools (Figure 14.11) — a simple rectangle 

is a good place to start. When lines are selected, the contextual tab changes to Modify Lines. 

Clicking the Create Form button (Figure 14.12) will then create a solid box, as 

shown in Figure 14.13.

Depending on the lines you select, you’ll be able to create a wide range for 

3D forms. If you draw a series of lines on multiple levels and then create a form 

from those lines, you’ll get a lofted surface.

Creating Your Initial Lines

The tools in the Draw panel provide a set of common line creation methods to create your 

initial lines. Note that there are two types of lines you can make: lines and references. Lines 

will be “consumed” into the form when used to make a form, while reference lines will not. 

That is to say, the lines no longer exist once you make form with them. Reference lines can 

also be used to host other elements, whereas lines cannot. For example, if you draw lines on 

a reference line and then rotate or move the reference line, the lines will go with it. 

You’ll notice that in this environment, you will not need to press Tab to select a chain 

of lines. 

Finishing the Mass Editing Session

Everything you add in the mass editing session will create a single mass instance when 

you finish. Your decision to create individual shapes as separate mass elements or as a 

collection of masses depends on how you intend to interact with your mass instance. 

For example, one mass element could have five boxes representing five buildings. Or, 

you could make five separate mass elements for each building. Do you want to move 

each building independently? Or will you likely want to move all the buildings together 

as a single object? These kinds of questions should guide your decision-making process.

When you’ve finished modeling, click the Finish Mass button in the Ribbon. After 

clicking Finish Mass, everything you modeled becomes a single mass element. To reedit 

the mass, select it and click the Edit In-Place button on the contextual tab.

Figure 14.11

The Draw panel 
gallery of line 

creation methods

Figure 14.12

Click the Create 
Form button

Figure 14.13

Lines are used to 
create a form using 

the Create Form 
command
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Direct Manipulation

Once you’ve made a form, some controls will show up when the mass is selected. The con-

trols let you edit directly by dragging the triangular control grips on the form (Figure 14.14), 

and they only show up on planar surfaces. The controls do not provide temporary dimen-

sions, and dragging will result in hard-to-predict numeric values. Rather than deal with 

these grips, it is easier to simply select the form and edit it in-place. You’ll get better interac-

tion and more precise controls with the arrow controls (Figure 14.15).

When you have a surface, edge, or vertex selected, you’ll be able to use the arrow con-

trol. Press the spacebar to change the orientation of the control to align with local geom-

etry. This is useful if the geometry you are working on is not aligned to the global XYZ 

coordinates. Note that if the local geometry is aligned with the global XYZ axis, the con-

trol will not change appearance with the spacebar. Figure 14.16 shows the different orien-

tation of the control when you use the spacebar to toggle it.

Figure 14.14

When a mass is selected, triangle 
grips appear on the form; you can 
drag these and change the form

Figure 14.15

For more precise editing and less visual noise, edit 
the form in-place and select the surface, edge, or 
vertex you want to edit

Figure 14.16

Use the spacebar 
to toggle between 
local and global 
move vectors
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Joining and Cutting Forms 

The conceptual tools support essential Boolean operations, such as cutting and joining of 

intersecting forms. It is important to note that massing forms can be solids or surfaces — 

something new to the 2010 release (Figure 14.17). However, surfaces 

cannot be used to cut into solids. We’ll explore the range for form 

topologies later in the chapter, in the section “Understanding Form 

Making and Rationalization.”

Any form can be either solid (positive form) or void (negative 

form), and can be changed back and forth at anytime using the 

Convert to Solid/Convert to Void toggle in the Form tab. Voids will 

automatically cut into solids. Try making two boxes — one void and one solid — 

using the options in the Create Form drop-down. If the two forms intersect, the void will cut 

away geometry from the solid.

Voids, as the name suggests, create negative volumes that carve away from solid forms, 

as shown in Figure 14.18. A void will automatically cut solids when they intersect, unless 

you tell it not to cut using the Don’t Cut tool on the Modify tab.

Multiple forms can be joined to one another to create 

connected forms. This tool joins solids to form one con-

nected element (note that voids can’t be joined together). 

It merges the shapes (masses) into one, both graphically 

and as data (Figure 14.19). To use this tool, select the 

tool, and then select the solids you want to join. 

Multiple solids can be joined together. The Join and 

Unjoin Geometry tools (Figure 14.20) are avail-

able on the Modify tab.

Figure 14.17

Surfaces, such as 
this loft, can be 

created in the con-
ceptual massing 

environment; how-
ever, they cannot be 

joined to solids

Figure 14.18

A void form 
intersecting a solid 

form creates the 
resulting form

Figure 14.19

Joining two masses 
together creates 

a single, seamless 
element

73559c14.indd   436 6/2/09   1:56:31 PM



Understanding Form Making and Rationalization  ■   437

Understanding Form Making and Rationalization
We’ve looked at the basics of how to get started on a massing form. Now we’ll dig into 

how to actually create some common forms, and then rationalize forms using the surface 

division tool. In the following exercise, we’ll guide you through the creation of several 

types for forms that you can make with the conceptual modeling environment, including 

extrusions, lofts, sweeps, and revolves. The result will be mass shapes similar to those 

shown in Figure 14.21.

Making a Parametric Extrusion
First, when you’re creating a new mass, it’s essential to select the correct family template. 

Be sure to use Mass.rft or Metric Mass.rft — the default template from the Application 

Menu, and choosing New ➔ Conceptual Mass. Follow these steps:

	 1.	 From the Application Menu, choose New ➔ Conceptual Mass. In the New dialog box, 

select the template Mass.rft or Metric Mass.rft and click the Open button.

	 2.	 Using the rectangle tool from the Draw/Pick Gallery, draw a rectangle on Level 1 

(Figure 14.22). This will be the default work plane, and will highlight as you draw the 

rectangle.

	 3.	 Select the lines, and click the Create Form tool. A box will appear, with a temporary 

dimension to the top of the box. Click the dimension and type 100’ to set the height 

(Figure 14.23).

	 4.	 To make the height parametric, click the Make Permanent icon next to the vertical 

temporary dimension. This will create a dimension.

Figure 14.21

Basic forms that can be generated include lofted surfaces, 
sweeps, revolves, and extrusions

Figure 14.22

Start with a rectangle
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	 5.	 Select the dimension and use the Options bar to add a parame-

ter (using the Label: drop-down menu) to the dimension, mak-

ing it parametric (Figure 14.24).

	 6.	 In the Parameter Properties dialog box that opens, name the 

parameter Height, group it under Dimensions, make it an 

instance parameter, and click OK.

	 7.	N ow, reselect the top face of the box and drag it up and down. 

Note how the parameter updates with the direct edit. You’ll 

notice that dragging a face results in overly sensitive precise 

dimension values — numbers that round to nearest 256th of an 

inch, for example. To overcome this, simply open the Family 

Types dialog box by clicking the Types button on the Ribbon and 

set the value using the properties dialog box (Figure 14.25).

	 8.	 Set the height to 120′ and click OK. As you can see, the height 

can be whatever you want in the family environment, but with-

out the parametric dimension, you’ll have no way to change the 

height parametrically once it’s loaded into a project.

	 9.	O pen a new project by clicking the Application button and 

selecting New ➔ Project. This will open a blank project. Press 

Ctrl+Tab to go back to the box you were making.

	10.	 Click the Load into Project button on the Ribbon to load the 

box into the project. You will be put into component placement 

mode, in the default plan view. Note that your cursor will display 

as a banned symbol, indicating that you cannot place the com-

ponent. This is because the placement mode is looking for a face 

to place your massing box onto. Not a problem — change the 

placement method to Place on Work Plane in the Placement panel 

on the Ribbon — this will allow you to place the mass family on 

Level 1 (or any level in your project using the Placement Plane 

drop-down list on the Options bar). See Figure 14.26.

	11.	 Click to place the mass family, and then press the Esc key twice 

to cancel the placement mode.

	12.	 Using the 3D view tool on the Quick Access toolbar, open the 

default 3D view to see the placed mass. Change the view display 

to Shaded with Edges, and you’ll see a semitransparent box.

Figure 14.23

Height can be 
changed using 
the temporary 

dimensions.

Figure 14.24

Make the form 
parametric

Figure 14.25

Use the Family 
Types dialog box to 

adjust the height
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	13.	 Select the mass and open the Instance Properties dialog box. Change the Height 

value to 200′ and click OK — you’ll see the form update to the new height. Your mass 

box is now working parametrically (Figure 14.27).

Making a Parametric Material
You probably noticed that the material in the previous exercise appeared slightly trans-

parent. This is because the material in the project has the same name as in the conceptual 

mass template, and materials in the project always trump those in the Family Editor. The 

reason for the semitransparent material is so you can visualize mass floors when they are 

added to a massing form, as shown in Figure 14.28. To add mass floor to the mass, first 

make new levels in an elevation view; then select the mass and use the Mass Floors com-

mand to select the levels you want to intersect the mass and to generate mass floor 

elements.

Figure 14.26

Use the Place on 
Work Plane option 
to place the family

Figure 14.27

The form’s height 
can be controlled 
parametrically 
using the Instance 
Properties 
dialog box
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Making a Revolve
A revolve form takes curves and revolves them around an axis. To make a revolve, first draw 

a line for the axis and lines to revolve around that axis. Then select the lines and use the 

Create Form command. Revolves can be made from open or closed profiles:

Figure 14.28

A mass form can be 
intersected with 

levels to create mass 
floor elements

Figure 14.29

If more than one 
form is possible, a 

preview will appear 
in the view 	 1.	 Create a new conceptual mass family.

	 2.	 In the view, draw a single straight-line segment; this will 

become the axis of rotation.

	 3.	 Draw an arc offset from the line segment; this is what will 

revolve around the axis.

	 4.	 Select the arc and line, and then click the Create Form button. 

You will see a preview to two possible forms appear below 

the form: a revolve and a surface. Hover your cursor over 

the revolve preview and click on it; this will create a revolved 

form (Figure 14.29).

	 5.	 Select the top face of the form and open the Instance 

Properties dialog box. Change the End Angle value to 180, 

and click OK. This will give you a half-revolve form (Fig-

ure 14.30).
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	 6.	 Select any edge of the form and experiment with drag-

ging the control arrows (Figure 14.31). You’ll notice 

that the start and end parameters update as you 

manipulate the form.

Making a Loft
A lofted form is a surface or solid that blends 

between two or more open or closed curves. For 

example, if you draw a series of splines on different lev-

els, you can loft between the lines and create a surface. 

Likewise, you can loft between closed loops, 

and even from a closed loop to a single line 

segment. Figure 14.32 shows a tower shape 

that is a loft between three profile loops.

Making a Sweep
Sweeps are composed of a path plus a profile 

that follows that path. A path can have mul-

tiple segments as long as they are connected 

end to end. Profiles can be open or closed; 

however, if the path contains multiple 

Figure 14.30

A revolve has start 
and end angles that 
can be adjusted 
interactively or by 
using the instance 
properties

Figure 14.31

Use the control 
arrow to directly 
edit the form

Figure 14.32

A lofted 
surface form
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segments, the profile must be closed. A profile must also be perpendicular to the path it will 

follow. A great way to establish a perpendicular work plane is to place a reference point on 

the path and then select the point. This makes the point the active work plane, and you can 

then start drawing your profile. Figure 14.33 shows a swept, 

closed loop profile following a rectangular path.

Rationalization of Surfaces
Once a form has been generated, it is often necessary to 

divide the form into regular intervals to better understand 

how a complex surface can be rationalized into buildable 

form (Figure 14.34). Now that the surface has been 

divided, you can begin to place real building components 

on it. These components begin to suggest an architectural 

articulation that goes beyond mere massing studies, sug-

gesting opening fenestration patterns, surface modulation, 

and surface variations.

Divide Surface Tool
To divide a surface, select any surface and then click the 

Divide Surface tool on the Modify Form contextual tab. 

The default setting divides the surface evenly into 12 

divisions in both U and V directions. U and V represent 

a way to show a surface as a mesh that follows the natu-

ral contours of a surface. You are probably familiar with 

XYZ coordinates — U and V are simply the letters in the 

alphabet directly before that. Start with a simple box, and 

select a surface to divide; then click the Divide Surface 

button, and you will see the surface disappear and a UV 

grid appear. You can see a UV division on nonplanar 

surfaces in Figure 14.35.

You can change the UV division of the surface in a 

number of ways: using the Options bar, using instance 

properties, or using the Configure UV layout mode 

(accessible by clicking the icon that appears on the cen-

ter of a divided surface when selected, as shown in 

Figure 14.36).

Figure 14.33

A swept form

Figure 14.34

A divided surface with a 
component family applied
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Figure 14.35

UV surface divisions
Figure 14.36

Click the UV Layout icon to get access to in-context controls

Divisions can be established using a fixed number or a fixed distance. If you want to 

start dividing a surface using more concrete sizes, change your division to fixed values. 

To change the division to use fixed distances, use the Options bar (Figure 14.37).

Applying a Pattern to the Surface

Once a surface has been divided, you can then apply patterns to the surface. Revit ships 

with a fixed set of predefined patterns that range from simple rectangles and triangles, to 

more complex hex patterns and brick layouts. To apply a pattern, select the divided sur-

face and use the Type Selector (Figure 14.38).

These patterns are 2D by default, but can be made 3D very easily. Once you have a 3D 

pattern family, you simply load it into the massing family, and it will be available in the 

Type Selector when you select any divided surface. Keep in mind that a surface has four 

levels of representation: the original surface, the UV division of the surface, a pattern that 

is “stitched” onto the UV division, and components that can fill in a pattern. Figure 14.39 

shows the progression, from left to right. The most important thing to keep in mind is 

that a pattern is always made of straight segments that span from node to node along a 

surface — it is not made of segments that follow the curvature of a surface. This fact is 

important, as this is what truly makes a surface rational, and eventually buildable. Once 

you load a mass with curtain panels into a project, you will be able to schedule the panels 

as curtain panels, to get accurate counts of the panels.

Figure 14.37

Use the Options bar 
to change how the 
U and V division is 
computed

Figure 14.38

Use the patterns in 
the Type Selector 
to create some 
interesting surface 
rationalizations
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Applying Building Elements to the Massing Form
Once you’ve made your form, you can start to skin it with Revit elements. With the Model 

by Face tools, you can use the mass as a basis for actual building elements and move to the 

next stage of design development. The tools for placing mass floors, roofs, curtain systems, 

walls, and floors are in the Model by Face drop-down on the Conceptual Mass panel on 

the Massing & Site tab (Figure 14.40)

Mass Floors
The tool for slicing masses into horizontal planes for floor area analysis is the Mass 

Floors tool, which is available when you select a mass instance in the project environ-

ment (Figure 14.41).

Depending on the type of building you’re making, the code regulations, and the build-

ing’s functional usage, you may be ready to begin to lay out levels for the building. Imagine 

the maximum allowed regulated height for your building is 70′ (22 m), and your building 

is a hotel, which will usually have a 10′ (3 m) floor-to-floor height. In that case, you can 

get approximately seven levels.

Switching to any elevation view, and using the Level tool, you can start adding levels 

to your project. Once you have established the number of levels your building will have, 

select the mass and click the Mass Floor button on the Modify Mass tab. (Note that mass 

floors are applied on a per-instance basis.) When you click the Mass Floor button, a dia-

log box will appear with a list of all available levels in the project. Clicking the levels will 

apply a mass floor to each level, which can then be calculated for area. Figure 14.42 shows 

mass floors applied to only one mass: the main building. 

The slicing of masses done by the Mass Floors tool doesn’t just visually help you under-

stand the number of floors and divisions — it also provides numerical information essen-

tial for early conceptual analysis. With the help of this tool, you can find out the following:

Floor area•	

Exterior surface area•	

Floor perimeter•	

Floor volume •	

Usage•	

Figure 14.39

From left to right: 
original surface, 
divided surface, 

patterned surface, 
patterned surface 

with component

Figure 14.40

The Model by Face 
tools

Figure 14.41

The Mass Floor 
tool appears when 

you select a mass 
instance
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This data can help you easily create a conceptual analysis and vali-

date the program fit. By using Revit’s scheduling, sorting, and fil-

tering tools, you can find out the exterior skin material for each 

use on each floor and calculate its percentage against the entire 

exterior surface of the building. You can do similar calculations 

for the floor area to determine the total use of various functions 

and their percentage of the total usable area of the building.

Verifying Your Design and 
Validating Its Program Fit 
You can schedule the parameters and values of the 

masses as you can any other Revit element. In the 

earliest phase of the project, you’ll probably want to 

schedule the functional zones. To create an under-

standable schedule, it’s a good idea to give the mass elements you created names accord-

ing to their function — Hotel, Conference Hall, Parking, Restaurants, and so on — and 

assign them different colors (materials) so it’s easy to visually represent the data. If you 

need to rename the mass element once it is created, you can do that from the Project 

Browser — find the mass element in question and rename it using the right-click menu. 

You can also add project parameters to the mass elements, such as Public or Private Space, 

Department, and so on. If you wish to tag those new parameters so that they are shown 

in the mass tag, you must make them shared parameters and add them to the Massing 

Tag family. Out of the box, the Massing category in Revit can report the following 

numeric properties:

Gross floor area•	

Gross surface•	

Gross volume•	

If you create an initial mass study and schedule the mass elements, 

the schedule reports gross surface and gross volume of the entire shape, 

as shown in Figure 14.43. Note that the gross floor area is blank. The 

reason for that is that you can’t schedule the gross floor area without 

first adding levels and creating mass floors, as explained at the begin-

ning of the chapter.

When you define levels and create floor area faces using the Mass 

Floor tool, the floor area slices will show in the mass and the missing 

information about the gross floor 

area will be automatically filled in 

the schedule (Figure 14.44). 

Figure 14.42

The Mass Floors tool 
applied to one of 
the masses
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Figure 14.43

Example of a mass 
element without 
mass floors applied 
(no floor area faces 
generated as of yet)
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The gross floor area of the mass is the 

sum of all the mass floor slices belonging 

to that one mass element. Periodically, 

you need to get separate data about the 

floor area per floor, sorted and grouped 

by use or function. This is possible by 

creating a schedule for the Mass Floor 

category (Figure 14.45).

The reported values are useful for 

further conceptual analysis: you can 

apply different cost factors for different 

exterior skins. For example, you can get 

a good idea about how much more 

expensive it would be to make the last 

five floors of your building glass skin 

versus having them all be solid walls.

After you’ve reviewed a couple of 

design options with the client, a decision 

is made and you need to get started on 

the real project. Moving to the next stage is simple, because you can convert the mass into 

building components using specially designed tools. Let’s look at these tools now.

Model by Face: Walls

You can start using the mass to generate real building elements such as a wall. For that 

you will use the Model by Face ➔ Wall tool on the Massing & Site tab. Note that you can 

Figure 14.44

The mass is sliced 
into floor area faces 

and the gross floor 
area is filled in

Figure 14.45

Scheduling new 
parameters can help 

you make a more 
accurate conceptual 

analysis about the 
use of space and 

materials

only create walls by face on vertical and inclined faces or arc faces 

of a mass. Walls cannot be applied to horizontal faces. Use 

Exterior Face if you modeled the massing to the exterior envelope 

of construction. Keep these limitations in mind:

Any wall in Revit can be converted into a curtain wall. •	

Unfortunately, this isn’t the case with walls created with the 

Wall by Face option. To make curtain walls, you need to use 

the Curtain System tool in the Model by Face drop-down list.

You can’t edit the profile of a wall by face (using the Edit Pro-•	

file tool available to standard walls) — meaning you will not 

be able to freely carve out shapes from a wall. To do that, you 

must change the shape of the underlying mass first.
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Model by Face: Floors

Once you have applied mass floors to a massing, you can apply real floor elements. 

Choose Model by Face ➔ Floor and start selecting the Mass floor area faces to which you 

want to assign a floor. To create the floors, you will need to click the Create Floors button 

in the Ribbon, or nothing will happen.

To accommodate floor creation in a tower with many floors, for example, you can 

check the Select Multiple option on the Options bar. You can then begin selecting all the 

floor area faces to which you wish to apply floors and finish with the Create Floors tool.

The Mass Floor tool slices the mass horizontally, creating horizontal floor plates by 

default. 

Model by Face: Roofs

Roofs follow the same creation principles, in that once a roof is created using the Model 

by Face: Roof method, you can’t edit its sketch to change its shape in plan. If you created 

a roof by face and need to change its sketch, you must change the shape of the underlying 

mass from which the roof has been derived.

Model by Face: Curtain System 

Curtain systems are a handy tool for dividing a façade into regular intervals of panels and 

mullions. With one click, you can convert the face of a mass into a curtain system with 

predefined parameters to match your needs. Curtain systems can be applied to any face 

and are composed of grids, panels, and mullions. Make sure the curtain system type you 

choose has a predefined Curtain Grid layout. Figure 14.46 shows a massing model with 

wall, roofs, curtain system, and floors applied directly to massing faces.

Figure 14.46

Massing study 
with Revit building 
components 
applied to surfaces 
of the mass
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Tips and Troubleshooting

C hap te r 15

This chapter provides  tips and tricksabout how to keep your 

Revit project file running smoothly. Listed here are some pointers to keep you from 

getting into trouble, along with some solutions in case you do. Topics we’ll cover 

include:

Optimizing performance■■

Using best practices■■

Dealing with file corruption■■

Getting started in Revit■■

Finding additional resources■■
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Optimizing Performance
It should make sense that a small file on a good network runs the quickest. “Typical” 

file sizes can vary widely. We’ve seen file sizes that range from 30 MB to 200 MB. Much 

of that variation depends on the level of detail you’ve put into your model, the presence 

of imported files (like other 3D files or CAD files), and the overall complexity of your 

model. Your hardware configuration is also a factor. There are a number of things you 

can do to be proactive about keeping your model performance optimized. Here are a 

few we recommend:

Use the 3 GB switch.  ​Revit now supports Microsoft XP’s 3 GB switch. Use of this setting 

will give your machine more RAM to draw from before it goes to virtual memory. 

Windows XP allows any given application access to only 2 GB of RAM at a given time; if 

the application needs more, it gets the rest from virtual memory. Microsoft’s switch (which 

is available in XP Service Pack 2) allows you to change that 2 GB limit to 3 GB. To find 

out how to do this, visit www.autodesk.com/support, choose Revit Architecture from the 

menu, and read the support article on enabling ‘The 3 GB switch and Revit’. Of course, 

you need more than 2 GB of RAM in your workstation for this switch to do you any good.

More information on RAM and virtual memory can be found at the Autodesk knowl-

edge website. Visit this site for details: http://usa.autodesk.com/adsk/servlet/ps/item? 

siteID=123112&id=8018971&linkID=9243099.

As another option, Revit supports 64-bit operating systems like Windows XP 64-bit and 

Windows Vista. This allows you to tap into even more RAM and go well beyond 3 GB. 

Don’t explode imported CAD files.  ​A CAD file imported into Revit is a collection of objects 

that is managed as a single entity. If you explode a CAD file, the single object immediately 

becomes many — and becomes that much more data that Revit needs to track and coor-

dinate. If you’re unfortunate enough to explode a hatch pattern, one object becomes many 

thousands. If you’re importing DWG files, leave them unexploded as much as possible. If 

you need to hide lines, use the Visibility/Graphic Overrides dialog box to turn layers on 

and off. Explode only when you need to change the imported geometry, and start with a 

partial explode. Figure 15.1 shows the tools available in the Options bar when you select 

an imported or linked DWG file. Also note that lines smaller than 1/32″ are not retained 

with CAD files that are exploded. This can result in unusable imports.

Another option is to change the DWG file directly in CAD by deleting lines and layers 

you don’t need, then reimporting the file into Revit.

As a final option, if you feel like you need to edit the linework in Revit directly, import 

your CAD file into a 2D Detail Component family, edit the linework there, and import 

that Detail Component into your project file. This is a great way to keep the CAD file 

editable but also keep the number of objects in your project file minimized.

Figure 15.1

Import and  
explode options
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Delete or unload unused DWGs.  ​Often, you import a DWG as a reference, but then you don’t 

need it later in the project lifecycle. It’s easy to forget, but if you no longer need an import, 

go ahead and delete it by selecting it in the view, right-clicking it, choosing Select All 

Instances from the context menu, and deleting it. This will delete the import in all views.

Close unused views.  ​Keeping the number of open views to a 

minimum helps the model’s performance. Choose Close 

Hidden Windows from the View ribbon often (Figure 15.2), 

because it’s easy to have many views open at once, even if 

you’re concentrating on only a few views. Once you reduce 

your open views to just two or three, you can take advantage of the view switch toggle: 

press Ctrl+Tab, and you’ll cycle through your open views. Press Ctrl+Shift+Tab to reverse 

the view cycle.

Turn on volume computation only when necessary.  ​You can turn on room volume calcula-

tion by choosing Area and Volume Computations from the Room flyout on the Home 

ribbon. Check Areas and Volumes under Volume Computations (shown in Figure 15.3) 

only if you need room tags or a schedule to display vol-

umetric information. Don’t forget to switch off this 

option after you print or view the information. 

Otherwise, the volumes will recalculate each time you 

edit something in the model, and this can affect the 

overall performance of your file dramatically.

Using Best Practices
The following best practices will not only help you 

keep your project files running smoothly but will 

also keep frustration levels with poorly performing 

files low.

Workshared files: Make a new local copy once a week.  ​

Sometimes in a workshared environment, your local 

copy can begin to perform poorly but others on your team don’t share the same prob-

lems. If this is the case, we recommend that you make a new local file. Local files can 

become problematic because of any of the things that commonly cause issues with large 

files in a networked environment. As a general practice, it’s a good idea to make a new 

local copy once a week.

Use graphics card options to improve drawing performance.  ​In the Application Menu ➔ 

Options ➔ Graphics tab make sure you have both Use OpenGL Hardware Acceleration 

and Use Overlay Planes to Improve Display Performance checked (Figure 15.4). Deselecting 

the overlay planes check box can cause significant degradation in performance — we recom-

mend you never deselect this option.

Figure 15.2

Close hidden 
windows that 
you're not using

Figure 15.3

Do not compute 
room volumes 
unless neccessary
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Import or link DWGs in one view only.  ​Importing in all views can seri-

ously affect performance. Figure 15.5 shows the Link (Instead of 

Import) check box in the Import or Link dialog box. Linking is better 

than importing if you don’t need to edit the geometry.

Watch out for imported geometry.  ​Although 

Revit has the ability to import files from a 

number of other sources, you should exercise 

caution when doing so. If you’re importing a 

60 MB NURBS-based Rhino file into your 

model, expect your Revit model to grow in 

size and react a bit slower than it did before 

the import. Delete unneeded imports or convert them to Revit con-

tent to reduce file size and improve overall performance.

Purge unused elements.  ​Revit has a built-in tool that allows you to 

purge unused families and content. This is a good way to reduce file 

size, improve performance, and minimize the list of things you need to search through 

when adding content in the project. Loaded but unused families can make your file grow 

quickly. To purge, choose Purge Unused from the Manage tab. If your file is very large, it 

may take a few minutes to run this command before you see the dialog box shown in 

Figure 15.6. Here, you can opt to keep or purge families individually.

This is typically not a good idea at the beginning of a project, because your template 

may contain families that you intend to use but haven’t yet inserted (such as wall types).

Manage the amount of information shown in views.  ​Learn to manage the amount of infor-

mation needed in your views. Don’t show more than you need to show in a view either in 

depth or in your level of detail. Here are a few easy ways to keep your 

views opening and printing smoothly:

Minimize the level of detail.  ​Set your detail level (in the View 

Control bar) relative to the scale you’re viewing. For example, if 

you’re working on a 1/32″ (1:50) plan, you probably don’t need 

Detail Level set to Fine — it will cause your view performance to 

suffer needlessly.

Minimize view detail.  ​This goes along with the level of detail, but 

this tip is more user based than tool based. If you’re printing a 
1/32″ (1:50) drawing, make sure you’re showing the proper level 

of detail in the view. Even if Detail Level is set to Coarse, do you 

really need to show balusters in an elevation on your railing at 

that scale? They will print as a thick, black line. Turning them off 

in this view will help improve not only your printing speed but 

also the quality of the resulting printed sheet

Figure 15.4

Enable video card 
options for better 

performance

Figure 15.5

Import into one view

Figure 15.6

Use the Purge 
Unused dialog box 

to reduce file size
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Using Purge to Reduce File Size

Some Revit families can only be removed from the project with the Purge command. You will 

notice with elements such as dimensions and text notes, there is no way to delete a family 

type from the Properties dialog box. To get rid of unused elements of these types, use Purge 

Unused. Everything included in the Other Styles group falls into this category.

Minimize view detail in component families. ​

Along these lines, make sure that compo-

nent families only display what needs to 

be shown with regard to orientation. 

Minimizing detail is a practice that will 

result in good performance through 

many aspects of Revit. When creating 

families, use the view levels to control the 

amount of detail you can see in a family.

Minimize view depth.  ​View depth is a 

great tool to enhance performance. It’s 

especially valuable in section views. A 

typical building section is shown in 

Figure 15.7. The default behavior causes 

Revit to regenerate all of the model geom-

etry the full depth of that view every time 

you open the view. To reduce the amount 

of geometry that needs to be redrawn, 

drag the section’s far clip plane (the green 

dashed line when you highlight the sec-

tion) in close to the cutting plane.

Turn off shadows.   ​Shadows can help you make 

beautiful presentations, give a sense of depth in 

façades, and show the effect of the sun in a site 

plan view; however, shadows are performance 

intensive and can significantly slow a view’s time to open, print, or regenerate as you pan 

and move around in it. Make sure you turn off shadows whenever you don’t need them.

Open only what you need.  ​One of the benefits of having worksets is that you don’t have to 

turn them all on at once. When you open the project, go to the Workset dialog box. There, 

you can highlight a workset and click the Close button (see Figure 15.8). Doing so drops 

that workset from active memory and gives you better performance. Remember, if worksets 

are closed, you can’t do anything with them. If a workset isn’t visible, it won’t print. To 

print a current copy of the whole model, you’ll need to turn the worksets back on.

Figure 15.7

Minimize the sec-
tion's Far Clip Offset
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U s i n g Le v e l o f D e tai l to S pe e d U p V i e w Pe r fo r m an c e

One project was taking upward of 20 minutes to open plan views. As you can imagine, this 

was very frustrating for the users, especially when they opened those views accidentally. 

As it turned out, the views were set to a 1⁄16″ scale and a fine level of detail. For many of the 

elements in the plan, none of them showed any significant information at this level of detail. 

By setting View Detail to Coarse, they were able to reduce the time to open those views to 

under two minutes. We further optimized view performance by modifying complex families 

in the view to show less detail at a coarse level.

Break up your model.  ​For larger projects, or campus-style projects, you can break up 

your model into smaller submodels that are referenced together. You can also do this on a 

single building. If you decide to divide your project, make your cuts along lines that make 

sense from a holistic-building standpoint. Don’t think of the cuts as you would in CAD, 

but think about how the actual assemblies will interact in the building. As an example, 

don’t cut between floors 2 and 3 on a multistory building unless you have a significant 

change in building form or program. Here’s a list of some good places to split a model. 

See Figure 15.9 for an example:

At a significant change in building form or massing•	

At a significant change in building program•	

Between separate buildings on the site•	

At the building site•	

Consider printing paper sheets from DWFs or PDFs.  ​Printing big Revit files can sometimes 

take a long time. Enabling raster printing speeds up printing, although there is a trade-off 

compared to the quality that vector printing offers. Depending on the printer, you may 

Figure 15.8

Worksets can be 
closed to reduce the 
amount of memory 

used to open a file
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get better line quality by going to a DWF or PDF first, then printing your physical sheets. 

Experiment on a few sheets to see what your printer responds to best before sending your 

entire set. Printing a digital set first will also give you a record copy of what you have just 

printed as well as a quick way to make additional copies later if needed.

Model just what you need.  ​Don’t fall into the trap of overmodeling. Just because you can 

doesn’t mean you should. Be smart about the level of detail you choose to model based on 

the complexity and size of your project. Some data is just easier and better to show in a 

2D detail rather than as 3D model data. The amount of information you model or do not 

model should be based on your project size and complexity, your time frame, and your 

comfort level with the software.

Ask yourself three simple questions when detailing.  ​Many people who understand the 

principles of modeling in Revit struggle with the changes in methodology when actually 

creating a set of construction documents. When moving from modeling to detailing, you 

will find that you are creating and modifying families to add details specific to the current 

state of the design. When doing this, it always begs the question, “How much do I model?” 

As a rule of thumb, here are three simple questions to help you make the right decision:

Scale: •	 What scale will this detail be seen in? If it’s a very small-scale detail, it might be 

simpler to just draft it in a drafting view.

Repetition: •	 How many times will this detail appear in the drawing set? If it will appear 

only in one location, it might be easier again to just draft it in 2D rather than try to 

model the element. If it will appear in several locations, modeling is probably the 

better solution.

Quality: •	 How good at modeling families in Revit are you? Don’t bite off more than you 

can chew. If you’re new to Revit, keep it simple and use 2D components. The more 

projects you complete in Revit, the better you’ll begin to understand the change to a 

BIM workflow.

Figure 15.9

Splitting up a 
model can improve 
performance
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Don’t overconstrain.  ​User-defined relationships and constraints are important to embed 

in the design to help keep important dimensions constant. However, if you don’t need to 

lock a relationship, don’t. Even though the option to lock all alignments is available, it’s 

often not necessary to do so. Overconstraining the model can cause problems later in the 

project process when you want to move or modify an element and you need to figure out 

(or remember) what you locked and where to allow the particular element to be moved or 

modified.

Assign proper view detail.  ​It is possible to create families in Revit with a seemingly infinite 

amount of detail. Use the Visibility tool found in the Family Editor to set the appropriate 

level of detail for when the element is viewed in plan, elevation, or section. Setting elements 

to Coarse, Medium, or Fine can also keep your families from looking like blobs in Coarse 

view and small scales as well as quicken your screen-refresh times.

Fix an overconstrained object.  ​If you keep encountering a dialog box telling you the model 

is overconstrained and this is impeding your workflow, you can delete the constraint. If 

it is a simple element (such as a wall with no openings or sections), it might be easier to 

simply delete and redo the troubled object.

Close Revit with an empty view.  ​To avoid long opening times for really large files, establish 

an office standard that you always close your last view as a drafting view or legend that is 

empty, or maybe contains only some text with the project name. This way, when Revit first 

opens the project it will need much less processing time. By default, Revit always opens 

with the view from when the project was last saved. We’ve seen some nice-looking “proj-

ect pages” made with a drafting view using text and some simple instructions.

Upgrade to new versions.  ​Many CAD workflows required you to use the same version  

of CAD over the lifecycle of the project. So, a project started in CAD 2000 would stay in 

CAD 2000. With each new release of Revit, many changes have been put in place to make 

large files easier to manage, to make saving faster, and to improve overall performance. 

Dealing with File Corruption
If your file becomes corrupted and begins to crash frequently, there are a few things you 

can do to help fix the problem before you call Revit Support in a panic. To proactively 

avoid this issue, focus on the previous tips before you begin having problems. Otherwise, 

here are some suggestions on what to do when you get into trouble:

Audit the file.  ​Auditing the file will review the data structures and correct problems that are 

found within the model. An audited file won’t look any different when the audit is com-

pleted; however, it should (ideally) not crash. This is not a cure-all, by any means, but it 

can help you get out of a tight spot when necessary.
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Get everyone out of any worksets 

and local files, and have them relin-

quish their permissions. Open the 

file using application button ➔ Open. 

The resulting Open dialog box lets 

you browse to a project location. 

Select your project and before click-

ing the Open button to open the file, 

select the Audit check box in the 

lower-right corner (shown in 

Figure 15.10). Revit gives you a 

warning before performing an audit 

on your file. The audit itself can take 

several minutes to complete. When 

this process is finished, save the project with a new name or in a new file location; don’t 

save this file over the old Revit file. Saving over an existing Revit file can sometimes lead 

to instability. When you’re finished, have everyone make a new local file, and you can get 

back to work.

Review warnings.  ​Each time you create something that Revit considers a problem, a 

warning is issued. Warnings will accumulate if left unresolved. Think of all these errors 

as unresolved calculations. The more there are, the more your computer will have to 

struggle to resolve them, and eventually you will have performance issues or file instabil-

ity. Revit provides an interface where you can review all the warnings in the project and 

fix problems.

Try to read and react to all warnings that Revit sends. You don’t have to do it when 

you’re under a tight deadline or when doing so will interrupt your work. But once a week, 

you should spend 30 minutes reviewing 

the warnings, as this can improve your 

model’s overall performance. You can find 

the list of warnings in your file on the 

Manage tab ➔ Review Warnings 

(Figure 15.11). 

Purge unused elements.  ​We referred to 

this earlier in the “Best Practices” section. 

Purge can also be used to get rid of poorly 

built families that might be wreaking 

havoc in your file.

Figure 15.11

Review the warnings 
in this dialog box

Don’t overconstrain.  ​User-defined relationships and constraints are important to embed 

in the design to help keep important dimensions constant. However, if you don’t need to 

lock a relationship, don’t. Even though the option to lock all alignments is available, it’s 

often not necessary to do so. Overconstraining the model can cause problems later in the 

project process when you want to move or modify an element and you need to figure out 

(or remember) what you locked and where to allow the particular element to be moved or 

modified.

Assign proper view detail.  ​It is possible to create families in Revit with a seemingly infinite 

amount of detail. Use the Visibility tool found in the Family Editor to set the appropriate 

level of detail for when the element is viewed in plan, elevation, or section. Setting elements 

to Coarse, Medium, or Fine can also keep your families from looking like blobs in Coarse 

view and small scales as well as quicken your screen-refresh times.

Fix an overconstrained object.  ​If you keep encountering a dialog box telling you the model 

is overconstrained and this is impeding your workflow, you can delete the constraint. If 

it is a simple element (such as a wall with no openings or sections), it might be easier to 

simply delete and redo the troubled object.

Close Revit with an empty view.  ​To avoid long opening times for really large files, establish 

an office standard that you always close your last view as a drafting view or legend that is 

empty, or maybe contains only some text with the project name. This way, when Revit first 

opens the project it will need much less processing time. By default, Revit always opens 

with the view from when the project was last saved. We’ve seen some nice-looking “proj-

ect pages” made with a drafting view using text and some simple instructions.

Upgrade to new versions.  ​Many CAD workflows required you to use the same version  

of CAD over the lifecycle of the project. So, a project started in CAD 2000 would stay in 

CAD 2000. With each new release of Revit, many changes have been put in place to make 

large files easier to manage, to make saving faster, and to improve overall performance. 

Dealing with File Corruption
If your file becomes corrupted and begins to crash frequently, there are a few things you 

can do to help fix the problem before you call Revit Support in a panic. To proactively 

avoid this issue, focus on the previous tips before you begin having problems. Otherwise, 

here are some suggestions on what to do when you get into trouble:

Audit the file.  ​Auditing the file will review the data structures and correct problems that are 

found within the model. An audited file won’t look any different when the audit is com-

pleted; however, it should (ideally) not crash. This is not a cure-all, by any means, but it 

can help you get out of a tight spot when necessary.

Figure 15.10

The Audit option is 
located in the Open 
dialog box
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Getting Started in Revit
Knowing how and where to begin your journey can be a challenge, and we want to give 

you a few pointers to help you get started. Although this list isn’t complete by any means, 

it should help steer you in the right direction:

Begin with the end in mind.   ​Planning is always a good way to start a project. Regardless of 

your project, when working with Revit it’s always harder to go back and modify the model 

to fit a new goal than to build to suit the goal along the way. You can set yourself up for a 

successful implementation from the beginning by using a bit of forethought about your 

process, workflow, and desired outcome. If you are using Revit for the first time, set some 

reasonable limits for how far you plan to take the modeling and detail process. This will 

help guide the development of families along the way. If you are trying to push into some 

higher-level BIM challenges like 4D, costing, or energy modeling using Revit model geom-

etry, set those goals at the beginning of the project process as each will require you to focus 

on aspects of the BIM model you might not have typically considered. 

Get your project and office standards in place early.   ​As design professionals, we have a 

tendency to develop unique graphic conventions and styles for our documents. This is a 

specific area where good planning leads to a good project. If possible, get your standards 

in place before you begin a project. Revit does an excellent job of getting you started with 

a good template of graphic standards to work with. However, if you’re like most architects, 

an application right out of the box is never quite nice enough. Revit provides a good 

starting point for customization, and with some up-front time, you soon can have your 

project and office standards up and running. Once you nail down your standards, they 

can be easily applied to your project using Transfer Project Standards.

Remember that the first project you do in Revit will require a change in methodology.   ​

You’re leveraging technology to help you change the way you approach design and docu-

mentation. Don’t expect the process to have the same workflow as it did in a CAD-based 

system. Try to stay flexible in your expectations and schedule and allow yourself time to 

adapt to the change.

Don’t try to conquer the world on the first project.   ​There are many advantages to using 

BIM as a design and documentation methodology. As this process becomes more main-

stream within the industry, those benefits will only increase. All of these things and more 

are possible with the use of Revit, but it will take a couple of projects to get there. Tailor 

the use of BIM to the project, and use the features that will maximize the benefits of using 

BIM. Choose your goals realistically based on the expertise of your project team, and plan 

ahead so those goals can be met successfully. Consider a project that is less complex for 

your initial pilot. 
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Le ar n i n g a M o d e li n g Wo r k f low

One of the most important rules to follow as you begin your project is to model the build-

ing as it will be built. That said, keep in mind that you do not need to model every condition 

three-dimensionally. Use Revit to get the essential dimensions and building form coordi-

nated. You can then embellish the model with 2D details to convey the fine grain.

Model correctly from the beginning.   ​We can’t stress this enough. As you refine your design, 

it’s critical to model correctly right from the beginning, so you don’t have to fix things later. 

What does this mean? As an example, think of a wall. Does it sit on the floor, or does the 

floor attach to the wall? If you can begin to think about how your project will be assem-

bled, it will save you a lot of time at the end. It’s good practice to plan ahead, but remem-

ber that Revit will allow you to make major changes at any stage in the process and still 

maintain coordination. If you are still in the early phase of design and do not know the 

exact wall type, use generic walls to capture your design intent; changing these later will 

be simple.

Get information into the project as soon as it is known.   ​A key advantage of using Revit is 

the ability to change your project schedule. In a traditional design process, most of the 

effort on a project is realized during the construction-document phase. At that time, a 

typical project has the most staff working on the project, and it can be fairly difficult to 

implement major changes to the project design. This is due to the complexity of the doc-

uments by this time and the amount of effort for the team to redraw all the changed 

information. You’ll find that with Revit, design change is largely managed by the software 

itself. This gives you a great deal of flexibility in both your design and documentation. Take 

advantage of this shift in the process, and add information to your model early. It can be 

in the form of more detailed content or showing the material construction of your wall 

system. Remember that you can change all this information much more quickly and eas-

ily than you ever could in CAD, so don’t assume you’re locked into the information you 

displayed early in the design process.

Plan for good communication among team members early in the process.   ​Communication 

within a team is critical for understanding a project and documenting it successfully. One 

of the downfalls inherent in a CAD-based system is that there is no connection among the 

different files that make up the drawing set. This phenomenon carries through to the 

project team and is a function of project workflow and project management. In CAD, it’s 

possible for team members to work in some degree of isolation. They aren’t forced to 

immediately reconcile their changes with changes made by their teammates. Revit’s 

single-file environment forces a much higher degree of team communication between not 

only the architects but also your structural and mechanical engineers.
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Don’t try to model everything.   ​Most of us have drafted in a 2D environment until now. 

Moving to a 3D world is a significant change. Do you have to model every single screw? 

Every mullion? Every stud? That’s a good question. The simple answer is no, you don’t 

have to, and in fact you should not attempt to do so. Like any BIM system, Revit isn’t 100 

percent 3D information. Standard computer workstations aren’t capable of handling all 

the data of a building in model form. Additionally, few projects have the time in their 

schedule to model the screws in a sheet of gypsum board or the sealant around all the 

windows; some of that information is best presented in 2D or in the specifications. This 

still leaves you with a wide range of options for modeling. In the beginning, err on the side 

of simplicity. It’s far easier to add complexity to your model later on as you gain experi-

ence and confidence than it is to troubleshoot overconstrained parameters early in the 

process. Start with the big ideas: walls, openings, roofs, and so forth. Work your way 

down to a comfortable level of detail for both you and your computer.

Organize your team.   ​A BIM project team includes three basic technical roles. These roles 

are interchangeable, especially on smaller projects with fewer team members. However 

small the team, it’s useful to make sure all these roles are filled:

Building designer  ​This is the person or team whose primary responsibility is to fig-

ure out what the project will look like and how it will be made. They create walls, 

floors, and roofs, and locate windows, doors, and other building elements.

Content/family creator  ​The family creator’s primary role is to create the parametric 

content in the Revit model. This is typically someone with 3D experience who also 

has a firm understanding of Revit and Revit families. The families, as you’ll see later, 

have parameters that can control visibility, size, color, proportion, and a number of 

other things.

Documenter  ​This role supplies the bulk of the documentation. It consists of drafting 

some of the 2D line work over portions of the 3D model to show detail, adding anno-

tations and keynotes, and creating details.

Finding Additional Resources
If you get stuck along the way, don’t assume you’re alone. There are myriad resources in 

the help file, in books, or on the Web to help you find a specific solution to your problem. 

Chances are, someone has tried the same thing before. In our digital age, a wealth of 

information is available online; powerful communities of passionate users are out there 

willing to help. So before you spend hours trying to work through a particular problem 

on your own, try tapping some of the existing resources:

Revit Help menu  ​Your first stop, if or when you get stuck, should be the Revit Help menu. 

It’s one of the easier and more robust help menus out there, and it can give you a lot of 
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useful information very quickly. It’s also the most accessible help source. As with most 

applications, it’s at the far right of the menu bar.

Subscription Support  ​If you have bought Revit on subscription, Revit Subscription Support 

offers an exemplary web-based support system. Their responses are speedy, and their advice 

is top-notch. If you need information more quickly, Revit also has an online knowledge 

base of FAQs that is available without a subscription. Both of these resources can be 

accessed at www.autodesk.com/revit.

AUGI  ​Autodesk User Group International (AUGI) is also an excellent source for tips and 

tricks. It’s an online user community free to participate in, ask questions, get answers, and 

share families and examples. To get the benefit of this fantastic online resource, go to 

www.augi.com and look for Revit Architecture as a product. If you’ve never logged in, you 

will have to register once; from then on it’s easy! 

Revit City  ​Looking for content and families? Revit City, another free online service, has a 

growing database of free families posted by other users. Its address is www.revitcity.com.

Autodesk Discussion Groups  ​These pages offer insightful discussions and some great 

Q&A threads: http://discussion.autodesk.com/.

AECbytes  ​This website is dedicated to following and reporting on the trends in the AEC 

industry, with a strong focus on BIM, technology, and the direction of the industry — put 

together by Lachmi Khemlani: www.aecbytes.com.

Blogs  ​There are numerous blogs from passionate, experienced Revit aficionados. Here 

are some of them in no particular order:

http://revit4you.blogspot.com  (Philippe Drouant [French])

http://insidethefactory.typepad.com  (Tom Vollaro, Revit Product Designers)

http://revitoped.blogspot.com  (Steve Stafford)

http://revitnorge.blogspot.com  (Håvard Vasshaug [English and Norwegian])

http://designreform.net  (Dave Fano)

http://www.allthingsbim.blogspot.com  (James Vandezande)

http://architechure.blogspot.com  (Phil Read)

http://irevit.blogspot.com  (Craig Barbieri)

http://dorevit.blogspot.com  (Robert Manna)

http://do-u-revit.blogspot.com  (David Baldacchino)

http://malleristicrevitation.blogspot.com  (Aaron Maller)

http://www.bimx.blogspot.com  (Laura Handler)

http://www.revitbeginners.blogspot.com  (Bradley Hartnagle)

73559c15.indd   461 6/2/09   1:56:58 PM



462  ■   Chapter 15 : Tips and Troubleshooting

http://revitbeginners.blogspot.com  (David Duarte)

http://www.revitcoaster.blogspot.com  (Troy Gates)

http://revitit.blogspot.com  (Daniel Hurtubise)

http://revitrocks.blogspot.com  (Daryl Gregoire)

http://www.revitfamilies.blogspot.com  (Shaun Van Rooyen)

http://www.revit-alize.blogspot.com  (Bruce Gow)

http://www.revitrants.blogspot.com  (Chris Price)

http://blog.reviteer.com  (Tom Dorner)

http://www.revitlution.blogspot.com  (Christopher Zoog)

http://www.revit-up.blogspot.com  (The PPI Group’s Revit evangelist)

http://www.greenrevit.blogspot.com  (Beau Turner and Bradley Hartnagle)

http://www.revitup.co.za  (Justin Taylor)

http://gmcdowelljr.wordpress.com  (Greg McDowell, Jr.)

http://www.autodesk-revit.blogspot.com  (David Light)

http://www.auservice-bim.blogspot.com  (Simone Cappochin [Italian])

http://www.cmotion.net/products/revit-tools.html  (Siggi Pfundt and Gotthard Lanz 

[German and Italian])
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#
? (question mark), for unidentified 

material, 351, 351
2D/3D extents icon, 100
2D boundary, to generate 3D floor, 

128
2D CAD files, converting to Revit 

model, 264, 264
2D Detail Component family, CAD 

file imported into, 450
2D drawings, converting to 3D 

model, 263–264
2D DWF file

exporting to, 397, 397
marking up from Revit model, 

400–401, 401
2D elements, 13
2D graphics, detail groups, 372
2D information, drafting views to 

display, 87
2D views

drafting views as, 369–370
floating palette for, 51, 51

3D DWG file
exporting to, 226, 398–399, 

398–399
marking up, 402, 402

3D elements, cut plane and, 83
3D model-based environment, early 

frustrations in using, 9
3D model, converting 2D drawing 

to, 263–264
3D solids, exporting, 239
3D views, 291, 291–292

adding walls to, 117
axonometric views, 89–90, 90
controlling extent, 49
navigating in, 52
perspective (camera) views, 91, 

91–92, 92
of stairs, 165, 165

3D Warehouse, 270

3ds Max, 8, 430
3GB switch, 450
64-bit operating systems, 450

A
accelerators. See keyboard shortcuts
Access, exporting files for, 232–233
Acquire Coordinates option, for link 

positioning, 245
active view, 38

closing, 77
exporting, 227

Add Point tool, 221
Add Split Line tool, 221
.adpx (Civil Design Package File), 

229
.adsk (Civil Design Exchange  

File), 229
Advanced Model Graphics icon, in 

View Control bar, 39
AECbytes, 21, 461
AIA layering schema, export list 

linked to, 239
Alias Studio (Autodesk), 8
Align tool, 120, 177, 177–178

for stairs, 163, 163
aligned dimensions, 332
Alt key, for Keytips, 32, 32
American Institute of Architects 

(AIA), Integrated Practice and 
Technology in Practice sections, 302

angles, Revit automatic 
straightening of, 67

angular dimensions, 333
animation

of camera on path, 92
exporting, 232
for solar study, 290–291

Annotate tab in Revit Ribbon, 28, 28
Component tool, 373
Detail panel

Component tool, 89
Detail Group, 373
Insulation tool, 378
Region, Masking Region, 374

Dimension panel, Dimension 
tools, 332

Tag panel, 326, 327
Keynote tool, 345, 350, 351
Tag All tool, 329
Tag by Category, 329
View Reference tool, 323

Text panel, Text tool, 341
annotation crop, 47, 318, 319
Annotation Crop setting,  

for views, 306
annotations, 326

categories, 14
controlling display, 47, 47
crop, 47, 47
dimensions, 330, 330–340

adding to model, 332–333
baseline, 334, 334–335
examples, 331
for f loor plan, 339–340, 340
modifying appearance, 

337–339
ordinate, 337, 337

hiding, 286
keynotes, 340, 344, 344–353

adding to view, 347–348
adding to wall section by 

element, 351–352
adding to wall section by 

material, 350–351
behavior and editing, 

345–346
family, 349, 349–350
filenaming conventions, 346
legends, 348, 348–349
predefining, 352–353
settings for, 347

parametric relationships and, 11
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tags, 326, 326–329
changing value, 328–329
loading, 326
placing, 327–328

text, 340, 341–344
model text, 343, 343–344
properties, 341–343, 342

application frame
Info Center toolbar, 27, 27
overview, 25–30
Quick Access Toolbar, 26, 27
Ribbon, 27, 27–30
title bar, 26, 26

Application Menu (R), 25–26, 26
➔ Export

➔ DWF, 395, 396
➔ FBX, 292
➔ gbXML, 235
➔ Images and Animation ➔ 

Solar Study, 291
➔ Images and Animations ➔ 

Image, 230
➔ Images and Animations ➔ 

Walkthrough, 232
➔ ODBC Database, 233
➔ Reports ➔ Room Area 

Report, 234, 234
➔ Reports ➔ Schedules, 233

➔ Export Building Site 
 option, 228

➔ New
➔ Conceptual Mass, 431, 437
➔ Family, 18, 202, 216, 410
➔ Project, 73, 74, 438

➔ Options, 68, 155
➔ Graphics, 451, 452

➔ Print, 388
➔ Publish, ➔ DWF to Buzzsaw, 

227
➔ Save As

➔ Library ➔ View, 383
➔ Project, 426

Apply Dependent Views option, 322
Arc from Center and End Points  

tool, 371
arc length dimensions, 333
Arc Passing Through Three Points 

tool, 371
architect, vs. builder, 2

architectural classification system, 
BIM based on, 8–9

architectural documentation
history, 2–4
labels for. See tags

architectural scale, 314–315
ArchVision RPC (Rich 

Photorealistic Content) file, 295
arcs, drawing tools for, 103
Area and Volume Computations 

dialog box, 282, 451, 451
Area Schemes tab, 283, 283
Areas and Volumes option,  

283, 284
Computations tab, 283, 283

area boundaries, 283, 283
area (Gross Building) schedule, 94
area plans, 84, 276, 282–283
areas (Rentable) schedule, 94
array, 174–175
Array tool, 174
arrowhead styles for keynotes,  

351, 351
artificial lights, 295
Associated Level, for views, 306
associativity, bidirectional, 11
attributes, of blocks and layers in 

imported CAD file, 252
auditing, 456–457
AUGI (Autodesk User Group 

International), 21, 403, 461
Auto Dimension Options dialog  

box, 333
Auto placement options,  

for links, 244
autoalignment, 178
AutoCAD, default view  

background, 248
Autodesk, 4

online families, 155
Autodesk 3ds Max, 8, 292
Autodesk Alias Studio, 8
Autodesk Buzzsaw, publishing 

exported DWF files to, 227
Autodesk Design Review, 227, 396

marking up drawings with, 
400–401

Autodesk Discussion Groups, 21, 461
Autodesk Ecotect, 235
Autodesk exchange format, 226

Autodesk Green Building Studio, 235
Autodesk Knowledge Base, 395
Autodesk Maya, 8
Autodesk Seek website, 71, 155
Autodesk User Group International 

(AUGI), 21, 403, 461
.avi files, saving animations as, 229
axonometric views, 89–90, 90

of house, 90

B
background

for AutoCAD default view, 248
color fill in, 279, 279
for dimension text, 339
gradient, 288, 289
image in, 288
for rendering, 295–296
of text, 342, 342

Backspace key, 64
balusters of railing, 165, 165–166
baseline dimensions, 334, 334–335

changing to linear dimension, 336
creating style, 335–336
drag control for, 336

beams, and grids, 100
Bentley Systems, MicroStation, 227
best practices, 451–456
bidirectional annotation, dimension 

as, 330
bidirectional associativity, 11
BIM (building information 

modeling), 1
advantages, 4–5
benefits of massing tools, 430
vs. computer-aided design 

(CAD), 5–9
and documentation trends, 302
exporting data, 395, 395–403
potential hazards, 9
sharing model, 228–229
team collaboration, linking for, 

242–243
typical outputs, 7

blend technique, for twisted wall, 211
blocks, attributes in imported CAD 

file, 252
blogs, 21–22, 461–462
blue font, for editable text, 99

annotations (continued)
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blue grips, 56
to resize window, 154

.bmp file format
exporting view or sheet as, 230
importing and linking, 241

bold text, 342
for dimensions, 338

BOMA area, 282
bottom plane, 83, 84
boundary, 126
break controls, 99
browsable website, creating from 

Revit model, 230, 231
Brunelleschi, Filippo, 2
builder, vs. architect, 2
building code requirements, and 

stairs, 160
building designer in project team, 

20, 460
building elements, relationships 

between, 9
building information modeling 

(BIM). See BIM (building 
information modeling)

Building Owners and Managers 
Association standard, 282

Building Site Export Settings dialog 
box, 229, 229

butt join, 197
By Range option, for color scheme 

definition, 277, 278, 279
By Value option, for color scheme 

definition, 277, 278–279, 279

C
CAD (computer-aided design)

vs. BIM, 5–9
drafting views to import files, 88
exploding, performance  

impact, 450
file formats, 226–227

importing and linking,  
241–242, 245–248

modifying, 251–253
files as model details, 247
importing details, 382
layers, 16

management, 250
typical outputs, 6
views, 76

Calculated Value dialog box, 364, 364
Callout Detail tool, 88
callouts, 85

creating, 357, 357
camera

on path, animation of, 92
placing in view, 91

camera (perspective) views, 91,  
91–92, 92

“Can’t keep elements joined” error 
message, 130, 130

Cascade Views button, 37
cascaded views, 38
case sensitivity, of custom field 

formulas, 365
categories

unhiding, 189–192
view-specific settings, 16

ceiling plans, 83
ceilings, 104
center of rotation, repositioning, 173
Center Tick Mark field, 338
Center to Center option, for link 

positioning, 244
Center tool in 3D SteeringWheel, 52
Centerline Pattern field, 338
Centerline Symbol, 338
central file for worksharing, 424

saving, 426, 427
chained wall, 110
chair rails, 202
change

BIM management of, 7
propagating through views, 5, 7

Change Element Type button, 249
check box icons, 100
chimneys, creating opening for, 142
Circle tool, 371
circles, drawing tools for, 103
Circumscribed Polygon tool, 371
Civil Design Exchange File (.adsk), 229
Civil Design Package File (.adpx), 229
civil engineering DWG files, 253–262
cleanup of imported civil engineering 

data, 253
clerestory windows, 142

curtain walls, 143
clipboard, 170
clipping plane, 315
Close command, for elements, 67
closed shapes, 128

boundaries for, 126
cleanup, 131

closet walls, 118
closing

Revit, empty view before, 456
views, 77

Collaborate tab in Revit Ribbon, 29, 29
Synchronize panel, Reload  

Latest, 428
Worksharing tools, 424, 425

collaboration in BIM project team, 
linking for, 242–243

color
of dimension strings, 338
of text, 342

color-coded drawings, 276, 276–285
section views, 283–285

Color Fill Schemes tool, color 
assignment, 280

color-fill view, 281
color scheme, 276

adding to view, 280–281
defining, 277–281
for views, 305

Color Scheme Location,  
for views, 305

Color Schemes dialog box, 280
columns, and grids, 100
communication, among team 

members, 20, 459
Communication Center, in Info 

Center toolbar, 27
complex nested families, 418
complexity, or simplicity in modeling, 

20, 460
component families, 17–18,  

409–410, 411
examples, 410
minimizing view detail, 453

components, 106
importing

in DWG format, 269, 270
in SketchUp (.skp) format, 

270, 270
placing, 156–158

computer-aided design (CAD). See 
CAD (computer-aided design)

computer-based technology, 3
conceptual design tools, 430–436
ConDoc system, 309
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466  ■   connected walls – Design Web Format 

connected walls, Tab key to select, 
112, 112

Constrain option, for Move 
command, 172

constraints (locks), 13, 60
limiting use of, 456
locking, 149, 150, 151
Pin tool for setting, 60–62, 62
Shift key for constraining 

movement, 64
construction costs, 4
content/family creator in project 

team, 20, 460
context menu, 50

for dimensions, Flipped 
Dimension Direction, 335, 336

for elements, Override Graphics in 
View by Element, 187

for family, 35
opening, 50
of roof, Override Graphics in View 

by Element, 141
for ViewCube, 54
of views, View Properties, 183

Contextual tab in Revit ribbon, Paste 
Aligned options, 170–171

Coordinate System Basis option, 
settings for DWG export, 238

coordinate systems, civil engineers vs. 
architects, 253

coordinates, shared, 244–245
Copy option, for Move command, 172
Copy tool, 172–173
copying

with clipboard, 170
floors between levels, 128–131, 129
levels, 79

cornices, 202
corrupted files, 456–457
costs, comparing and estimating, 419
Count Selection tool, modifying and 

personalizing, 34, 34
counts, Revit auto-calculation of, 365
Create Floor Boundary tab in Revit 

Ribbon, 126
Create Form tool, 437
Create Similar command, 114
Create Stair Sketch mode, 160
Create tab in Revit Ribbon, 28, 28

Create tool, for special walls,  
209–211, 210, 211

crop boundaries, printing, 393
crop region, 319, 319, 359

modifying for view, 315, 316
rotating, 319, 320, 321
visibility, 320

Crop Region tool, 306
in View Control bar, 39, 44–45, 45

Crop Region Visible setting,  
for views, 306

Ctrl key, and selection, 64
currency, settings for, 65
Current View option

in Import and Link CAD Formats 
dialog boxes, 247

for Paste Aligned command, 
170–171

current window, printing, 389, 389
Cursor at Base Point option, for link 

placement, 245
Cursor at Center option, for link 

placement, 245
Cursor at Origin option, for link 

placement, 245
curtain grids, 212
curtain panels, 213, 216–217
Curtain Wall Panel.rft file, 216
curtain walls, 102, 103, 142–147, 

143–145, 147, 213
advanced design techniques, 

212–219
attaching to roof, 218, 218–219
complex panel possibilities, 219, 

219, 220
design, 214–216, 215
doors and windows in, 217
examples, 213
Model by Face tool for, 447
parametric behavior, 217–219
selecting elements within, 214
taxonomy, 212

custom content, creating, 406
custom fields, 365
customizing Quick Access Toolbar, 26
cut plane, 81, 82, 82

family categories not impacted, 85
cutting forms, 436, 436
cycling, Tab key for, 63

D
data-driven design tool, BIM as, 8
Data Exchange Format (DXF), 227

importing and linking, 241, 246
data, organization of, 13–16
datum (origin point), 337
default template, 73, 240
Default View Template field, for 

views, 306
Delete key, 64
Delete Layers tool, for imported  

file, 251
deleting

dimensions, warning when, 150
elevation tag, 87
views, 77

deliverable timetable, 302
dependent views, 314

converting to independent  
view, 324

duplicate as, 80, 316
project divided among, 319–322
setting for, 305

depth
of elevation, 86, 86–88
of section, and performance, 87

Depth Clipping setting, for views, 307
deselecting elements, 64
design

change in Revit, 459
layers of, 3
software management of  

changes, 19
three-dimensional visualization, 5
verifying and validating program 

fit, 445–447
design documents, as drawings, 2
Design Options dialog box,  

420–421, 421
Accept Primary button, 423
Make Primary button, 423

Design Options tool, 419, 419–423
interface, 420–423

creating elements for, 422–423
customizing views for, 421

Design Web Format (DWF)
exporting, 395, 395–402
printing, 454–455
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detail
duplicating view with, 80
levels of, 15
and performance, 452, 455
rotation for repeating detail, 377

detail components, 350, 350, 373
options, 41, 41
repeating detail, 375–377, 376
reusing from other projects, 

382–385
detail groups, 372–373
Detail Level icon, in View Control bar, 

39, 40, 40–41
Detail level of view, 304
Detail Lines tool, 375

vs. Model Line tool, 372
detail number, 313

for views, 304, 358
Detail View property, of views, 304
details, duplicating view with, 80
.dgn file format, 227

importing and linking, 241, 246
template for, 240

dialog launchers, 30
dimension line extension, setting for, 

338, 338
Dimension Line Snap Distance 

option, 338
Dimension String Type property, 335
Dimension Text dialog box, 331
dimensions, 330, 330–340, 334. See 

also temporary dimensions
adding to model, 332–333
baseline, 334, 334–335

creating style, 335–336
deleting, warning when, 150
examples, 331
for f loor plan, 339–340, 340
modifying appearance, 337–339
object manipulation using, 59, 

59–60
ordinate, 337, 337

creating style, 335–336
Disallow Join tool, 197
Discipline property, for views, 305
Disjoin option, for Move  

command, 172
Display Model property, of views, 304
Divide Surface tool, 442, 442

document delivery system, 5
documentation

formatting, 356–360
goal of good set, 309
sheet index to, 94
trends, 302

documenter in project team, 20, 460
door swing, 105
doors, 105, 148–152, 148–152

in curtain walls, 217
schedule creation, 95–96, 96
Spacebar to f lip orientation, 149

drafting views, 87–88, 369–370
saving, 383

drag controls, 99
Draw panel, 103, 371, 371
drawing list schedule, 94
Drawing mode, 263
drawing points, to create topography, 

260, 260–262, 261
drawings

design documents as, 2
markup with Design Review, 

400–401
Duplicate as Dependent method,  

316, 317
use cases, 318, 318–322

Duplicate with Detailing method, 
317, 317

duplicating views, 80
DWF (Design Web Format)

exporting, 395, 395–402
printing, 454–455

DWF Export Settings dialog box, 227, 
228, 396

DWFx file format, 227
.dwg files

civil engineering, 253–262
converting for use in Revit  

model, 263
converting gridlines into Smart 

Revit gridlines, 265–266, 266
deleting unused, 451
exporting, 226, 236–240
for imported library components, 

270, 270
importing, 241, 246, 452

for drafting view, 88
and performance, 450

linking, 241, 246, 452
and print performance, 394–395
transforming info into 

topography, 255, 255–257
using lines as reference to create 

Revit f loors, 268–269, 269
using lines to create Revit walls, 

268, 268
.dxf files, 227

importing and linking, 241, 246

E
Edit Assembly dialog box, 102

Esc button and, 206
Modify, 206
for roof structure, 223
Sweeps or Reveals button, 202
and wall preview, 202

Edit Color Scheme dialog box, 277, 277
by range, 278, 280–281, 281
Scheme definition, 277, 279

Edit Label dialog box, 310, 310
editable text

blue font for, 99
in keynote, 345

editing tools, 170–176
copy, paste and cut, 170–171
Copy tool, 172–173
Mirror tool, 175, 175, 176
Move tool, 171–172
Rotate tool, 173
Split tool, 180, 180
Trim/Extend tool, 180–181, 181

Element Properties button, 32
Element Properties dialog box,  

115, 115
defined status in, 401, 401
for keynotes, 351
for legend, 280
to modify wall height, 119
for roof, 134–135
for stacked wall, 199

elements. See also families
aligning, 177, 177–178
applying to massing form, 444–447
borrowing between team 

members, 424
changing host, 344
closing chain, 67

73559bindex.indd   467 6/4/09   8:58:00 PM



468  ■   elements  – file formats

context menu, 33
creating for Design Options, 

422–423
deselecting, 64
dragging without selecting, 34
finding, 367
hosted or unhosted, 412, 413
keynotes for, 345, 352, 352
model categories, 13
overrides, 187, 187
physical properties  

information, 93
purging unused, 452
removing from selection, 113
scheduling, by link instance 

name, 243
in sketch-based design, 142
Snap Overrides, 66
subcategories, 14, 15, 16
tags for, 326
unhiding, 189–192
visibility, 15, 16
in worksets, 427

elevation graphics, 287–288
elevation tag, 86

deleting, 87
inserting, 85–86

elevation views
duplicating, 86
for Level tool, 79
using images in, 288–289, 289

elevations, 85–87
Ellipse tool, 371
embedded DWF viewer, in Vista, 396
embedded relationships, 11–13
empty view, when closing Revit, 456
end point, for Move command, 172
energy analysis, 4
EPS format, 403
error messages, “Can’t keep 

elements joined” error message, 
130, 130

Excel
for editing keynote file, 346
exporting files for, 232–233

expanded panels, 30
Explode tool, for imported file, 247, 

251–252
Export Building Site functionality, 228

Export CAD Formats dialog box
DWG Properties tab, 238–240, 239
View/Sheet Set tab, 236–238, 237

Export gbXML dialog box, 235, 235
Export Image dialog box, 230, 230

format section, 231
image size section, 231

Export Layers DGN option, 240
Export Layers dialog box, 240
export template, 240
exporting, 226–236

animation, 232
BIM data, 395, 395–403
CAD formats, 226–227
details from Revit projects, 

382–385
images, 230–231
ODBC database tables, 232–233
view or sheet as single DWF  

file, 397
exterior walls, 110–113

level 2, 116–119, 118
external text file, for keynotes, 345

F
face of wall, joins and, 120–123
families, 13–19, 70, 406–418

for 3D content, 270
component, 17–18, 409–410, 411

examples, 410
context menu for, 35
creating, with solid or void 

geometry, 210
default insertion point, 412
in-place families, 408–409, 409
for keynotes, 349, 349–350
levels of detail and view 

visibility, 414–415, 415
nested, 416, 416–417, 417

complex, 418
opening, 25
parametric and nonparametric, 

413, 413–414, 414
in Project Browser, 35, 35
shared, 417
system families, 407
templates for, 410, 411–413, 412
types, 415
upgrading, 418
visual control, 416

Family Category and Parameters 
dialog box, 408, 408

Family Editor, 17–18, 70, 405, 406
to create custom profile, 202
to create new family, 410
opening, 410
sketch-based tools, 431
for system families, 17
Visibility tool, 456

Family Element Visibility Settings 
dialog box, 414, 414

family libraries, default location, 
68–69

family template files (RTF), 72
family worksets, 425
FAQs, 21

knowledge base of, 461
Far Clip Plane, 394, 453
far clipping for camera, 92
fascia board, 374
Favorites button, in Info Center 

toolbar, 27
FBX, 234, 292
Field Format setting, 65
fields, custom, 365
file formats, 70–74. See also .dwg 

files
.bmp

exporting view or sheet as, 
230

importing and linking, 241
CAD, 226–227. See also CAD 

(computer-aided design)
DWF (Design Web Format)

exporting, 395, 395–402
printing, 454–455

.dxf, 227
importing and linking,  

241, 246
.jpg

exporting view or sheet as, 
230

importing and linking, 241
PDF (Portable Document 

Format)
printing from, 454–455
printing to, 402–403

.plt, 388

.prn, 388

.rfa, 70–72

elements (continued)
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.rft, 72

.rte, 72–74

.rvg, 72

.rvt, 70
file locations, settings for, 68–69
File Locations tab, 155
file names

for keynote files, 346
on title bar, 26, 26

FileMaker Pro, exporting files for, 
232–233

files
corruption, 456–457
printing to, 388
purging to reduce size, 453

fill available space layout, for 
repeating detail, 377

Fill Pattern Graphics dialog box,  
286, 286

Fill Pattern Graphics override dialog 
box, 185–186

Filled Region tool, 378, 378–380, 379
filled region, type properties, 379–380
Fillet Arc tool, 371
Filter tool, and selection, 55
filtering data on schedule, 361
finding

elements, 367
resources, 460–462

Finish Floor button, 127
Finish Sketch button, 163–164
fireplace walls, 113–115
fixed distance layout, for repeating 

detail, 377
fixed number layout, for repeating 

detail, 377
Fixed - Varied Size window, 154
flat roof, 132–136

slope for, 134
flip controls, 59, 59
Flipped Dimension Line Extension 

option, 338
floor area analysis, 444
floor divisions. See levels
f loor plans, 83

accentuating walls, 286–287
after applying graphic  

overrides, 287
dimensions for, 339–340, 340
typical, 285

f loors, 104
advanced shape editing, 220–224
copying between levels,  

128–131, 129
creating, 126, 126–127, 127
Model by Face tool for, 447
using DWG lines as reference to 

create, 268–269, 269
folders, for custom library  

elements, 155
fonts, for dimensions, 339
foreground

color fill in, 279, 279
image in, 288
for rendering, 295–296

Form Z, 430
Format dialog box, 65, 65
formatting

documentation, 356–360
schedule data, 362

forms
applying building elements to, 

444–447
creating, 434
joining and cutting, 436, 436
lofted, 441, 441
making and rationalization, 

437–442
revolve, 440, 440–441, 441
sweep, 441–442, 442
temporary dimensions for  

height, 438
tools for creating, 431, 431–432

Full Explode, for imported DWG  
file, 252

Full Navigation wheel, 51, 51
furniture, placing, 156, 156–157, 157

G
gbXML (Green Building XML), 

234–235
geometry, imported, 452
.gif file format, importing and 

linking, 241
glazed panels, 213
glazing materials, 299, 299

printing transparent vs.  
opaque, 392

gradient backgrounds, 288, 289

Graphic Display Options dialog box, 
288, 290

Graphic Display Options in View 
Control bar, 42, 42–43
shadows and sun, 42–43
silhouette edges, 43
sun studies, 44

graphics card
and performance, 451
settings for, 68

Gray Inactive Worksets toggle, 427
grayed-out sketch, 164
Green Building XML (gbXML), 

234–235
gridlines, converting DWG to smart 

Revit gridlines, 265–266, 266
grids, 98–100

changing pattern, 146,  
146–147, 147

creating, 99–100
limiting range for, 267
for schedules, 362
and structural elements, 100

grip editing, 56, 56–57
gross f loor area, 282, 445–446
Group and Associate option,  

for array, 174
grouping schedule data, 361
gutters, adding to roof, 374,  

374–375, 375

H
hatches, and print performance, 394
height

of opening, displaying, 339, 339
of room, dragging in view, 284, 284
of wall, 109

changing, 123–124,  
123–124, 125

height coordinate, when creating 
topography, 260

height of form, temporary dimensions 
for, 438

help lines, for stair run, 161
Help menu

for formula syntaxes, 365
in Revit, 460–461

help, resources for, 20–22
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hidden elements, magenta color  
for, 191

hidden line
displaying, 112
views, 392

hidden line graphic style, 41, 42, 392
Hide/Isolate tool, in View Control 

bar, 39, 45–46, 46
historical architecture, 418
Home tab in Revit Ribbon, 28, 28

Build panel, 104
Component - Model In-Place 

tool, 209, 408
Component Placement  

tool, 156
Component tool, 106, 217
Curtain Grid tool, 214
for doors and windows, 105
Floor tool, 126, 194, 268
Multi-Select tab, 195
Roof tool, 132
Wall Sweep tool, 209
Wall tool, 103, 108, 110, 198, 

208, 214
Circulation panel

Railing, Ramp, and Stairs, 105, 
106–107

Railing tool, 166
Stairs tool, 160

Component panel, Load from 
Library, 18

Datum panel
Grid tool, 99, 265
Level tool, 79, 99

Draw panel, 103, 371, 371
Element panel, Change Element 

Type, 214
Model panel

Model Line tool, 372
Model Text tool, 343

Mullion tool, 214–215
Room & Area panel

Area and Volume 
Computations, 282

Area Boundary tool, 283
Area Plan button, 283
Color Schemes, 280

Room flyout, 451
Windows tool, 153

host sweeps, 209
hosts, for elements, 412, 413

house project, 104, 110, 110
axonometric view, 90
bathroom layout, 158
component placement, 156–158
default 3D view, 116
doors and windows, 148–152, 

148–152
adding doors to level 2,  

152, 152
placing windows, 152–154, 153
resizing windows, 154

final perspective view, 168, 168
fireplace walls, 113–115
f loor plan, with dimensions, 340
f loors, 126, 126–127, 127
interior walls, 120, 120

attaching to roof, 141–142
railings, 165, 165–168
roofs, 132–136, 133, 134, 135

adding gutter, 374, 374–375, 375
additional, 137, 137–141, 138, 141

stairs, 159, 159–165
creating, 160–163
properties, 160

starting sketch, 111
wall join and face resolution, 

120–123
walls, 125

closet, 118
exterior, 110–113
exterior, level 2, 116–119, 118
finished, 122
interior, 120, 120
interior, level 2, 124, 125

hung façade, 102

I
i-drop content, 271
IES (Illuminating Engineering 

Society), 295
IES <VE>, 235
IFC (Industry Foundation Class), 236

export options, 240
importing, 241

IGDS (Interactive Graphics Design 
System), 227

Illuminating Engineering Society 
(IES), 295

images
in elevation views, 288–289, 289
exporting, 230–231

importing, 248–249, 249
presentation graphics, 285–289
resizing after inserting, 249

implicit alignment lines, 99–100
Import CAD Formats dialog box, 247

Current View Only option, 264
Import Instance Query dialog box, 

252–253, 253
Import/Link Revit Files dialog  

box, 246
Import Units option, in Import and 

Link CAD Formats dialog  
boxes, 248

importing, 241–249
CAD files, 241–242, 245–248, 382

drafting views for, 88
.dwg files, 254
exploding file after, 247
images, 248–249, 249
library components in SketchUp 

(.skp) format, 270, 270
vs. linking, 246–248
points file to create topography, 

259, 259
views into projects, 384, 384–385
working with files, 250–253

in-place families, 18, 408–409, 409
In-Place Mass tool, 432
independent view, dependent view 

conversion to, 324
Industry Foundation Class (IFC), 236

export options, 240
importing, 241

Info Center toolbar, 27, 27
information, 1

adding to model, 459
inclusion in project, 19

Inscribed Polygon tool, 371
Insert tab in Revit Ribbon, 28, 28

Autodesk Seek search field, 155
Import panel, 241, 241

Import CAD, 254
Insert from File

Insert 2D Elements from File, 
385, 385

Insert Views from File, 384
Views, 383

Link panel, 241, 241
Link Revit, 244

Load From Library panel, Load 
Family, 311
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inside setting, for repeating  
detail, 377

instance parameters
to change object size, 62–63
changing type parameters to,  

63, 63
in tags, 329
for windows, 154

Instance Properties dialog box, 98, 194
for controlling form’s height, 439
for images, 249, 249
Scope Box, 267, 267
for views, 304
for walls, 102

instance property, of stair, 107
insulation, 378
Insulation Bulge to Width Ratio 

parameter, for Insulation tool, 378
Insulation Options bar, 378
Insulation tool, 377–378
integrated wall sweep, placing,  

202–205, 207
Interactive Graphics Design System 

(IGDS), 227
interdependence of documents within 

BIM model, 5
interference checking, 5
Intergraph, Interactive Graphics 

Design System (IGDS), 227
interior elevation, 86
Interior Tick Mark option, 338
interior walls, 120, 120

level 2, 124, 125
invisible lines, in sheet border, 309
italic text, 342

for dimensions, 338

J
Jaws PDF, 403
joining forms, 436, 436
joins, disallowing between walls, 12
.jpg file format

exporting view or sheet as, 230
importing and linking, 241

K
keyboard shortcuts, 63–64

modifying and personalizing, 32
Keyboard Shortcuts.txt file, 32

keyframes, for walkthrough, 92
Keynote Legend Properties dialog 

box, 349
Filter tab, 349

keynote legend schedule, 95
Keynote Tag.rfa family, 349
keynotes, 340, 344, 344–353

adding to view, 347–348
adding to wall section

by element, 351–352
by material, 350–351

arrowhead styles for, 351, 351
behavior and editing, 345–346
family, 349, 349–350
filenaming conventions, 346
legends, 348, 348–349
predefining, 352–353
preview prior to placement, 348
settings for, 347

Keynoting Settings dialog box,  
347, 347

keytips, modifying and personalizing, 
32

Khemlani, Lachmi, 21, 461
knee wall, 109
knowledge base, of FAQs, 395, 461

L
labels, for contour elevations, 262
Layer/Level Colors option, in Import 

and Link CAD Formats dialog 
boxes, 248

layers, 9
attributes in imported CAD file, 252
in CAD, 16
join cleanup, 196–197
managing in imported CAD  

file, 250
settings for DWG export, 238, 239
in wall, 203

Layers option, in Import and Link 
CAD Formats dialog boxes, 248

layout, for repeating detail, 377
leader line

for tags, 327
for text, 342, 342–343

left mouse button, 50
legends, 88–89, 89, 280

for keynotes, 348, 348–349
notes keyed to, 344

Level tool, 79
levels, 78–79, 98–100

attaching walls to, 131
creating, 79, 99–100
creating views with, 78–79
graphical editing controls, 99–100
limiting range for, 267
smart relationships with, 98

Libraries folder, 411
library components, imported DWG 

file, 270, 271
library, default location for keynote 

.txt file, 347
library elements

folders for custom, 155
RFA file format for, 70–72

Light Groups dialog box, 295
lighting

for rendering, 294–295
upgrading, 295

Line Graphics override dialog box, 
185, 185

Line Styles dialog box, 108
line thickness

for schedule grid, 362
for tick mark, 338

Line tool, 371
line types, custom, 377
line weights, 67

of text, 342
Line Weights dialog box, 67
linear array, 174
linear dimensions, 333

changing baseline dimension  
to, 336

lines
for mass, creating, 434
Split tool for, 180, 180
in views, visibility, 247

linetype scaling control, settings for 
DWG export, 238

Link CAD Formats dialog box,  
247, 248

linking, 241–244
.rvt files, 244–245
CAD formats, 241–242, 245–248
editing linked file, 244
vs. importing, 246–248
other Revit models, 242–243
positioning linked files, 244–245
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472  ■   lists. See schedules – Modify tab in Revit Ribbon

lists. See schedules
Load Family dialog box, 155
loaded families, 35
Loaded Tags dialog box, 326
local files, for worksharing, 451
Location Line parameter, of wall, 

109, 109
locks, 13, 60, 99

for constraints, 150, 151
for elements, 178
limiting use of, 456
for wall layers, 206, 207

lofted form, 441, 441
Look tool in 3D SteeringWheel, 52
loop, 126

cleanup to form, 131
closed, 128

M
magenta color, for hidden  

elements, 191
Manage Links dialog box, 242,  

242, 243
Manage Place and Locations dialog 

box, 295, 295
Manage tab in Revit Ribbon, 29, 29

Design Options panel, 420, 420
Manage Project panel, Manage 

Links, 242
Materials, 100, 287
Project Settings panel, 66

Object Styles, 68, 83
Review Warnings, 457
Settings

Line Styles, 108
Object Styles, 182
Sheet Issues/Revisions, 313

Settings panel, Object Styles, 14
Transfer Project Standards, 17

manual alignment, 178, 179
Masking Region tool, 374
masking regions, 373–374
mass. See also forms

creating, 433–436
direct manipulation, 435, 435
finishing editing session, 434
sliced into f loor area faces, 446

mass elements, names for, 445
mass families, 431

Mass Floors tool, 432, 432,  
444–445, 445

Massing & Site tab in Revit Ribbon, 
29, 29
Conceptual Mass panel, 431, 431

Model by Face tools, 444, 444
Create Site panel, Toposurface 

tool, 260
In-Place Mass tool, 433
Model by Face, Wall, 446
Model Site panel, Toposurface 

tool, 254, 255
Modify Site panel, Label 

Contours, 262
massing workflow, 430–431, 431
Mass.rft file, 431, 437
master builder, 2
match lines, view tags and, 323, 323
Match Type tool, 139
material library, for rendering, 292
Material tag, 328
material take-off schedule, 94
materials

editing colors, 287
keynotes for, 345, 353
parametric, 439
preventing light effect on  

color, 288
preview of keynote, 350
quantity take-offs, 5
for rendering, 297–299

Materials dialog box, 287
defining keynotes, 352
Render Appearance tab, 297, 

297–298
Materials folder, 292
mathematical formulas, in family 

design, 415, 416
maximum spacing layout, for 

repeating detail, 377
Maya (Autodesk), 8, 430
.mdb files, 233
measurement units, for CAD 

packages, 239
memory, 3GB switch, 450
Metric Mass.rft file, 437
Metric Profile.rft file, 202
Microsoft. See Windows Vista; 

Windows XP
Microsoft ODBC connector, 

232–233

MicroStation (Bentley Systems), 227
Minimized to Panel Titles state, 77
Mirror tool, 175, 175, 176
miter join, 197, 197
Model by Face: Curtain System  

tool, 447
Model by Face: Floors tool, 447
Model by Face: Roofs tool, 447
Model by Face tools, 432, 432
Model by Face: Walls tool, 446
model categories, 13
model crop, 319
Model Graphics Style property

in View Control bar, 41, 41, 42
for views, 305

Model Group tool, 72
model text, 343, 343–344
modeling, 19

break up in submodels, and 
performance, 454

finding elements in, 367
limits on, 460
simplicity or complexity, 20
starting from scanned drawing, 

271–274, 271–274
visualizing, 76
workflow for, 459

modeling applications, 8
Modify Floors tab in Revit Ribbon

Clipboard panel, Paste  
Aligned, 128

Edit Boundary button, 129
Shape Editing panel, 220–221

Modify Furniture tab in Revit 
Ribbon, Mirror tool, 156

Modify Sub Elements tool, 221
Modify tab in Revit Ribbon, 29, 29

Align tool, 146
Clipboard panel, Match Type 

tool, 139
Edit Geometry panel, 196
Edit panel

Align tool, 121–122, 177, 
177–178

Trim tool, 127
Element panel, Change Element 

Type button, 406
Form panel, Visibility  

Settings, 414
Join tool, 436
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Modify Wall Sweeps tab in Revit Ribbon – Paste Aligned command  ■   473  

Modify Wall panel
Edit Profile button, 217
Top/Base Attach tool,  

135, 218
Rotation tool, 272
Scale tool, 272, 272
Section panel, Split Segment 

tool, 87
Unjoin Geometry tool, 436

Modify Wall Sweeps tab in Revit 
Ribbon, Modify Returns 
command, 208

Modify Walls tab in Revit Ribbon
Attach tool, 144
Curtain Grid panel, Add or 

Remove Segments button, 146
Edit Profile button, 217

Modifying Roof Shape start.rvt  
file, 221

mouse, to select objects, 50
Move tool, 171–172

for text, 341
moving objects, 57

with nearby elements, 62, 62
mullions, 213

with custom profiles, 216
multi-category schedule, 93–94
Multi-Category tag, 328
multi-user environment, 423–428
Multistory parameter, for stairs, 107

N
named guides, 108
names

for color-fill legend, 277
for exported DWG file, 237–238
for schedules, 95

navigating
in 3D views, 52
through project, 35–36
views, 77–78

negative space, 142
nested families, 416, 416–417, 417

complex, 418
New Area Plan dialog box, 283
New Drafting View dialog box, 369
New Plan dialog box, 79, 79
New Schedule dialog box, 95, 95–96, 

361, 361
nonparametric families, 413–414, 414

note block schedule, 95
Notepad, for editing keynote file, 346
notes. See also keynotes

adding, 350
nudging elements, 172
Number field, for elements, 174
numbering, for keynotes, 347

O
“[object] is slightly off axis”  

warning, 266
Object Styles dialog box, 14, 14, 68, 

68, 182, 256
Model Objects tab, 257
for topography, 257

objects
manipulating, 55–63

constraints (locks), 60. See 
also locks

flip controls, 59, 59
grip editing, 56, 56–57
instance parameters to 

change size, 62–63
moving, 57
moving with nearby 

elements, 62, 62
Pin tool for setting 

constraints, 60–62, 62
smart constraints, 57–58
using dimensions, 59, 59–60

relationships between, 10–11
selecting, 54–55
Tab key to select, 112, 112

ODBC database tables, exporting, 
232–233

offset of text from dimension  
line, 339

Offset tool, 181, 182
online content, 155
opaque background, of text, 342
opaque filled region, 379, 379
Open dialog box, Audit option, 457
open views, viewing all, 78
openings for stairs, chimneys, 

creating, 142
optimizing performance, 450–451. 

See also performance
Options bar

for array, 174, 174
Ungroup, 175

for dimensions, 332, 332–333, 340
Location Line parameter, as Core 

Face:Exterior, 110
modifying and personalizing, 33
for Move command, 172, 172
Reference Other View option, 88
Tag on Placement, 149
for tags, 327
to unhide element, 191, 191

Options button in Application  
menu, 26

Options dialog box, 26, 26, 68, 68
General tab, 452
SteeringWheels tab, 69, 69
ViewCube tab, 69, 69

Orbit tool in 3D SteeringWheel, 52
ordinate dimensions, 337, 337

creating style, 335–336
organization of data, 13–16
orientation

of element, f lip control to 
change, 59, 59

for views, 305
origin point (datum), 337
Origin to Origin option, for link 

positioning, 244
output size, from rendering, 294
overconstrained object, 456
overmodeling, avoiding, 455
overrides. See also Visibility/Graphic 

Overrides dialog box
for elements, 187, 187

ownership of elements, 424

P
panels, undocking from Ribbon, 30
panning

in SteeringWheel, 51
views, 50–54

parameters, 10
parametric change engine, 11
parametric extrusion, 437–439
parametric families, 413, 413–414
parametric material, 439
parametric objects, 10–11
Partial Ellipse tool, 371
Partial Explode option, for imported 

file, 252
Paste Aligned command, 170, 

170–171
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474  ■   Path creation mode – Rectangle tools

Path creation mode, for railings, 166
patterns, applying to surfaces, 443
PDF (Portable Document Format)

printing from, 454–455
printing to, 402–403

Pdf995, 403
performance

exploding DWGs and, 252, 382
linking to optimize, 242
open views and, 37
optimizing, 450–451
printing hatches and, 394
section depth and, 87
warnings and, 457, 457

perspective views, 91, 91–92, 92
annotations, 326
rendering, 292–299

.pgn files, importing and linking, 241
phase filter, for schedules, 95
Phase Filter, for views, 307
Pick Level Graphics option, for Paste 

Aligned command, 171
Pick Lines tool, 264, 371
pick method, 175
Pick option, for dimensions, 333
Pick Supports tool, 221
Pick Walls command, 126
pin, 13
Pin tool, for setting constraints, 

60–62, 62
Place Mass tool, 432
plan views, 81

adding, 79
walls in, 100

planning, 18, 458
plotters, 394
.plt file, 388
plumbing fixtures, 157–158, 158
.png file format

exporting, and background, 296
exporting view or sheet as, 230

points file, importing to create 
topography, 259, 259

Points.csv file, 259
polygons, drawing tools for, 103
polylines, exporting rooms and 

areas as, 239
Portable Document Format (PDF)

printing from, 454–455
printing to, 402–403

position options
in Import and Link CAD 

Formats dialog boxes, 248
for linking model, 244–245

post of railing, 165
Power and Light Building, Kansas 

City, MO, 2, 2–3
ppi, for exported files, 231
predefining keynotes, 352–353
Prefer option, for dimensions,  

333, 333
Presentation - 11 x 17.rfa file, 310
presentation graphics, 285–289

elevation graphics, 287–288
f loor plans, accentuating walls, 

286–287
Press & Drag check box, 34
Print dialog box, 388
Print Setup dialog box, 391, 391–393

Options pane, 393
printing, 388–395

from DWFs or PDFs, 454–455
line weights and, 67
to PDF (Portable Document 

Format), 402–403
tips, 394–395

PrintScreen key, 390
.prn file, 388
Profile.rft file, 202
Project Browser, 34, 34–35

3D views folder, 91
Area Plans, 283
drag and drop from, 314
Families node, 35, 35, 406

Annotations, 313
groups in, 373
keynote legends in, 349
modifying and personalizing, 

31–32
to place components, 157–158
Revit links, 35, 35
Schedules node, 311
Sheets node, 358
views, 34–35, 77

project environment, setting up, 
64–69

project schedule, 19
Project Settings panel,  

Project Units, 65
project standards worksets, 425

project team, 20. See also 
worksharing
collaboration, linking for, 

242–243
communication among 

members, 20, 459
Project Units dialog box, 65, 65–66
projects. See also house project

importing views into, 384, 
384–385

opening, 25
reusing details from other, 

382–385
starting new, 265–270

template for, 73–74
properties

of elements, schedules based on, 
93

settings for DWG export, 238
of views, 303–307

Publish Coordinates option, for link 
positioning, 245

publishing exported DWF files, to 
Autodesk Buzzsaw, 227

Purge Unused dialog box, 452

Q
Query tool, 252–253
question mark (?), for unidentified 

material, 351, 351
Quick Access Toolbar, 26, 27

3D button, 90
changing tools on, 26

R
R (Application menu), 25–26, 26. 

See also Application Menu (R)
radial array, 174
radial dimensions, 333
railings, 106, 106–107, 162–163

creating, 166, 166
hosts for, 168, 168
modifying existing, 167, 167

rails of railing, 165
raster processing, for printed  

view, 392
rationalization of surfaces, 442–443
Rectangle tools, 103, 371
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recycled content of walls – section marks  ■   475  

recycled content of walls, displaying 
information about, 363

Redo command, 64
reference lines, 434

limiting range for, 267
reference planes, printing, 393
referencing

drafting view to model, 88
similar elements, 58, 58

Rehost button, for text, 344
relationships, embedded, 11–13
relinquishing elements, 424
rendering

camera, 293
materials for, 297–299
perspective views, 292–299

foreground and background, 
295–296

saving image, 296
Rendering Appearance Library, 298, 

298, 299
Rendering dialog box, 292, 292

lighting, 294–295
quality settings, 294

rendering library, default installation 
path, 69

rentable area, 282
repeating detail, creating, 375–377, 376
Report Shared Coordinates option, 

for link positioning, 245
reports, 233–234
resizing windows, 154
resources, finding, 460–462
Return Panels to Ribbon  

command, 30
Reveal Hidden Elements toggle, 39, 

48, 48, 189
reveals, 208
revision clouds, 311
Revision Properties dialog box

Appearance tab, 312, 312
Fields tab, 311, 311

revision schedule, in title block, 
311–313, 312

Revit. See also user interface
beginnings, 3–4
closing, empty view before, 456
concepts, 10–13
getting started in, 18–22, 458–460
potential hazards, 9

reasons for, 10
starting, 24
upgrading, 456

Revit Architecture, 243
Revit City, 21, 461
Revit Group file format (RVG), 72
Revit links, 35
Revit MEP, 243
Revit model. See also modeling

linking other Revit models, 
242–243

visualizing, 76
Revit Structure, 243
RevitKeynotes_Imperial.txt file, 

345–346
revolve form, 440, 440–441, 441
Rewind History stack, 51, 51–52
.rfa files, 17, 70–72

dragging and dropping, 155
.rft files, 72
Rhinoceros, 8, 430
Ribbon in Revit interface, 25, 27, 

27–30. See also specific tabs
contextual tabs on, 108
Finish Roof button, 134
modifying and personalizing, 

30–32
Move tool, 162
restoring default, 30–31
states for tabs, 77
tabs, 28–29

right mouse button, 50
Roof by Footprint method, 224
roof structure preview, 223
roofs, 104, 104, 132–136, 133, 134, 135

adding gutter, 374, 374–375, 375
additional, 137, 137–141, 138, 141
advanced shape editing, 220–224
attaching curtain wall to, 218, 

218–219
Model by Face tool for, 447
modifying existing, 138–141
slope of, 221, 221–223, 222
transparent, 141, 141
warped surfaces, 224, 224

Room/Area Reports, 233–234, 234
Rotate tool, 173, 173
rotating elements

crop region, 319, 320, 321
spacebar for, 173

Rotation on Sheet setting, for views, 304
.rte files, 72–74
.rvg files, 72
.rvt files, 70

exporting view as, 383
linking, 244–245

S
Same Place option, for Paste Aligned 

command, 171
Santa Maria del Fiore, 2
SAT (Standard ACIS Text) files, 227

importing and linking, 241, 246
saving

audited file, 457
drafting views, 383
rendered image, 296
workshared file, 427

Scale command, 11
Scale parameter, for material when 

rendering, 297
Scale tool, 176, 176

in View Control bar, 39, 39–40
Scale Value property, of views, 304
scanned drawing, starting model 

from, 271–274, 271–274
Schedule Properties dialog box

Appearance tab, 366, 366
Filter tab, 364, 364
Sorting/Grouping tab, 364, 364

schedules, 5, 93–96, 233, 361–369
to control elements, 367
creating, 93–95
creating and customizing, 361–366
for Design Options, 423
making simple, 95–96
placing on sheets, 368–369
in table form, 96
view templates for, 367–368

scope boxes, 267–269
applying to view, 306
printing, 393

screen display, 24–30, 25
color settings for, 68

scroll wheel on mouse, 50–51
scrolling views, 50–54
Section Box tool, 49
section flag, 78, 78
section marks, 315
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476  ■   section symbol – stairs

section symbol, 87
section views

color-coded, 283–285
for Level tool, 79
of stairs, 164
wall in, 203

sections, 87
color fill, 276

Select All Instances command, 35
Select Levels by Name option, for 

Paste Aligned command, 171
Select Views by Name option, for 

Paste Aligned command, 171
Selected Views/Sheets option, 

390–391
selecting objects, 50–63

adding multiple objects, 64
removing elements from, 113

Selection Filter dialog box, 34
selection window, 54, 55
selections, creating, 357, 357
Shading graphic style, 41, 42, 392
Shading with Edges graphic style, 

41, 42, 112, 392
for elevation view, 287

shadows, 289–292
and performance, 43, 453

Shape Editing tools, 220–221
shared coordinates, 244–245
shared families, 417
sharing. See also worksharing

BIM model, 228–229
sheet index, to documents, 94
Sheet Information fields,  

for views, 306
sheets, 309–324

adding title block, 309–313
revision schedule, 311–313

adding views to, 358
border, 309

printer type and, 311
exporting

as image file, 230
as single DWF file, 397

layout, 356–360, 360
parametric relationships and 

management, 11
placing schedules on, 368–369
placing view on, 314–324

splitting views across multiple, 
316–317

standard sizes, 395
templates for, 358
view titles on, 313–314

Shift key, for deselecting elements, 64
Show Crop Region tool, 319, 359
Show Mass tool, 432
Show/Remove Hidden Lines tool, 

381, 381–382
simplicity, or complexity in 

modeling, 20, 460
simulations, on-demand, of 

building performance, usage and 
cost, 4

Singapore Code Checking (BCA) 
certification, 236

site plans, 83
Site Settings dialog box, 261, 261
SitePlan.dwg file, 254
size of dimension text, 338
size of view, and space on sheet, 

314–315
sketch lines, 194
Sketch mode, to create stairs, 106
SketchUp, 8, 430
SketchUp (.skp) file format, 414

importing and linking, 241, 246
importing library components 

in, 270, 271
skirting, 202
“slightly off axis” warning,  

for object, 266
slope

for f lat roof, 134
of roof, 221, 221–223, 222
settings for, 65, 65

smart constraints, 57–58
smart move, 11–12, 12
“smart” relationships, breaking, 12
Snap Overrides, 66
snapping walls to intersection points 

of guidelines, 111
snaps, 66
Snaps dialog box, 66
solar studies, 289–292

creating, 290–291
exporting as animation, 232

solid form, 436

solid geometry, creating family  
with, 210

solid panels, 213
sorting schedule data, 361
Source_House_Beginning_

Detailing 
.rvt file, 329

Source_House_Complete 
. rvt file, 292

Source_House_Components_Start 
.rvt file, 156

Source_House_CurtainWall_Start 
.rvt file, 142

Source_House_End_Detailing 
.rvt file, 339

Source_House_Floor_Roofs_Start 
.rvt file, 126

Source_House.rvt file, 356
Source_House_Stairs-Railings_

Start 
.rvt file, 160

Source_House_Walls_Start.rvt file, 
108, 110

Spacebar, 64
to change control orientation, 

435, 435
to f lip door orientation, 149
for f lipping objects, 114, 114
to rotate elements, 58, 173
for rotating objects, 115

spacing setting, for repeating  
detail, 377

specialization, in design and 
construction process, 2

Specify Coordinates at a Point 
option, for link positioning, 245

spelling, settings for, 69
Spline tool, 371
Split tool, 131, 131, 180, 180

for schedules, 368, 369
splitting views across multiple 

sheets, 316–317
spreadsheet/database application, 

exporting data for, 233
SQL Server, exporting files for, 

232–233
stacked walls, 197–200, 199

variable instance in, 200
staggered section lines, 87
stairs, 106, 106–107
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Standard ACIS Text  – type catalog  ■   477  

3D sectional view, 164, 164–165
creating opening for, 142
as railing host, 168

Standard ACIS Text (SAT) files, 227
importing and linking, 246

standard families, 409. See also 
component families

standards, 18, 458
start page for Revit, 24, 25
start point, for Move command, 172
Station.rvt file, 362
Station_Start.rvt file, 280, 308
status bar, modifying and 

personalizing, 34
steel, 2
SteeringWheels, 51, 51, 53

to navigate model, 90
for perspective views, 293

STEP application protocol, 236
structural bays. See grids
structural elements, and grids, 100
Structure parameter, editing, 102
study models, 430
subcategories, of elements, 14, 15, 16
Subscription Center, in Info Center 

toolbar, 27
Subscription Support for Revit,  

21, 461
Sun and Shadows Settings dialog 

box, 288, 288, 294
Multi-Day tab, 290

surfaces, 436
applying pattern to, 443
dividing, 442, 442
levels of representation, 443, 444
rationalization of, 442–443

sweep, 441–442, 442
sweep path, editing, 211
symbols, visibility, 100, 100
Synchronize with Central tool, 427
system families, 17, 407

reusing in other projects, 17

T
tab-delimited text, exporting, 233
Tab key, 63

impact in text box, 342
to select objects, 112, 112

Tag All Not Tagged dialog box,  
329, 329

Tag All Not Tagged tool, 329
Tag By Category option, 328
tags, 11, 326, 326–329

changing value, 328–329
for door, 149
loading, 326
placing, 327–328
rotating with view, 322

Tangent Arc tool, 371
task-oriented methodology, for 

BIM, 8
team members. See also worksharing

collaboration, linking for, 
242–243

communication among, 20, 459
organization, 460

templates
default location, 68–69
for export, 240
for family, 410, 411–413, 412
files, 72–74
of graphic standards, 18
opening, 18
for schedule view, 367–368
tags preloaded to, 326
views preset with, 77

Temporary Dimension Properties 
dialog box, 149, 149

temporary dimensions, 60, 61, 111, 
111, 150
converting to permanent, 149
for door, 148
for height of form, 438

temporary mode, for hide and 
isolate, 45–46

text, 340, 341–344
adding to dimension string, 331
blue font for editable, 99
formatting tools, 341
leader line of, 342, 342–343
model text, 343, 343–344
properties, 341–343, 342

for dimensions, 338–339
text notes, schedules of, 93
textnotes, 344. See also keynotes
.tga file format, exporting view or 

sheet as, 230
thin line mode, 40

three-dimensional design 
visualization, 5

tick mark, for dimensions, 337, 337
Tick Mark Line Weight option, 338
.tif file format

exporting view or sheet as, 230
importing and linking, 241

tiled windows, 39
title bar, 26, 26
title block

adding revision schedule to, 311, 
311–313

adding to sheet, 309–313
turning off, 314, 314

Title on Sheet field, for views, 306
toolbars, moving undocked to 

Ribbon, 30, 30
tooltips, 49, 49
Top/Base Attach tool, 135
Top Constraint parameter, for wall, 

117, 123
Top Down tool in 3D 

SteeringWheel, 52
top plane, 82
topography

importing points file to create, 
259, 259

Object Styles dialog box for, 257
transforming DWG site info 

into, 254, 255, 255–257, 256
Visibility/Graphic Overrides 

dialog box for, 258
toposurface, 256
totals, Revit auto-calculation of, 365
trace, 16
Transfer Project Standards feature, 

18, 458
transparency, graphic overrides 

using, 190
transparent background, of text, 342
transparent filled region, 379, 379
transparent roof, 141, 141
triangular snap, 163, 163
Trim/Extend tool, 180–181, 181
twentieth century, buildings, 2–3
twisted wall, blend technique for, 211
.txt file format

exporting, 233
for keynotes, 345–346

type catalog, 415, 415
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478  ■   Type Mark parameter – View window

Type Mark parameter, 328
type parameters, changing to instance 

parameters, 63, 63
Type Properties dialog box, 36, 194

for dimensions, 335, 337
for filled region, 379, 379–380
for repeating detail, 375,  

375–376, 376
for stacked wall, 198, 198
for stairs and railings, 107
for tags, 329
for text, 341–343, 342
Text pane options, 338–339
for wall layers, 101, 101
for wall, with predefined  

keynote, 352
Type Selector, 32, 32, 33, 33, 406

Basic Wall: Panelized Wall, 115
Curtain Wall, 214
for imported image, 249
visual previews in, 157

U
UIState.dat file, 31
unconnected wall height, 109
Underlay option, for views, 305
Underlay Orientation option, for 

views, 305
underlined text, 342

for dimensions, 338
Undo command, 64
unhiding elements, 189–192
unreferenced view tags, hiding for 

print, 393, 393, 394
upgrading Revit, 456
usable area, 282
use cases

Duplicate as Dependent method, 
318, 318–322

for importing CAD files, 246
user-defined rules, 13
user files, default location, 68–69
user interface, 24–30

application frame, 25–30
Application Menu (R), 25–26. 

See also Application Menu (R)
Info Center toolbar, 27, 27
Quick Access Toolbar, 26, 27
Ribbon, 27, 27–30
title bar, 26, 26

modifying and personalizing, 
30–49. See also View Control bar
Count Selection tool, 34, 34
keyboard shortcuts, 32
keytips, 32
Options bar, 33
Project Browser, 31–32, 34, 

34–35
Ribbon in Revit interface, 

30–32
status bar, 34, 34
View window, 37–38

navigating through project, 35–36
screen display, 24–30, 25
start page, 24, 25

user notes, 352, 353
username, 68
UV division of surface, 442, 443

V
variable instance in stacked wall, 200
vector processing, for printed view, 392
video card adapters, options for better 

performance, 452
View Control bar, 38–48, 39

Crop Region tool, 44–45, 45
Crop View/Do Not Crop View, 322
for detail level, 194
Detail Level icon, 40, 40–41
Graphic Display Options, 42, 

42–43
shadows and sun, 42–43
silhouette edges, 43
sun studies, 44

Hide Element option, 142
Hide/Isolate tool, 45–46, 46
light bulb icon, 189, 189
Model Graphics Style property, 

41, 41, 42
Rendering tool, 292, 292–293
Reveal Hidden Elements toggle, 

48, 48
Scale tool, 39, 39–40
shadow options, 288
Show Crop Region tool, 319, 359
temporary hide/isolate tool, 142

view depth, 83
view links, printing in blue, 393
view list schedule, 94
view marker, moving, 315
View menu, ➔ Properties, 45

View Properties dialog box, 276, 291
accessing, 303
Color Scheme Location to 

Foreground, 281
Far Clip Plane, 394
Visibility/Graphic Overrides, 356

view range, 81–84
View Range dialog box, 81, 81

opening, 306
Primary Range features, 82, 82–84, 

84, 85
view reference graphics, to navigate 

between views, 77–78, 78
view references, 323–324, 324
view scale, 314–315
View Scale property, 304
View/Sheet Set dialog box, 390–391, 

391
View tab in Revit Ribbon, 29, 29, 77, 77

Camera tool, 291
Close Hidden Windows, 451
Create panel

3D, Camera, 91
3D View tool, 89
Callout tool, 88, 357
Drafting View, 88, 369
Legends, 89
Plan Views/Floor Plan, 79
Schedules, 93, 95, 361
Walkthrough tool, 92, 232

Graphics panel
templates, 307
Thin Line button, 208
Visibility/Graphics, 250, 286

Legend list, Keynote Legend, 348
Revision Schedule, 311
Section tool, 164
Sheet Composition panel, 314

Matchline tool, 323
view tags

match lines and, 323, 323
unreferenced, 393

view templates, 307–309
for schedules, 367–368

View Templates dialog box,  
307–309, 308

view titles, on sheets, 313–314
View toolbar, 90
View window, 37–38

exercise, 36, 37
modifying and personalizing, 

37–38
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view workset – walls  ■   479  

view workset, 425
ViewCube, 52–54, 53, 54, 90, 288

in perspective view, 54
viewport, 313
views, 76

adding to sheet, 358
cascaded, 38
closing unused, 451
creating, 76–78

with levels, 78–79
crop region, and import  

display, 265
customizing for design  

options, 421
depth, and performance, 453
detail level, 456

and performance, 454
drafting, 369–370
dragging room height, 284, 284
duplicating, 80
editing, 316
exporting

as image file, 230
as single DWF file, 397

hidden line, 392
hiding elements in, 188
importing into projects, 384, 

384–385
information management in, 452
keynotes added to, 347–348
moving to different sheet, 316
name in title bar, 26, 26
navigating, 77–78
opening, 36
placing on sheets, 314–324
preparing, 302–309
Project Browser for listing, 34–35
propagating change through, 5
properties, 303–307
Revit vs. CAD, 76
saving as .rvt tile, 383, 383
splitting across multiple sheets, 

316–317
types, 80–88

3D view — axonometric 
views, 89–90, 90

3D view — perspective 
(camera) views, 91,  
91–92, 92

callouts, 85
drafting views, 87–88

elevations, 85–87
legends, 88–89, 89
plan views, 81
sections, 87
walkthroughs, 92

viewing all open, 78
zooming, panning and scrolling, 

50–54
virtual memory, 450
visibility

of elements
controlling, 15, 16
examples, 184

of symbols, 100, 100
Visibility/Graphic Overrides dialog 

box, 16, 17, 182–192, 184, 247, 257
Annotations tab, 286
categories, 183
Design Options tab, 421, 422
Detail level, 186
halftone and transparent, 186, 186
Imported Categories tab, 250, 

251, 258
line and pattern overrides, 185, 

185–186
Model Categories tab, 286
Override Host Layers, 187
to see mass elements only in 

specific views, 433, 433
for topography, 258
for views, 304
visibility, 183–184, 184
and worksharing, 424

visible portion of current window, 
printing, 389, 390

visualizing Revit model, 76
void form, 436
void geometry, creating family  

with, 210
volume computations

enabling for rooms, 283
performance impact, 451

W
Walk tool in 3D SteeringWheel, 52
walkthroughs, 92

exporting as animation, 232
wall core, 194
Wall Join Display property, for 

views, 305

wall join, grips to edit, 56, 57
Wall Joins tool, 197
Wall Options bar, 108
wall profiles, 204

adding, 205
Wall Sweep tool, 208
Wall tool, 8
walls, 100–103, 101. See also 

curtain walls
accentuating on presentation 

floor plans, 286–287
adding keynotes to section

by element, 351–352
by material, 350–351

advanced modeling, 194–211
Disallow Join tool, 197
with integrated sweeps and 

reveals, 200–211, 201
layer join cleanup, 196–197
stacked walls, 197–200, 199
Wall Joins tool, 197

changing height, 123–124, 
123–124

changing type, 113, 113,  
115–116, 116

compound types, 201
Create tool for special, 209–211, 

210, 211
creating, 103
curtain walls, 102, 103
disallowing joins between, 12
extending components, 206, 207
exterior, 110–113
fireplace, 113–115
with integrated sweeps and 

reveals, 207
interior, 120, 120

attaching to roof, 141–142
level 2, 124, 125

joins
example of bad, 121
and face resolution, 120–123
modifying, 121

layers, 203
mass to generate, 446
modifying height, 119
in section views, 203
snapping to intersection points 

of guidelines, 111
Split tool for, 180, 180
sweep returns, 208, 209
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480  ■   walls  – zooming views

type creation, 196
using DWG lines to create,  

268, 268
windows and doors hosted by, 105

warnings
“[object] is slightly off axis”, 266
“Can’t create Curtain Wall 

Mullion ...”, 144
“Highlighted walls are  

attached ...”, 136
for lines not forming closed  

loops, 127
reviewing, 457
when deleting dimension, 150
“You are changing a type 

parameter”, 328, 328
warped surfaces, 224, 224
web library, for window and door 

types, 155
website, creating browsable from 

Revit model, 230, 231
width factor for text, 342
width of elevation, 86, 86–88
Width parameter, for Insulation  

tool, 377
windows, 105, 148–152, 148–152

aligning, 178, 179
in curtain walls, 217

placing, 152–154, 153
resizing, 154
tiled, 39

Windows Explorer, dragging and 
dropping family into project, 155

Windows Vista
embedded DWF viewer, 396
UIState.dat file location in, 31

Windows XP
3 GB switch, 450
UIState.dat file location in, 31

wireframe graphic style, 41, 42, 392
Witness Line Control, 338
Witness Line Extension option, 338
Witness Line Gap to Element  

option, 338
Witness Line Length, 338
Work Plane dialog box, 344
work plane, for model line, 372
work space, 37. See also View 

window
workflow, 19

flexibility, 458
marking up 2D DWF,  

400–401, 401
massing, 430–431, 431
for modeling, 459
for worksharing, 426–427

worksets, 424–425
open, 245
organization, 426–427

Worksets dialog box, 425, 425,  
453, 454

worksharing, 423–428
best practices, 451
borrowing elements, 424
loading work from other team 

members, 428
saving file, 427

Worksharing dialog box, 425, 425

X
XREF views on sheets, 238

Z
zeros, suppressing, 66
Zoom option in SteeringWheel, 51
zoom scale, graphics drawn 

independent of, 40
zooming views, 50–54

walls (continued)
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Hotel and wellness center

Inspirational Revit Projects

Galle ry

This gallery of projects  comes from architects all around the globe 

who have embraced the move to a smarter way of working on projects and who use BIM as 

their main methodology. They have different approaches to how they start a project, from 

a conceptual massing or legacy CAD files to hand-sketching and importing from other 

modeling applications. All have different skill levels with Revit, but what ties them together 

is that they have managed to produce beautiful architectural examples using BIM. They 

have all adapted their workflows and are able to offer a competitive advantage as a result.

All projects shown have been modeled in Revit, using many of the concepts, principles, 

and techniques explained throughout this book. The renderings vary: some are done 

within Revit, using Accurender, the rendering engine that was embedded in Revit up to 

release 2008; the majority, however, have been rendered using 3ds Max and VRay, pro-

ducing some stunning visuals.

BIM is not a myth. These are real people, real projects, and real sources of inspiration. 

And don’t forget: it’s technology, it’s digital, but still, what really matters is that it’s good 

architecture.

We would like to express our sincerest gratitude to all of the architects who generously 

shared their work.

Enjoy!
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Residential design
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Andrea Sader and Ines Magri
Residential design
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E.N. Raycroft; T. Castro; A. Blood; D. Belcher
Operations Center in Napo, Equador
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RMJM Hillier
Addition to St. Louis Public Library
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Kubik+Nemeth+Vlkovic
Housing project
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Gensler
American University of Beirut, School of Engineering
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Simone Cappochin
Loggia del Capitano, Palladio
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HOK
School design, Kazakhstan

A
rc


h

itect





: HO


K
, U

K



HOK
Tower designs

A
rc


h

itect





: HO


K
, M

e
x

ic
o



Montealegre Beach Arquitectos
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Cut&Paste Design Slam
20min Competition rounds: Design Slam using Revit
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Custom families

P
h

il
ip

p
e

 D
r

o
u

ant



, France











Philippe Drouant
Custom families

  P
h

il
ip

p
e

 D
r

o
u

ant



, France











BEAUTIFUL FULL-COLOR INSERT 
Draw inspiration and ideas from the striking
images in the book’s beautiful, 16-page 
color insert while you master essential Revit 
techniques. Introducing Revit

® Architecture 2010

Dzambazova

Krygiel

Demchak

Take advantage of Revit 2010’s inspiring 
new conceptual design modeling tools 

Case Burt Hill E.Raycroft; T.Castro; A.Blood; D.Belcher

Create beautiful, functional color-coded plans Build compelling 3D models

ABOUT THE AUTHORS
Tatjana Dzambazova is an internationally recognized AEC industry technology speaker. She was project manager for Revit 
Architecture for two years and previously practiced architecture for twelve years in Vienna and London. Eddy Krygiel is 
an Autodesk Authorized Author and registered architect at HNTB Architects. He has used Revit to complete projects of all 
scopes and sizes. Eddy is responsible for implementing BIM at his fi rm and consults for other architecture and contracting 
fi rms looking to implement BIM. Greg Demchak is a product designer for Revit Architecture. He also teaches at Boston 
Architectural College and holds a master’s degree in architecture from MIT. 

www.sybex.com/go/introducingrevit2010
www.sybex.com

ISBN: 978-0-470-47355-9

$49.99 US
$59.99 CANCOMPUTERS/CAD-CAM

HARNESS  THE POWER 
OF BIM  WITH REVIT
Revit Architecture has transformed how architectural projects are 
designed and documented, and the latest edition of this popular guide 
will get you quickly up to speed on the industry-leading BIM solution. 
Introducing Revit Architecture 2010 explains the principles of BIM, provides a thorough overview of Revit, and 
then delves into fi ne detail on vital Revit tools and tasks. You’ll get comfortable with Revit’s newly designed user 
interface, and, through a series of challenging exercises, learn how to model, document, present, and share your 
design ideas using this groundbreaking software.

The expert authors—all architects with years of solid experience with BIM technology—offer pages of impressive 
examples, practical explanations, real-world architectural scenarios, and in-depth, focused tutorials. This book is 
the perfect resource for readers of all skill levels who want to quickly accomplish crucial Revit tasks. 

• Implement smart workfl ows and effectively use Revit 2010’s very latest user interface, features, and functions
• Understand BIM and its advantages over traditional drafting
• Learn parametric modeling and the Revit philosophy
• Develop a design and move it to construction documentation
• Use analysis tools to help drive sustainable design decisions
• Uncover the secrets to creating impressive presentations
• Select the best ways to exchange and share your design with others

INTRODUCING REVIT
®

 
ARCHITECTURE 2010
BIM for Beginners

Tatjana Dzambazova 

Eddy Krygiel

Greg Demchak
SERIOUS SKILLS.

B
IM

 for 
B

eginners

Foreword by Stephen Stafford


	INTRODUCING REVIT ARCHITECTURE 2010: BIM for Beginners
	Contents
	Introduction
	Chapter 1: Understanding BIM
	A Brief History of Architectural Documentation
	Advantages of a BIM Approach
	How BIM Is Different from CAD
	Why Revit?
	Revit Concepts
	Types of Elements in Revit
	Tips for Getting Started in Revit

	Chapter 2: Getting Acquainted with the Revit Interface and File Types
	Overview of the Revit User Interface
	Modifying and Personalizing the Interface
	Selecting Objects and Navigating Views
	Using Keyboard Shortcuts
	Setting Up Your Project Environment
	Revit File Formats

	Chapter 3: Views
	Visualizing a Revit Model
	Creating Views
	Working with Views
	Schedules

	Chapter 4: Modeling Basics
	Levels and Grids
	Basic Walls
	Floors, Roofs, and Ceilings
	Doors and Windows
	Components
	Stairs and Railings
	Getting Started with a Project

	Chapter 5: Modifying Elements
	Standard Editing Tools
	Additional Editing Tools
	Graphic and Visual Overrides

	Chapter 6: Extended Modeling
	Walls: Advanced Modeling Features
	Curtain Walls: Advanced Design Techniques
	Roofs and Floors: Advanced Shape Editing

	Chapter 7: Working with Other Applications
	Exporting Your Data
	Exporting DWG Drawings
	Importing and Linking
	Working with Imported Files
	Working with Civil Engineering DWG Files
	Converting 2D Drawings into a 3D BIM Model
	Starting a New Project
	Starting a Model from a Scanned Drawing

	Chapter 8: Preparing Documents for Clients
	Color-Coded Drawings
	Creating Presentation Graphics
	Shadows and Solar Studies
	Rendering a Perspective

	Chapter 9: Sheets
	Documentation Trends
	Preparing Views
	The Sheet

	Chapter 10: Annotations
	Annotating Your Project
	Tags
	Dimensions
	Text and Keynotes

	Chapter 11: Construction Documentation
	Formatting Your Documents
	Schedules
	Using Drafting Views
	Understanding Drafting Tools
	Importing CAD Details
	Reusing Details from Other Projects

	Chapter 12: Printing
	Printing Your Documents
	Revit Printing Tips
	Export Your BIM Data

	Chapter 13: Advanced Topics
	Understanding Families
	Using Design Options
	Worksharing—The Multiuser Environment

	Chapter 14: Conceptual Modeling
	Understanding the Conceptual Design Tools
	Understanding Form Making and Rationalization
	Rationalization of Surfaces
	Applying Building Elements to the Massing Form

	Chapter 15: Tips and Troubleshooting
	Optimizing Performance
	Using Best Practices
	Dealing with File Corruption
	Getting Started in Revit
	Finding Additional Resources

	Index
	Gallery: Inspirational Revit Projects




